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От авторов

Уважаемый читатель, мы предлагаем Вашему вниманию свою очередную кни-
гу, посвященную проблемам применения персонального компьютера в музыкаль-
ном творчестве. Это наша десятая книга, изданная в России.

В предыдущих книгах [ 1, 2, 3,4, 5, 6, 7, 8, 9] мы познакомили Вас с программа-
ми Midisoft Studio, Cool Edit 96, Cool Edit Pro 1.2, Vienna SoundFont Studio, Visual
Arranger, Band-in-a-Box, Cakewalk Pro Audio, Cakewalk Guitar Studio, Cakewalk
Overture, Cakewalk In Concert, Cakewalk Audio FX, RhythnVn'Chords, Nemesys
Gigastudio 160 (V.2), Gigastudio Instrument Editor 2.0, Sonar 1.3.1, а также со многи-
ми plug-in-модулями.

Книги позволили любителям музыки узнать о существовании этих удивитель-
ных программ и не только обучиться работе с ними на начальном уровне, но и
постигнуть секреты мастерства.

Оказалось, что нам есть, о чем рассказать не только русскоязычным читате-
лям, но и заокеанским компьютерным музыкантам. В марте 2002 года в США выш-
ла в свет и пользуется неплохим спросом наша книга (Petelin, Roman, and Yury
Petelin. PC Music Home Studio: Secrets, Tips, & Tricks. Wayne: A-LIST, 2002.- 640 p).
Это позволяет строить планы и реализовывать новые замыслы, связанные с изда-
нием книг на английском языке.

И по обычной, и по электронной почте приходит много писем, содержащих
конкретные вопросы, предложения, просьбы. По возможности стараемся помо-
гать людям, обращающимся к нам. Проект «Музыкальный компьютер» — это ра-
дио- и телепередачи, клуб, конкурсы, концерты. В последнее время у нас появи-
лась еще одна возможность популяризации работ читателей. Речь идет о
компакт-дисках, которыми теперь сопровождаются наши книги. Мы избрали
очень интересный формат (CD Extra), объединяющий в себе форматы CD-ROM и
CD Digital Audio. Это, прежде всего, позволяет разместить на диске полезные дан-
ные, такие, как демоверсии описываемых программ и примеры проектов компо-
зиций в форматах этих программ. Одновременно удается познакомить читателей
с завершенными продуктами музыкального творчества — сведенными музыкаль-
ными композициями.

Для тех авторов, чьи работы представлены на дисках, участие в подобных сбор-
никах — уникальная возможность заявить о себе во всеуслышанье. Наши книги и
диски издаются достаточно большими тиражами. И, как показывает опыт, обяза-
тельно находят своих покупателей. Чем не раскрутка, да к тому же еще и такая, и



Cool Edit Pro 2. Секреты мастерства

которую раскручиваемый автор музыки, получив 100% гарантию доведения ком-
позиций до слушателей, не вкладывает пи копейки? Многие читатели поняли и
оценили это. Не случайно, в период формирования нынешнего сборника посту-
пило значительно больше заявок, чем было прислано на первый аналогичный
конкурс (диск к книге «Sonar. Секреты мастерства»}. Правда, оказалось, что очень
немногие компьютерные музыканты в состоянии выполнить все условия конкур-
са. Не так просто уложиться в сжатые сроки. Но еще сложнее подкрепить инте-
ресную музыкальную композицию поучительным проектом в заданном формате.

Показательно, что после опубликования в наших книгах и статьях [7,9, 11,21,24]
материалов об отечественном звукотехническом оборудовании и музыкальном «со-
фте», созданном в России, с нами связываются все новые экспериментаторы, раз-
работчики аппаратуры, авторы самостоятельных программ и плагинов, расширя-
ющих возможности известных звуковых и музыкальных редакторов. Мы
постараемся и впредь способствовать продвижению наиболее интересных и та-
лантливых разработок.

В наши дни проект, связанный с применением компьютера, не может успешно
существовать без Internet. Именно поэтому мы тратим много времени, сил и средств
на развитие сайта «Музыкальный компьютер» http://www.musicalpc.com/. Его стра-
ницы наполняются новыми статьями. «Биржа творческих предложений» помога-
ет звукорежиссерам, аранжировщикам, композиторам, авторам слов и исполни-
телям найти друг друга. Форум сайта превратился в место встречи и виртуального
общения увлеченных людей. К моменту завершения работы над книгой на сайте
успели побывать более 120 000 посетителей.

Впереди еще много интересных дел, встреч, событий. Приглашаем Вас уча-
ствовать в них.

Если у Вас есть пожелания, вопросы и предложения, адресованные авторам
этой книги, посылайте их по почте petelin@musicalpc.com (Роману Петелину) или
musicalpc@mail.ru (Юрию Петелину).

О своем намерении участвовать в работе клуба «Музыкальный компьютер» Вы
можете сообщить потел. (812) 321-47-44, а присылать диски — по адресу 197372,
Санкт-Петербург, А/Я 153, Петелину Юрию Владимировичу.

Авторы книги ждут Вас в клубе «Музыкальный компьютер» по четвергам с 18
часов. Адрес: Санкт-Петербург, Большой проспект В. О., д. 65, Дворец Культуры
«Гавань», класс 84.

Сайт проекта «Музыкальный компьютер»: http://www.musicalpc.com/.

Выражаем благодарность Сергею Золотареву за постоянную поддержку всех
наших замыслов, касающихся подготовки новых книг.

Особая благодарность за фантастическое терпение женам — Валентине и Татьяне.

Эту книгу мы посвящаем нашей любимой маленькой Анечке — дочке и внучке.

Роман Юрьевич Петелин, Юрий Владимирович Петелин



ВВЕДЕНИЕ

Cool Edit Pro 2 принадлежит к числу наиболее мошных звуковых редакторов.
Предшественниками современной версии программы являются Coo] Edit 96, Cool
Edit 2000 и Cool Edit Pro 1.2. Все лучшее, что было в этих версиях программы,
сохранено в Cool Edit Pro 2, а кроме того, здесь появились и новые эффективные
средства анализа и обработки звука.

В своих книгах мы уже в третий раз обращаемся к этому «крутому» звуковому
редактору. В книге [2] вместе с начинающими компьютерными музыкантами мы
впервые совершили попытку освоения принципиально важных возможностей Cool
Edit 96. Оценив удобство, надежность, высокое качество функционирования про-
граммы, а также высочайшую степень насыщенности ее самыми современными
методами и алгоритмами обработки аудиосигналов, в книге [8] мы довольно под-
робно рассказали о приемах работы с Cool Edit Pro 1.2. Эта версия принципиаль-
но отличалась от предшествующих: в ней впервые в качестве «программы в про-
грамме» появился мультитрековый редактор. В ту пору мы занимались подготовкой
еженедельной радиопередачи «Музыкальный компьютер», а монтаж каждого вы-
пуска выполняли как раз в Cool Edit Pro 1.2. Очень наглядно, просто и, вместе с
тем, эффективно организовано в Cool Edit Pro 1.2 выполнение всех операций и с
отдельными аудиофайлами (запись, монтаж, шумоподавление, динамическая об-
работка, фильтрация, обработка эффектами), и с группой файлов-блоков (мон-
таж на параллельных треках, панорамирование, достижение баланса уровней гром-
кости, сведение в стереотрек).

И вот теперь мы предлагаем вашему вниманию книгу о самой новой (на мо-
мент завершения работы над рукописью) версии этой популярной программы.

Интерфейс Cool Edit от версии к версии не подвергается существенным изме-
нениям (хотя в программу и заложено немало средств для гибкого формирования
ее облика всоответствии с эстетическими пристрастиями владельца), наблюдает-
ся также преемственность встроенных средств обработки звука. Поэтому, есте-
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ственно, в нашей новой книге, претендующей на полное описание возможностей
программы, а не на анализ отличий от предыдущих версий, есть материал, с кото-
рым наши читатели могли уже встречаться в книге [8]. Вместе с тем мы постара-
лись подробно рассмотреть все новые возможности программы, а также допол-
нить примерами и пояснениями некоторые разделы, посвященные элементам,
присутствие которых в Cool Edit уже стало традицией. Такой подход не мог не
сказаться на объеме материала. Можно смело утверждать: вы держите в руках са-
мое подробное описание способов работы с Cool Edit Pro 2.

А теперь поговорим о самой программе. Прототип звукового редактора Cool
Edit Pro создан всего одним человеком — Дэвидом Джонсом. Правами на распро-
странение программы обладает Syntrillium Software Corporation. Популярность Cool
Edit Pro отчасти объясняется тем, что ранняя версия редактора (Cool Edit 96) яв-
лялась свободно распространяемой (Share Ware). Да и сейчас его демоверсии можно
найти в Internet на сайте www.syntrillium.com.

На протяжении ряда лет автор программы непрерывно улучшал свое детище и
достиг совершенства. Последняя на момент написания книги версия программы
Cool Edit Pro 2 представляет собой звуковой редактор, обладающий практически
всеми возможностями программ такого класса.

Многие специалисты дают этой программе самые высокие оценки. Показа-
тельно, что Coo! Edit Pro входит в комплект поставки ряда профессиональных плат
оцифровки звука.

Для того чтобы эффективно применять Cool Edit Pro в своем творчестве, нуж-
но иметь представление о некоторых из его принципиальных особенностях. Рас-
смотрим их.

Программа Cool Edit Pro предназначена для работы с оцифрованным звуком,
т. е. аналоговые звуковые волны должны быть предварительно преобразованы (сэм-
плированы) в последовательность двоичных цифровых отсчетов. Такое преобра-
зование осуществляется в аналого-цифровом преобразователе (АЦП). В результа-
те работы АЦП получается цифровой образ звука, то, что в английском языке
именуется Waveform. В своих предыдущих книгах мы предпочитали называть этот
объект сэмплом. Однако в процессе подготовки книг к изданию в США перевод-
чики столкнулись с некоторыми проблемами, что и определило необходимость
использования в наших новых книгах буквального перевода термина Waveform:
волновая форма.

Волновые формы хранятся на жестком диске в файлах различных форматов.
Чаще всего это файлы с расширением WAV. Таким образом, когда вы «собираете»
в Cool Edit Pro аудиокомпозицию (например, песню), WAV-файлы служат стан-
дартными элементарными блоками, кирпичиками.

В принципе, существует два метода редактирования звуковых данных: разру-
шающий и неразрушающий. При разрушающем методе преобразования (вырезка,
вставка, обработка эффектом и т. д.) применяются непосредственно к исходному
WAV-файлу так, что изменяются сами первоначальные звуковые данные, в то вре-
мя как неразрушающее редактирование подразумевает, что файл на диске факти-
чески не изменяется. Вместо этого каждая операция редактирования сохраняется
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как команда, которую нужно выполнить при воспроизведении волновой формы.
Например, при разрушающем редактировании изменение громкости звука фак-
тически изменило бы амплитуду волновой формы. А при неразрушающем редак-
тировании изменение громкости будет вызвано выполнением последовательнос-
ти команд, которые, по существу, являются инструкциями программе о том, как
перестраивать коэффициент передачи усилителя звуковой карты.

В Cool Edit Pro используются и разрушающие, и неразрушающие методы ре-
дактирования. Однако даже разрушающее редактирование не будет применено
непосредственно к исходной волновой форме до тех пор, пока вы не сохранили
файл. Здесь реализован метод, который можно назвать отсроченным разрушаю-
щим редактированием- Когда вы в Cool Edit Pro открываете WAV-файл, програм-
ма помещает копию файла во временный каталог и для редактирования использу-
ет эту копию. Исходный файл остается неизменным до тех, пока вы не сохраните
изменения на диске (например, выбирая из меню File команду Save...). И только
когда вы сохраняете внесенные изменения, Cool Edit Pro записывает поверх ис-
ходного файла файл с теми изменениями, которые вы сделали в файле-копии.

Поскольку весь редактируемый в Cool Edit Pro материал хранится во времен-
ных файлах-копиях, имеется принципиальная возможность защитить вашу рабо-
ту от всевозможных сбоев компьютера, питания, операционной системы и т. и.
Если в процессе редактирования произойдет, например, отключение питания, то
после перезагрузки компьютера и запуска Cool Edit Pro программа предложит вам
продолжить редактирование с того места, на котором оно было прервано.

В Cool Edit Pro 2 существуют два принципиально различных режима работы:
редактирование отдельных волновых форм и совместное мультитрековое редак-
тирование совокупности волновых форм. Для каждого из режимов предусмотре-
ны свое главное меню и свое главное окно: Edit Waveform View и Multitrack View —
два различных по назначению звуковых редактора, объединенных в функциональ-
ный комплекс. Важно понимать, что операции редактирования, выполняемые в
Edit Waveform View (подобные вырезке, вставке и обработке эффектами), по своей
сути являются разрушающими, и когда вы сохраняете файл, изменения вносятся
непосредственно в волновую форму. Редактирование, выполненное в Multitrack
View (типа переноса, состыковки волновых форм, изменения громкости, панора-
мы, параметров эффектов реального времени) является неразрушающим.

При отсроченном разрушающем редактировании есть возможность использо-
вать в Cool Edit Pro функцию многократной отмены операций (Undo). Когда вы
применяете разрушающее редактирование к WAV-файлу, Cool Edit Pro сохраняет
копи ю того файла, который существовал до редактирования. Это делается для каж-
дой выполненной вами операции редактирования. Вы можете «путешествовать»
как назад, так и вперед по всей предыстории редактирования. Многократная фун-
кция Undo дает вам свободу при работе над волновыми формами. Вам не стоит
переживать о том, что самый интересный результат творчества окажется безвозв
ратно утраченным. Однако за свободу приходится платить. В данном случае воз-
можность многократной отмены операций достигается ценой затрат дисковой
памяти. Правда, все автоматически созданные копии будут также автоматически
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удалены с жесткого диска, когда вы закроете файл или выйдете из программы. Но
непосредственно в процессе работы с Cool Edit Pro нужно иметь на диске много сво-
бодного места. Впрочем, вы можете ограничить максимальное число уровней Undo
или вовсе отключить эту функцию, если есть проблемы с дисковым пространством.

Во многих музыкальных редакторах, имеющих средства обработки аудиодан-
ных, предусмотрены два варианта использования эффектов: применение эффек-
та в реальном времени и пересчет звукопых данных. Первый вариант удобнее, по-
скольку вы регулируете параметры эффекта и тут же слышите результат. Однако
при этом требуется высокопроизводительный компьютер. Применение эффекта
путем пересчета позволяет обрабатывать звуковые данные с помощью относитель-
но «слабого» компьютера, но процесс обработки может продолжаться десятки
минут. Поневоле не захочешь лишний раз вносить улучшения, пробовать что-ни-
будь новенькое.

Оптимальная стратегия использования эффектов могла бы состоять в следую-
щем. Сначала, включив циклический режим воспроизведения волновой формы,
в реальном времени вы подбираете параметры эффекта, наилучшим образом со-
ответствующие вашему замыслу, затем единственный раз пересчитываете волно-
вую форму, применив к ней эффект с уже подобранными параметрами.

В Cool Edit Pro вы можете использовать как собственные, встроенные в про-
грамму эффекты, так и эффекты, подключаемые посредством DirectX.

Важнейшем нововведением Cool Edit Pro 2 является поддержка эффектов ре-
ального времени в Multitrack View.

Основной способ применения эффектов в Edit Waveform View— пересчет зву-
ковых данных. Полноценный режим реального времени в Edit Waveform View не
предусмотрен. Однако замена режима реального времени все же имеется. Если в
окне того или иного эффекта есть кнопка Preview (предварительное прослушива-
ние, проба в реальном времени), то вы сможете подобрать параметры эффекта.
Результаты изменений параметров эффекта, которые вы производите регулятора-
ми в окне эффекта, будут слышны немедленно. Правда, для того чтобы от попыт-
ки предварительного прослушивания был какой-то толк, ваш компьютер должен
обладать высокой производительностью. В отличие от настоящего режима реаль-
ного времени, при предварительном прослушивании можно пользоваться только
одним эффектом.

Мы уже говорили о том, что Cool Edit Pro является многоканальной средой,
которая позволяет поместить любое число волновых форм (блоков) на различные
треки как для одновременного воспроизведения, так и для последующего объеди-
нения всех треков в один.

Процесс микширования включает в себя объединение всех волновых форм, по-
мещенных на треках, в два (или больше) каналов вывода. Вы можете редактировать,
добавлять на треки и убирать с них блоки, a Cool Edit Pro постоянно будет отслежи-
вать изменения, происходящие в ходе многоканальной сессии (типа перемещения
или удаления блока, изменения громкости). Как только что-либо будет изменено.
Cool Edit Pro немедленно отработает эти изменения, внеся необходимые корректи-
вы в микс, поступающий на выход программы (например, в ЦАП звуковой карты).
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Эти изменения выполняются программой в фоновом режиме — происходит фоно-
вое микширование. Если вы владеете достаточно производительным компьютером,
то можете безостановочно редактировать композицию, фоновое микширование не
будет мешать вам. Вы его просто не ощутите, хотя в программе предусмотрен спе-
циальный индикатор, не только свидетельствующий о том, что фоновое микширо-
вание идет, но и позволяющий определять, на какой стадии находится этот про-
цесс. Если производительность процессора и жесткого диска не достаточна, то
фоновое микширование все же будет тормозить вашу работу.

Напомним, что поток воспроизводимых данных может быть направлен к паре
устройств вывода (одиночная стереофоническая звуковая карта) или к множеству
устройств вывода (несколько стереофонических звуковых карт или одна многока-
нальная плата). Cool Edit Pro генерирует миксы для каждого набора применяемых
устройств вывода. Если вы используете одну стереофоническую звуковую карту,
Cool Edit Pro генерирует только один стереомикс. Если же к компьютеру подклю-
чена многоканальная система, то должны быть созданы отдельные миксы для каж-
дого устройства вывода (для каждой из стереопар). Многоканальный вывод тре-
бует большего объема обработки и, следовательно, появляется тенденция к
замедлению процесса микширования. Таким образом, аудиоплата и компьютер
должны соответствовать друг другу Нет смысла устанавливать дорогое многока-
нальное устройство оцифровки звука в дешевый компьютер.

В дополнение к аудиофайлам различных форматов, например, к WAV-файлам,
Coo) Edit Pro позволяет также использовать файлы, именуемые сессионными
(Session) файлами (файлы с расширением SES). Мы назвали WAV-файлы стан-
дартными блоками, из которых строится любая аудиокомпозиция, например,
песня. Тогда можно считать, что сессионный файл — это и есть собственно пес-
ня, хотя в SES-файле фактически нет никаких звуковых данных. Размер SES-файла
очень мал. В нем содержатся только подробные указания программе Cool Edit Pro
в виде следующих данных:

> Имена используемых WAV-файлов и пути к ним
> Имена треков
> Моменты времени включения и выключения воспроизведения определен-

ного WAV-файла
> Уровень громкости и панорама, устанавливаемые перед началом воспроиз-

ведения каждого файла, и законы изменения этих параметров в процессе
воспроизведения

> Подключенные эффекты реального времени и законы изменения их пара-
метров

Можно сравнить SES-файл с дирижером, а WAV-файлы — с оркестрантами.
Дирижер указывает каждому исполнителю, когда он должен вступить и с какими
нюансами вести свою партию. Однако и дирижеру нужен оркестр. Аналогично
SES-файл имеет смысл только тогда, когда и он, и WAV-файлы, участвующие в
сессии, находятся в определенных каталогах. Вы не можете просто скопировать
на гибкий диск и перенести его на компьютер друга, не можете произвольным
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образом переименовать или переписать в другой каталог какой-либо из WAV-фай-
лов, задействованных в сессии. Если, совершив любое из перечисленныхдействий,
вы попытаетесь открыть SES-файл и воспроизвести композицию, ничего из этого
не выйдет. Дирижер не обнаружит музыкантов на положенных местах и концерт
не состоится. Это не означает, что SES-файлы и все внедренные в них WAV-фай-
лы нельзя перемещать из каталога в каталог. Можно, Но для этого в Cool Edit Pro
существуют специальные операции сохранения сессии на диске.

Отметим, что возможность применения эффектов реального времени в про-
цессе мультитрекового редактирования — важнейшая, но не единственная новинка
Cool Edit Pro 2. Если скрупулезно сравнивать эту программу с Cool Edit Pro 1.2, то
мы увидим, что появились новые возможности, некоторые функции реализованы
более удобно, алгоритмы и интерфейс оптимизированы. Кратко рассмотрим ос-
новные новинки программы.

Расширен инструментарий автоматизации работы звукорежиссера. В частно-
сти, в программе предусмотрены средства для конвертирования форматов и нор-
мализации группы файлов, включенных в предварительно составленный список.

Аудиоданные теперь можно извлекать в Cool Edit Pro 2 из AVl-файлов и с тре-
ков аудиодисков.

Не выходя из Cool Edit Pro 2, можно записывать компакт-диск CD Digital Audio.
В мультитрековом режиме реализованы принципиально новые технологии ре-

дактирования с использованием огибающих автоматизации. Эффекты реального
времени можно применять не только к отдельным трекам, но и к группам треков,
объединенных в шины. С помощью микшера можно маршрутизировать сигнал
между отдельными эффектами, подключенными к шине. Реализованы новые опе-
рации., связанные с формированием и использованием лупов, грувов.

Особенно актуальна возможность работы с видео.
Программа теперь сама распознает DirectX-эффекты, установленные в систе-

ме, и оценивает свою совместимость с ними.
В распоряжении пользователей появились несколько новых встроенных эф-

фектов и обработок:

> Stereo Field Rotate — управление стереополем (в том числе вращение его
вокруг слушателя)

> Dinamic Delay — дилэй с динамическим изменением задержки и обратной
связи

> QuickVerb... — реверберация с упрощенным набором регулируемых параметров
> Dynamic EQ... — параметрический эквалайзер с динамическим управлени-

ем частотой настройки, усилением и полосой фильтра
> DopplerChifter... — имитатор эффекта Доплера (изменение частоты колеба-

ния, излученного движущимся источником) с возможностью выбора фор-
мы траектории и скорости кажущегося перемещения источника звука

> Frequency Band Splitter — кроссовер, позволяющий разделять спектр сигнала на
отдельные полосы и направлять полученные компоненты сигнала в различ-
ные каналы воспроизведения (обработка действует в мультитрековой среде)
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К имевшимся в предыдущих версиях программы средствам анализа свойств
обрабатываемого звука (таким, как анализаторы текущего и мгновенного спект-
ра, гистограмма распределения уровней аудиосигнала) добавился виртуальный
стереогониометр, позволяющий по виду фигур Л иссажу оценить качество стерео-
поля (в частности — моносовместимость создаваемой композиции).

Заметно пополнился список пресетов эффектов, перешедших в Cool Edit Pro 2
из предыдущих версий программы.

Увеличилось число форматов файлов, поддерживаемых звуковым редактором.
В Cool Edit Pro 2 встроен фирменный преобразователь WAV-файлов в файлы

формата МРЗ.
В мультитрековом режиме наряду со звуковыми файлами можно использовать

MIDI-файлы и AVI-файлы. Для файлов этих типов отведено по одному треку.
Появилась принципиально новая панель Organizer, делающая удобной рабо-

ту с файлами, эффектами и наиболее часто используемыми операциями редак-
тирования.

В главном окне программы теперь имеются плавающие панели, которые мож-
но переносить с места на место, отделять от главного окна либо присоединять к
нему. Отображаемые панели выбираются пожеланию пользователя.

Новинок столько, что перечислить все просто невозможно.
Рассмотрим структуру книги. Книга состоит из 12 глав, авторского предисло-

вия, введения, приложения, заключения и списка литературы. Книгу сопровож-
дает компакт-диск в формате CD Extra.

Глава - т- -it
В первой главе рассмотрена чрезвычайно важная проблема —

подготовка программы Cool Edit Pro 2 к работе. Оттого, насколь-
ко грамотно вы выполните все необходимые подготовительные
операции, зависит удобство работы с программой и качество

полученных вами результатов.
Бэтой главе мы описали опции, содержащиеся в тех окнах диалога, которыми

вам придется воспользоваться при подготовке программы к работе. Рассмотрены
такие вопросы, как:

> Общие и системные настройки
> Настройка цветовых схем интерфейса и параметров отображения
> Выбор параметров обработки звуковых данных и параметров мультитреко -

вого редактирования
> Выбор опций, определяющих параметры синхронизации по интерфейсу SMPTE
> Выбор внешнего контроллера, устройств ввода-вывода цифрового звука и

MIDI-сообщений
> Редактирование списков устройств записи и воспроизведения

Рекомендуем по мере освоения новых приемов практической работы с компо-
зициями периодически возвращаться к первой главе. Это позволит глубже понять
назначение операций по подготовке программы к работе и их влияние на конеч •
ный результат.
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Глава *ТЬ , . Во второй главе рассмотрена работа в главном окне в режи-
Ш/.. .J ме Edit Waveform View.

Описаны панели Transport Controls (для управления запи-
%-• сью и воспроизведением) и Zoom Controls (позволяющая гиб-

ко управлять отображением волновых форм). Приведены тех-
нологии регулирования уровня сигнала и записи звуковых данных, выделения
фрагментов волновой формы с помощью инструментов панели Selection/View
Controls. Пояснен смысл информации, содержащейся в строке статуса.

В последующих главах (за исключением главы 12) подробно рассмотрены ко-
манды главного меню программы в режиме Edit Waveform View.

Главное меню содержит 10 меню. В каждом из них сосредоточена одна из сле-
дующих функционально однородных групп команд и подменю:

1. Работа с файлами
2. Редактирование
3. Управление отображением
4. Управление эффектами
5. Генерирование звуковых колебаний с заданными свойствами
6. Анализ свойств звуковых данных
7. Создание меню, сконфигурированного по желанию пользователя
8. Выбор опций настройки
9. Управление окнами
10. Получение помощи

Многие команды главного меню дублируются кнопками панели инструментов
главного окна.

В третьей главе мы рассмотрели команды меню File. Наряду
с большими группами команд, выполняющих разновидности
традиционных операций загрузки и сохранения файлов в дан-
ном меню представлены также такие уникальные команды, как:

> Extract Audio from Video... — извлечение звуковой дорожки из видеофайла и
ее загрузка в Cool Edit Pro
Extract Audio from CD... — извлечение треков с диска CD Digital Audio и их

загрузка в Cool Edit Pro
> CD Burning... — запись компакт-диска
> Batch File Convert... — конвертирование форматов файлов в пакетном режиме

Рассмотрены все опции и методики применения окон, открывающихся коман-
дами меню.

В четвертой главе описано меню Edit, в котором содержатся
Глава Jm команды и подменю, ориентированные на редактирование аудио-

данных. Рассмотрены особенности действия команд, реализую-
щих стандартные операции копирования, вставки, удаления. Под-
робно раскрыты возможности специфических операций:
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г Delete Silence — удаление из волновых форм.фрагменте в, содержащих тишину
> Zero Crossings— перемещение начала и конца выделенного фрагмента к

ближайшим точкам, в которых звуковая волна пересекает нулевой уровень
> Find Beats — выделение фрагмента, совпадающего с перепадами уровня сигнала
> Auto-Cue — определение границ фраз или долей
> Snapping — выбор опций привязки границ выделенного участка волновой

формы к координатной сетке
> Group Waveform Normalize — совместная нормализация нескольких волно-

вых форм
> Adjust Sample Rate — изменение частоты дискретизации
> Convert Sample Type — преобразование типа сэмплирования

Глава МП ^ пятой главе описано меню View, включающее в себя ко-
манды и подменю, с помощью которых осуществляется управ-
ление отображением элементов интерфейса программы.

Приведены сведения о разновидностях спектральных пред-
ставлений аудиосигналов и описана методика работы в режиме
отображения мгновенного спектра Spectral View.

Рассмотрены панели:

> Organizer Window — органайзер, облегчающий работу с файлами и эф-
фектами

> Cue List / Ranges — инструмент разметки фрагментов волновой формы
> Show Play List — средство редактирования списка очередности воспроизве-

дения открытых волновых форм или их фрагментов
> Edit Tempo — окно, предназначенное для вычисления и редактирования тем-

па музыкального произведения, содержащегося в файле
> Wave Properties — окно для определения атрибутов аудиофайла

Кроме того, рассмотрено назначение всех панелей инструментов главного окна.

-ж Шестая глава относится к числу самых объемных глав кни-
1 ги. В этом нет ничего странного, ведь речь в ней идет о меню

Effects, в котором собраны все команды, позволяющие приме-
нять эффекты (и встроенные, и подключаемые посредством
DirectX). Список эффектов растет с каждой новой версией про-
граммы и в Cool Edit Pro 2 он выглядит так:

1. Invert — инвертирование звукового сигнала
2. Reverse — реверсирование звукового сигнала
3. Silence — установление абсолютной тишины на заданном участке волновой

формы
4. DirectX — доступ к окнам аудиоэффектов, подключенных посредством DirectX.
5. Amplitude —преобразование амплитуды- Подменю, в которое входят следу-

ющие команды:
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> Amplify... — преобразование уровня звукового сигнала
> Channel Mixer... — канальный микшер
> Dynamics Processing... — динамическая обработка
> Envelope... — управление формой огибающей амплитуды
> Hard Limter...— жесткое ограничение
> Normalize... — нормализация
> Pan/Expand,.. — расширение стереобазы, преобразование стереообра-

за источника звука
> Stereo Field Rotate... — вращение стереополя

6. Delay Effects — эффекты, основанные на задержке. Подменю, в которое вхо-
дят следующие команды:
> Chorus... — хорус
> Delay... — дилэй
> Dinamic Delay — дилэй с динамическим изменением задержки и обрат-

ной связи
> Echo... — эхо
> Echo Chamber... — имитация акустики помещений
> Flanger... — флэнжер
> Full Reverb... — универсальный процессор реверберации
> Multitap Delay... — многоканальная задержка
> QuickVerb... — реверберация с упрощенным набором регулируемых па-

раметров
> Reverb... — реверберация
> Sweeping Phaser... — перестраиваемый фазовращатель (фейзер)

7. Filters — фильтрация звукового сигнала. Подменю, в которое входят коман-
ды, открывающие окна следующих эффектов:
> Dynamic EQ... — эквалайзер с динамическим управлением частотой на-

стройки, усилением и полосой
> FFT Filter... — фильтр на основе быстрого преобразования Фурье
> Graphic Equalizer... — универсальный графический эквалайзер
> Graphic Phase Shifter... — графический фазовращатель
> Notch Filter... — пятиполосный фильтр выреза
> Parametric Equalizer... — семиполосный параметрический эквалайзер
> Quick Filter... — восьмиполосный графический эквалайзер
> Scientific Filters... — фильтры Бесселя, Баттеворта, Чебышева

8. Noise Reduction — шумоподавление. Подменю, в которое входят следующие
команды:
> Click/Pop Eliminator... — обнаружение и исправление щелчков и/или вы-

падений отсчетов
> Clip Restoration... — устранение клиппирования
> Hiss Reduction... — спектральное пороговое шумоподавление
> Noise Reduction. . . — шумоподавление на основе анализа свойств образца шума
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9. Special — специальные эффекты
> Brainwave Synchronizer... — синхронизация с ритмами головного мозга
> Convolution... — свертка
> Distortion... — дистошн
> Music — исполнение мелодии

10. Time/Pitch — преобразование длительности и высоты тона волновой фор-
мы. Подменю, в которое входят следующие команды:
> Doppler Chifter.., — имитатор эффекта Доплера (изменение частоты ко-

лебания, излученного движущимся источником)
> Pitch Bender — сдвиг высоты тона волновой формы
> Stretch — преобразование длительности волновой формы

Разъяснена физическая сущность каждого из эффектов, даны подробные ре-
комендации по выбору их параметров, описаны методики применения.

В седьмой главе рассмотрено меню Generate, включающее в
Глава WF * себя команды:

> Silence... — генерация тишины
> DTMF Signals... — генерация звука тонального набора те-
лефонного номера
> Noise.., — генерация шума
> Tones... — генерация тона

Описаны особенности генерации перечисленных процессов. Подробно проиллюс-
трирована реализация аддитивного метода синтеза звука средствами окна Generate Tones.

В восьмой главе рассмотрены команды меню Analyze:
Глава

> Show Frequency Analysis — проведение частотного (спект-
рального) анализа
> Show Phase Analysis — проведение фазового анализа (кон-
троль качества стереосигнала и моносовместимости)
>• Statistics — получение статистической информации о вол-
новой форме и построение гистограммы значений отсчетов

Изложена методика проведения спектрально анализа. Приведено описание
принципа действия стереогониометра, позволяющего по виду фигур Лиссажу оце-
нивать качество и моносовместимость стереосигнала. Разъяснена сущность ста-
тистической информации о файле, содержащейся в гистограмме распределения
уровней, приведены примеры ее использования для выбора параметров динами-
ческой обработки.

В девятой главе рассказывается об окне диалога Favorites. С по-
ГЛава JTfc мощью средств окна можно создавать, удалять, редактировать и

структурировать пункты, появляющиеся в меню Favorites. Под фа-
воритами понимаются те операции, которые вы выполняете чаще
других. Они разбросаны по программе, и для создания комфортных
условий есть смысл организовать доступ к ним из единого меню.
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10Глава -rfW В десятой главе завершается описание команд меню Options,
начатое в гл.1. Много внимания уделено окну диалога Scripts
and Batch Processing, которое предназначено для создания, ре-

,iW "'"•-.•••> дактирования и выполнения записей последовательностей опе-
раций (сценариев).

Подробно описано окно диалога Shortcuts (Keyboard&MIDI Triggers), позволя-
ющее выбрать в качестве клавиш управления редактированием не только клави-
ши компьютерной клавиатуры, но также клавиши и контроллеры, расположен-
ные на MIDI-клавиатуре.

Глава n
Глава

Одиннадцатая глава — самая короткая. В ней рассмотрены
особенности меню Window и меню Help.

В двенадцатой главе описана методика работы в мультитре-
ковой среде редактора.

Наряду с общими принципами работы в режиме Multitrack
View подробно изложены:

> Методика записи аудиоданных в ходе мультитрековой сес-
сии и приемы импортирования в нее волновых форм
> Технология выбора атрибутов треков и подключения к ним
эффектов

> Работа с шинами и микшером, блокирование треков в целях высвобожде-
ния ресурсов процессора

> Особенности использования параметрического эквалайзера, подключенного
к каждому из треков

Детально описаны операции с блоками: перемещение, копирование, расщеп-
ление, удаление, группировка, выделение фрагментов и группы блоков.

Подробно освещена работа с лунами и грувами, описаны все существующие
способы изменения темпа и транспонирования тональности.

Много внимания уделено проблеме автоматизации. Приведено описание при-
емов создания и редактирования огибающих автоматизации.

Изложены сведения о командах главного меню и контекстных меню в режиме
Multitrack View. Описаны встроенные эффекты, применение которых возможно
только в мультитрековом режиме.

В Приложении описывается содержание компакт-диска, ко-
торым комплектуется книга. Особенность диска состоит в том,

что за счет особого формата, который принято обозначать
'..термином CD Extra, он одновременно является и диском,

1 пригодным для воспроизведения с помощью CD-плеера, и
/диском, информация с которого может быть считана в ком-

пьютер посредством CD-ROM-привода. Это, по существу,
два диска в одном. Итак, на диске представлены 2 раздела:

CD-ROM и CD Digital Audio.
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В разделе CD-ROM содержатся:
1. Примеры, ссылки на которые имеются в книге.
2. Программы:

> Демонстрационная версия Cool Edit Pro 2.0;
> Плагин Cool Edit Pro для «прожига» CD-R(W);
> Пакет инструментальных средств для разработки плагинов к Cool Edit Pro.

3. Offline-версия сайта авторов книги http://www.musicalpc.com/.
4. Авторские проекты-сессии Cool Edit Pro 2.

Авторы композиций — мы сами, а также наши читатели-участники проекта
«Музыкальный компьютер» — на практике демонстрируют применение ряда спе-
цифических возможностей Cool Edit Pro 2.
В аудио-сборник раздела CD Digital Audio включены следующие композиции:

1. «Возвращайся» — музыка, аранжировка, запись, сведение Роман Петелин,
слова Юрий Петелин, вокал Ирина Димакова (Санкт-Петербург).

2. •«Город» — музыка, слова, вокал, аранжировка, запись, сведение Семен Об-
ломкий; аранжировка, сведение Андрей Мовсесян, Игорь Орлов; вокал Аня
Макаренко (группа «Небритые», Санкт-Петербург).

3. «Больше, чем любовь» — музыка, слова, вокал Ирина Полякова; аранжи-
ровка, запись, сведение Владимир Арутюнянц (шоу-группа «Х--Press», г. Ка-
менск-Шахтинский, Ростовская область).

4. «Хиросима» — музыка, запись, сведение Максим Корольков (проект
«Pentagon», Санкт-Петербург).

5. «Ветер» — музыка, слова, вокал Ирина Полякова; аранжировка, запись, све-
дение Владимир Арутюнянц (шоу-группа «X-Press», г. Каменск-Шахтинс-
кий, Ростовская область).

6. «Птицы» — музыка, слова, аранжировка, запись, сведение, вокал Семен Об-
ломкин; аранжировка, сведение Игорь Орлов {группа «Небритые», Санкт-
Петербург).

7. «Я нтарное море» — музыка, аранжировка, запись, сведение Роман Петелин
(Санкт-Петербург).

8. «Идущий в темноту» — музыка, аранжировка, запись, сведение Роман Пе-
телин (Санкт-Петербург).

9. «Нет до этого дела* — музыка, аранжировка, запись, сведение Роман Пете-
лин (Санкт-Петербург).

10. «Птипа-тройка 2000» — музыка, аранжировка, запись, сведение Роман Пе-
телин (Санкт-Петербург).

1 1 . «Аэлита» — музыка, аранжировка, запись, сведение Юрий Петелин; аран-
жировка, запись, сведение Роман Петелин (Санкт-Петербург). •
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Поскольку данную книгу нежелательно рассматривать в отрыве от наших пред-
шествующих работ, мы приводим список литературы, содержащий библиографи-
ческие сведения о книгах и статьях, посвященных применению компьютера в му-
зыкальном творчестве, которые опубликованы нами ранее.
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ПОДГОТОВКА ПРОГРАММЫ К РАБОТЕ

В принципе, вы можете начать работу с Cool Edit, не производя никаких спе-
циальных настроек. Демонстрационный проект, поставляемый с Cool Edit Pro,
будет «звучать», запись будет осуществляться. Однако по мере освоения работы с
программой или в случае возникновения каких-либо проблем с синхронизацией
треков вам придется заглянуть в главное меню Options и обратить внимание на
три команды: Settings..., Device Properties... и Device Order.... С их помощью можно
внести тонкие изменения во взаимодействие программы с оборудованием, настро-
ить некоторые параметры обработки аудиоданных, подстроить интерфейс про-
граммы под собственные потребности. О назначении опций, доступ к которым
осуществляется с помощью перечисленных выше команд, вы узнаете, прочитав
данную главу.

1,1. Окно Settings
• Выберите команду Option > Settings.... Появится окно диалога Settings, содер-

жащее 7 вкладок: General, System, Colors, Display, Data, Multitrack и SMPTE. По-
очередно открывая вкладки, задайте основные параметры программы.

1.1.1. Вкладка General - общие установки
Вкладка General (рис. 1.1) окна диалога Settings содержит опции, определяю-

щие общие установки программы.
В левой верхней части вкладки располагаются пять флажков:

> Show Tip of the Day — показывать «совет на каждый день» при запуске программы
> Use shiny look — если этот флажок сброшен, то кнопки инструментальных

панелей и ряддругих элементов интерфейса выглядят плоскими, в против-
ном случае их поверхность кажется выпуклой
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(•/ Show Tip of the Day
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Рис. 1.1. Вкладка General окна диалога Settings

> Auto-play on command-line load — включение режима автовоспроизведения
при запуске программы из командной строки с именем звукового файла в ка-
честве параметра

> Live update during recording — прорисовывать волновую форму в рабочем поле
главного окна программы во время записи

> Auto-scroll during Playback and Recording при воспроизведении указатель
текущей позиции оставлять на месте (волновая форма будет смещаться
относительно него)

Два последних режима требовательны к аппаратной части вашего компьютера.
Если на его материнской плате установлен малопроизводительный процессор, то
могут возникать сбои при воспроизведении и записи звука.

В группе Upon a manual scroll/zoom/selection change: выбирают логику организации
прокрутки экрана втех случаях, когда в процессе воспроизведения или записи вы изме-
няете фаницы выделенного фрагмента или масштаб отображения волновой формы:

> Abort auto-scrolling until next play/record — прокрутка будет остановлена,
для ее возобновления нужно вновь включить режим записи или воспроиз-
ведения

> Resume auto-scrolling only after play cursor enters view — возобновить прокрут-
ку после того, как указатель текущей позиции войдет в отображаемый на
экране участок волновой формы

"г Resume auto-scrolling immediately — возобновить прокрутку немедленно
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Поле ввода Custom Time Code Display_frames/sec служит для выбора пользова-
тельского формата кодирования времени (Часы: Минуты: Секунды: Кадры), в ко-
тором можно изменять только количество кадров в секунду.

Кнопка Restore Default Window Layouts предназначена для приведения разме-
ров и оформления всех окон Cool Edit Pro в состояние по умолчанию.

Если флажок Ctrl key allows dockable windows to dock (normally, Ctrl key forces
undocking) установлен, то ряд панелей главного окна (Transport Controls, Zoom
Controls, Time, Selections/View Controls, Play List, Organizer и некоторые другие)
можно будет состыковать друг с другом и с границами главного окна только при
нажатой клавише <Ctrl>. Если флажок сброшен, то состыковка панелей возмож-
на и без применения клавиши <Ctrl>.

В группе Mouse Wheel имеется единственное поле ввода Zoom Factor:__%, пред-
назначенное для выбора коэффициента чувствительности колеса мыши.

Переключатели Arrow и I-Beam группы Mouse Cursor Over Display позволяют выб-
рать вид курсора мыши — стрелку или вертикальную черточку, соответственно.

В группе Edit View Right-Clicks находятся переключатели, определяющие функ-
цию щелчка правой кнопкой мыши на поле отображения волновой формы. Если
выбрана опция Popup Menu (use Shift+Click to extend), то щелчок правой кнопкой
мыши будет вызывать контекстное меню, а нажатие клавиши <Shift> с последую-
щим щелчком левой кнопкой мыши позволит изменить гран ииы выделенного участ-
ка волновой формы. Если выбрана опция Extend Selection (hold Ctrl for popup menu), то
перемещение курсора при нажатой правой кнопке мыши приведет к изменению гра-
ницы выделенного участка волновой формы. Для вызова контекстного меню в этом
случае нужно сначала нажать <Ctrl>, а потом щелкнуть правой кнопкой мыши.

Опции группы Default Selection Range позволяют изменять область волновой фор-
мы, по умолчанию считающуюся выделенной. Если выбрана опция View, то по умол-
чанию будет считаться выделенным тот фрагмент вол новой формы, который отобра-
жается на рабочем поле главного окна. Если выбрать опцию Entire Wave, то по
умолчанию будет считаться выделенной вся текущая волновая форма (включая и те
ее участки, которые в данный момент могут быть не видны из-за того, что выбран
крупный масштаб отображения). Установка, выполненная в данной группе, играет
существенную роль в процессе обработки волновой формы эффектами. Дело в том,
что если предварительно вы не выделите какой-либо фрагмент волновой формы, ти
эффект будет применен ктой области, которая считается выделенной по умолчанию

Если флажок Highlight after Paste установлен, фрагмент звуковых дан ных, встав-
ленный в текущую волновую форму, будет выделен (подсвечен белым по умолча-
нию цветом). В противном случае вставленный фрагмент окажется невыделен-
ным и его трудно будет отличить от звуковых данных, существовавших ранее.

1.1.2. Вкладка System — системные установки программы

Опции вкладки System (рис. 1.2.) окна диалога Settings позволяют изменить
системные установки программы.

Самая первая и самая важная рекомендация: если вы до конца не разобрались в
назначении опций этой вкладки, постарайтесь ничего не менять! Обращайтесь к ней
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Рис. 1.2. Вкладка System окна диалога Settings

лишь в случае крайней необходимости и только после ознакомления с назначени-
ем опций вкладки System, приведенным ниже.

Рассмотрим группу Play/Rekord Buffer.
Total Buffer Size — общий объем буферов, хранящих звуковые данные. Эта ве-

личина измеряется в секундах. Чем больше объем буферов, храняших временные
звуковые данные при воспроизведении или записи, тем надежнее будет работать
программа (особенно, если одновременно запущено несколько приложений
Windows). Однако чем больше памяти занято буферами, тем меньше остается па-
мяти для других целей.

В поле ввода using _buffers указывается число буферов (о которых мы только что
говорили). Эта величина тоже может влиять на качество звука. Некоторые звуковые
драйверы некорректно работают с большим количеством буферов, в результате чего
могут происходить сбои при записи или воспроизведении звука. Если это случится,
попробуйте уменьшить число буферов, либо попытайтесь изменить их общий объем.

В группе Preview Buffer имеется единственное поле ввода Minimum Size_mc, в ко-
тором можно выбрать размер буфера, используемого в процессе предварительного
прослушивания результатов обработки волновой формы каким-либо эффектом. При
малом размере буфера изменения в настройках эффекта будут проявлять себя быстро
(без заметной на слух задержки), но возможны сбои в воспроизведении звука. При
большом размере буфера сбоев, вероятнее всего, вы не ощутите, т. к. программа будет
успевать просчитывать звуковые данные, но реакция программы на ваши действия,
связанные с регулировкой параметров эффекта, станет чрезвычайно замедленной.
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Рассмотрим группу Wave Cache. Здесь Cache Size_K bytes — размер кэш-памя-
ти. Программа позволяет свободно оперировать волновыми формами, длитель-
ность звучания которых достигает десятков минут, а объем — сотен мегабайт. В
необходимых случаях Cool Edit Pro использует свободное пространство жесткого
диска. Скорость обмена с винчестером значительно меньше, чем с оперативной
памятью, а при обработке звука программе приходится многократно обращать-
ся к отдельным отсчетам волновой формы. Если бы обращения каждый раз про-
исходили только к жесткому диску, то, например, создание эффекта ревербера-
ции для волновой формы большого объема заняло бы несколько часов (а может
быть, и суток).

Гениальный и при этом простой выход из подобной ситуации программисты
придумали еще на заре компьютерной эры. Фрагмент данных, обрабатываемый в
текущий момент, заносится в оперативную память, и там над ним проводятся все
необходимые операции. Затем уже обработанный фрагмент вновь записывается
на диск, а в оперативную память считывается очередной блок данных. Так про-
должается до тех пор, пока не будут обработаны все данные. Чем больше инфор-
мации, временно помещаемой в оперативную память, тем быстрее завершится
процесс обработки, однако зависимость между этими величинами не является
линейной. Описанная технология, как известно, называется кэшированием, а об-
ласть памяти, в которую загружается блок обрабатываемых данных, — кэш-памя-
тью. В зависимости от объема оперативной памяти вашего компьютера рекомен-
дуется занимать под кэш-память от 8192 до 32768 Кбайт. Первое число
соответствует оперативной памяти 64 Мбайт, второе 512 Мбайт.

Если вы хотите, чтобы при работе Cool Edit Pro использовался системный кэш,
выберите опцию Use System's Cache. Однако лучше все-таки этого не делать.

Рассмотрим группу Temporary Polders.
В полях ввода Тегар Folder и Secondary Temp следует указать основной и допол-

нительный каталоги для хранения временных файлов. В целях повышения произ-
водительности программы эти каталоги должны находиться на разных физичес-
ких дисках. Для каждого из временных каталогов в полях ввода reserve free_ MB
можно задать минимальный объем дисковой памяти, которую программа не име-
ет права занимать служебной информацией. Если в процессе работы объем сво-
бодной памяти станет меньше указанного в рассматриваемом поле ввода, то про-
грамма предупредит вас об этом, и вы сможете своевременно удалить из памяти те
данные, без которых можно обойтись.

В группе Undo содержатся опции управления функцией возврата к предыду-
щим этапам редактирования данных:

> Enable Undo — флажок включения и отключения режима отмены операций
с количеством уровней, заданным в поле ввода Levels (minimum)

> Purge Undo— кнопка очистки служебной информации, необходимой для
выполнения операции отмены на уровнях, выше заданного максимального

Если за сеанс работы с программой вы произвели, скажем, 10 операций и
нажали кнопку Purge Undo (а максимальное количество уровней отмены, например,
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равно 5), то отменить после этого можно будет не все 10, а только последние 5 дей-
ствий. Иногда, если на диске мало свободного места, действительно есть смысл
ограничить возможности возврата к далеким предыдущим версиям редакции вол-
новой формы.

На вкладке осталось рассмотреть назначение двух флажков: Delete clipboard files
on exit и Force complete flush before saving.

Если установлен флажок Delete clipboard files on exit, то при выходе из програм-
мы данные из буфера обмена будут удаляться. В противном случае они остаются в
буфере обмена и могут быть использованы в других приложениях.

Cool Edit Pro позволяет избегать непосредственной работы с загруженными
аудиофайлами. Если в режиме редактирования волновой формы (Edit Waveform
View) воспользоваться командой File > Flush Virtual File, то вся информация из те-
кущего файла незаметно для пользователя скопируется в один из каталогов, пред-
назначенных для хранения временных файлов, асам исходный файл с точки зре-
ния операционной системы будет закрыт. Благодаря этому, другие приложения
смогут работать с данным файлом. Средствами MS Windows вы можете переиме-
новать загруженный ранее в Cool Edit Pro файл или даже удалить его, но при рабо-
те с этим файлом в Cool Edit Pro все будет выглядеть так, словно с ним ничего не
произошло. Завершив его обработку, вы можете воспользоваться командой сохра-
нения и ваш уже отредактированный файл окажется на своем прежнем месте. Та-
кой способ работы с файлами называется flushing. На случай возникновения ка-
ких-либо проблем при сохранении редактируемого файла поверх его исходной
версии (с тем же именем) предусмотрен флажок Force complete flush before saving,
который по умолчанию выключен. Если его включить, то непосредственно перед
сохранением аудиофайла незаметно для пользователя будет автоматически выпол-
няться команда Flush Virtual File (если ранее она не была вызвана вручную). То
есть, сначала аудиоданные будут скопированы в каталог для временных файлов,
исходный файл будет закрыт, и только потом будет выполнена команда сохране-
ния. Естественно, это приведет к замедлению выполнения команды сохранения.

1.1.3. Вкладка Colors - настройка цветовых схем интерфейса
С помощью опций вкладки Colors окна Settings можно задавать цвета интерфейса

программы. В свою очередь вкладка Colors состоит из трех вкладок: Waveform, Spectral
и Controls. Вкладка Colors-Waveform выглядит так, как показано на рис. 1.3 а.

Непосредственно под названием вкладки имеется список, в котором перечисле-
ны основные элементы рабочего поля, на котором отображается волновая форма:

> Waveform Foreground— изображение собственно волновой формы
> Waveform Background — фон, на котором изображается волновая форма
^ Boundary Lines — линии, ограничивающие максимально возможный размах

графика волновой формы по вертикали
> Center Lines — центральная л и н и я (линия нулевого уровня)
> Cue Start Marker — маркер начала размеченного фрагмента (фразы)
> Cue End Marker — маркер окончания размеченного фрагмента (фразы)
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Settings

General j System Colors | Display] Data j Multtoackj SMPTE

Waveform j Specdeli Controls Color Presets: Delete

Waveform Forearaund
Waveform Background
Boundary Lines
Center Lines
Cue Starl Marker
Cue End Marker
Grid Lines
Selection Highlight
Selection Cursor

-Selection-
invert

101

[(Default Scheme)

Example:

OK

Cancel

Help

Рис. 1.3 а. Вкладка Colors - Waveform окна Settings

> Grid Lines — линии координатной сетки на поле отображения волновой форм ы
> Selection Highlight — подсветка, обозначающая выделенный фрагмент вол-

новой формы
> Selection Cursor — указатель текущей позиции

Когда вы выделяете тот или иной элемент данного списка, то выбранный для
него цвет отображается в безымянном поле, расположенном левее кнопки Change
Color. Для изменения цвета выбранного элемента нажмите эту кнопку. Откроется
обычное для всех приложений MS Windows окно диалога Color (Цвет), в котором
вы можете по своему усмотрению выбрать любой оттенок цвета.

В поле Example: приводится пример того, как будет выглядеть интерфейс про-
граммы, если нажать кнопку ОК.

В группе Selection содержатся два элемента: флажок Invert и слайдер Transparency.
Если флажок Invert установлен, то выделенная область подсвечивается цветом,
инверсным по отношению к цвету иол новой формы. Слайдер Transparency при этом
недоступен. При сброшенном флажке Invert слайдером можно регулировать про-
зрачность выделенной области по отношению к общему фону рабочего поля.

Раскрывающийся список Color Presets: содержит названия стандартных цве-
товых схем. Кроме уже существующих палитр, вы можете создать свою собствен-
ную цветовую схему и, воспользовавшись кнопкой Save As..., сохранить ее под
своим именем. Кнопка Delete удаляет из раскрывающегося списка выбранную
цветовую схему.
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[Settings

Seneral I System Colors j Display] Data j Mulftrack | SMPTE |

Waveform Spectral I Controls I ' £obr Presets:

Specttal Hiah Energy
Spectral Low Energy
Frequency Analysis Lett
Ftequency Analysis Right

•Spectrum

P fleverse
Direction

gamma:

Selection
Iranspatency:

0 " " % 100

(Default Scheme)

E «ample;

Рис. 1.3 6. Вкладка Colors - Spectral окна Settings

Вкладка Colors — Spectral представлена на рис. 1.3 б.
С помощью опций данной вкладки выбирают цветовое оформление окон, в

которых волновая форма отображается в виде спектров. Речь идет о главном окне
программы в режиме отображения мгновенного спектра (см. гл. 5) и окне Frequency
Analyses (см. гл. 8).

Список элементов интерфейса, цвет которых можно изменять, на этой вклад-
ке не очень велик:

> Spectral High Energy — наивысший уровень спектральной плотности
> Spectral Low Energy — наименьший уровень спектральной плотности
> Frequency Analyses Left — результат спектрального анализа сигнала левого

канала
> Frequency Analyses Right — результат спектрального анализа сигнала правого

канала

Если флажок Reverse Direction в группе Spectrum установлен, то цвета, отобра-
жающие мгновенный спектр, меняются на обратные (в системе координат RGB).
Фактически флажок позволяет производить выбор либо красных, либо зеленых
тонов окраски мгновенного спектра.

В поле Gamma вводится коэффициент, определяющий насыщенность цветовой
гаммы. Если он равен нулю, то градации уровня мгновенного спектра становятся не-
видимыми. Все поле заливает белый цвет. При значениях коэффициента, превыша-
ющих 10, на спектральной диаграмме также трудно что-либо разглядеть: сплошная
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Settings

General) System Colors |Display] Data ) Multitfaokj SM.PTE |

' Waveform] Spectral Controls). £olorPresets: . ; „Sggf.bl ...Ĵ ,6,,

Track Thumb LED
Edit Box Text
Progress Bar
Chart Line
Chart Background
Chart Grid
Chart Dots

- * :Г" Segmefrtedgiogress Bar

P' 'W$e Progress Background

,r Dockable Wiidows—

\:f~ Use system 3D color
I C .Useĵ arkened system 3D color

f* Use specified 3D color

{(Default Scheme)

Example: - ,

OK

Cancel

Help

Рис. 1.3 в. Вкладка Colors - Controls окна Settings

чернота. Оптимальное значение данного коэффициента находится в пределахЗ... 3.
Остальные элементы данной вкладки идентичны элементам вкладки Colors —

Waveform окна Settings.
Вкладка Colors — Controls окна Settings представлена на рис. 1.3 в.
Список элементов управления, цвет которых можно менять с помощью опци и

данной вкладки, насчитывает 8 позиций:

> Dockable Window 3D Color — цветовое оформление окон, которые обладают
свойством присоединяться (пристыковываться) друг к другу или к обрам-
лению главного окна

> Track Thumb LED — цвет шкалы уровней сигнала (у регулятора уровня сиг-
нала каждого трека мультитрекового редактора)

> Edit Box Text — цвет текста в полях ввода
> Progress Bar — цвет прогресс-индикатора
> Chart Line — цвет некоторых интерактивных графиков
> Chart Background — цвет фона координатной сетки в некоторых окнах диалога
> Chart Grid — цвет координатной сетки в некоторых окнах диалога
> Chart Dots — цвет узловых точек на некоторых интерактивных графиках

Если установлен флажок Segmented Progress Bar, то полоска прогресс-индикато-
ра будет состоять из отдельных сегментов. В противном случае полоска непрерыв-
на. При установленном флажке White Progress Background фоном для полоски про-
гресс-индикатора будет служить белый цвет, а при сброшенном флажке — черный.
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В группе Dockable Windows расположены переключатели, с помощью которых
можно быстро перейти к одному из трех вариантов цветового оформления тех окон,
которые обладают свойством пристыковываться друг к другу или к обрамлению
главного окна:

> Use system 3D color — использовать системные цвета
> Use darkened system 3D color — использовать затемненные системные цвета
> Use specified 3D color— использовать цвета, выбранные вами в данном окне

Остальные элементы интерфейса данной вкладки знакомы вам из описания
вкладки Colors — Waveform.

1.1.4. Вкладка Display - настройка параметров отображения
Программа позволяет отображать звуковой файл в спектральном (диаграмма

мгновенного спектра) и временном представлении (осциллограмма волновой фор-
мы). Ас помощью опций вкладки Display (рис. 1.4) окна Settings можно изменять
параметры отображения.

Параметры спектрального отображения определяются опциями группы
Spectral Display.

General I System! Cokus Display! Data ] Multitracki SMPTE

Windowing j 1 ' 1 " " "
; "Function (eiackmann-Hams ĵ

FteSQlution ] 256 ĵ j Bands

; Wjndow Width Г 75 %

'• pPlol Style--

.i (* Logarithmic Energy Plot

Range ]" 120 dB

; С Linear Energy Rot

Scaling j П >'' %
'. ::•' '•

R Show Cue and Range Lines

i j I"/ Show Gt id Lines

p1 Show Center Lines

p1 Show Boundary Lines

Display Lines at | -1 dB

-, Peak Files -

• Peaks Cache j 256 ^ Block

' W Save Peak Cache Files

• J | fV * :'. .•--.'•! :^f Л. Ч,//- j j

OK .

Cancel .
J

Help

Рис. 1,4. Вкладка Display окна Settings

Классический алгоритм вычисления спектра предполагает, что анализируемый
сигнал бесконечен во времени и что любые его изменения, произошедшие беско-
нечно давно, вносят такой же вклад и формирования спектра, как и текущие из-
менения. В действительности же у любого сигнала есть начало и конец, анализа-
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тор спектра включают и выключают в определенные моменты времени, да и фи-
зически реализуемым приборам ciieKTpaibHoro анализа свойственно «подзабывать»
информацию о давних событиях. Раскрывающийся список Windowing Function со-
держит перечень алгоритмов преобразования, используемых для отображения
спектра сигнала. Алгоритмы отличаются друг от друга видом функции, с помо-
щью которой в процессе вычисления спектра учитывается предыстория анализи-
руемого сигнала.

Если у вас не выработалась привычка использовать какой-либо определенный
алгоритм спектрального анализа, то не имеет большого значения, какую именно строч-
ку вы выберете в этом списке. Разница между ними на практике слабо ощутима.

Раскрывающийся список Resolution^ Bands позволяет выбрать разрешающую
способность при представлении сигнала в виде спектра. Чем больше полос, на
которые будет разбит диапазон анализируемых частот, тем точнее анализ, но и
вьЕчисления требуют больше времени. Так как спектральный анализ проводится
на основе алгоритмов быстрого преобразования Фурье (БПФ), то параметр
Resolution^. Bands численно равен размеру выборки.

В поле ввода Window Width_% можно установить ширину спектрального окна,
выраженную в процентах по отношению к размеру выборки. Рекомендуется ос-
тавлять эту величину равной 100%.

Опции подгруппы Plot Style определяют стиль шкалы при отображении спект-
ра. Logarithmic Energy Plot — логарифмическая шкала. Диапазон шкалы (Range_dB)
задается в децибелах. Linear Energy Plot — линейная шкала. Масштаб (Scaling_%)
задается в процентах.

В группе Waveform Display сосредоточены элементы, позволяющие выбрать
стиль и параметры отображения волновой формы. Прежде всего, это 4 флажка:

> Show Cue and Range Lines — включение отображения линий, обозначающих
границы фраз, выявленных посредством команд подменю Edit > Auto Cue
(см. гл. 4)

> Show Grid Lines — включение отображения линий координатной сетки
> Show Center Lines — включение отображения центральной линии коорди-

натной сетки (линии нулевого уровня)
> Show Boundry Lines — включение отображения ограничительных линий ко-

ординатной сетки

Далее следует поле ввода Display Lines at_dB. Число, которое вы введете здесь (н
децибелах), определит положение ограничительных горизонтальных линий, слу-
жащих своеобразным ориентиром для визуальной оценки уровня сигнала. Вели-
чина OdB соответствует максимально возможной величине амплитуды сигнала.
При превышении этого уровня происходит ограничение сигнала, сопровождаю-
щееся заметными на слух искажениями. Установив значение Display Lines at_dB
равным, например, -1 clB, и следя, чтобы изображение волновой формы не пере-
секало ограничительныелинии, вы можете сбольшой вероятностью избежать воз-
н и к н о в е н и я и с к а ж е н и й .

Рассмотрим группу Peak Files.

23ак. 1152
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В поле Peaks Cached/Block следует ввести количество отсчетов в блоке данных
при записи или считывании информации из служебных файлов (РЕАК-фаЙлов),
предназначенных для ускорения операций загрузки WAV-файлов и отображения
волновых форм. При работе с WAV-файлами большого размера (десятки мегабайт)
рекомендуется увеличить это значение до 1024.

Если установлен флажок Save Peak Cache Files, то Cool Edit Pro будет сохранять как
WAV-файлы, так и файлы с расширением РК. Эти файлы содержат информацию, по-
зволяющую значительно ускорить прорисовку огибающей звуковых волн на экране при
повторной загрузке соответствующего WAV-файла. Когда со временем объем памяти,
занимаемой РЕAIC-файлами, станет неприемлемо большим, можно удалить наиболее
«древние» из этих файлов. Главное — случайно не удалить необходимый WAV-фай;!!

Нажатие кнопки Rebuild Wave Display New приводит к обновлению (перерисов-
ке) изображения волновой формы.

1.1.5. Вкладка Data - выбор параметров обработки звуковых данных
С помощью опций вкладки Data (рис. 1.5) окна Settings можно управлять пара-

метрами обработки звуковых данных.
Если установлен флажок Auto-convert all data to 32-bit upon opening, то при открытии

файла все аудиоданные будут автоматически преобразованы в 32-битный формат.
Установленный флажок Interpret 32-bit PCM.wav files as 16.8 float (compatibility

with old Cool Edit format) включает режим совместимости 32-битных файлов фор-
мата WAV PCM с форматом представления данных в старых версиях Cool Edit Pro.

| Settings

General] System] Colors] Display Data JMultilfackj SMPTE |

. Г" AutQ-converl all data to 32-bit upon opening

p1 Interpret 32-bit PCM ;wav files as 1 6.8 float (compatibility with old Cool Edit format]

*Р Diiner Transform Results [increases dynamic range)

Jv* Use Symmetric Dithering

П? Smooth Delete and Cut boundaries

1*7 Smooth all edit boundaries by cross! ading ,5 rns

г Auto-convert settings for Paste- •

Downsampling quality level |8U f? Pre-lilter

Upsampiing quality level p 20 p Po;t-filtei

. ; , : . - . . • - : . . .

!«/ Allow for partially processed data after cancelling effect

zl

OK

j.
Cancel

tielp )
ч

Рис. 1.5. Вкладка Data окна Settings
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Если звуковой сигнал представлен 16-битными отсчетами, то можно предпо-
ложить, что для его преобразования (например, для создания эффекта ревербера-
ции) используется 16-битная арифметика. Но если бы так было в действительно-
сти, то после нескольких преобразований проявились бы заметные на слух
искажения звука. Все-таки 16 бит для этих целей маловато. Поэтому для внутрен-
него представления звука, как и многие другие современные звуковые редакторы.
Cool Edit Pro использует больше 16 двоичных разрядов. За счет такого расшире-
ния динамического диапазона представления цифрового сигнала существенно
уменьшается погрешность, накапливающаяся при выполнении операций над зву-
ковыми данными. Однако после всех преобразований, необходимых для созда-
ния того или иного эффекта, эти данные конвертируются в обычный 16-битный
формат. При этом динамический диапазон сигнала вновь сужается до стандарт-
ных 96 дБ. Конечно, часть полезной информации теряется после выполнения пре-
образований звука. Чтобы такая потеря не стала заметной на слух, ее можно ком-
пенсировать добавлением псевдослучайного шума с очень маленькой амплитудой.
При этом динамический диапазон сигнала как бы остается на уровне 105 дБ, что
соответствует 24-битному представлению сигнала. У физиков и математиков та-
кое утверждение может вызвать недоумение и недоверие: как 16-битный сигнал
может иметь такой динамический диапазон? Действительно, с позиций матема-
тики такого быть не может, но благодаря особенностям человеческого слухового
восприятия при добавлении псевдослучайного шума возникает ощущение, что
качество звука оказывается лучше, чем при 16-разрядном представлении. Такой
подход используется и в Cool Edit Pro.

Включение и выключение эффекта кажущегося расширения динамического
диапазона посредством дитеринга осуществляется при помоши флажка Dither
Transform Results (increases dynamic range).

Флажок Use Symmetric Dithering включает особый алгоритм дитеринга, при ко-
тором добавляемые отсчеты цифрового шума принимают как положительные, так
и отрицательные значения и в среднем симметрично распределены в окрестнос-
тях нулевого уровня. Такой алгоритм позволяет избежать возникновения посто-
янной составляющей в обработанном сигнале, а значит, и шел ков на границах об-
работанного фрагмента. Поэтому, хотя на слух различие в результате работы
алгоритма несимметричного и симметричного дитеринга уловить трудно (за ис-
ключением возможных щелчков при несимметричном дитеринге), желательно,
чтобы флажок Use Symmetric Dithering был всегда установлен.

Флажок Smooth Delete and Cut boundaries следует установить для того, чтобы
сгладить фрагменты волновых форм в местах сращивания при выполнении опе-
раций Cut и Delete и устранить слышимые щелчки.

Установленный флажок Smooth all edit boundaries by crossfading_ms означает, что
будет производиться сглаживание на границе редактируемых фрагментов. Опера-
ция аналогичная Crossfade (уменьшение амплитуды сигнала предшествующего
фрагмента и одновременное увеличение амплитуды сигнала текущего фрагмен-
та). Время, за которое осуществляется плавный набор и сброс громкости, задает-
ся в соответствующем поле в миллисекундах.



36 Глава 7

В группе Auto-convert settings for Paste можно задавать параметры автоматичес-
кой конвертации при выполнении операции вставки. Автоматическая конверта-
ция работает в том случае, когда вставляемый блок звуковых данных имеет фор-
мат, отличный от формата редактируемой волновой формы.

Downsampling quality level и Upsampling quality level — параметры точности вы-
полнения операций понижения и увеличения частоты сэмплирования, которые
задаются числами от 30 до 1000.

С помощью опции Pre-filter включается специальная фильтрация оцифрован-
ных звуковых данных перед понижением частоты дискретизации. А опцией Post-
filter включается фильтрация после увеличения частоты дискретизации.

Dither amount for saving 32-bit data to 16-bit filesJbits — в этом поле ввода вы дол-
жны указать число, определяющее величину псевдослучайного сигнала, добавля-
емого для сохранения 32-разрядных данных в 16-разрядных файлах (от 0 до 1).
Значение 1 включает режим добавления псевдослучайного сигнала, в то время как
значение 0— отключает. Для частичного подмешивания псевдослучайного сиг-
нала выберите значение 0,5.

Флажок Allow for partially processed data after canceling effect определяет порядок
завершения процесса обработки волновой формы эффектом в том случае, когда
вы прервали этот процесс, нажав кнопку Cancel в окне прогресс-индикатора. Если
данный флажок сброшен, то результаты обработки волновой формы будут анну-
лированы. Если флажок установлен, то та часть звуковых отсчетов, которые про-
грамма успела обработать, будет оставлена в волновой форме и соответствующем
файле именно в обработанном виде.

1.1.6. Вкладка Multitrack — параметры мультитрекового
редактирования

В отличие от ранних версий программы, Cool Edit Pro 2 является мультитреко-
вым редактором. После того как произведено индивидуальное редактирование каж-
дой из волновых форм, вы можете разместить их на отдельных треках и заняться
монтажом аудиопрограммы. Подробно о работе в мультитрековом режиме (Multitrack
View) мы расскажем в главе 12. А сейчас рассмотрим опции вкладки Multitrack
(рис. 1.6) окна Settings, определяющей некоторые параметры этого режима.

В группе Play/Record вы можете переопределить количество и объем буферов
памяти, используемых в режимах записи и воспроизведения:

> Playback Buffer Size (response time)_sekonds — размер буфера при воспроиз-
ведении (в секундах)

> Playback Buffers — количество буферов воспроизведения
> Recording Buffer Size_sekonds — размер буфера при записи (в секундах)
> Recording Buffers — количество буферов записи
> Background Mixing Priority (Lower = Higher Priority) — уровень приоритета

процесса микширования в мультитрековом сеансе по отношению к другим
процессам, причем меньшие значения этого числа указывают на более вы-
сокий уровень приоритета по сравнению с другими событиями системы (вы
можете вводить дробные числа, например 0,8}
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Рис. 1.6. Вкладка Multitrack окна Settings

Для мультитрекового редактирования подходят звуковые карты, поддержива
юшие дуплексный режим (одновременное воспроизведение и запись). С техни-
ческой точки зрения для воспроизведения и записи используются разные устрой
ства. Прежде чем начать работу с этими устройствами, программное обеспечение
должно выполнить некую последовательность действий, делающую работу воз-
можной, т.е. «открыть» эти устройства. Для некоторых звуковых карт может иметь
значение порядок, в котором устройства записи и воспроизведения будут откры-
ваться в многоканальной среде. В группе Open Order этот порядок можно задать.

В группе Start Order задается порядок запуска устройств записи и воспроизве-
дения в мулътитрековом режиме: хотя запись и воспроизведение осуществляются
одновременно, какое-то из устройств должно запускаться в первую очередь, а ка-
кое-то во вторую. Для некоторых звуковых карт требуется, чтобы этот порядок
был специфическим. Например, владельцы звуковых карт Sound Blaster должны
выбрать опцию Rec, Play.

Может возникнуть вопрос: что, если выбрать порядок неправильно? Никакие
катастрофических последствий не будет. Возможно, в целом неправильные на-
стройки отразятся на конечном результате вашей работы, но почувствовать это
дано не каждому. Во многих звуковых редакторах возможность столь тонких на-
строек вообще отсутствует. Cool Edit Pro позволяет учесть особенности оборудо-
вания, чтобы добиться максимально возможной эффективности его применения.
Например, в звуковых картах SB Live! устройства записи и воспроизведения рабо-
тают от разных тактовых генераторов, частота которых в принципе не может быть
абсолютно одинаковой. В результате получается, что запись осуществляется
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с одной частотой сэмплирования, а при воспроизведении частота сэмплирования
хоть и немножечко (доли процента), но все же отличается. Эта же проблема акту-
альнадля системы, где используются несколько звуковых карт. Опять-таки, заме-
тить неточность способен не каждый пользователь, но в Cool Edit Pro предусмот-
рена возможность коррекции.

При установленном флажке Correct for Drift in Recordings программа будет сле-
дить за наличием синхронизации между устройством воспроизведения и устрой-
ством, посредством которого записана волновая форма. Если между частотами
дискретизации этих устройств существует различие, то устранение дрейфа будет
обеспечено за счет ресэмплирования. Когда для записи и воспроизведения ис-
пользуются устройства, работающие от одного и того же тактового генератора,
флажок следует сбросить. Данная опция работает только применительно к но-
вым трекам, на которые в ходе сессии была выполнена запись. Ресэмплирова-
ние начнется сразу после окончания записи и может длиться ощутимый проме-
жуток времени.

Некоторые звуковые карты работают с небольшой задержкой перед началом
записи, что может вызвать некоторые проблемы при работе в мультитрековом ре-
жиме: воспроизведение уже началось, а запись еще не пошла. Задержка неболь-
шая - порядка нескольких миллисекунд, но может ощущаться как рассогласова-
ние между разными партиями инструментов во времени при условии, что партии
эти записаны на разных звуковых картах. Опция Correct for Start Sine in Recordings
позволяет компенсировать это рассогласование путем введения задержки перед
началом воспроизведения. Если данная опция не помогает, можно определить
экспериментальным путем и ввести вручную параметр Multitrack Latency. О том,
как это сделать, мы расскажем в разд. 1.2.2.

В группе Merging выбирают опции слияния волновых форм, находящихся на
треках, в единый микс:

> Delete old takes after merging — удалять старый материал после объединения.
Данная операция освободит пространство жесткого диска.

> Crossfade Time (ms) — время перекрестного затухания, т. е. время, в течение
которого производится кроссфейд, когда осуществляется запись нового
фрагмента в существующий материал. Состыковка двух фрагментов осуще-
ствляется не путем резкого выключения одного и включения другого. В этом
случае очень трудно избежать щелчка. Делается по-другому. В конце пре-
дыдущего фрагмента сигнала его уровень плавно, но быстро уменьшается
от номинального к нулевому, а в начале последующего — наоборот увели-
чивается от нулевого до номинального. Стык получается незаметным на слух.
В этом и состоит суть кроссфейда.

В группе Mixdowns вы можете выбрать разрядность, с которой осуществляет-
ся микширование (объединение нескольких треков в один): 16-разрядное (16-
bit) или 32-разрядное (32-bit). Целесообразно для всех промежуточных опера-
ций выбирать разрядность наибольшую из возможных, а к 16-и битам переходить
только перед записью на носитель окончательно подготовленной фонограммы.
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Нажатием кнопки Dithering Options... открывается окно диалога Mixdowns
Dithering Options, предназначенное для выбора параметров дитеринга, сопровож-
дающего понижение разрядности представления звуковых данных. Данное окно
полностью идентично окну Convert Sample Type, назначение элементов которого
описано в разд. 4.35 (см. рис. 4.21)

В группе Defaults следует выбрать ряд параметров, которые будут установлены
по умолчанию:

> Track Record: — формат записи аудиофайла
> Pre-Mixing — разрядность предварительного микширования
> Panning Mode — один из двух способов панорамирования: L/R Cut (log) (ло-

гарифмическое панорамирование, характерное для старых версий Cool Edit)
или Equal-power Sine (панорамирование с сохранением постоянной синусо-
идальной мощности)

На вкладке Multitrack осталось рассмотреть лишь три флажка.
Если флажок Auto Zero-Cross Edits установлен, то перед выполнением опера-

ций редактирования (вырезка, удаление, вставка) границы выделенного участка
будут автоматически перемещены к ближайшим точкам, в которых волновая форма
пересекает нулевой уровень. Это позволит избежать шелков в местах состыковки
отредактированных фрагментов.

Если флажок Smooth auto-scrolling during playback сброшен, то в мультитреко-
вом редакторе используется «страничная* организация прокрутки изображения,
экономящая ресурсы компьютера. Если флажок установлен, то будет применен
метод «плавной» прокрутки, такой же, как и в редакторе волновых форм.

В Cool Edit Pro имеется возможность подключения эффектов реального време-
ни к трекам. После того как нужные эффекты подключены, трек можно заблокиро-
вать (Lock). При этом фактически произойдет перерасчет волновых форм трека с
учетом примененных к нему эффектов: где-то в папке для временных файлов по-
явятся новые файлы и при воспроизведении трека будут считываться именно они, а
не те волновые формы, которые отображаются графически. Естественно, на пере-
расчет уйдет какое-то время. Но зато после этого высвободятся ресурсы процессо-
ра, поскольку отпадает необходимость расчета эффектов в реальном времени. Ког-
да вам понадобится внести изменения в настройки эффектов, просто разблокируйте
трек. Если флажок Save locked track files after closing sessions (for faster session loads)
установлен, то временные файлы, содержащие волновые формы заблокированных
треков, будут сохранены после закрытия сессии (обычно все временные файлы после
закрытия сессии удаляются). Когда вы вновь вернетесь к сессии, то не будет необ-
ходимости в расчете этих файлов и загрузка произойдет быстрее.

Вам осталось познакомиться с последней вкладкой окна диалога Settings.

1.1.7. Вкладка SMPTE — опции синхронизации

На вкладке SMPTE (рис. 1.7) окна Settings содержатся опции, определяющие
параметры синхронизации по интерфейсу SMPTE. Для большинства компьютерных
музыкантов эта вкладка не представляет интереса. Ведь и домашних студиях очен F>
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Рис. 1.7. Вкладка SMPTE окна Settings

редко возникает необходимость сведения аудиоматериала, записанного на не-
скольких различных устройствах. Но следует знать, что Cool Edit Pro в принципе
предусматривает работу с интерфейсом SMPTE, а вкладка SMPTE позволяет оп-
тимизировать параметры этой работы.

На вкладке SMPTE имеется 5 полей ввода:

> Lead Time (to prepare wave driver)_ms — интервал времени от момента вклю-
чения режима воспроизведения, по прошествии которого программа долж-
на установить полную синхронизацию. Рекомендуется выбирать это время
в пределах от 500 до 1000 мс.

> Stopping Time (freewheel — audio stops after no input detected for this time)_ms —
время, в течение которого Cool Edit Pro будет работать в автономном режи-
ме после пропадания сигнала синхронизации.

> Lag Time (constant time difference between sound card driver's reported position
and actual)_samples — смещение сигналов синхронизации относительно
шкалы времени (задается в количестве отсчетов-сэмплов). Ненулевое зна-
чение этого параметра необходимо выбирать в том случае, когда звуковые
данные имеют постоянное смещение по отношению к коду времени.

>- Slack (time error allowable before repositioning play cursor)_frames — максимально
допустимое количество кадров, воспроизводимое между сбоем и восстанов-
лением синхронизации. Не рекомендуется устанавливать эту величину боль-
ше 2—3. В противном случае временное рассогласование между треками
будет ощутимо на слух.
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> Clock Drift Correction Time (crossfade length to use when adjusting playback
position)_samples — число выборок, соответствующее интервалу завершения
коррекции дрейфа последовательности синхронизирующих сигналов, на-
блюдающегося в местах перехода от одной волновой формы к другой.

Кроме полей ввода, на вкладке имеется два переключателя:

> Reposition playback cursor when shuttling — устанавливать заново текущую по-
зицию при зацикливании

> Full re-sync when shuttling — полное обновление синхронизации при зацик-
ливании

Подготовка к работе на этом не завершается. Необходимо еще выбрать устрой-
ства ввода и вывода.

1.2. Окно Device Properties — выбор устройств
записи и воспроизведения

Окно диалога Device Properties содержит 5 вкладок:

> Wave Out — выбор устройств вывода цифрового звука
> Wave In — выбор устройств ввода цифрового звука
> MIDI Out — выбор устройств вывода MTDI-сообщений
> MIDI In —выбор устройств ввода MlDl-сообщений
> Ext. Contoller — выбор внешнего контроллера

Рассмотрим каждую из вкладок.

1.2.1. Вкладка Wave Out — выбор устройств вывода цифрового звука

В левой верхней части вкладки Wave Out (рис. 1.8) окна диалога Device Properties
расположен раскрывающийся список доступных устройств вывода аудиоданных.
Внимание! Все остальные параметры, доступные на рассматриваемой вкладке,
относятся именно к тому устройству, которое выбрано в списке.

Правее раскрывающегося списка находится информационное поле Order. Циф-
ра в нем означает порядковый номер выбранного драйвера, под которым он знп-
чится в раскрывающемся списке. Кнопкой Change открывается окно диалога Device
Ordering Preference (см. разд. 1.3), с помощью которого можно изменить порядок
следования драйверов в списке.

Если установлен флажок Use this device in Edit View, то выбранное устройстно
будет использовано в редакторе волновых форм Waveform View.

Правую часть вкладки занимает таблица Supported Formats: совместимости выб-
ранного устройства воспроизведения с различными форматами представления
звукового сигнала.

В левых столбцах таблицы приведены частоты дискретизации от 8 до 96 кГц.
На самом деле значения частот указаны приближен но (пет дробных частей чисел.
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Рис. 1.8. Вкладка Wave Out окна диалога Device Properties

например, надпись ПК соответствует частоте 11,025 кГц). Все эти частоты уже
давно стандартизированы, поэтому, хотите того вы или нет, но звуковая карта бу-
дет воспроизводить и записывать звук, используя стандартные значения частот
дискретизации.

Самая верхняя строка таблицы содержит четыре возможные комбинации ре-
жимов: 8/16-bit (разрешающая способность сигнала) и Mono/Stereo.

Пользоваться этой таблицей так же просто, как и таблицей умножения. По-
смотрите на точку пересечения строки и столбца, соответствующих интересую-
щему вас режиму. Если звуковая карта поддерживает данный режим, то в точке
пересечения находится слово Yes.

Опции группы Limit Playback to: используются для компенсирования ограни-
чений, присущих вашим аппаратным средствам. Например, если звуковая карта
не обрабатывает 32-разрядный звук, а способна работать только с 16-разрядными
данными, вы можете использовать эту опцию, чтобы пусть и н е е высоким каче-
ством, но все же воспроизводить 32-разрядные звуковые данные. Для этого нужно
установить флажок 16-bit. Надеемся, что ваша звуковая карта поддерживает рабо-
ту со стереозвуком, и флажок Mono вам устанавливать не придется.

В группе Send 32 bit audio as: содержатся переключатели, определяющие форму
представления 32-битных аудиоданных. Перед выбором одного из трех возможных
вариантов вы должны ознакомиться с документацией на вашу звуковую карту.

При установленном флажке Try as WDM будет использоваться WDM-драйвер
устройства, если таковой имеется в системе.

Ваша звуковая карта может быть 16-битной, но вне зависимости от этого для
представления волновых форм лучше использовать 32 бита. Это позволит избе-
жать деградации качества звука после многократных преобразований волновых
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форм и сохранить асе тонкие изменения. В какой-то мере сохранить полезные
качества 32-битного звука при воспроизведении его через 16-битную звуковую
карту можно за счет применения дитеринга. Если установлен флажок Enable
Dithering, то в воспроизводимый через устройство вывода цифрового звука сигнал
будет подмешиваться дитеринговый шум, выбор свойств которого вам также дос-
тупен.

В поле Bits задается разряд, соответствующий амплитуде дптерингового шума.
Например, для 16-битной звуковой карты имеет смысл установить значение Bits
равное 16.

Ниже расположен раскрывающийся список p.d.f. (p.d.f.. Probability Distribution
Function — функция распределения вероятности), в котором можно выбрать не-
сколько моделей шума. Какая из них подходит лучше — решать вам. Модели шума в
списке отсортированы в определенном порядке: самая первая модель (Rectangular)
соответствует наибольшим гармоническим искажениям (harmonic distortion) и наи -
меньшему субъективному зашумлению сигнала. Самая последняя модель (Shaped
Gaussian) соответствует наименьшим гармоническим искажениям и наибольшему
зашумлению, Разработчик рекомендует функцию распределения вероятности
THangular для достижения компромисса между двумя объективными показателями:
ухудшением отношения сигнал/шум (SNR Loss) и шумовой модуляцией.

Еще один метод борьбы с шумом квантования, нойс-шейпинг, заключается в
применении специальных алгоритмов округления значений отсчетов при пони-
жении разрядности. После применения данного метода большая часть энергии
шума квантования сосредотачивается в области высоких частот, к которым чело-
веческий слуховой аппарат наименее восприимчив. Обычно нойс-шейпинг при-
меняется совместно с дитерингом.

В нижней части окна располагается раскрывающийся список Shaping. В нем
можно выбрать тип нойс-шейпинга, соответствующий одному из вариантов рас-
пределения спектра шума в полосе звуковых частот. Выбрав удачный вариант,
можно замаскировать шум квантования и шум. вносимый при применении дите-
ринга. Разработчик рекомендует следующие варианты:

> Noise Shaping А и В при частотах дискретизации, не превышающих 32 кГц
> Noise Shaping Cl, C2 и СЗ при частотах дискретизации не менее 44,1 кГц
> Noise Shaping D при частоте дискретизации 48 кГц
> Noise Shaping (44.1 KHz) при частоте дискретизации 44,1 кГц
> Noise Shaping (48 KHz) при частоте дискретизации 48 кГц
> Noise Shaping (96 KHz) при частоте дискретизации 96 кГц

1.2.2. Вкладка Wave In - выбор устройств ввода цифрового звука
Опции вкладки Wave In (рис. 1.9) окна диалога Device Properties предназначены

для выбора устройств ввода цифрового звука и режима их работы.
Большинство элементов интерфейса данной вкладки аналогичны элементам

вкладки Wave Out. В пояснениях нуждаются только две опции: поле Multitraclk
Latency и флажок Adjust to zero-DC when recording.
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Рис. 1.9. Вкладка Wave In окна диалога Device Properties

Мы уже говорили о том, что некоторые звуковые карты работают с небольшой
задержкой перед началом записи. Такая задержка может негативно проявить себя
в мультитрековом режиме: воспроизведение уже началось, а запись еше не пошла.
Cool Edit Pro позволяет компенсировать эту задержку: начать воспроизведение
немного позже, чтобы оно оказалось совмещенным с записью. Данную задержку
следует ввести в поле Multitrack Latency. Существует не очень сложный способ
выяснения точного значения задержки. Однако для того, чтобы воспользоваться
им, нужно уже обладать определенными навыками работы с Cool Edit Pro. Если
вы еще ими не обладаете, можете пока пропустить следующий абзац, чтобы вер-
нутся к нему позже.

Итак, рассмотрим технологию измерения значения Multitrack Latency.

1. В режиме редактирования волновой формы сгенерируйте любой сигнал (на-
пример, синусоидальный) небольшой продолжительности (например, I с)
и с достаточно высокой частотой (около 3 кГц).

2. Перейдите в мультитрековый режим и разместите сгенерированную волно-
вую форму в самом начале первого трека.

3. Подготовьте второй трек к записи, установите указатель текущей позиции в
самое начало треков.

4. Настройте микшер звуковой карты так, чтобы записывался сигнал, воспроиз-
водимый самой же картой {если карта одна), Если вы используете несколько
звуковых карт, то выход той карты, через которую воспроизводится первый трек,
следует соединить со входом той, что используется для записи. Микшер после-
дней должен быть настроен на запись сигнала именно с этого входа.

5. Включите запись в Cool Edit Pro и остановите ее буквально через секунду.
Этого будет достаточно.
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6. Перейдите в режим редактирования вновь записанной волновой формы.
7. Измените горизонтальный масштаб отображения волновой формы так,

чтобы пауза, предшествующая фронту записанного сигнала, занимала
большую часть окна. Выделите часть волновой формы, соответствующую
этой паузе.

8. Сделайте так, чтобы единицами измерения времени служили отсчеты
(Samples). В поле End будет показан номер последнего отсчета выделенной
области (соответствует окончанию паузы перед записью). Запомните это
число. В нашем случае оно равно 88.

9. Умножьте полученное число на 1000 и разделите на частоту сэмплирования в Гц.
В результате получится искомая величина в мс. Пример: 88x1000/48000=1.8 (3).

10. Введите полученное число в поле Multitrack Latency (с точностью в пределах
разумного). В нашем случае 1.833.

11. Перейдите в мультитрековый режим, очистите второй трек и вновь проде-
лайте пункты с 3 по 7 для того, чтобы убедиться, что пауза перед записан-
ным сигналом исчезла.

Иногда для того, чтобы реализовать многоканальную запись, идут по пути
установки в PC нескольких мультимедийных карт, каждая из которых, в прин-
ципе, обладает неплохим АЦП. Однако было бы правильнее затратить немно-
го больше средств и приобрести одну специализированную многоканальную
карту, решив тем самым массу проблем, связанных с синхронизацией. Каждая
из нескольких звуковых карт в отдельности может быть сколь угодно хороша,
но в разных картах (пусть даже и одинаковой модели) используются разные
тактовые генераторы, которые, повторимся, в принципе не могут быть абсо-
лютно синхронными,

Флажок Adjust to zero-DC when recording позволяет включить режим коррек-
ции постоянной составляющей в записываемом сигнале. Некоторые аппарат-
ные средства записи могут пропускать постоянную составляющую сигнально-
го напряжения на вход аналого-цифрового преобразователя (АЦП), что
приводит к записи волновой формы со смещением относительно нулевого уров-
ня. При монтаже таких волновых форм возможно появление щелчков. Если
флажок Adjust to zero-DC when recording установлен, то Cool Edit Pro автомати-
чески скорректирует постоянную составляющую таким образом, что на треке в
главном окне каждая волновая форма будет расположена симметрично отно-
сительно нулевого уровня.

1.2.3. Вкладка MIDI Out - выбор устройств вывода MIDI-сообщений

Опции вкладки MIDI Out (рис. 1.10)окна диалога Device Properties предназна-
чены для выбора устройств вывода MIDI-сообщений и сигналов синхронизации,
передаваемых посредством интерфейса SMPTE.

В списке MIDI Output: выби-рают драйвер устройства вывода MIDI-сообще-
н и й , а в списке SMPTE Output: — драйвер сигналов синхронизации, передавае-
мых посредством интерфейса SMPTE.
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Рис. 1.10. Вкладка MIDI Out окна диалога Device Properties

1.2.4. Вкладка MIDI In - выбор устройств ввода MlDI-сообщений

Опции вкладки MIDI Out (рис. 1.11) окна диалога Device Properties предназна-
чены для выбора устройств ввода MIDI-сообщений,

Все элементы этой вкладки вам уже знакомы.

1.2.5. Вкладка Ext. Controller — выбор внешнего контроллера
Опции вкладки Ext. Controller (рис. 1.12) окна диалога Device Properties пред-

назначены для выбора внешнего устройства управления из числа имеющихся у вас
и поддерживающих работу с Cool Edit Pro.

Device Properties

WeveGutj Wavelnf W!DIQut MIDNre j ExtConbdler

SBLivelMIDIUART Щ Ord«-2nd Cliange;

Рис. 1.11. Вкладка MIDI In окна диалога Device Properties
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На этой вкладке в раскрывающемся списке Volume Increment (dB) можно также
выбрать величину приращения громкости, соответствующую элементарной по-
сылке сигнала с внешнего контроллера.

Device Properties

Wave-Qut] Wave In j MIDIOulj MIDI In E*t.ContFCifer

^Л External Control Device

Рис. 1.12. Вкладка Ext. Controller окна диалога Device Properties

1.3. Окно Device Ordering Preference —
редактирование списков устройств записи
и воспроизведения

Окно диалога Device Ordering Preference предназначено для выбора порядка сле-
дования устройств записи и воспроизведения в списках окна Device Properties,
а также входных/выходных портов треков в мультитрековом режиме и содержит
4 вкладки;

> Playback Devices — редактирование списка устройств вывода цифрового звука
> Recording Devices — редактирование списка устройств ввода цифрового звука
> MIDI Output Devices— редактирование списка устройств вывода MlDI-co-

общений
> MIDI Input Devices — редактирование списка устройств ввода MIDI-co-

обш.ений
Нет необходимости рассматривать каждую из вкладок, т. к. они внешне абсо-

лютно одинаковы. Поэтому прокомментируем назначение элементов только вклад-
ки Playback Devices (рис. 1. 13) окна диалога Device Ordering Preference.

В списке Unused Playback Devices могут содержаться имена устройств, которые
в принципе, имеются в вашей системе, но не должны использоваться в мульти-
трековом режиме.
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Рис. 1.13. Вкладка Playback Devices окна диалога Device Ordering Preference

В списке Multitrack Device Preference Order перечислены имена устройств, ко-
торые используются в режиме мультитрекового редактирования. Для переноса
имени устройства из списка Unused Playback Devices в список Multitrack Device
Preference Order нужно воспользоваться кнопкой Use», а для переноса имени ус-
тройства в обратном направлении — кнопкой «Remove.

Для изменения очередности драйверов устройств в списке Multitrack Device
Preference Order нужно выделить один из них и нажать кнопку Move Up, чтобы
переместить его вверх, или кнопку Move Down, чтобы переместить его вниз.

Если нажать кнопку Use in EV, то выделенное в данный момент устройство бу-
дет использоваться в редакторе волновых форм (Edit Waveform View).

В информационном поле, расположенном в верхней части каждой из вкладок,
содержатся необходимые рекомендации и напоминания.

Кнопкой Properties... вызывается окно диалога Device Properties, рассмотрен-
ное в разд. 1.2.

Завершив подготовку программы, можно перейти к работе с ней. Конечно,
начинать нужно с наиболее простых часто выполняемых действий. Поэтому сна-
чала следует ознакомиться с назначением элементов главного окна программы в
режиме редактирования отдельных волновых форм (Edit Waveform View).
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РАБОТА С ГЛАВНЫМ ОКНОМ ПРОГРАММЫ
В РЕЖИМЕ EDIT WAVEFORM VIEW

В текущей версии Cool Edit Pro существуют два принципиально различных ре-
жима работы:

> Редактирование отдельных монофонических или стереофонических волно-
вых форм

> Мультитрековый редактор, в котором из отдельных волновых форм, как и:з
кубиков, можно составить композицию

Для каждого режима предусмотрено свое главное меню и свое главное окно:
Edit Waveform View и Multitrack View соответственно. По сути дела, это два различ-
ных по назначению звуковых редактора, объединенных в функциональный ком-
плекс. Основным режимом работы для Cool Edit Pro является мультитрековый.
Именно в этом режиме находится программа после запуска. Технологию работы
с Cool Edit Pro как с мультитрековым редактором, поддерживающим многоканаль-
ную запись, в целом можно сформулировать следующим образом:

> Выполнение одноканальной (методом наложения) или многоканальной
записи в мультитрековом режиме

> Редактирование записанных волновых форм, а также волновых форм, полу
ченных извне (например, из библиотеки сэмплов) в режиме Edit Waveform View

> Возврат в мультитрековый режим, сведение композиции на основе отредак-
тированных волновых форм с применением эффектов реального времени
и средств автоматизации

При таком подходе работа над композицией начинается и заканчивается в муль-
титрековом режиме, но связующим звеном в технологической цепи является ре-
жим Edit Waveform View. Только в этом режиме можно редактировать отдельные
волновые формы. Именно режиму Edit Waveform View посвящена данная и после-
дующие главы, включая гл. 11. А особенности работы в мультитрековой среде бу-
дут подробно рассмотрены в главе 12.
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Приступим к детальному освоению всех средств программы, доступных пользо-
вателю в процессе редактирования отдельных монофонических или стереофони-
ческих волновых форм в главном окне Edit Waveform View.

2.1. Основные элементы главного окна
После первого запуска программа будет находиться в мультитрековом режиме.

Чтобы переключиться в режим редактирования волновой формы, нажмите кла-
вишу <FI2> или воспользуйтесь командой главного меню View > Edit Waveform
View. Если теперь даже закрыть Cool Edit Pro и запустить его вновь, то программа
окажется в том режиме, из которого она была закрыта.

Главное окно Cool Edit Pro в режиме Edit Waveform View будет выглядеть так,
как показано на рис. 2.1.

В верхней части главного окна расположена панель инструментов, внешний
вид и состав которой можно формировать по своему усмотрению: размещать на
ней или исключать из нее те или иные инструменты (кнопки, соответствующие
командам главного меню). Забегая вперед, отметим, что выбор инструментов, ото-
бражаемых в главном окне, производится с помощью подменю Toolbars меню View.

Рис. 2.1. Главное окно програглмы



Работа с главным окном программы в режиме EDIT WA VEFORM VIEW

Чтобы узнать о назначении какого-либо инструмента, нужно подвести к нему
указатель мыши и оставить неподвижным на некоторое время (примерно на I с),
в результате рядом с инструментом высветится подсказка, содержащая перечень
функций, которые он выполняет. Мы не будем подробно останавливаться на на-
значении инструментов, так как их набор не является постоянным, а сами они
полностью дублируют пункты главного меню, которые, в свою очередь, подробно
рассмотрены в главах 3— 11.

Обратим ваше внимание только на левую кнопку панели инструментов. Эта
кнопка — еше один способ перехода от режима редактирования отдельных волно-
вых форм (главное окно в этом режиме носит название Edit Waveform View) к муль-
титрековому режиму (Multitrack View). Облик кнопки меняется в зависимости от
того, каким является текущий режим. В Edit Waveform View она выглядит так:

1, а в Multitrack View - так: ****Н
^̂ ^̂••Ш̂  MI In и.н-il

На рис, 2.1 видно не заполненное никакой информацией рабочее поле. Оно
свободно лишь потому, что вы еше не загрузили в память программы звуковой
файл. Если считать звуковой файл с диска или произвести запись звука с любого
из доступных входов звуковой карты, то в этом поле будет отображаться волновая
форма. К рассказу о работе с этим полем мы вернемся сразу после того, как в на-
шем распоряжении окажется звуковой файл.

Перед тем как продолжить вглядываться в элементы главного окна, нужно
договориться о двух терминах: маркер и указатель текущей позиции. Оба эти
объекта выглядят на экране как самые обычные отрезки вертикально направ-
ленных прямых линий. Правда, маркер — пунктирная линия, а указатель теку-
щей позиции — сплошная. На рис. 2.1 их нет, потому что еще не создана волно-
вая форма. Вы увидите эти линии на других рисунках, но упоминать их нужно
будет уже сейчас.

Маркер указывает то место (то время) в волновой форме, с которого начнется
запись или воспроизведение. Маркер виден только в статическом состоянии про-
граммы — в режиме Stop.

Указатель текущей позиции, напротив, существует и виден только в динами-
ческих режимах: при воспроизведении и записи. Он указывает на графическом
изображении волновой формы то место, запись или воспроизведение которого
происходит в текущий момент времени.

По умолчанию в левой нижней части окна расположены кнопки, напоминаю-
щие кнопки управления магнитофоном. Это панель управления, которую иногда
называют также транспортной панелью. В рассматриваемой версии программы эта
панель (рис. 2.2), так же как и некоторые другие панели главного окна, можно
отстыковать от других панелей или обрамления главного окна. Панель станет са-

Transport Contr

И М V

Рис. 2.2. Панель Transport Controls
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настоятельной, у нее появится название (в данном случае — Transport Controls), ее
можно перемещать в любое место главного окна. Можно и вновь пристыковать к
другим панелям. Напомним о том, что опции перемещения подобных (плаваю-
щих) панелей выбираются на вкладке General, а цветовое решение на вкладке Colors
- Controls окна диалога Settings.

С помощью кнопок этой панели осуществляется управление записью, воспро-
изведением и отображением волновых форм. Остановимся подробнее на их на-
значении.

sj (Stop) — кнопка остановки записи или воспроизведения. После нажатия
этой кнопки указатель текущей позиции возвратится к маркеру. Следующий се-
анс записи или воспроизведения начнется с точки расположения маркера.

(Play) — кнопка включения режима воспроизведения. Может быть воспро-
изведен только тот фрагмент волновой формы, который отображен на экране.
После достижения указателем текущей позиции правой границы экрана воспро-
изведение прекратится, а указатель текущей позиции возвратится к маркеру. Если
имеется выделенный фрагмент волновой формы, то воспроизведен будет только
он, а по окончании воспроизведения указатель текущей позиции возвратится к
началу выделенного фрагмента.

(Pause) — кнопка временной остановки записи или воспроизведения. Пос-
ле остановки указатель текущей позиции останется на том месте, где его застало
нажатие этой кнопки. Повторное нажатие кнопки приведет к продолжению вос-
произведения (записи).

(Play to End) — еще одна кнопка включения режима воспроизведения. Мо-
жет быть воспроизведена вся волновая форма, а не только ее часть, отображенная
на экране или выделенная. В процессе воспроизведения изображение волновой
формы прокручивается таким образом, что указатель текущей позиции всегда на-
ходится в середине экрана. После завершения воспроизведения или нажатия кноп-
ки Stop отобразится участок волновой формы в окрестностях маркера (та область
волновой формы, с которой было начато воспроизведение).

(Play Looped) — кнопка включения режима циклического воспроизведе-
ния. Воспроизведение начнется с позиции маркера. Когда указатель текущей по-
зиции дойдет до правого края отображенного на экране фрагмента волновой фор-
мы, воспроизведение не прекратится, а продолжится с его левого края. Если
имеется выделенный фрагмент, циклически будет воспроизводиться только он.

(Go to Beginning or Previous Cue) — кнопка перемещения маркера к началу
волновой формы или к предыдущей позиции автоматической разметки границ
фраз и тактов (разд. 4.11).
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I (Rewind) — кнопка «обратной перемотки». Если программа находится в со-
стоянии Stop, то нажатие этой кнопки приведет к перемещению маркера в на-
правлении начала волновой формы. Причем, однократное нажатие кнопки вызо-
вет перемещение маркера на один шаг. Если кнопку нажать и удерживать, маркер
будет перемещаться до тех пор, пока не дойдет до начала волновой формы или
пока не будет отпущена кнопка Rewind.

Щелчком правой кнопки мыши на кнопке Rewind вы откроете меню (рис. 2.3),
в котором можно выбрать скорость перемотки. Верхние две строчки этого меню
соответствуют переменной скорости перемотки: чем дольше вы удерживаете на-
жатой кнопку Rewind, тем быстрее происходит перемотка. При выборе любой из
оставшихся строк установится фиксированная скорость перемотки.

</ Variable $xf Sxy Юх)

Variable (2x, 4x, 8x)

Constant 2x

Constant 3x

Constant 4x

Constant 6x

Constant 8x

Constant 2x (reverse Ix)

Рис. 2.З. Меню выбора скорости перемотки

Если нажать кнопку Rewind во время воспроизведения волновой формы, в
обратном направлении будет перемещаться не маркер, а указатель текущей по-
зиции. На слух полученный результат будет напоминать работу реального лен-
топротяжного устройства в режиме обратной перемотки. Когда вы кнопку отпус-
тите, воспроизведение продолжится с того места, к которому успел переместиться
указатель текущей позиции.

(Fast Forward) — кнопка ускоренной перемотки вперед. За исключением
направления перемотки эта кнопка ничем не отличается от кнопки Rewind.

(Go to End or Next Cue) — кнопка перемещения маркера к концу волновой
формы или к следующей позиции автоматической разметки границ фраз и тактов,

(Record) — кнопка включения режима записи.

В главном окне есть еше несколько элементов и инструментов, но рассказывать
о них сейчас не имеет смысла. Сначала нужно заполнить главное окно волновой
формой. Для этого есть несколько возможностей. Волновую форму можно загру-
зить из файла, вставить из буфера обмена и, наконец, записать. Начнем с записи.
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2.2. Запись звуковых данных

Кнопка _J U (Record) после запуска Cool Edit Pro является единственной дос-
тупной. Остальные кнопки управления транспортировкой пока не работают, так
как звуковые данные не загружены, и отображать или воспроизводить еще нечего,

Прежде чем нажать кнопку '$;.\ (Record), убедитесь в том, что сигнал от источ-
ника звука (проигрывателя CD, микрофона, внутреннего синтезатора звуковой
карты или любого другого источника, подключенного, например, к линейному
входу звуковой карты) подан на вход АЦП. Как в этом убедиться? Очень просто:
на время сверните панель программы Cool Edit Pro и запустите программу-мик-
шер звуковой карты. Выберите там источник звука и установите такой уровень
записи, чтобы при максимальной громкости не было нелинейных искажений,

Для точной установки уровня записи Cool Edit Pro предоставляет очень удоб-
ный инструмент. По умолчанию в нижней части окна расположены индикаторы
уровня сигнала и шкала-линейка (рис, 2.4) с отметками. По умолчанию же уста-
новлены пределы шкалы 0 и - 72 дБ (числа от 0 до - 69). Диапазон отображаемых
уровней можно менять. Для этого нужно щелкнуть на шкале правой кнопкой
мыши и выбрать значение отображаемого диапазона уровней в контекстном
меню (от 24 до 120 дБ).

Рис. 2.4. Измеритель уровня сигнала. Уровень сигнала довольно еелик, но не превышает 0 дБ

Понятие уровня сигнала подробно разъяснено в книге [8j, здесь же ограни-
чимся лишь кратким определением. Уровень аудиосигнала характеризует сигнал в
определенный момент и представляет собой выраженное в децибелах выпрямлен-
ное и усредненное за некоторый предшествующий промежуток времени напря-
жение аудиосигнала, отнесенное к некоторой условной величине U0.

Щелкните на шкале два раза или выберите пункт главного меню Options >
Monitor Record Level. Линейка оживет. Если для звуковых данных установлен сте-
реофонический формат, на ней будут индицироваться уровни сигналов левого и
правого звуковых каналов. Две ярких полоски будут удлиняться или сокращаться
в соответствии с мгновенными значениями уровней сигналов в правом и левом
каналах. Чтобы вы смогли уследить за пиковыми значениями уровней, индикато-
ры на короткое время их запоминают. Если формат звуковых данных монофони-
ческий, то вместо двух трепещущих полосок вы будете наблюдать только одну.

По сути, то, что вы сейчас проделали, дважды щелкнув на индикаторах уровня за-
писи, — это «холостой» запуск АЦП. при котором не происходит накопления звуковых
отсчетов в памяти компьютера, а просто отображается текущий уровень сигнала.

Ваша главная задача состоит в том, чтобы уровни не доходили до 0 дБ, но в то
же время не были малыми.
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Правее отметки 0 друг над другом расположены два квадратика — индикаторы
перегрузки (клигширования) левого и правого каналов. Они загораются, если ам-
плитуда сигнала достигает максимально допустимой величины ил и превышает ее.
Уровень 0 дБ соответствует максимально допустимому значению цифрового от-
счета звукового сигнала. Если эта величина будет превышена записываемым сиг-
налом, то произойдет переполнение разрядной сетки АЦП. На слух этот факт вос-
принимается как очень заметное искажение сигнала, особенно если переполнение
разрядной сетки будет происходить часто или в течение продолжительного интер-
вала времени. Поэтому не случайно индикаторы перегрузки сигнализируют о ней
тревожным красным цветом. Успех сеанса записи в опасности!

Если источник звука позволяет повторять записываемую фонограмму (напри-
мер, вы выполняете запись с компакт-диска), то лучше будет, если вы предвари-
тельно прослушаете всю фонограмму. Причем, всякий раз после срабатывания
индикаторов перегрузки следует:

1. Остановить воспроизведение.
2. Регулировкой на микшере звуковой карты (с помощью виртуального мик-

шера) немного уменьшить уровень сигнала.
3. Сбросить индикатор перегрузки (щелчками на нем погасить виртуальные

светодиоды).
4. «Отмотать» фонограмму назад (установить маркер перед тем местом волно-

вой формы, в котором наблюдалась перегрузка).
5. Вновь проконтролировать подозрительное место фонограммы.

Подобрав с помощью микшера нужный уровень, не забудьте прекратить холо-
стую работу АЦП: снова дважды щелкните кнопкой мыши на индикаторах уров-

ня или нажмите кнопку \^\ (Stop).
Чтобы завершить тему измерителя уровня, рассмотрим команды контекстного

меню, которое открывается щелчком правой кнопки мыши на его поле (рис. 2.5):

> Monitor Record Level — включение измерителя уровня (дублируется двой-
ным щелчком левой кнопкой мыши на измерителе)

> Show on Play and Record — отображение уровня как в режиме записи, так и и
режиме воспроизведения

> Clear Clip Indicators — сброс индикаторов клиппирования в исходное состо-
яние (дублируется щелчком на индикаторах клиппирования)

> Adjust for DC — корректировка измеряемого уровня сигнала с учетом нали-
чия постоянной составляющей

> Show Valleys — включение отображения текущих минимальных значений
уровня сигнала

> 120 dB Range... 24 dB Range — выбор диапазона измеряемых значений уровня
> Dynamic Peaks — включение режима динамического отображения макси-

мальных значений уровня сигнала (черточки, обозначающие максимальное
значение уровня сигнала, будут менять свое положение через небольшой
интервал времени)
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Static Peaks — включение режима статического отображения максимальных
значений уровня сигнала (черточки, обозначающие максимальное значе-
ние уровня сигнала, будут менять свое положение только в том случае, если
зафиксированное первым пиковое значение уровня в дальнейшем будет
превышено, иными словами, по окончании воспроизведения или записи
на измерителе уровня останется отмеченным наибольшее за весь сеанс зна-
чение уровня)

w Monitor Record Level

Show on Play and Record

Clear Clip Indicators

Adjust for DC

Show Valleys

12QdB Range

96dB Range

* 72dB Range

60dB Range

4SdB Range

24dB Range

* Dynamic Peaks

Static Peaks

Рис. 2.5, Контекстное меню измерителя уровня

Нам представляется более удобным работать с измерителем уровня, когда па-
нель Level Meters размещена вертикально и пристыкована к правому краю глав-
ного окна, как показано на рис. 2.6.

Теперь нужно выбрать один из двух возможных режимов записи. Для этого щел-

кните правой кнопкой мыши на кнопке ;« \ (Record). Откроется меню, предназна-
т ? Г il I

ченное для выбора режима записи. В нем два пункта; Instant Record и Timed Record.
Если вы выберете вариант Instant Record, то запись будет начинаться в момент

нажатия кнопки j».-j (Record).

Выбор Timed Record позволяет запрограммировать время начала и продолжитель-
ность сеанса записи. О том, как это сделать, мы расскажем в конце данного раздела.

Выберите вариант Instant Record. Наконец-то можно смело нажимать кнопку :« I

(Record). Вы ожидали, что прямо сейчас начнется запись? Потерпите немного. Ос-
талось определиться с форматом, в котором будет вестись запись. Не случайно ведь
открылось окно диалога New Waveform, изображенное на рис. 2,7. Это же окно по-
явится и в том случае, когда вы выберете пункт главного меню File > New....

Окно диалога New Waveform предназначено для задания формата, в котором
будет храниться оцифрованный звук. Можно считать и так: до тех пор, пока в этом
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Рис. 2.6- Измеритель уровня размещен вертикально

окне диалога не выбраны необходимые параметры, и вы его не закроете, волновая
форма не существует. И только после закрытия окна диалога New Waveform можно
говорить о том, что она появилась. Правда, пока сеанс записи еще не начат, суще-
ствующая волновая форма не содержит ни одного отсчета.

[New Waveform ;

r SampleRate — , r- Channels \ r-Qesolution —

I
TEfiTj] i j * МОПО I -̂Dlt

. ! 1 f» StPtpn : f* 1R-hit
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M-| ; :-. .
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Help

Рис. 9.7. Окно диалога New Waveform для
выбора Формата волновой формы
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В списке Sample Rate выберите частоту дискретизации (сэмплирования).
В группе Channels выберите режим: моно (Mono) или стерео (Stereo).
В группе Resolution выберите разрешающую способность: 8-битное (8-bit), 16-бит-

ное (16-bit) или 32-битное с плавающей точкой (32-bit (float)) представление сигнала.
Сразу после того, как вы нажмете кнопку ОК или клавишу <Enter>, окно New

Waveform закроется и начнется запись.
Время записи можно контролировать, глядя на табло, по умолчанию распо-

ложенное в средней нижней части главного окна программы. Эту панель также
можно отделить от других и переместить в любое место рабочего поля, Возмож-
ный вид панели Time приведен на рис. 2.8. В процессе записи пифры на табло
меняются.

0:06.938
Рис. 2.8. Табло контроля текущего времени

В нашем примере дифры 0:06.938 на рисунке означают, что с момента начала
записи прошло 0 минут, 6 секунд и 938 миллисекунд. В данном случае время ото-
бражается в десятичном формате. Но вы можете выбрать и другой формат отобра-
жения времени. О том, как это сделать, мы расскажем в гл. 5.

Для отображения волновой формы используется рабочее поле главного окна,
представляющее собой координатную плоскость.

По горизонтальной оси откладываются единицы времени. Выбор единиц изме-
рения времени предоставляется пользователю, но об этом поговорим также в гл. 5.

Если выбран монофонический формат волновой формы, то в рабочем поле
будет отображаться только один трек. При стереофоническом формате будет два
трека, расположенных друг под другом: трек, соответствующий левому каналу ввер-
ху, правому — внизу.

Оцифровка вертикальной оси (каждого из треков в отдельности) соответствует
диапазону значений отсчетов сигнала. Для 16-битного сигнала этот диапазон ог-
раничен значениями -32 768 и 32 767, а для 8-битно.го — 0 и 255. Для удобства
пользователей предусмотрено еше три варианта разметки вертикальной оси сис-
темы координат:

> В процентах от максимально допустимого значения отсчета сигнала, кото-
рое соответствует 100%

> Нормализованная разметка — в виде правильных десятичных дробей (еди-
нице соответствует максимально допустимое значение отсчета сигнала)

> В децибелах
Переключение единиц измерения размаха волновой формы осуществляется

посредством команд подменю View > Vertical Scale Format.
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Напомним, что сейчас речь идет о главном окне программы в режиме отобра-
жения волновой формы. Но в окне может отображаться не сама волновая форма,
а ее текущий спектр. В этом случае по вертикальной оси откладываются значения
частоты, а не значения отсчетов сигнала. Подробнее о такой форме представле-
ния звукового сигнала читайте в разд. 5.1,

В самом низу главного окна расположена строка статуса (рис. 2.9), в полях ко-
торой отображаются данные об уже записанном звуке.

[Slopped ""'" ""'~R:-.ftB@ 0.07,531 цГш'Тб-ЬИ Stpac- 1*36h. 0'08 И9 ЕЧГмВ tee . 5239.3!йИм" ДРГ ~^\

Рис. 2.9. Строка статуса

Слева отображается режим, в котором находится программа: Stopped (стоп),
Playing (воспроизведение), Recording (запись).

В поле Data Under Cursor отображаются текущие координаты курсора мыши.
В примере, приведенном на рис. 2.9, запись означает, что стрелка курсора нацеле-
на в точку, где уровень звукового сигнала левого канала равен -0,9 дБ, причем эта
точка отстоит от начала волновой формы на время, равное 7,531 с. С наибольшей
пользой это поле можно применять для оценки уровня сигнала в характерных точ-
ках. Для этого достаточно нацелить на одну из них курсор мыши.

В следующем поле (Sample Format) содержится напоминание о том, какой формат
был выбран при создании волновой формы (в данном случае 44,1 кГц, 16 бит, стерео).

Далее слева направо расположены поля, в которых отображаются:

> Объем памяти, занятой звуковым файлом (поле File Size)
> Общая продолжительность волновой формы (поле File Size [time])
> Объем свободной памяти на тех логических дисках, где созданы временные

каталоги для хранения копий звукового файла, формируемых программой
во время текущей сессии (поля Free Space[K]) и Free Space[time])

В правом поле (Keyboard Modifiers) отображается состояние клавиатуры (вдан-
ном случае при копировании экрана была нажата клавиша <Alt>).

В процессе записи/воспроизведения содержимое полей изменяется, инфор-
мируя вас о состоянии дел.

Если отвлекают цифры, мелькающие в полях строки статуса, вы можете вык-
лючить отображение всех или некоторых из этих полей. Щелкните правой кноп-
кой мыши на строке статуса и в открывшемся контекстном меню снимите помет-
ки напротив названий тех полей, видеть которые вы не хотите.

Формат отображения времени зависит от установок, с которыми вы познако-
митесь в разд.5.4.

Мы рассказали о том, как записать звуковые данные в режиме Instant Record.

В нем запись начинается непосредственно после того, как вы нажмете кнопку * ]

(Record) и определите параметры аудиофайла.
Существует и второй режим записи — Timed Record. В нем вы можете запрограм -

мировать время начала и продолжительность сеанса записи. Этот режим полезен..
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когда нужно, например, записать интересную радиопередачу, время начала кото-
рой вам известно заранее. Как запрограммировать Cool Edit Pro для автоматическо-

го выполнения сеанса записи? Щелкните правой кнопкой мыши на кнопке
(Record). Откроется меню, предназначенное для выбора режима записи. Выберите

пункт Timed Record. Теперь, если нажать кнопку jfe-j (Record), то перед записью

откроется окно диалога Recording Time (рис. 2.10).

Recording Time

Recording Time

No Time Limit

jRecatding LenglR j I

•^art Recording-

f* Rjght Away

Г At on

Г 24 hr

ff 12Ы

Рис. 2.10. Окно диалога
Recording Time

Состояние переключателей группы Maximum Recording Time определяет про-
должительность сеанса записи. Если вы выберете No Time Limit, то она не будет
ограничена ничем, кроме количества свободного места на диске.

Выбрав опцию Recording Length, вы должны также указать продолжительность
сеанса записи в поле ввода.

В группе Start Recording сосредоточены опции, определяющие начальный мо-
мент включения режима записи.

Если выбрана опция Right Away, то запись начнется немедленно после нажатия кноп-
ки ОК в окне Recording Time. В этом случае режим записи Timed Record отличается от
режима Instant Record только тем, что можно задать продолжительность сеанса записи.

Если выбрать опцию At_on_, то запись будет начинаться в определенный мо-
мент времени определенной даты.

Остальные элементы окна предназначены для выбора формата представления
времени суток и даты:
> 24 hr — количество часов задается числами от 0 до 23
> 12hr — количество часов задается числами от 0 до 11 с примечанием AM (до

полудня) или РМ (после полудня)
> dd/mm/yyyy — дата задается в формате день/месяц/год
> min/dd/yyyy — дата задается в формате месяц/день/год

Будем считать, что так или иначе вы включили режим записи. Если ваш ком-
пьютер достаточно производителен, то запись должна идти гладко: сбоев не про-
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изойдет, а значения параметров времени и объема памяти, отображаемых в ин-
формационных нолях, будут монотонно изменяться.

Если вы решили временно прервать запись, воспользуйтесь кнопкой J |J( Pause).
Считать, что в вашем распоряжении уже есть полисная форма, можно будет

только после нажатия кнопки | jjf] (Stop). Так нажмите ее!

2.3. Отображение и воспроизведение волновой
формы

Итак, вы записали собственную волновую форму. После этого вид главного окна
программы изменится. На рабочем поле появится графическое изображение (ос-
циллограмма) звукового сигнала — волновая форма. Возможный вид стереофо-
нической волновой формы показан на рис. 2.11.

Обратите внимание на то, что сразу по окончании записи записанный фра! -
мент выделен.

На рис. 2 . 1 1 временная позиция характеризуется номером отсчета (поэтому в
числах на горизонтальной оси много нулей).

Ив Е* View Effects Gererate ffntfia Pavortes Options *Ыо* н

Рис. 2.11. Стереофоническая волновая Форма



Глава 2

Часто бывает так, что изображение всей волновой формы не умещается на ра-
бочем поле главного окна: видна только его часть. Чтобы помочь вам сориентиро-
ваться в том, какая именно часть волновой формы видна, над ее изображением
расположена диаграмма, светлый прямоугольник которой обозначает отображае-
мую область. Перемещая этот прямоугольник с помощью мыши, можно «перема-
тывать» волновую форму. Если вся диаграмма светлого цвета, значит, в окне ото-
бражается вся волновая форма. Размер прямоугольника относится к размеру всей
диаграммы так же, как и длительность отображаемого фрагмента к длительности
всей волновой формы. Щелкните на этой диаграмме правой кнопкой мыши. По-
явится контекстное меню, с помощью которого можно управлять масштабом ото-
бражения волновой формы (рис. 2.12).

Zoom In Alt+Right Arrow

Zoom Out

2oom Full

Alt-Reft Arrow

• Above Display

Befow Display

Рис. 2.12. Контекстное меню диаграммы отображаемой
области

Если выбрать команду Zoom In, то масштаб отображения волновой формы бу-
дет увеличен, если Zoom Out — уменьшен. Выбор Zoom Full приведет к тому, что на
экране будет отображаться полностью вся волновая форма.

С помощью двух оставшихся команд контекстного меню можно изменять рас-
положение самой диаграммы: над рабочим полем главного окна (Above Display)
или под ним (Bellow Display).

Если фрагмент волновой формы выделен, то на диаграмме информация о его
протяженности и расположении относительно границ всей волновой формы ото-
бражается в виде серого прямоугольника. Это очень удобно: после любых переме-
щений вдоль волновой формы всегда можно возвратиться к выделенному фраг-
менту, совместив на диаграмме зеленый прямоугольник с серым.

Существует еще один способ «перемотки» волновой формы. Нацельте мышь
на горизонтальную линейку с отметками времени. Она находится под рабочим
полем главного окна. Указатель мыши примет форму руки. Удерживая нажатой
левую кнопку мыши, «проматывайте* волновую форму влево или вправо.

Масштабом отображения волновой формы по вертикали и горизонтали мож-
но управлять с помощью инструментов панели Zoom Controls (рис. 2.13).

Zoom Cont
Рис. 2.13. Панель Zoom Controls
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Масштаб отображения пол ново и формы по горизонтали задается при помощи
кнопок:

(Zoom In Horizontally) — увеличить масштаб

(Zoom Out Horizontally) — уменьшить масштаб

(Zoom Out Full Both Axis) — отобразить всю волновую форму

(Zoom to Selection) — увеличить масштаб так, чтобы на экране отображался
весь выделенный фрагмент волновой формы

(Zoom In to Left Edge of Selection) — увеличить масштаб и отобразить на
экране левую границу выделенного фрагмента

(Zoom In to Right Edge of Selection) — увеличить масштаб и отобразить на
экране правую границу выделенного фрагмента

Для изменения масштаба отображения волновой формы по вертикали пред-

назначены кнопки ji%j (Zoom In Vertically) и |(Sy (Zoom Out Vertically).

Масштабом отображения волновой формы можно также управлять с помощью
команд подменю Zooming контекстного меню (рис. 2.14), которое открывается
щелчком правой кнопкой мыши на линейке прокрутки волновой формы.

Display Time Format >

Snapping >

Zooming

42QOOQO 4400000 smplv

Zoom In Alt+Right Arrow

Zoom Out-

Zoom Full

Zoom to Selection

Zoom In to Left Edge of Selection Alt+Home

Zoom In to Right Edge of Selection Alt+End

Рис. 2,14. Контекстное меню линейки прокрутки

Стоит обратить внимание на две команды из этого меню:
> Above Display — расположить линейку прокрутки над изображением волно-

вой формы
> Below Display — расположить линейку прокрутки под изображением волно-

вой формы
Вообще, линейка прокрутки сама по себе является инструментом. Ее длина от

начала до конца соответствует длине всей волновой формы. Ярко-зеленая под-
вижная область— ползунок, соответствует отображаемому в данный момент уча-
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стку волновой формы. Если в окне отображается вся волновая форма, то ползу-
нок занимает всю длину линейки и перемещаться ему некуда. Кактолько вы умень-
шите масштаб отображения волновой формы по горизонтали (Zoom Out
Horizontally), уменьшится и длина ползунка. Ухватившись за ползунок, можно
прокручивать волновую форму. А если ухватиться за границу ползунка и подви-
нуть ее, то изменится граница отображаемой части волновой формы, и, соответ-
ственно, масштаб отображения волновой формы по горизонтали.

Существует и еще один способ прокрутки изображения волновой формы: хва-
таетесь мышью за горизонтальную координатную шкалу — шкалу времени, рас-
положенную под волновой формой, и перемешаете ее в нужном направлении.
Кстати, у шкалы времени есть еще одна не менее полезная функция — эффектив-
ный способ уменьшения горизонтального масштаба отображения волновой фор-
мы. Если, удерживая нажатой правую кнопку мыши, выделить фрагмент шкалы,
то после того как кнопка мыши будет отпущена, выделенный фрагмент «растя-
нется* на весь экран.

В последующей работе вы не сможете обойтись без инструментария для выде-
ления фрагментов волновой формы.

Начнем с простого. Допустим, вам понадобилось прослушать фрагмент не с на-
чала, а с какого-то определенного момента. Подведите указатель мыши к этой по-
зиции и щелкните на нем один раз. Если звуковой файл стереофонический, старай-
тесь, чтобы по вертикали указатель мыши находился около линии, разделяющей
треки левого и правого каналов {не обязательно точно на ней). На месте щелчка
появится маркер — вертикальная пунктирная линия, «прикрепленная» за верхний
и нижний концы к главному окну. В примере, который показан на рис. 2.15, эта
вертикальная линия находится приблизительно в позиции 2 500 000-го отсчета.

Если быть точными, то следует сказать, что маркер находится в позиции отсче-
та № 2500 573. Это хорошо видно на дисплее отображения текущей позиции.

Теперь, если вы нажмете кнопку jj^j (Play) (или клавишу <Space>), то воспро-
изведение начнется с той позиции, в которой находится маркер.

Попробуйте установить маркер точно в заданную позицию. Думается, что это
удастся сделать далеко не с первой попытки. Особенно трудно «попасть в цель»,
если вы работаете с протяженной волновой формой. Погрешность визуальной ус-
тановки маркера почти всегда будет составлять величину порядка нескольких от-
счетов или даже нескольких десятков отсчетов. Иногда точность установки пози-
ции маркера принципиально важна. В таких случаях следует воспользоваться
одним из шести полей ввода панели Selection/View Controls (рис. 2.16), по умолча-
нию расположенной в нижней части окна, правее табло отображения времени.

Эти поля ввода организованы в таблицу, содержащую две строки и три столбца.
В верхней строке (Sel) отображаются (и могут быть отредактированы) времен-

ные параметры выделенного фрагмента волновой формы, а в нижней (View) —
фрагмента волновой формы, отображаемого на экране.

Левый столбец (Begin) соответствует начальному моменту фрагмента волно-
вой формы, средний (End) — конечному. В правом столбце (Length) содержится
информация о протяженности фрагмента.
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Рис. 2.15. Маркер установлен в позицию 2 500 573 отсчета

Selection/ View Controls
, Begin End

?e! 2500000 !i

Length

0

Рис. 2.16. Панель Selection/View Controls

View 0 682S487 i 68284S3

Для того чтобы точно задать позицию маркера, щелкните левой кнопкой мыш и
на поле ввода, находящемся на пересечении строки Sel и столбца Begin, сделав это
поле ввода доступным для редактирования. Введите необходимое число и нажмите
<Enter>. Хотя мы воспользовались инструментом для выделения фрагмента волно-
вой формы, нам удалось применить его для точного позиционирования маркера.

Чтобы определить границы выделенного участка с высокой точностью, нужно
задать их в полях ввода, находящихся на пересечении строки Sel и двух столбцов:

> Begin — левая граница выделенного фрагмента волновой формы
> End — правая граница выделенного фрагмента волновой формы

Для определения границ выделенного или отображаемого фрагмента можно
задать его начало и конец. Этот способ мы только что рассмотрели. Но можно
действовать и по-другому: задать левую границу фрагмента и его протяженность.
Для этого предназначены поля ввода, сосредоточенные в столбце Length. Следует
знать, что в любом случае только две из трех величин, характеризующих времен-
ные параметры фрагмента волновой формы, являются независимыми. Если вы
задали координату правой границы фрагмента, то цифру в поле ввода его протя-
женности программа определит автоматически. И наоборот.

3 Зак П52
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Численный способ выбора грани ц фрагмента точен, ноне всегда удобен и мо-
жет замедлять вашу работу с волновой формой. Пользоваться графическим спо-
собом проще и быстрее.

Как мы уже отметили, для установки маркера нужно щелкнуть на рабочем поле
главного окна только один раз. Если же щелкнуть два раза, то выделится тот фраг-
мент волновой формы, который отображается в окне программы. Если вы хотите
выделить часть этого фрагмента (еще более короткий участок фонограммы), то
воспользуйтесь следующей рекомендацией.

Подведите указатель мыши к позиции, соответствующей началу (или концу)
фрагмента, и нажмите ее левую кнопку. Не отпуская кнопку, подведите указатель
мыши к концу (или началу) фрагмента. Отпустите кнопку. Результат проделанной
работы будет напоминать картинку, представленную на рис. 2.17.

Рис. 2.17. Выделенный
фрагмент волновой формы

Если потребуется изменить границы выделенной области волновой формы,
то совсем не обязательно повторять описанную выше последовательность дей-
ствий. Как только вы щелкнете левой кнопкой мыши на волновой форме, весь
труд по выделению звукового фрагмента пропадет. Чтобы этого не произошло,
для уточнения границ ранее выделенной области воспользуйтесь правой кноп-
кой мыши.

Используя правую кнопку мыши для выделения фрагмента волновой формы
(или для изменения границ выделенного фрагмента), не забывайте о том, какие
установки вы выбрали в группе Edit View Right-Clicks вкладки General (см. разд.
1.1.1, рис. 1.1) окна диалога Settings.

Итак, вы выделили фрагмент волновой формы. Если теперь нажать кнопку Play, то
воспроизведется только этот выделенный фрагмент. Но выделение фрагмента необхо-
димо не только для того, чтобы его воспроизвести. Программа организованна таким
образом, что все операции производятся исключительно над выделенным фрагментом.



Работа с главным окном программы в режиме EDIT WAVEFORM VIEW 67

Cool Edit Pro позволяет работать отдельно с каждым из стереоканалов. Для этого
нужно выделять фрагменты определенным образом. Делается это просто. Подведите
указатель мыши не к линии, разделяющей треки, а к верхнему или нижнему трекам
(для работы с левым или правым каналами соответственно). Как только вы поместили
указатель мыши на нужной высоте, он изменит свой вид: кроме обычной стрелочки
появится буква L (Left — левый) или R (Right — правый). После этого вы можете рабо-
тать со звуковой информацией отдельных каналовточнотакже, каки с целой волновой
формой. На рис. 2.! 8 показан выделенный фрагмент волновой формы левого канала.

Вероятно, вы уже заметили, что при воспроизведении по изображению волно-
вой формы пробегает сплошная вертикальная линия. Это и есть указатель теку-
шей позиции, который показывает на фонограмме фрагмент, воспроизводимый в
данный момент. При определенных условиях (когда отображаемый в окне фраг-
мент значительно меньше всей волновой формы и включен особый режим вос-
произведения) отображение воспроизводимого места фонограммы происходит
довольно интересным способом. Вертикальная линия стоит посередине окна, а
перемещается само изображение волновой формы.

Ос *•* "trfi уячн &Л.П ftaffH а*<™ дом до

Рис. .̂18. Выделенный
фрагмент волновой формы
левого канала

В главном окне программы можно редактировать волновую форму на уровне
отдельных звуковых отсчетов (микроуровне). Иногда это может быть очень полез-
но, например, если нужно удалить короткую импульсную помеху (щелчок). А мож-
но вручную нарисовать звуковую волну и использовать ее в будущем для создания
собственного музыкального инструмента, обладающего уникальным тембром.

Познакомимся с этим режимом редактирования на практике. Чтобы редакти-
ровать волновую форму на микроуровне, нужно установить соответствующий мас-

штаб. Нажимая кнопку ;̂ .| (Zoom In Horizontally), добейтесь того, чтобы отдель-
ные отсчеты были не только видны, но и можно было бы ухватиться за них мышью
(курсор мыши примет форму руки, у которой согнуты все пальцы, кроме указа-
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тельного). В этом режиме звуковые отсчеты отображаются в виде маленьких квад-
ратиков, которые соединены тонкими линиями (рис. 2.19).

Рис. 2.19. Режим редактиро-
вания отдельных звуковых
отсчетов

Эти линии помогают ориентироваться в том, какую форму будет иметь сигнал,
прошедший ЦАП звуковой карты (включая фильтр нижних частот). Вы, навер-
ное, уже догадались, что с помощью мыши эти квадратики можно перетащить в
вертикальном направлении. Именно так и осуществляется редактирование фор-
мы сигнала на микроуровне. Можно вернуться к нормальному масштабу (редак-
тирование на уровне огибающей амплитуды, а не на уровне отдельных отсчетов),

неоднократно нажимая кнопку j-y (Zoom Out Horizontally) или один раз нажав

кнопку <iy::[ (Zoom Out Full Both Axis).

Теперь, когда вы познакомились с основными приемами работы в главном окне
программы, можно переходить к изучению главного меню.
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МЕНЮ FILE - РАБОТА С ФАЙЛАМИ

В меню File содержатся следующие команды:

> New... — создать новый файл
> Open... — открыть файл
> Open As... — открыть файл, переопределив его атрибуты
> Open Append... — открыть файл в дополнение к уже открытому (добавляемая

волновая форма размещается следом за той, что уже находится в редакторе)
> Extract Audio from Video... — извлечение звуковой дорожки из видеофайла

и ее загрузка в Cool Edit Pro
> Extract Audio from CD... — извлечение треков с диска CD-Digital Audio и их

загрузка в Cool Edit Pro
> Revert to Saved — вернуться к последнему сохраненному файлу
> Close — закрыть текущий редактируемый файл
> Close All (Wives and Session) — закрыть все файлы и текущую мультитреко-

вую сессию
> Close Only Non-Session Waveforms — закрыть любые открытые аудиофайлы,

не используемые в текущей мул ьти трековой сессии (не используемые в мно-
гоканальной среде)

> Save — сохранить файл с прежним именем
> Save As... — сохранить файл с именем, заданным пользователем
> Save Copy As... — сохранить копию файла
> Save Selection.,, — сохранить в файле только выделенный фрагмент волно-

вой формы
> Save All — последовательно сохранить все открытые в настоящее время вол-

новые формы и сессии; если данные еще не существуют как файл, то от-
кроется окно Save As

> CD Burning... — запись компакт-диска
> Batch File Convert... — конвертировать форматы файлов в пакетном режиме
> Flush Virtual File — освободить открытый файл для использования другим

приложением
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> Free Up Space in Temp Files... — открыть окно диалога, содержащее сведения
об объеме свободной памяти на жестком диске, предназначенное для рас-
чистки и резервирования дискового пространства

> Exit — выйти из приложения Cool Edit Pro

3,1. New... — создание новой волновой формы
Самой первый командой меню File является команда New.... Она предназначе-

на для создания новой волновой формы. Если довыполнения команды была дос-
тупна для редактирования другая волновая форма, она не потеряется. В програм-
ме эта волновая форма будет существовать, располагаясь на другой странице,
перейти на которую можно посредством меню Window.

Выбор команды File > New... приводит к появлению окна диалога New Waveform
(см. рис. 2.7), с которым вы уже познакомились в процессе записи собственных
звуковых данных (разд. 2.2).

Если выбрать команду New... перед записью и задать формат будущей волно-
вой формы, то при нажатии в главном окне кнопки Record программа не станет
повторно вызывать окно New Waveform, а сразу приступит к записи.

3.2. Открытие файлов
Команда Open... открывает звуковой файл. При этом на экране появляется окно

диалога Open a Waveform, изображенное на рис. 3.1.

lOnen a Waveform

Recent Folders ] c: \good

Пегаса- I _J Good

cod-ok [master)

Хип Файлов, jwindovjs PCM [*.wav|

Г~ Oon> ask for further details

.

3
Z1---** ШЙ'Ш-

'FullSize: 44374K

4iVQDHiU6-b£ Stereo

Отмена

Справка 1 Play

Рис. 3.1. Окно диалога Open a Waveform
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Кроме элементов, традиционных для окон открытия файлов в любых
Windows-приложениях, это окно содержит дополнительные поля, о которых
следует упомянуть.

В раскрывающемся списке Recent Folders: перечислены те каталоги (папки), к ко-
торым вы обращались ранее, открывая файлы. Для того чтобы быстро перейти от
одного каталога к другому, достаточно выбрать в этом списке необходимую строку.

Если установлен флажок Show File Information, то в окне Open a Waveform будет
отображаться информация о формате выделенного звукового файла, продолжи-
тельности его звучания и объеме памяти, занятой им.

Если установлен флажок Auto Play, тогда при выделении звуковых файлов в рас-
крывающемся списке Recent Folders: они будут воспроизводиться. Выделенный
файл можно также прослушать, нажав кнопку Play.

Cool Edit Pro поддерживает множество различных форматов звуковых фай-
лов и даже позволяет загружать файлы неизвестных форматов с произвольными
расширениями, подразумевая, что для представления звука в них используется
РСМ (импульсно-кодовая модуляция). Перед загрузкой такого файла, не имею-
щего известного для Cool Edit Pro заголовка, программа попросит вас самостоя-
тельно определить частоту сэмплирования, количество каналов (моно/стерео) и
разрешающую способность представления звуковых данных. Если после загруз-
ки файла он будет звучать «не так, как надо» (слишком замедленно, с шумом или
будет слышен один сплошной шум), а вы точно уверены, что в этом файле хра-
нятся именно звуковые отсчеты, то следует пробовать загружать этот файл еще и
еще, перебирая каждый раз параметры его формата методом «научного тыка».
Кстати, ради интереса можете загрузить какой-нибудь ЕХЕ-файл и послушать,
как он будет звучать.

Возвращаясь к рассмотрению окна Open a Waveform, следует заметить, что при
включенной опции Don't ask for further details Cool Edit Pro не будет запрашивать
у вас сведения о представлении звуковых данных в формате неизвестного ему типа,
а будет считать, что файл имеет такой же формат, как и предыдущий загруженный.

В раскрывающемся списке Files of type выбирается тип звукового файла (по
умолчанию WAV). Cool Edit Pro умеет работать с различными форматами звуково-
го файла (всего около десятка), в том числе и с теми, которые используются на
других платформах (например, на компьютерах Amiga, Mac). Но мы с вами рабо-
таем на платформе, называемой PC (IBM-совместимый компьютер), поэтому не
будем углубляться в особенности «чужих» форматов звуковых данных. Приведем
пример лишь самого экзотического, на наш взгляд, формата, с которым может
работать Cool Edit Pro.

Звуковые данные можно хранить в обыкновенном текстовом файле с расши-
рением ТХТ Каждый отсчет представляется десятичным числом. Данные разных
звуковых каналов отделяются друг от друга знаком табуляции. Каждый последую-
щий отсчет (пара стереоотсчетов) отделяется от предыдущего отсчета (или пары)
невидимым символом возврата каретки, то есть при помощи нажатия клавиши
<Enter>. В начале файла записывается служебная информация. В начале каждой стро-
ки следуют: ключевое слово, двоеточие, символ табуляции, после них— значение
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параметра (число или слово). Примером такого файла может служить следую-
щая запись:

SAMPLES: 31
BITSPERSAMPLE: 16
CHANNELS: 2
SAMPLERATE: 4 4 1 0 0
NORMALIZED: FALSE

2 4 6 2 4 6

-242 -242
-725 -725
-118C -1180
-1617 -1617
-2057 -2057

-2495 -2495
-2901 -2901

Запись в первой строке (ключевое слово SAMPLES) означает, что файл содержит
31 отсчет, во второй строке (BITSPERSAMPLE) содержится информация о разрядно-
сти звуковых отсчетов, в третьей строке (CHANNELS) — количество каналов, в чет-
вертой (SAMPLERATE) — частота сэмплирования (дискретизации). В последней слу-
жебной строке хранится информация о том, применена ли к звуковым данным
нормализация в диапазоне значений от -1,0 до 1,0 (TRUE — да, FALSE — нет).

Приведем пример текстового файла, хранящего уже описанную волновую фор-
му, но на этот раз с включенной нормализацией.

SAMPLES: 31
BITSPERSAMPLE: 16
CHANNELS: 2
SAMPLERATE: 44100
NORMALIZED: TRUE
0.00750732 0.00750732
-0.00738525 - 0 . 0 0 7 3 8 5 2 5
-0.0221252 - 0 . 0 2 2 1 2 5 2
-0.0360107 -0 .0360107

- 0 . 0 4 9 3 4 6 9 - 0 . 0 4 9 3 4 6 9
-0.0627747 -0.0627747
-0 .0761414 - 0 . 0 7 6 1 4 1 4
-0.0885315 -0 .0885315
-0.0993958 - 0 . 0 9 9 3 9 5 8

Как видно из примера, значения звуковых отсчетов действительно не выходят
заграницы диапазона -1,0— 1,0. Опция нормализации в данном случае не влияет
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на качество звучания, она нужна только для различного представления звуковых
данных.

Имейте в виду, что описанный формат представления звуковых данных очень
некомпактен. Текстовый файл со звуковыми данными будет занимать на диске при-
мерно в 10 раз больше места, чем традиционный WAV-файл. Для чего же нужна та-
кая форма представления звуковой информации? Один из возможных примеров
использования текстового формата — перенос звуковых данных между звуковым
редактором и программами, не умеющими работать с WAV-файлами. Возникает
вопрос: а зачем тогда загружать в такие программы звуковые данные? Например,
для того, чтобы произвести анализ звука при помоши математических программ,
большинство из которых считывают массивы чисел из текстовых файлов.

Заметим, что программа Cool Edit Pro умеет загружать один за другим сразу
несколько звуковых файлов. Для этого в окне Open File нужно выделить имена
всех интересующих вас файлов и нажать кнопку Open. Помеченные файлы по оче-
реди будут загружены в программу. Каждый из них разместится на отдельной стра-
нице главного окна программы.

Наверное, теперь следует рассказать о том, как можно выделить сразу несколь-
ко файлов. Это делается очень просто. Выделите с помощью мыши файл из числа
тех, которые вы собираетесь загружать. Теперь нажмите клавишу <Ctrl> и удер-
живайте ее нажатой. Перемешаясь по списку доступных файлов при помощи кла-
виш управления курсором, подведите маркер к следующему файлу, который нуж-
но загрузить, и нажмите клавишу <Space>. Теперь выделенными окажутся уже два
файла. Подведите маркер к очередному файлу и пометьте его. Можно поступить и
по-другому: удерживая клавишу <Ctrl>, «перещелкайте» все необходимые назва-
ния файлов левой кнопкой мыши. Повторяйте процедуру столько раз, сколько
необходимо. Только после того, как выделенными окажутся все требующиеся фай-
лы, клавишу <Ctrl> можно отпустить. Теперь смело нажимайте <Enter> или кнопку
Open. Все выделенные файлы загрузятся.

Следующая команда меню File — Open As... (Открыть как...) аналогична пре-
дыдущей, за исключением того, что в процессе загрузки звуковые данные, храня-
щиеся в выбранном файле, можно конвертировать в другой формат (задать новую
частоту сэмплирования, разрядность и количество каналов). После того как в окне
Open a Waveform As вы выберете один или несколько файлов и нажмете кнопку
Open, появится окно диалога, аналогичное изображенному на рис. 2.7, только на-
зываться оно будет не New Waveform, a Open File(s) As (рис. 3.2.). С его помощью вы
можете задать новый формат загружаемого файла (или файлов).

Итак, новый формат выбирается вовсе не в раскрывающемся списке FiJes of
type: (Тип файлов:) окна Open a Waveform As, как иногда думают пользователи. Этот
список— всего лишь логический фильтр, ускоряющий поиск необходимого фай-
ла известного вам типа.

Преобразование формата аудиоданных начнется после того, как в окне Open
File(s) As вы нажмете кнопку ОК. Процесс может занять довольно много времени,
так как он состоит из нескольких операций. Их число и содержание зависит от
соотношения исходного и заданного формата файла. Вас это не должно заботить,
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Рис. З.2. Окно диалога Open File(s) As

программа автоматически задаст необходимый набор операций и выполнит их все.
О начале и ходе очередной операции вас оповестит окно прогресс-индикатора.
Когда необходимые преобразования будут завершены, загруженная и преобразо-
ванная в процессе загрузки волновая форма появится на рабочем поле главного
окна. В профамме предусмотрена возможность и полностью автоматического кон-
вертирования формата заранее заданной последовательности файлов, о ней мы
расскажем в разд. 3.8.

Команда Open Append... так же, как и команда Open..., предназначена для от-
крытия файлов. Однако при загрузке одного или нескольких файлов с диска ко-
мандой Open Append... волновые формы окажутся размещенными на одном треке
(в случае монофонического формата аудиоданных) или на одной паре треков (при
стереофоническом формате) последовательно друг за другом. Иными словами, эта
команда служит для объединения нескольких исходных волновых форм, храня-
щихся в различных файлах, в один результирующий файл.

На рис. 3.3 и 3.4 показано содержимое двух страниц главного окна после заг-
рузки файлов с именами CHORD.WAV и DING.WAV посредством двух команд

Рис. 3,3. Страница главного
окна с волновой формой из
файла CHORD.WAV
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Open.... На рис. 3.5 иллюстрируется применение команды Open Append... к файлу
с именем DING.WAV (файл с именем CHORD.WAV загружен заранее).

Несколько замечаний, касающихся форматов файлов. Наверняка вам извест-
но о существовании форматов аудиофайлов, в которых применяются различные
методы сжатия объема, занимаемого аудиоинформацией, например, МРЗ, Real
Audio, Microsoft ADPCM и др. В подавляющем большинстве методов сжатия зву-
ковой информации используется сжатие с потерями: качество фонограммы ухуд-
шается, но зато она занимает меньший объем.

Ни при каких обстоятельствах не используйте сжатие для хранения промежуточ-
ных аудиофайлов. Пример того, как нельзя делать: выполнили запись с микрофона,

Рис. 3.4. Страница главного
окна с волновой формой и:-;
файла DiNG.WAV

Рис. 3.5. Волновые формы,
объединенные командой
Open Append...
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сохранили файл в МРЗ. Через какое-то время открыли файл, чтобы удалить из
него шумы и выполнить динамическую обработку. Вновь сохранили файл в фор-
мате МРЗ. Затем использовали этот файл в многодорожечном проекте, а результат
сведения опять сохранили в МРЗ. Качество звука в описанном отрицательном
примере будет стремительно деградировать при каждом сохранении файла. Что-
бы избежать этого, используйте формат Windows PCM.

Теперь, что касается способа представления звуковых отсчетов в таких файлах.
Понятно, что если запись выполняется с микрофона, который в 99,99% случаев
монофонический, то имеет смысл использовать монофонический формат. Другое
дело, если в процессе обработки ваша изначально монофоническая запись полу-
чит стереофонические свойства (всевозможные эффекты, в которых применяется
задержка). В этом случае ваша фонограмма должна иметь стереофонический фор-
мат еще до начала обработки. Если вы не собираетесь применять эффекты, при-
дающие фонограмме стереофонические свойства в режиме редактирования вол-
новой формы, а хотите использовать эффекты реального времени при сведении
мультитрекового проекта, то изменять монофонический формат волновой фор-
мы на стереофонический не нужно. Поток звуковых данных с выходов эффектов
будет поступать на стереофонический аудиопорт или шину. Поэтому звучание сте-
реофонических эффектов не будет зависеть от формата, в котором представлены
исходные монофонические данные.

Важный вопрос - разрешающая способность. Трудно представить, где сейчас
могут применяться 8-битные звуковые файлы. Будем рассматривать только 16-
битный и 32-битный с плавающей точкой форматы, используемые для представ-
ления звуковых данных при редактировании в Cool Edit Pro. 16-битный формат
следует использовать в том случае, когда запись изначально имеет низкое каче-
ство. Понятно, что если запись выполнена с помощью мультимедийного микро-
фона, подключенного к микрофонному входу звуковой карты, то о сохранении
каких-то тонких нюансов, полученных в ходе обработки изначально низкокаче-
ственного звука, речь не идет.

Другое дело, если вы пользуетесь качественным звукозаписывающим обору-
дованием и подготовленным для звукозаписи помещением. Используйте 32-бит-
ный формат, это поможет избежать накопления погрешностей при многократном
применении всевозможных эффектов.

3*3. Extract Audio from Video* , * — извлечение
аудиоданных из видеофайла

Команда File > Extract Audio from Video., .позволяет извлечь аудиоданные из AVI-
файла. В результате ее применения вы можете, например, получить в свое распо-
ряжение саунд-трек того или иного фильма, если, конечно, у вас есть его копия в
формате AVI (или в некоторых других форматах, обеспечиваюших сжатие видео-
данных). Командой открывается окно диалога Choose a video file (рис. 3.6).
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Choose a video file

3 ** и d* И-

j|horne_Etijdio_2

•Ihomertudio 3

jhome_stLidio_5

Shome studio 6

Windows AVI

|Fu!ISize:206B5K; '

[44100 НгЛ&М, Mono

Имя Файла: home studio .Дткрьпъ

Тип Файлов: JAVI Video ("avi) Отмена

AVI Video ['.avi|
MPEG MgyieJ.mly^'.m2v,'.mpa,'.mpe,'.mpe

Рис. З.6. Окно диалога Choose a video file

Кроме своего названия данное окно практически ни чем не отличается от дру-
гих окон, предназначенных для загрузки файлов. В раскрывающемся списке Files
of type: (Ъга файлов:) вы обнаружите перечень тех расширений файлов, с которы-
ми работает функция извлечения саунд-трека.

Нажав кнопку Open (Открыть), вы запустите процесс извлечения звуковых дан-
ных из видеофайла- Его ход будет отображаться прогресс-индикатором. По окон-
чании процесса изображение извлеченной волновой формы появится на рабочем
поле главного окна. Теперь можно сохранить полученные аудиоданные в файле, а
с волновой формой сделать все, что вам угодно, в частности, отредактировать с ис-
пользованием любых средств Cool Edit Pro.

3.4. Extract Audio from CD.,. — извлечение
аудиоданных с треков CD-Digital Audio
в Cool Edit Pro

Командой File > Extract Audio from CD... открывается одноименное окно диа-
лога (рис. 3.7), предназначенное для извлечения аудиоданных с компакт-диска
(CD Digital Audio) в программу Cool Edit Pro.

Фактически окно Extract Audio from CD выполняет задачу аналогичную той,
для решения которой созданы многочисленные так называемые «граберы» -
программы, позволяющие скопировать трек компакт-диска, превратив его в
WAV-файл и сделав доступным для дальнейшего использования именно в этом
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качестве. Многие музыканты применяют подобные программы в процессе созда-
ния ремиксов.

Иногда с компакт-дисков заимствуются понравившиеся фрагменты и на их
основе создаются лупы (короткие фрагменты партии ударных инструментов, пред-
назначенные для использования в циклическом режиме) и грувы (фрагменты
партий мелодических инструментов).

Бывает, что с целого диска извлекают совсем короткий фрагмент - звучание един-
ственной ноты в исполнении какого-нибудь инструмента. А затем на его основе с
помощью специальных программ (например, Vienna SoundFont Studio, см. [2], GS
Edit, см. [8]) формируются все остальные ноты. Полученный таким образом инст-
румент в дальнейшем загружают в сэмплер и используют в своих композициях.

Конечно, применять средство превращения чужих композиций, записанных
на CD, в доступные для редактирования WAV-файлы нужно чрезвычайно акку-
ратно, не нарушая ничьих авторских прав.

Entrart Audio From CD ••НВПМ1 - - • yl

"Device JE.(ATAPI-CD RQM-ORIVE-5№

\ --Inletface Орбоп!"

-Г Geneffc Win32

! ff ASR / 5PTI

'- г ASPt/SPTI Options --

- ReadMethcd;

fMMC-ReadCD ^\

CD Speed:

:• /JMax Speed •*• j

- j i. : fluBei See: . . '-.:,: Л .

\ : t !6K-e zJ-i
Г" Swap Bite Oder

i . 1 5«гр Chamois

P Spm Up BefcMB Ettftactior» [

AX 50LT |

•Source Selection

f» Track iMinSec.Fiamej

Track 01 .(04:3715]
Tiack02.(04:3052|
Tiack 03: (03:41 23]
Tiack 04:(04:36:10]

, lock 05. (03:20.60]
1 Track OS: (03:58:47]
• Track 07: [03:07:23]

Track 03: 103:48:40]

Г" E»tbaet to Srngte Waveform

~ Effw CorecSori *•
. ff CODA Accurate

Review j Ciose !f j

OK Cancel ]

Нф j
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* i 'тГ'~

; i " i

^ ' -~ d
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, , --- . - , -. •• . • . , • ;

Рис. З.7. Окно диалога Extract Audio From CD

Рассмотрим назначение элементов окна диалога Extract Audio From CD.
В раскрывающемся списке Device перечислены все имеющиеся в вашей систе-

ме устройства воспроизведения компакт-дисков. Нужно выбрать устройство, в
которое установлен компакт-диск.

Обращаем ваше внимание на то, что не все приводы CD-ROM поддерживают
операцию извлечения аудиоданных с треков CD Digital Audio (в англоязычной ли-
тературе эту операцию принято называть «ripping»}. Поэтому если вам не удастся
добиться позитивного результата с помощью окна диалога Extract Audio From CD, не
торопитесь обвинять Cool Edit Pro. Скорее всего, дело в вашем приводе CD-ROM.
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Существует еще один способ извлечения треков CD-DA: с помощью команды
Open... вы можете загружать их словно файлы с расширением *.CDA. Однако спо-
соб загрузки треков через окно Extract Audio From CD можно считать более пред-
почтительным ввиду его большей гибкости. В вашем распоряжении имеются раз-
личные опции, которые в ряде случаев могут позволить выполнить операцию
извлечения треков даже с таким приводом CD-ROM, с которым команда Open...
не работает. Существует еще и функциональное отличие: с помощью команды
Extract Audio From CD... можно загружать заданные фрагменты аудиотреков CD-
DA. С помощь команды Open... аудиотреки CD-DA загружаются только целиком.

В группе Interface Options выбирают один из двух вариантов опций интерфей-
са: Generic Win32 или ASPI / SPTI.

Вариант ASPI/SPTI пригоден в том случае, когда ваш привод CD-ROM имеет
интерфейс SCSI.

Если выбрать ASPI / SPTI, то становятся доступны опции группы ASPI / SPTI
Options:

> Read Method: — раскрывающийся список, в котором нужно подобрать ме-
тод чтения, дающий наилучшие результаты (варианты выбора: ММС- Read
CD, SBC - ReadlO, Plextor (D8), D5, NEC)

> CD Speed: — раскрывающийся список, предназначенный для выбора ско-
рости чтения диска

> Buffer Size — раскрывающийся список, предназначенный для выбора раз-
мера буфера промежуточного хранения данных при чтении диска

> Swap Byte Order — флажок включения порядка чтения байтов данных, ха-
рактерного для платформ DEC и Macintosh; для платформы PC этот фла-
жок нужно сбросить

> Swap Channels — флажок включения режима инверсии каналов: правый ка-
нал трека CD Digital Audio будет помещен в левый канал Cool Edit Pro, ле-
вый канал трека CD Digital Audio — в правый канал Cool Edit Pro

> Spin Up Before Extraction — флажок принудительного включения вращения
двигателя привода CD-ROM до начала считывания данных

Опдию Generic Win32 в группе Interface Options выбирают в том случае, когда
вариант ASPI / SPTI не дает положительных результатов.

В группе Source Selection можно выбрать два варианта загрузки данных: Track
(Min:Sec:Frame) или Time (Min:Sec:Frame).

В первом случае (выбрана опция Track (Min:Sec:Frame)) в соответствующем
списке нужно выделить один или несколько треков. Если при этом установлен
флажок Extract to single Waveform, то все аудиотреки, независимо от их количества,
будут представлены в виде одной волновой формы (записаны в Cool Edit Pro пос-
ледовательно друг за другом).

Если в группе Source Selection выбрана опция Time (Min:Sec:Frame), то в Cool
Edit Pro будет извлечен фрагмент заданной длины (поле ввода Length подгруппы
Range), начинающийся в заданный момент времени (поле ввода Start подгруп-
пы Range).
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И начальный момент, и длина извлекаемого фрагмента указываются в форма-
те Минута: Секунда: Кадр (учтите, что для CD Digital Audio в одной секунде со-
держится 75 кадров).

Диаграмма, расположенная над полями ввода Start и Length, служит визуаль-
ным ориентиром того, где на аудиотреке располагается извлекаемый фрагмент.

Данные CD Digital Audio слабее, чем CD-ROM, защищены от возникновения оши-
бок при чтении из-за некачественной записи, нарушения фазовой синхронизации, де-
фектов материала диска и т. п. При «нормальном» режиме работы привода CD-ROM,
когда он воспроизводит диски CD-DA, корректирующие алгоритмы действуют непос-
редственно в электронной начинке привода. При извлечении треков CD-DA в компь-
ютер по интерфейсам IDE или SCSI может требоваться программная коррекция.

Cool Edit Pro предусматривает использование корректирующих алгоритмов в
процессе загрузки треков CD Digital Audio. В группе Error Correction следует выб-
рать опции коррекции данных при чтении диска:

> CDDA Accurate — привод CD-ROM поддерживает аппаратную коррекцию
ошибок при захвате треков CD-DA по интерфейсам IDE и SCSI (программ-
ная коррекция не требуется)

> No Correction — выключение программной коррекции
> Jitter Correction — включение программной коррекции ошибок чтения, выз-

ванных джиттером (случайным изменением взаимного сдвига фаз опорных
генераторов разных цифровых устройств)

Если у вас современный привод CD-ROM, то, скорее всего, автоматически бу-
дет выбран первый вариант. Последний вариант, актуальный для устаревших при-
водов CD-ROM, выбирают при наличии щелчков и выпадений отсчетов в извле-
ченных звуковых данных.

Выбранный фрагмент трека или список треков, подлежащих извлечению, мож-
но запомнить в виде пресета. Для добавления пресета в список Presets нужно на-
жать кнопку Add. Откроется чрезвычайно простое окно диалога, в котором вы
можете лишь указать имя создаваемого пресета. Для удаления пресета из списка
воспользуйтесь кнопкой Del.

Если вы хотите предварительно прослушать, как в Cool Edit Pro будет звучать
извлеченный аудиоматериал, нажмите кнопку Preview (надпись на ней превратится
в Stop, нажатие на эту модифицированную кнопку приведет к прекращению пред-
варительного прослушивания).

Для того чтобы привести в действие процедуру извлечения аудиоданных с тре-
ка CD Digital Audio в Cool Edit Pro, нужно нажать кнопку ОК.

3.5. Закрытие файлов
Команда Revert to Saved (Вернуться к сохраненному) бывает полезной в том

случае, если вы решили сразу отказаться от всех изменений, внесенных после пос-
леднего сохранения звуковых данных на диске или последнего выполнения ко-
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манд загрузки. Проще говоря, команда Revert to Saved производит загрузку файла
с именем, которое в данный момент отображается в заголовке главного окна. При
выполнении этой операции программа запросит разрешение на сохранение теку-
щей волновой формы в файле,

Команда Close закрывает редактируемый файл, Вернее, она освобождает па-
мять программы от редактируемой волновой формы. Программа возвращается в
исходное состояние.

Команда Close All Waves and Session закрывает все файлы всех сессий.
Команда Close Only Non-Session Waveforms закрывает любые открытые аудиофий-

лы, не используемые в текущей сессии (не вставленные в мультитрековую среду).

3.6. Сохранение файлов
Команда Save сохраняет редактируемый файл на диске с тем же именем, с ко-

торым он был загружен с диска. Если файл был создан командой New..., то вместо
команды Save выполнится следующая команда из меню File — Save As.,..

Команда Save As... сохраняет файл с именем, определенным пользователем.
После вызова этой команды появляется окно диалога Save Waveform As (рис. 3.3),
которое содержит стандартные элементы управления, но имеет две особенности.

*
Recent FcWas: j

г:Папк£,.] 03 Goo

L-J

(master) ; j сл
] * Temp Di

Имя Файла JDING

lun вайл* jWindow! PCM (" vav

P" Save extfa mai-audo itjamalion

Сохранить

3"
Options, .

Отмена

Справка

Рис. З.8. Окно диалога Save Waveform As

Первая особенность — наличие кнопки Options. После ее нажатия появляется
окно, которое имеет различный вид для звуковых файлов различных форматов.
Для некоторых форматов кнопка Options недоступна. Опции дополнительного окна
также бывают разными: например, предназначенными для выбора способа сжатия
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звуковой информации. Скажем, для рассмотренного текстового формата в окне
опций можно включить или выключить режим нормализованного представления
звуковых данных.

Вторая особенность — наличие флажка Save extra non-audio information (Сохра-
нять дополнительную незвуковую информацию). Если он установлен, то в звуко-
вом файле, кроме спецификации формата и самой волновой формы, будет запи-
сана такая информация, как, например, название композиции, сведения об
авторских правах и многое другое. О том, какая дополнительная информация мо-
жет сопровождать звук, нам еще предстоит поговорить в гл. 5, рассматривая ко-
манду View > Wave Properties....

Следующая команда Save Copy As... аналогична команде Save As... за исключе-
нием того, что в файл сохраняется в заданную вами папку.

Командой Save Selection... меню File в файле сохраняется только выделенный
фрагмент волновой формы.

Команда Save All, предназначенная для сохранения файлов, в режиме Waveform
View доступна только в том случае, если ранее вы применяли команду загрузки
файлов с объединением волновых форм Open Append.... Она позволяет сохранить
все объединенные волновые формы в одном файле. Собравшись применить эту
команду, сосредоточьтесь. Программа не запрашивает имя файла, содержащего
объединенную волновую форму. Файл с объединенной волновой формой будет
сохранен под именем того файла, который был загружен первым (к которому вы
присоединили все остальные). Может случиться неприятность: исходный файл
будет затерт. Конечно, утраченное можно будет постараться восстановить. Но что-
бы это сделать, придется основательно потрудиться, вырезая все присоединен-
ные волновые формы.

3.7. CD Burning... — запись компакт-диска
Не удивляйтесь, если, заглянув даже в самые потаенные уголки программы Cool

Edit Pro, установленной на вашем компьютере, вам не удастся обнаружить коман-
ду CD Burning.... На момент написания книги эта команда не входит в базовую
версию Cool Edit Pro 2.0, а соответствующий модуль находится на стадии бета-
тестирования. Установить его можно отдельно, загрузив с сайта фирмы Syntrillium
Software Corporation (http://www.syntrillium.com) соответствующий файл. Этот же
файл (cep2cdr.exe) можно найти на диске, прилагающемся к книге. Вполне воз-
можно, что к тому моменту, когда эта книга окажется у вас в руках, CD Burning
будет входить в современную версию Cool Edit Pro, которую, опять-таки, можно
скачать на сайте http://www.syntrillium.com.

Воспользовавшись командой CD Burning..., вы сможете «прожигать» CD-R и
CD-RW диски, не выходя из Cool Edit Pro. Разумеется, по сравнению с такими
мощными специализированными программами, ориентированными на запись
дисков, как, например. Easy CD Creator, возможности Cool Edit Pro покажутся
вам весьма скромными. В частности, из всего множества известных насегодняш-
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ний день форматов дисков здесь поддерживаются только CD Digital Audio. Но та-
кое ограничение вряд ли можно считать недостатком Cool Edit Pro. Ведь эта про-
грамма и предназначена только для работы со звуковыми данными.

Командой File > CD Burning... открывается окно диалога Cool Edit Pro CD Burning
(рис. 3.9).

I [Т* Coal Edit Pro CD Binning
' с ' "Ca
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LongBongSong wav
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01 Side... Enti... 00:00.00 03.24:02 00:00:00 No No Not used
02 Ded. Enti... 03:24.02 0309:54 00:00:00 No No Not used' '
03 Cybo.. Enti. 063356 03:21:03 00.00:00 No No Notused \
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• " 80 Mk Ope" |

. Save As j
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Рис. З.9. Окно диалога Cool Edit Pro CD Burning

В поле Source Files_Bbi видите список файлов-источников данных для буду-
щих треков диска. В списке перечислены все файлы, загруженные в Cool Edit
Pro. Если ни один файл не загружен — список пуст. Обращаем ваше внимание
на то, что перед записью диска в Cool Edit Pro следует загрузить именно сведен-
ные аудиофайлы в формате 44,1 кГц, 16 бит, стерео, а не проекты мультитреко-
вой сессии (см. гл. 12).

Проект будущего диска создается в поле Tracks. Из поля Source Files в поле TVacks
файлы можно перенести двумя способами:

1. Двойным щелчком на имени файла.
2. Буксировкой по методу Drag & Drop.

Список в поле Tracks организован в виде таблицы. Одна строка соответствует
одному треку будущего диска, а в столбцах содержатся сведения о каждом из них
(атрибуты трека):
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> Track — номер трека
> Source — имя файла-источника
> Selection — сведения о части волновой формы (аудиофайла), которая будет

использована при создании трека. Запись Entire FUe означает, что будет ис-
пользован весь файл. Эксперименты показали, что других вариантов полу-
чить не удается. В частности, если даже в главном окне Cool Edit Pro заранее
выделить какой-либо фрагмент волновой формы, то для записи трека все рав-
но будет использоваться вся волновая форма, а не ее выделенный фрагмент

> Start — время начала трека на CD
> Total Length — общая продолжительность трека с учетом возможной паузы

между соседними треками
V Neg. Length — длительность отрицательной области трека
> Сору — информация о наличии защиты трека от копирования. Если трек

защищен, то в соответствующей ячейке будет записано Yes. Отсутствие за-
щиты отмечается словом No

> Рге — информация о наличии (Yes) или отсутствии (No) предварительной
коррекции

> ISRC — международный стандартный код записи (International Standard
Recording Code). Код представляет собой уникальную 12-разрядную ком-
бинацию цифр и символов в формате ASCII и однозначно идентифицирует
трек. Существуют специальные уполномоченные организации, которые
выдают эти коды. Однако Cool Edit Pro не проверяет корректности введен-
ных кодов

Могут возникнуть вопросы: что такое предварительная коррекция и что такое
отрицательная область трека?

Предварительная коррекция заключается в том, что во время записи усилива-
ется высокочастотная область спектра сигнала, чтобы обеспечить «хорошее» от-
ношение сигнал/шум. Соответственно при воспроизведении такой фонограммы
нужно выполнить обратное преобразование - ослабить высокие частоты.

Теперь поговорим об отрицательных областях трека. Может быть, вам доводи-
лось слушать CD-DA, при воспроизведении которых плеер показывал отрицатель-
ное время перед началом очередного трека. Отрицательные области трека обычно
используются для организации пауз между треками, но, в принципе, могут содер-
жать и фонограмму. Дело в том, что любое место трека можно назначить его «офи-
циальным» началом, даже если оно реально располагается где-то в середине тре-
ка. За счет этой особенности можно организовать «скрытый трек», доступ к
которому можно получить следующим образом: запускаете диск на воспроизведе-
ние и нажимаете кнопку перемотки назад до нужного места скрытого трека, от-
пускаете кнопку перемотки и слушаете область первого трека, которая располага-
ется до его «начала». Однако в Cool Edit Pro отрицательные области треков
используются исключительно для организации пауз между композициями.

С помощью кнопки Delete выбранный трек удаляется из списка. Кнопкой Move Up
трек перемещается на одну строку вверх, кнопкой Move Down — на одну строку вниз.
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Кнопкой Edit открывается окно диалога CD Track Properties (рис. 3.10), пред-
назначенное для редактирования атрибутов трека. Это окно можно вызвать также
двойным щелчком на строке с именем трека в поле Track.

Source:

Selection:

f Us* Defauli Options

(* tJse Сдай

Г~

. EE-88See-ftame

Г" Copyprotection

Cancei-

Рис. 3.10. Окно диалога CD Track Properties

Если в окне CD Track Properties выбрана опция Use Default Options, то трек бу-
дут сопровождать атрибуты, установленные по умолчанию. При выборе опции Use
Custom Options пользователю становятся доступными для редактирования неко-
торые из свойств (атрибутов) трека:

> Force track to start at Index 1 — фактически означает запрет на отрицатель-
ную область трека

> Use Pre-track Silence — использовать перед треком паузу (длительность пау-

зы в формате Секунда: Кадр задается с помощью кнопок ^Я). Пауза перед

треком (форма волны — горизонтальная прямая) генерируется программой
автоматически непосредственно во время записи диска

> Copy Protecion — включить защиту от копирования (помогает далеко не всегда).
> Pre-emphasis — включить предварительную коррекцию
> Use ISRC — использовать международный стандартный код записи. Соб-

ственно код вводится в поле, расположенном ниже надписи Use ISRC

После нажатия на кнопку Save установленные вами атрибуты появятся в соот-
ветствующих ячейках поля Track.

Вернемся к окну диалога Cool Edit Pro CD Burning (см. рис. 3.10). В группе Options
находятся 4 вкладки, опции которых частично дублируются опциями, сосредото-
ченными в окне CD Track Properties и уже рассмотренными нами.
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Рис. 3.11. Вкладка Disc
окна Coot Edit Pro CD
Burning

На рис. 3.1 1 показана вкладка Disc.
Опция Use Catalog Number знакома вам. Она аналогична опции Use ISRC окна

диалога CD Track Properties.
В группе Length можно выбрать одну из стандартных длительностей звучания

диска (74 минуты или 80 минут), либо установить длительность звучания, отличаю-
щуюся от стандартной. В последнем случае время вводится в формате Минуты: Се-

кунды: Кадры с помощью кнопок *"Н. Для того чтобы обоснованно выбрать дли-
.•№Wll

тельность звучания диска, равную SO минутам, одного вашего желания недостаточно.
Нужно, чтобы «болванка» диска, подготовленная к прожиганию, была пригодна для
хранения соответствующего количества информации. Иными словами, если для
записи 74 минут музыки вы обойдетесь диском, рассчитанным на 650 мегабайт, то
для записи 80-минутного альбома понадобится приобрести 700-мегабайтную заго-
товку диска. В наши дни второе решение не намного дороже первого,

Смысл всех опций вкладки Track Defaults (рис. 3.12) окна диалога Cool Edit Pro
CD Burning вам знаком. Точно такие же опции имеются в окне CD Track Properties.
Различие состоит только в том, что атрибуты трека, выбранные на вкладке Track
Defaults, будут далее применяться по умолчанию.

На вкладке Processing (рис. 3.13) находится единственная кнопка Group
Normalize All Tracks.

Нажав эту кнопку, вы откроете окно диалога, предназначенное для совмест-
ной нормализации группы выбранных треков. Детальное описание работы с
этим окном мы приводим в разд. 4.13 (поскольку команда Group Waveform
Normalize..., открывающая его, находится в меню Edit). Здесь же ограничимся

W UseFfltHrack Silence

02-00Sec-Frame ~rj
, . ..*nJ

Г" Copy Protect

Г" Pre-emphasis

Рис. 3.12. Вкладка Track
Defaults окна диалога
Cool Edit Pro CD Burning
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Рис. 3.13. Вкладка
Processing окна диалога
Cool Edit Pro CD Burning

пояснением роли совместной нормализации в ходе подготовки треков к запи-
си на диск. На наш взгляд, совокупность тех операций, которые доступны
пользователю при совместной нормализации волновых форм, можно считать
составляющими весьма упрощенного мастеринга диска. Во всяком случае,
пользуясь рассматриваемым средством, можно произвести ограничение и нор-
мализацию уровня аудиосигналов, а также многополосную коррекцию уровня
нормализации с учетом зависимости чувствительности слухового аппарата че-
ловека от частоты.

На вкладке Device (рис. 3.14) находятся раскрывающиеся списки, посредством
которых вы можете выбрать:

> Устройство записи (Device:)
> Размер буфера данных (Buffer Size:)
> Скорость работы выбранного устройства при записи (Write Speed:)

Если установлен флажок Test Write, то перед записью будет производиться тес -
тирование выбранного устройства.

Еще раз обратимся к окну диалога Cool Edit Pro CD Burning (см. рис. ЗЛО).
В группе Info содержится информация о том, какой объем диска займут фай-

лы, включенные в проект. Индикатор Disc Size в графической форме отображает
величину занятого дискового пространства. Та же самая информация в количе-
ственном выражении содержится в поле Current:. А в поле Remaining: отображает-
ся размер свободной области диска.

В группе Disc расположены следующие кнопки:

- Options —

Disc ] Track DefaiJts j Processing

Device:|F:(TEACCD-W58E

; ; Write Speed : | 8x [1 41 1 kBps)

. . Buffer Size: | S 4 K B

Fie

Device |

k ... .. .... ^

st. Write

Рис. 3.14. Вкладка Device
окна диалога Cool Edit
Pro CD Burning
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> Burn! — включение процесса записи диска
> New — создание нового проекта диска
> Open — загрузка существующего проекта диска
> Save — сохранение проекта диска под прежним именем
> Save As — сохранение проекта диска под новым именем h

Под проектом диска понимается файл, в котором хранится список предназначен-
ныхдля записи на диск треков со всеми их атрибутами и путями кфайлам-источникам.

3.8. Batch File Convert... — конвертирование
форматов файлов в пакетном режиме

Команда Batch File Convert... позволяет организовать продесс автоматического
конвертирования форматов заранее выбранных файлов, Это очень полезное ново-
введение Cool Edit Pro 2.0. Ведь пересчет файла из одного формата в другой (осо-
бенно когда происходит сжатие данных) может занимать очень много времени. К че-
му вам проводить это время у компьютера, ожидая, когда он справится с обработкой
текущего файла и нужно будет сформулировать компьютеру новое задание? Не про-
ще ли сразу составить целый список (пакет) задач, дать старт программе, а самому в
это время, например, попить кофе? Ваш ответ на эти риторические вопросы преду-
гадать не трудно. Итак, командой File > Batch File Convert... открывается одноимен-
ное окно диалога, содержащее 4 вкладки, каждая из которых соответствует опреде-
ленному этапу подготовки процесса конвертирования.

На рис. 3.15 представлена вкладка Files окна диалога Batch File Convert, предназ-
наченная для создания списка тех файлов, формат которых следует конвертировать.

Работать с этой вкладкой очень просто. Нажатием на кнопку Add Files... сле-
дует открыть стандартное окно загрузки файлов, затем, пользуясь мышью и кла-
вишами <Sift> или <Ctrl>, выделить необходимые файлы и загрузить их в про-
грамму. Если из списка загруженных файлов нужно удалить какой-то один,
выделите его и нажмите кнопку Remove, если все — нажмите кнопку Remove All.

При сброшенном флажке Hide Path в списке на вкладке Files будут отображать-
ся полные пути к файлам, при установленном флажке — только имена файлов.

Кнопка Open Raw PCM As... позволяет задать программе сведения о разрядно-
сти представления дан ных и частоте дискретизации перед загрузкой файлов неиз-
вестного формата. Подразумевается, что в этих файлах не применяется никаких
алгоритмов сжатия информации, а для представления волновой формы использу-
ется импульсно-кодовал модуляция (РСМ). Вы, естественно, должны знать фор-
мат этих файлов, а откуда — это вопрос отдельный.

Следующий шаг конвертирования (Step 2: Convert the sample type if needed) реа-
лизуется с помощью вкладки Resample (рис. 3.16).

Из названия данного шага следует, что, если вам необходимо, вы можете изме-
нить такие компоненты формата, как частота дискретизации, разрядность пред-
ставления и количество каналов (моно—стерео).
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Рис. 3.15. Вкладка Files окна диалога Batch File Convert
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Рис. 3.16. Вкладка Resampte окна диалога Batch File Convert
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Если установить флажок Convert Sample Type, то станет доступной кнопка
Change Destination Format.... Нажав на нее, вы откроете окно диалога Convert
Sample Туре (рис. 3 . 1 7 )

В группе Sample Rate можно задать новую частоту дискретизации для звуковых
данных. При изменении частоты дискретизации значения отсчетов будут опреде-
ленным образом пересчитываться. Точность вычислений можно задать при помо-
щи слайдера, который расположен под списком частот (Low — низкая точность,
High — высокая). Чем выше точность, тем больше времени потребуется на преоб-
разование звуковых данных.

Состояние флажка Рте/Post Filter определяет, следует ли производить специ-
альную фильтрацию звука перед (Рге) понижением частоты дискретизации или
после (Post) ее повышения. Фильтрация позволяет избежать побочных эффектов
при изменении частоты дискретизации. Флажок доступен в том случае, когда вы
выбираете новое значение частоты дискретизации (отличное от того, при кото-
ром записан редактируемый звуковой файл).

В группе Channels можно выбрать количество каналов. Если преобразуемый
звуковой файл имеет стереоформат, а вам требуется моно, то программа произве-
дет смешивание сигналов левого и правого каналов. Пропорции такого «коктей-
ля» задаются в полях Left Mix и Right Mix. По умолчанию смешивание осуществ-
ляется в соотношении «пятьдесят на пятьдесят».

I Convert Sample Type

Convert att files to:

"r Sample Rate Conversion

I

r Cample Rate ™

(48000 H
; 1Э2000 *

эероо

44100
32000
22050
16000

' 11025
SOOO _^j

Low High Quality

:il J ±|id̂d̂ J J4IHNI **+~~4

"$ Pre/Post Ffter

*| S#veAs;;.

~~] р Channels-- — i

i ^" Mono

f*" SteFeO

Le|tMiK [TOO™* %

Right Mix !l 00 %
" *"•" 1 . . . !

_^^ „_,̂  ' '••' ' ' ' |

Г" iEnableDitherincf

Dithei Depth (bits) IT"

p.df. iTnanqifer Tf
50 M L_ -"• : ' ™ ] '

| | No 1Чше Sh-sping ./. - I .j*) :]r '
~ ' !•' .-. , . ' . . . , . 1

'"" „ijj

Delete |

-Resolution— -j-

|32 bit

OK

.Caned I

Help

Рис, 3.17. Окно диалога Convert Sample Type
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Если вы хотите оставить звучание только одного канала (например, правого),
то произведите следующие установки: Left Mix 0 %, Right Mix 100%.

При задании пропорций (уровней громкости), в которых будут смешиваться
каналы, нужно проявлять определенную осторожность. Новый монофонический
звуковой файл может зазвучать значительно громче своего стереофонического
«родителя», что приводит к нелинейным искажениям. Такая ситуация возникает,
например, если задать Left Mix 100 %, Right Mix 100 %. Амплитуда сигнала может
превысить верхнюю границу разрядной сетки.

В группе Resolution задается разрешающая способность: 8, 16 бит или 32 бита.
При переходе от высокой разрядности к более низкой (например, от 32-битного
формата к 1 6-битному) есть смысл применить дитеринг (добавление псевдослучай-
ного сигнала для уменьшения нежелательных эффектов процесса квантования) [8J.
Дело в том, что при недостаточно высокой разрешающей способности цифрового
звука и очень слабом уровне сигнала (значения отсчетов изменяются в пределах
нескольких квантов от уровня 0) появляется относительно тихий, но неприятный и
раздражающий слушателя эффект похрустывания. Этот эффект обусловлен тем, что
уровень сигнала сопоставим с уровнем шума квантования, от которого невозможно
избавиться и теоретически, и практически. Однако существуют особенности чело-
веческого слухового аппарата, позволяющие замаскировать нежелательный эффект
ценой сравнительно небольших потерь. А делается это так. Прежде чем произво-
дить переход от 32-битного представления к 16-битному, к полезному сигналу под-
мешивается слабый случайный шум. Затем происходит преобразование 32-битного
представления сигнала с плавающей точкой в 16-битное. Благодаря наличию под-
мешанного шума эффект похрустывания пропадает, а сам шум воспринимается зна-
чительно спокойнее, чем похрустывание. При переходе от 16-битного сигнала к 8-
битному шум квантования будет гораздо сильнее, чем при переходе от 32-битного к
16-битному. Соответственно искусственный (дитеринговый) шум, скрывающий шум
квантования, должен быть интенсивнее. Однако слушатель привыкнет и к такому
шуму, после чего перестанет обращать на него внимание.

Вы уже знаете, что подмешивание шумового сигнала в процессе снижения раз-
рядности представления звука называется дитерингом. Группа Dither становится
доступной, если установить флажок Enable Dithering.

Уровень случайного шума в битах (или его интенсивность) задается в поле Dither
Depth (bits). Здесь речь идет о битах будущего 8-разрядного цифрового звукового сигна-
ла, поскольку именно при переходе к 8-битному звуку можно в явном виде услышать
шум квантования и понять природу дитерин га. Конкретное значение уровня шума под-
бирается на слух для конкретного звукового файла: выберите одно значение, не понра-
вится — отмените операцию, возьмите другое и т. д. Как показал наш собственный опыт.
в данном случае оптимальный уровень шума варьируется в пределах от 0,01 до 0,5. Это
достаточно слабый шум, который не будет раздражать слушателя.

Ниже поля Dither Depth (bits) расположен раскрывающийся список p.d.f.. Об
этом элементе мы уже рассказали в разд. 1.2.1.

В самом низу окна, в группе Dither находится еще один (безымянный) раскры-
вающийся список. В нем можно выбрать тип нойс- шейпинга, соответствующий
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одному из вариантов распределения спектра шума в полосе звуковых частот. Выб-
рав удачный вариант, можно замаскировать шум квантования и шум, вносимый при
применении дитеринга. Разработчик рекомендует выбирать следующие варианты:

> Noise Shaping А и В при частотах дискретизации, не превышающих 32 кГц
> Noise Shaping Cl, C2 и СЗ при частотах дискретизации не менее 44,1 кГц
> Noise Shaping D при частоте дискретизации 48 кГц

Количество вариантов формирования спектра шума увеличивается с каждой
новой версией программы. Поэтому не ленитесь заглядывать в Help. Но, главное,
не бойтесь экспериментировать.

Все настройки, произведенные в окне Convert Sample Type, можно сохранить в
виде файла. В группе Sample Rate Conversion Presets имеется список предустановок
(на рис. 4.21 он пуст). Правее списка расположена кнопка Save As..., с ее помощью
можно сохранить все настройки в окне под любым именем, которое впоследствии
попадет в список предустановок. Кнопка Delete позволяет удалять элементы это-
го списка.

Вернемся к окну диалога Batch File Convert, откроем его вкладку New Format
(рис. 3.18) и совершим шаг № 3 (Step 3: Choose new file format and format properties).

С помощью этой вкладки формат аудиофайла можно преобразовать самым
кардинальным образом. В списке Sample Format Types отображен формат, выб-
ранный в окне диалога Convert Sample Type (рис. 3.17). Этот список — просто
памятка. Самое интересное — перечень поддерживаемых форматов —находится
в раскрывающемся списке Output Format. В текущей версии данный список со-
держит 19 строк. Исходные файлы хранятся у вас в некотором формате, а преоб-

&:h File Convert : :I

Step3. Choose new fte format and formal properties

Output Fomiet

;: . Sample Foimat Types

I For eachpossifcfe type .of audio dala, you may choose different Йе format properties.
j. For example, a 22KHz fits may need different encoding options than a 44. 1KHz file.

I j ' . ; . . . - . - ll__L

1 . Files | 2. Resample '3 New Format J 4. Destination |

"Я

Run Batch]

Close |
:'"" "'—-'—---*

Help 1 ;

Рис. 3.18. Вкладка New Format окна диалога Batch File Convert
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разевать их можно в любой из оставшихся 18 форматов. Нажав кнопку Format
Properties, вы откроете окно, в котором отображаются свойства того формата, и
который вы решили преобразовывать файлы. Для каждого формата окно свойств
будет иметь особый вид. Со свойствами можно просто знакомиться, но ими мож-
но также и управлять. Набор редактируемых параметров для каждого формата
свой. Нет смысла демонстрировать и описывать все окна редактирования свойств.
Остановимся только на том окне (рис. 3.19), с которым вам понадобится рабо-
тать, когда вы захотите преобразовать аудиоданные и популярный формат МРЗ
(официальное название MPEG Layer III). Если быть точнее, то в ел иске поддер-
живаемых Cool Edit Pro форматов этот формат называется трЗРКО® (.МРЗ).
Заметим, что трЗРКО — это своеобразная надстройка над форматом МРЗ, це-
лью которой является улучшение качества фонограммы по сравнению с обыч-
ным МРЗ. Файлы со звуковыми данными, закодированными по алгоритмам
mp3PRO, в принципе, могут воспроизводиться любым плеером. Но если в этой
плеере нет поддержки трЗРКО, то вы не услышите высоких частот, которые в
трЗРКО кодируются отдельным потоком.

iMP3/mp3PRO« Encoder Options

Piesefs
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Рис. 3.19. Окна диалога МРЗ/
mp3FRO® Encoder Options

В верхней части окна расположен раскрывающийся список, в котором вы най
дете несколько готовых пресетов, содержащих конфигурацию преобразования. Все
установки, которые вы выберете, также можно сохранить в качестве пресета. Для
этого достаточно набрать его имя и нажать кнопку Add. Для удаления пресета и:з
списка его нужно выделить и нажать кнопку Delete.

Переключатели CBR (Constant Bitrate) и VBR (Variable Bitrate) позволяют выб-
рать один из двух режимов сжатия: с постоянным или переменным битрейтом (ско-
ростью потока звуковых данных). Использование VBR позволяет сократить объем
МРЗ-файла: простые с точки зрения алгоритма участки фонограммы будут зани-
мать меньше места.

Переключателями МРЗ и трЗРКО® осуществляется выбор алгоритма сжатия.
В информационном поле, расположенном правее переключателей, первый алго-
ритм назван стандартным, а для повышения качества звука рекомендуется исполь-
зовать алгоритм трЗРКО®, Кстати гоооря, информация в этом поле меняется в
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зависимости оттого, на каком элементе интерфейса окна вы щелкнете. Т. е. поле
представляет собой контекстную подсказку.

В безымянном раскрывающемся обширном списке вам предстоит выбирать
параметры качества преобразования, определяющиеся битрейтом и частотой дис-
кретизации.

Если вы хотите преобразовать стереофонический формат в монофонический,
то установите флажок Convert to Mono.

Для получения доступа к дополнительным установкам следует нажать кнопку
Advanced».

В результате появится один из расширенных вариантов окна MP3/mp3PRO/
Encoder Options. Его вид и набор доступных опций зависят от состояния двух пар
переключателей (CBR (Constant Bitrate) -VBR (\kriable Bitrate) и МРЗ — mp3PRO®).
На рис. 3.20—3.23 показаны 4 варианта расширенного окна MP3/mp3PRO Encoder
Options. Кнопка Advanced » переименовывается в « Simple. Воспользовавшись
ею можно вернуться к минимальной конфигурации окна.

Рассмотрим тот вариант окна, который представлен на рис. 3.20 (выбраны оп-
ции CBR (Constant Bitrate) и МРЗ).

Итак, в расширенном варианте окна есть две безымянные группы (слева внизу
и справа внизу), отделенные линиями друг от друга и от остальной части окна.

В левой группе в данном случае располагаются следующие опции:

Maximum Bandwidth — верхняя граница кодируемой области спектра сигна-
ла. Чем ниже эта граница, тем меньше будет объем файла
CBR Bitrate_Kbps — поле ввода значения постоянного битрейта
Sample Rate — раскрывающийся список для выбора частоты сэмплирования
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> Codec — раскрывающийся списокдля выбора кодека (программа предлага-
ет три варианта, отличающиеся качеством; чем выше качество, тем больше
время преобразования

> Allow Mid-Side Joint Stereo — опция разрешает метод кодирования, при
котором стереосигнал будет раскладываться на два отдельных сигнала:
монофонический (А + В — сумма стереоканалов) и разностный (А - В
— разность стереоканалов). Разностный сигнал кодируется с меньшим
битрейтом, что позволит улучшить качество кодирования для фоно-
грамм, не содержащих ярко выраженных стереоэффектов и фазовых
сдвигов.

> Allow Intensity Joint Stereo - опция разрешает метод кодирования, при кото-
ром стереосигнал, в свою очередь, раскладывается на еще большее количе-
ство сигналов, для которых будут использоваться разные битрейты. Причем
для некоторых диапазонов частот будет кодироваться только отношение мощ-
ностей сигнала в стереоканалах. Такой метод эффективен при очень низких
битрейтах.

> Allow Narrowing of Stereo Image — опция означает разрешение сужения сте-
реообраза фонограммы с целью экономии объема информации. Т е. пусть в
отдельных местах фонограммы стереообраз будет и не таким широким, но
общее качество звука будет лучше.

В правой группе находятся следующие опции:

> Set 'Private' Bit, Set 'Copyright' Bit, Set 'Original' Bit — флажки приватности.
авторства и оригинальности (в смысле «не копия») фонограммы, предус-
мотрены в каждом кадре MPEG-потока, в основном носят декларативный
характер

> Padding — раскрывающийся список, содержащий параметры, влияющие на
совместимость MPEG-потока с программными и аппаратными средствам и
его передачи и декодирования. Рекомендуется оставить значение ISO
Padding, принятое по умолчанию.

> Write CRC Checksums — флажок добавления контрольных сумм в поток М РЗ -
данных, благодаря чему могут быть выявлены ошибки в потоке

Несколько слов о параметрах Padding. Данные в потоке MPEG передаются
кадрами (в одном кадре определенное количество бит). Битрейт, частота сэмп-
лирования и размер кадра связаны между собою. Для некоторых комбинаций
битрейта и частоты_сэмплирования количество бит в кадре не получается крат-
ным 8, т.е. в одном кадре не получается целого количества байт. Поскольку
это является недопустимым, происходит округление размера кадра до целого
количества байт, В какую сторону происходит округление - зависит от режи-
ма, заданного в списке Padding. Always Pad — округление в сторону большего
значения, No Padding - в сторону ближайшего значения. Однако только в ре-
жиме ISO Padding гарантируется соответствие получаемого потока стандарту
ISO MPEG.
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Если выбраны опции CBR (Constant Bitrate) и mp3PRO®, то вид расширенного
окна изменится (рис, 3.21).

Сравнивая рисунки 3.20 и 3.21, вы можете заметить, что отличия состоят в том,
что исчезли опции Maximum Bandwidth. CBR Bitrate_Kbps и Sample Rate, а вместо
них появился флажок Low Complexity Stereo. Если он установлен, то при кодиро-
вании потока с очень низким битрейтом стереосигнал на некоторых участках фо-
нограммы будет превращаться в моносигнал. По-видимому, будет сохраняться
какая-то информация о свойствах исходного стереосигнала, которая будет исполь-
зоваться при декодировании монофонических участков с использованием эффекта
псевдостерео.

Третий вариант расширенного окна MP3/mp3PRO<3> Encoder Options (рис. 3.22)
соответствует ситуации, когда выбраны опции VBR (Variable Bitrate) и МРЗ.

В данном случае новым элементом является поле ввода VBR Quality (1... 100).
Значение 1 данного параметра соответствует наихудшему качеству и наименьше-
му размеру МРЗ-фаЙла, а значение 100 — наивысшему качеству и наибольшему
размеру МРЗ-файла.

Последний вариант расширенного окна MP3/mp3PRO® Encoder Options (рис.
3.23) соответствует ситуации, когда включены опции VBR (Variable Bitrate) и
mp3PRO®. По сравнению с вариантом окна, представленным на рис. 3.22, здесь
отсутствует возможность выбора верхней границы кодируемой области спектра
сигналаг: нет поля ввода Maximum Bandwidth.
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Рис. 3.21. Расширенное окно MP3/mp3PRO® Encoder Options.
Выбраны опции CBR (Constant Bitrate) v mp3PRO®
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Рис. 3.22. Расширенное окно MP3/mp3PRO® Encoder Options.
Выбраны опции VBR (Variable Bitrate) и МРЗ
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Рис. 3.23. Расширенное окно MP3/mp3PRO® Encoder Options.
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Итак, завершив рассказ о третьем шаге подготовки группы файлов к конверти-
рованию формата файлов, мы переходим к последнему шагу (Step 4: Choose
Destination folder and file renaming scheme). С помощью вкладки Destination окна
диалога Batch File Convert (рис. 3.24) вам предстоит выбирать папку, в которой бу-
дут храниться преобразованные файлы, и создать схему образования новыхимен.

Если выбрана опция Same as file's source folder, то преобразованные файлы бу-
дут записаны в те же папки, в которых они хранились до преобразования.

Bdtch File Convert
• " - ••- -.••;", . • •• • •;" .г"'-' ,!«-=•

Step 4: Choose desitvitw folder and file renaming scheme

'f jjeroe as fife's source folder
ff,iffibirJi*3 _____ • "" ' '

CADocunw.r:- and SettingsMGBWy Documents fifOHSB,., \

Г" .Jjverwiie existing IBes

. . Г" Delete sowce Яе и converted OK.

. Г" Qenavz from soufce Ы it convetted OK

Output Filename Template j".mp3

•

\ Here sas some e*«rples pf;fSename templates for the Iris "Test. wav";
j - Template New Name

1- "2.mp3 TEsl2.mp3
NEW " NEW Testwav
Wt23 Tesl23.wav
'.'{backup! TesLwavlbackipl

. . - - - • . . - .

1 Fies j 2. fiesample 3. New Fcimat . .̂ Destination |
-

•~,jg

RLCI Batch 1

\ : dose i
, !;

аФ

Рис. 3.24. Вкладка Destination окна диалога Batch File Convert

Выбрав опцию Other folder, вы получите доступ к кнопке Browse..., и сможете
определить для хранения преобразованных файлов новый путь и новую папку.

Если установлен флажок Overwrite existing files, то преобразованные файлы бу-
дут записаны поверх исходных.

При установленном флажке Delete source file if converted OK исходные файлы
будут удалены после успешного завершения конвертирования. Если этот флажок
сброшен, то становится доступным флажок Remove from source list if converted OK.
Он, в свою очередь, означает автоматическое удаление исходных файлов из спис-
ка на вкладке Files окна диалога Batch File Convert, если «все OK».

В поле Output Filename Template содержится шаблон, который будет использовать-
ся при именовании преобразованного файла. Символом * обозначается фрагмент
имени исходного файла без расширения. Например, если исходный файл называется
file.wav, то при использовании шаблона new_*.mp3 получится файл new_file.mp3.

Все о чем мы рассказали в завершающемся разделе, было лишь подготовкой к
конвертированию группы файлов, состоящей из 4-х шагов (причем, не все из ша-
гов являются обязательными). После завершения подготовки остается лишь на-
жать кнопку Run Batch — и процесс конвертирования наконец-то пойдет.
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3.9. Flush Virtual File — освобождение открытого
файла для использования другим приложением

Работая с Windows-приложениями, вы наверняка сталкивались с ситуацией, когда с
файлом, который открыт в данный момент в одном приложении, нужно выполнить
какие-либо операции в другом приложении. Однако не всегда Windows позволит вам
сделать это. Например, файл с документом, открытым в Microsoft \\brd, не удастся пе-
ренести в другой каталог, воспользовавшись программой Windows Commander.

Команда Flush Virtual File освобождает для использования другим Windows-при-
ложением файл, открытый в Cool Edit Pro.

3.10* Free Up Space in Temp Files... — расчистка
дискового пространства

Команда Free Up Space in Temp Files... открывает одноименное окно диа-
лога (рис. 3.25), предназначенное для расчистки и резервирования дисково-
го пространства.

В группе Clear some Undo Items or close some Waveform Files содержатся следую-
щие списки.

Free Up Space in Temp Files

г 3eat 'some Undo Stems or dose some Waveform Fries- ~ — ~ — ^ •• ~ — г

Waveform . ; ; Undo History .? • г .

CHORD.WAV (dAwindowsVmedia\CH
DING WAV [dAwir1dows\medta\DING
LOGOFF.WAV (dAwmdows\media\LC;

RECYCLE.WAV fd \windowsSmediaSF :

, i TADA WAV fd Swhdowa\n»ciaVTADJ

II . ;

0 U ndo Paste
1 К Undo Cut/Delete S& Smooth :

26K Undo Cut Undo *erns get
cbared from selected =
item to end of !isl, \

!
' 'ni

|
~.

• . Close Ffe ;

'- Lowe? Hard D'iVe Reserves - -

Free ' ' • Reserve

i Primaiy JC.\OQCUME~1 \21 23~1 MOCALS~1 |326S6 (38 MB
Я I I , . . • j

S econdary ]

7 ofal Available Space ]33,4p3,360

J38 [sj|E( Sef New Reserves I "•

~ ' I - = = O K :1

-
j Cancel Last Opeiahon | Heip

Рис. 3.25. Окно диалога Free Up Space in Temp Files
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*• Waveform — перечень открытых аудиофайлов. Выделите файл, который не
нужен в настоящее время, и нажмите кнопку Close File

> Undo History — предыстория функции Undo (применительно к выделенно-
му в поле Waveform файлу). Выделите операцию, к которой вам не потребу-
ется больше возвращаться, и нажмите кнопку Clear Undo(s)

В группе Lower Hard Drive Reserves можно установить минимальный объем сво-
бодного дискового пространства на первом (Primary) и втором (Secondary) аудио-
дисках. Эти параметры вводятся в соответствующих полях Reserve в мегабайтах.
Нажатием кнопки Set New Reserves вы укажете программе на то, что установлены
новые параметры зарезервированной памяти.

В поле Total Avialable Space отображается общий объем свободной дисковой
памяти.

Когда в процессе работы с Cool Edit Pro свободного места на дисках становит-
ся мало, программа автоматически откроет окно диалога Free Up Space in Temp
Files, и вы сможете воспользоваться кнопкой Cancel Last Operation, отменив пос-
леднюю операцию (для завершения которой на диске не хватило пространства),
Затем вы должны либо средствами рассматриваемого окна диалога, либо средства-
ми операционной системы освободить пространство на диске, чтобы можно было
продолжить работу с редактором Cool Edit Pro.

Мы рассмотрели команды меню File. На очереди меню Edit, с которым вам при-
дется работать очень часто.
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МЕНЮ EDIT - РЕДАКТИРОВАНИЕ
ВОЛНОВЫХ ФОРМ

В меню Edit содержатся следующие команды и подменю:

> Undo — отменить последнюю операцию редактирования
> Redo — повторить отмененную операцию редактирования
> Enable Undo — включить функцию Undo
> Repeat Last Command — повторить последнюю команду
> Set Current Clipboard — выбрать рабочий буфер обмена
> Сору — скопировать в буфер обмена выделенные аудиоданные
> Cut — вырезать выделенные аудиоданные
> Paste — вставить аудиоданные из буфера обмена
> Paste to New — создать новый файл и вставить в него данные из буфера обмена
> Mix Paste... — смешать звуковые данные, хранящиеся в буфере обмена, со

звуковыми данными, находящимися на треке
> Copy to New — создать новый файл и вставить в него выбранные данные
> Insert in Multitrack — вставить аудиоданные в мультитрековую среду
> Insert Play List in Multitrack — вставить в мультитрековую среду файлы, пе-

речисленные в списке Play List
> Select Entire Wave — выделить все аудиоданные
> Delete Selection — удалить выделенный фрагмент
> Delete Silence.,. — удалить фрагменты, содержащие тишину
> Trim — удалить все данные, кроме выделенного фрагмента
> Zero Crossings — переместить начало и конец выделенного фрагмента к ближай-

шим точкам, в которых звуковая волна пересекает нулевой уровень (подменю)
> Find Beats — выделить фрагмент, совпадающий с перепадами уровня сигна-

ла (подменю)
> Auto-Cue — определить границы разговорных/музыкальных фраз или долей

(подменю)
> Snapping— выбор опций привязки границ выделенного участка волновой

формы к координатной сетке (подменю)
> Group \\fcveform Normalize... — совместно нормализовать несколько волновых форм
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> Adjust Sample Rate... — изменить частоту дискретизации
> Convert Sample "type... — преобразовать тип сэмплирования

Рассмотрим возможности, которые предоставляет компьютерному музыканту
меню Edit.

4.1. Отмена и повторение операций
Первая команда меню Edit — это команда Undo. Она отменяет последнее со-

вершенное действие. Если повторить отмену, то отменится еще один шаг редакти-
рования и т. д. до тех пор, пока возможность отмены не исчезнет. Если отмену про-
извести невозможно, то вместо названия Undo вы увидите бледную надпись Can't
Undo (He могу отменить).

Команда Redo восстанавливает отмененную ранее операцию.
Команда Enable Undo позволяет включать (для этого надо установить галочку в

меню напротив этого пункта) или выключать режим отмены.
Для предоставления возможности использования команды Undo, результа-

ты каждого шага при работе с программой автоматически записываются в спе-
циальные временные файлы, которые могут занимать много памяти. Если на
вашем диске немного свободного места, то можно отключить режим отмены,
тогда временные файлы создаваться не будут. В этом случае придется как сле-
дует обдумывать каждое свое действие, поскольку отменить неудачное реше-
ние вы не сможете. Мы уже рассказали, как ограничить максимальное число
отмен (разд. 1.1.2).

По команде Repeat Lust Command (<F2>) повторяется последняя выполненная
команда. Здесь нужно быть очень внимательным! Повторяться будет та команда,
которую Cool Edit Pro выполнил последней независимо оттого, с какой волновой
формой вы работали, — с текущей или с другой. Причем если команда открывает
окно диалога, где есть изменяемые опции и параметры, то при повторе в нем бу-
дут те же установки, что и при предыдущем выполнении команды.

Заметим, что не все команды могут повторяться. Строка Repeat Lust Command
(<F2>) в меню Edit доступна, если последняя команда может быть повторена.

4.2. Set Current Clipboard — выбор рабочего
буфера обмена

Если в меню Edit выбрать пункт Set Current Clipboard, то раскроется подменю
(рис. 4.1).

В нем можно выбрать рабочий (текущий) буфер обмена. В программе предус-
мотрено 5 внутренних буферов обмена и один внешний (общесистемный). Имен-
но в буфер обмена, выбранный в этом подменю, будут помешаться данные при
выполнении тех операций редактирования, которым требуется буфер обмена.
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Рис. 4.1. Подменю выбора рабочего
буфера обмена

Через внешний (общесистемный) буфер можно обмениваться данными с дру-
гими Windows-приложениями.

Чем хороша работа не с общесистемным, а с собственным буфером обмена
программы? Если вы выключите компьютер, а на следующий день решите про-
должить работу с Cool Edit Pro, то обнаружите, что информация, помещенная во
внутренний буфер обмена, сохранилась. Никуда она не пропадет и через неделю,
и через год. Секрет прост — внутренний буфер обмена организован в виде файла.

А в каких случаях может оказаться полезным наличие нескольких буферов об-
мена? Допустим, вы формируете композицию из нескольких волновых форм, при-
чем некоторые из них используются многократно. Каждую из них можно скопи-
ровать в отдельный буфер обмена, чтобы затем вставлять в нужные места; главное —
не запутаться, где что хранится, и вовремя менять текущий буфер обмена.

4.3. Copy Cut Paste — копирование, вырезание,
вставка

Следующие команды, используемые при редактировании, тоже работают с бу-
фером обмена:
> Copy (<Ctrl>+<C>) — копировать
> Cut (<Ctrl> + <X>) — вырезать
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> Paste (<Ctrl>+<V>) — вставить
> Paste to New — создать новый файл и вставить в него данные из буфера обмена
> Copy to New — создать новый файл и вставить в него выбранные данные

Чтобы скопировать или вырезать фрагмент волновой формы, его нужно сна-
чала выделить. О том, как это делать графическим или численным способами, мы
подробно рассказали в разд. 2.3.

При выполнении команд Сору и Cut данные будут помещены в текущий буфер
обмена.

Команды Paste и Paste to New обеспечивают вставку в волновую форму данных
также из текущего буфера обмена.

Если вы примените команду Paste, то данные будут вставлены в волновую фор-
му, находящуюся на активной странице. Начало вставляемого фрагмента будет
совпадать либо с положением маркера, либо с началом выделенного фрагмента
волновой формы.

Команда Paste to New, по существу, представляет собой целую последователь-
ность операций: сначала автоматически создается новая страница, а потом из бу-
фера обмена на нее вставляется фрагмент. Затем фрагмент превращается в новую
волновую форму Ее можно сохранить в файле, присвоив имя.

Командой Copy to New вы также организуете последовательность операций.
В результате фрагмент, выбранный в текущей волновой форме, будет вставлен в
автоматически созданный новый файл.

4.4. Mix Paste.*.— вставка с микшированием
Команда Mix Paste... заслуживает большего внимания. Она предназначена для

наложения звуковых данных, хранящихся в буфере обмена, на редактируемую вол-
новую форму. Вызов команды Mix Paste... приводит к появлению окна диалога,
показанного на рис. 4.2.

В группе Volume (Громкость) расположены элементы управления громкостью
вставляемого материала для левого (L) и правого (R) каналов. Уровень громкости

Volume

В ч ) _J

. 'f~ insert

P" Overlap №1
f~ Replace

Г~ Cre&ifade pO n>s

^* Рюп^СйрЬоз

Г Fwrr;tfntte?

f РквпЕВе

(J3

j-bbboe

Sdsd F'f'e. .

F Laop Pajte (imes

Рис. 4.2. Окно диалога Mix Paste
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задается в процентах (по умолчанию 100%) при помощи слайдеров или численно.
Если установить флажок Lock Left/Right, то громкость обоих стереоканалов мож-
но будет изменять одновременно. При установленном флажке Invert происходит
инверсия волновой формы перед вставкой. Слово «инверсия» имеет очень много
значений. В данном случае оно означает умножение каждого из отсчетов на -1.
Результат будет таким: положительные полуволны колебаний превратятся в отри-
цательные, а отрицательные, наоборот, — в положительные.

В левой нижней части окна вы можете выбрать способ вставки.

> Insert — вставка, при которой редактируемая волновая форма будет «раз-
двинута», чтобы разместить содержимое буфера

> Overlap (Mix) — вставка с микшированием. Материал из буфера «переме-
шается» с редактируемой волновой формой

> Replace — вставка с заменой. Материал из буфера заменит собой звуковые
данные, которые находились в этой области волновой формы до вставки

> Modulate — вставка с модуляцией по амплитуде. Каждый отсчет звукового
сигнала из буфера умножается на соответствующий отсчет волновой формы

Флажок Crossfade предназначен для установки режима сглаживания, который
часто бывает очень полезен. Речь идет вот о чем. Когда вы выделяете блок звуко-
вых данных, то значения отсчетов сигнала на краях этого блока не обязательно
будут равны нулю, что в дальнейшем может вызывать неприятные щелчки при
воспроизведении материала, вставленного из буфера обмена. От этих щелчков
нужно как-то избавляться, что и делается при помощи режима сглаживания.

Если детально рассмотреть сущность данного режима, то окажется, что при
сглаживании программа не просто вставляет звуковой блок в волновую форму, а
делает это «разумно»: она управляет его громкостью, т. е. в начале блока уровень
громкости плавно возрастает от 0 до 100%, а за некоторое время до окончания
блока начинает плавно убывать до 0%. Время изменения громкости, задаваемое в
поле, расположенном справа от флажка, очень мало (порядка десятка миллисе-
кунд), поэтому слушатель не заметит никакого подвоха. Такими свойствами обла-
дает не только рассматриваемая программа, но и профессиональная студийная
аппаратура. В противном случае, в аудиозаписях, теле- и радиопередачах посто-
янно прослушивались бы щелчки, сопровождающие оперативную коммутацию
аппаратуры.

Величину интервала времени изменения громкости от 0 до 100% (или наобо-
рот) вы должны ввести в поле Crossfade.

Другая группа переключателей позволяет выбирать источник вставляемого
блока.

> From Clipboard N — внутренний буфер обмена. Символ N заменяет в тексте
ссылку на текущий буфер обмена. Программа заботится, чтобы вы не пере-
путали, какой именно материал вставляете

> From Windows Clipboard — общесистемный буфер обмена.
> From File — файл
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Если вы решили вставить данные из файла (и выбрали соответствующий пе-
реключатель), то далее нужно выбрать интересующий вас файл, нажав кнопку
Select File... (откроется окно загрузки файлов). Если этого не сделать, то вставка
будет осуществляться из буфера обмена, несмотря на то, что выбран переключа-
тель From File.

Опция Loop Paste позволяет вставлять волновую форму, находящуюся в буфере
обмена, несколько раз подряд (количество задается в поле, расположенном спра-
ва от флажка).

Когда все параметры вы уже задали, нажмите кнопку ОКили клавишу <Enter>.
Вы, наверное, убедились, что команда Mix Paste... и соответствующее окно

диалога — универсальный мощный инструмент монтажа фонограмм. До превра-
щения Cool Edit Pro в мультитрековый редактор это средство редактирования было
просто незаменимым.

4.5. Insert in Multitrack—вставка аудиоданных в
мультитрековую среду

Пока мы рассматриваем работу с Cool Edit Pro в режиме редактирования от-
дельных волновых форм (Edit Waveform View), но не следует забывать, что Cool
Edit Pro фактически объединяет в себе два редактора: первый — редактор волно-
вых форм, с ним мы сейчас учимся работать; второй — мультитрековый редактор
(режим Multitrack View). Основная работа — монтаж из отдельных волновых форм
завершенной аудиокомпозиции — выполняется именно в мультитрековом редак-
торе. Подробно об этой работе мы расскажем в главе 12.

Команда Insert in Multitrack предназначена для вставки текущей волновой фор-
мы в мультитрековый проект. Однако чаще всего редактируемая волновая форма
уже присутствует в нем: вы осуществили запись, работая в мультитрековом редак-
торе, переключились в режим редактирования волновой формы, где и выполнили
необходимую обработку. В этом случае не нужно пользоваться командой Insert in
Multitrack, а просто переключите программу в мультитрековый режим, чтобы про-
должить работу над проектом.

Забегая вперед, скажем, что в окне мультитрекового редактора действительно
имеется много треков, расположенных один под другим. Там также есть свой мар-
кер. Если вы, работая в режиме Edit Waveform View, в меню Edit выберете команду
Insert in Multitrack, то волновая форма, находящаяся на активной странице, будет
вставлена на трек мультитрекового редактора, причем начало вставленной волно-
вой формы совпадет с положением маркера.

Если вы обратились к команде Insert in Multitrack в первый раз, то волновая
форма будет вставлена на первый свободный трек. Вторая вставка произойдет на
следующий трек и т. д. Опять забегая вперед, скажем, что этот порядок вставки
можно изменить: например, несколько волновых форм вставить на один и тот же
трек. Можно также и пропустить некоторые из треков, Как это делается, мы рас-
скажем в главе 12.
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4.6, Insert Play List Multitrack — вставка
в мультитрековую среду файлов,
перечисленных в списке Play List

Команда Insert Play List Multitrack предоставляет возможность вставить в муль-
титрековую среду волновые формы из файлов, перечисленных в списке Play List,
Команда относится к числу средств автоматизации процесса обработки большого
числа файлов. Вместо того чтобы «поштучно» вручную вставлять файлы в мульти -
трековую среду, достаточно составить их список и применить команду Insert Play
List Multitrack.

Подробно работа с Play List освещена в гл. 5.

4.7. Выделение и удаление
Командой Select Entire \\bve (<Ctrl>+<A>) можно выделить всю волновую фор-

му. Если выделенную волновую форму вставить в мультитрековую среду, то в ней
она тоже будет выделенной. Волновые формы, загруженные в программу, но на-
ходяшиеся на неактивных страницах, не выделяются.

Команда Delete Selection (<De]>) предназначена для удаления выделенного зву -
кового блока.

Команда Trim (<Ctrl>4-<T>), наоборот, удаляет из текущей волновой формы
все звуковые данные, кроме выделенных. Оставшийся после удаления фрагмент
будет по-прежнему выделен.

4.8, Delete Silence... —удаление фрагментов,
содержащих тишину

Команда Delete Silence... предназначена для того, чтобы удалить из волновом
формы звуковые отсчеты с тех участков, которые не содержат полезных звуковых
данных: например, паузы между словами, фразами. Если запись осуществлялась с
микрофона, то в паузах между словами оказались зафиксированными шумы или
нежелательные относительно тихие звуки. Конечно, можно на слух и вручную
выбирать участки волновой формы, не содержащие полезной информации. Но
сейчас речь пойдет о средстве, автоматизирующем такую деятельность.

Команда Delete Silence...открывает одноименное окно диалога (рис. 4.3). Рас-
смотрим опции этого окна.

В группе «Silence» is defined as: следует определить условия, при которых програм-
ма классифицирует фрагмент волновой формы как содержащий только «тишину».

В поле Signal is below укажите максимальное значе ние уровня си гнала (н деци-
белах), соответствующего тишине.
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Рис. 4.З. Окно диалога Delete Silence

В поле For more than введите минимальное значение интервала времени (в мил-
лисекундах), на котором уровень сигнала не должен превышать указанного зна-
чения, чтобы программа сочла этот сигнал «тишиной».

В группе «Audio» is defined as: следует определить условия, при которых программа
классифицирует фрагмент волновой формы как содержащий полезный звук.

В поле Signal is above укажите минимальный уровень сигнала (в децибелах),
соответствующий звуку.

В поле For more than введите минимальный интервал времени (в миллисекун-
дах), на котором сигнал не должен опускаться ниже указанного уровня, чтобы
программа идентифицировала этот сигнал как звук.

Если нажать кнопку Find Levels, то критерии тишины и звука для выделенного
фрагмента волновой формы будут выбраны программой автоматически.

Если установлен флажок Mark Deletions in Cue List, то все участки волновой
формы, где тишина удалена, будут помечены.

В поле Limit Continuous Silence to устанавливают минимальную протяженность
неудаляемого фрагмента тишины. Если найденная область тишины короче, чем
задано в этом поле, то она не будет удалена вообше. Если найдена область тиши-
ны более протяженная, чем задано в этом поле, то после удаления останется фраг-
мент тишины, длительность которого равна заданной в поле Limit Continuous
Silence to.

В группе Scan Results содержится единственная кнопка: Scan for Silence Now.
Нажав ее, вы включите режим предварительного поиска фрагментов, содержа-
щих тишину. В результате этого программа проинформирует вас, сколько уча-
стков, содержащих тишину, было найдено, но тишина при этом не удаляется.
Эта информация отображается в поле, расположенном над кнопкой Scan for
Silence Now.

Для того чтобы действительно удалить участки, содержащие тишину, нужно
нажать кнопку ОК.

Вы должны четко представлять себе, что в результате применения рассмотрен-
ной команды длительность вол и о ной формы изменяется.
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4.9. Zero Crossings — перемещение границ
выбранного фрагмента к точкам нулевого
уровня

Подменю Zero Crossings (рис. 4.4) содержит команды, которыми можно пере-
двинуть начало и конец выделенного звукового блока в те позиции, где звуковая
волна пересекает нулевой уровень. Он соответствует нулевой отметке для 16-бит-
ного формата и значению 127 — для 8-битного. Эта функция, а также функция
Crossfade предназначены для достижения одной и той же цели — предотвращенкя
щелчков в начале и в конце вставляемого фрагмента. Алгоритм поиска нуля рабо-
тает с учетом того, что у вас могут быть два стереоканала, волновые формы в кото-
рых отличаются.
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Рис. 4.4. Подменю Zero
Crossings

Применение команды Adjust Selection Inward означает, что границы выделен-
ного фрагмента будут автоматически перемещены к ближайшим нулевым точкам,
расположенным внутри выделенного интервала. На рис. 4.5 приведен пример не-
удачно выделенного фрагмента волновой формы. Видно, что границы фрагмента
оказались в тех точках, где отсчеты имеют ненулевые значения. Если такой фраг-
мент вырезать и смонтировать с какой-либо другой волновой формой, то будут
слышны щелчки.
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Рнс. 4.5. Пример выделенного фрагмента волновой формы

На рис. 4.6 представлена та же волновая форма после применения команды
Adjust Selection Inward. Сравните рисунки и убедитесь, что границы выделенного
участка переместились к ближайшим нулевым точкам, приблизившись друг к другу.

Применение команды Adjust Selection Outward приведет к тому, что границы
выделенного фрагмента будут автоматически перемещены к нулевым точкам, рас-
положенным вне выделенного интервала.

Команда Adjust Left Side to Left сдвинет левую границу выделенного фрагмента
к ближайшей слева нулевой точке.

Команда Adjust Left Side to Right сдвинет левую границу выделенного фрагмен-
та к ближайшей справа нулевой точке.

Команда Adjust Right Side to Left сдвинет правую границу выделенного фраг-
мента к ближайшей слева нулевой точке.

Команда Adjust Right Side to Right сдвинет правую границу выделенного фраг-
мента к ближайшей справа нулевой точке.

Если вы несколько раз проделаете опыты по перемещению границ выделенно-
го фрагмента, то вам может показаться, что не всегда они перемещаются именно к
ближайшим нулевым точкам: создается впечатление, будто иногда Cool Edit Pro
«проскакивает» их. И все же программа не ошибается. Просто, если вы выделили
фрагмент стереофонической волновой формы, то Cool Edit Pro отыскивает такие
точки, где нулю равны одновременно сигналы и правого, и левого канатов. Быва-
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Рис. 4.6. Пример фрагмента волновой формы с границами выделения, перемещенными
внутрь предварительно выделенного интервала

ет, что глаз не в состоянии увидеть незначительные различия в графиках волн пра -
вого и левого каналов, а на самом деле они существенны.

Если выделить фрагмент волновой формы только в одном из каналов, то сдви г
границы выделения всегда происходит именно в ближайшую нулевую точку.

4.10. Find Beats — выделение фрагмента,
совпадающего с перепадами уровня сигнала

Команда Find Beats открывает подменю, представленное на рис. 4.7.
Воспользовавшись этим подменю, можно выделить фрагмент волновой фор-

мы, границы которого совпадают с перепадами уровня сигнала.
Иногда команду Find Beats называют функцией выделения границ тактов. При

работе с музыкальным материалом это действительно может соответствовать ис-
тине. В музыке (особенно современной) на границы тактов приходятся удары ба-

Find Next Beat (Left Side) 5hirt+[

Find N&J Beat (Right Side) 5hiFt+]

Beats Settings.,, Рис. 4.7. Подменю Find Beats
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Рис. 4.8. Пример волновой формы

рабанов, которые и идентифицируются программой как сильные перепады уров-
ня сигнала.

Проиллюстрируем применение команд подменю на примере. Допустим, в ва-
шем распоряжении имеется волновая форма, представленная на рис. 4.8.

На рис. 4.8 маркер находится недалеко от левой границы отображаемого участка
волновой формы. Для того чтобы выделить фрагмент, нужно определить положе-
ния его левой и правой границ. Применим команду Find Next Beat (Left). Сканиро-
вание происходит в направлении от начала к концу волновой формы. В результате
маркер переместится к ближайшему справа перепаду уровня (рис. 4.9). Это поло-
жение маркера отмечает будущую левую границу выделенного фрагмента.

Теперь применим команду Find Next Beat (Right). Программа отыщет ближай-
ший справа от маркера перепад уровня сигнала. Эта точка и будет правой грани-
цей выделенного участка. По окончании анализа вы увидите волновую форму с
выделенным фрагментом (рис. 4.10).

Даже на глаз видно, что границы выделенного фрагмента совпадают с момен-
тами перепадов уровня сигнала. Очень может быть, что мы отыскали границы такта
(или границы доли такта).

Согласитесь, рассматриваемая функция полезна. Она позволяет ускорить по-
иск характерных частей в фонограмме. Во всяком случае, приблизительные гра-
ницы тактов отыскать можно. А необходимые уточнения следует сделать на слух
или визуально (установив по оси времени масштаб, позволяющий вести деталь-
ное наблюдение волновой формы).
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Рис. 4.9. Результат применения команды Find Next Beat (Left)
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Рис. 4.10. Результат применения команды Find Next Beat (Right)
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Критерии, определяющие, что следует считать перепадом уровня сигнала, за-
даются с помощью окна диалога Beat Find Settings (рис. 4.11), которое открывает-
ся командой Beats Settings... подменю Find Beats.

Beat Find Settings \ -> :

Decibel Rise

Rise Time

ji о as Ж "
[a tns Cancel

Close

Рис. 4.11. Окно диалога Beat Find Settings

В окне диалога Beat Find Settings вы увидите две опции:

> Decibel Rise — значение перепада амплитуды (в децибелах), необходимое для
того, чтобы программа обнаружила границу доли (такта) при использова-
нии функции Find Beats

> Rise Time — интервал времени (в миллисекундах) в течение которого амп-
литуда должна повыситься на величину, установленную в Decibel Rise

4.11, Auto-Cue - определение границ фраз
или долей

Команда Auto-Cue открывает подменю, представленное на рис. 4.12.

AdiustiSelection to Phrase

Find Phrases and Mark

Find Beats and Mark.,.

Auto-Cue Settings...

Trim Digital Slence

Рис. 4.12. Подменю Auto-Cue

Команды этого подменю позволяют определить границы разговорных/музы-
кальных фраз или долей, а также задать критерии, согласно которым программа
будет искать эти границы.

Команда Adjust Selection to Phrase включает алгоритм поиска фразы внутри
выбранной области, по завершении работы которого происходит коррекция под-
светки .

Границы выделенного фрагмента перемещаются к границам обнаруженной
фразы. Тишина игнорируется. В список Cue List новые элементы не добавляются.

Команда Find Phrases and Mark включает алгоритм поиска внутри выбранной
области границ фраз, найденные границы отмечаются на экране, им присваива-
ются номера. Под этими номерами он и вносятся в список Cue List. В списке также
содержатся сведения о положении границ фраз на оси времени.
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Команда Find Beats and Mark включает алгоритм поиска внутри выбранной
области границ долей, найденные границы отмечаются на экране, им присваива-
ются номера. Под этими номерами они вносятся в список Cue List. В списке также
содержатся сведения о положении границ долей на оси времени, О применении
списка Cue List см. в гл. 5.

Команда Trim Digital Silence заменяет абсолютной тишиной (фактически удаляет)
участки волновой формы, находящиеся справа и слева от выделенного фрагмента.

Команда Auto-Cue Settings... открывает окно диалога (рис. 4.13), с помощью
опций которого следует задать критерии поиска границ фраз и долей.

1 Аи to - Си е Setti ritje

-Ллсйо «S be consideied "sibnce" when:

Signal is below

' foi mac than |14Q m?

Audio wibe conadaed as vaid vfr&n -

ЗйпаГваЬоче (-34 .dB.

For mote tfian 25 ms

Cancel

Рис. 4.13. Окно диалога Auto-Cue Settings

В группе Audio will be considered «silence* when: необходимо задать условия, при
выполнении которых программа будет считать проверяемый отсчет тишиной.

Если уровень сигнала ниже порога, заданного в децибелах в поле Signal is Belov,
и этот низкий уровень сохраняется дольше, чем указано в поле For more Than (в
миллисекундах), тогда данный фрагмент волновой формы будет считаться тиши -
ной.

Для высококачественной фонограммы порог можно установить равным -60 дБ.
Для более шумной записи, он может быть намного выше (примерно -30 дБ).

Если вы хотите чтобы слова, между которыми есть паузы, входили в одну фра-
зу, укажите в поле For more than достаточно большой интервал времени.

В группе Audio will be considered as valid when: задаются условия, при выполне-
нии которых программа будет считать, что проверяемый отсчет содержит полез-
ный звук.

Если уровень сигнала выше порога, заданного в поле Signal is above (в децибе-
лах), и этот высокий уровень сохраняется дольше, чем задано в поле For more Than
(в миллисекундах), тогда фрагмент волновой формы будет считаться звуком. Про-
тяженность временного интервала следует выбрать так, чтобы программа игнори-
ровала короткие всплески сигнала (например, щелчки, звуки шагов, ударов). Од-
нако если эта величина слишком высока (более 200 мс), короткие слова могут быть
пропущены.

Нажав кнопку Find Levels, вы приведете в действие алгоритм автоматического
выбора критериев выявления границ фраз для выделенного фрагмента волновой
формы.
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4.12. Snapping — выбор опций привязки границ
выделенного участка волновой формы
к координатной сетке

Команда Snapping открывает подменю, представленное на рис. 4.14.

^ 5nap to Cues

Snap tauter (Coarse)

Snap to RiJer (Fine)

Snap to Zero Crossings

Snap to Frames (Always)

Рис. 4.14. Подменю Snapping

Команды этого подменю облегчают процесс ручной привязки границ выде-
ленного фрагмента волновой формы к характерным точкам: либо к линиям шка-
лы времени (координатной сетке), либо к границам фраз/долей.

Выберите команду Snap to Ruler (Fine) и займитесь выделением фрагмента вол-
новой формы. Щелкните левой кнопкой мыши, и, не отпуская ее, медленно пере-
мешайте курсор мыши, например, вправо, Зона выделения будет расширяться, но
не всегда характер движения ее правой фаницы соответствует движению мыши.
Как только вы приблизите правую границу зоны выделения к очередной линии
координатной сетки, оставшийся небольшой интервал граница преодолеет скач-
ком. А при дальнейшем движении мыши она не сразу «отлепится» от линии коор-
динатной сетки. Этот алгоритм имитирует слабое «притяжение» границы зоны
выделения к линии координатной сетки.

Если же выбрана команда Snap to Ruler (Coarse), описанный процесс станет
еще заметнее: граница зоны выделения будет сильно «притягиваться* линиями
координатной сетки.

При выборе команды Snap to Cues граница зоны выделения «притягивается»
не к линиям координатной сетки, а к линиям, которыми после применения ко-
манды Auto-Cue отмечены границы фраз и долей.

Если выбрана команда Snap to Zero Crossing, то граница зоны выделения будет
испытывать тяготение к тем точкам, в которых волновая форма пересекает нуле-
вой уровень.

При монтаже звуковых треков видеофильмов очень удобен вариант Snap to Frames
(Always). В этом случае легко выделить фрагмент, совпадающий с границами кадров.

Если не выбрана ни одна из перечисленных команд, перемещение границы
выделенного участка строго соответствует движению курсора мыши в горизон-
тальном направлении.
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4*13, Group Waveform Normalize... - - совместная
нормализация нескольких волновых форм

Суть классической нормализации волновой формы состоит в таком измене-
нии значений всех ее отсчетов, что наибольший из них принимает заданное зна-
чение. Остальные отсчеты волновой формы при этом изменяются в той же самой
пропорции, в которой изменен наибольший отсчет. Приведем пример. На рис. 4 15
представлена волновая форма, состоящая из двух характерных частей, разделен-
ных паузой (участком, содержащим абсолютную тишину). Левый фрагмент зву-
чит тихо, так как его уровень мал. Наибольший из отсчетов этого фрагмента со-
ставляет -12 дБ. Правый фрагмент звучит громче, а его наибольший по величине
отсчет составляет -3 дБ.

Рис. 4.1 5. Пример волновой формы до нормализации

Если с помощью команды Effects > Amplitude > Normalize (см. гл. 6.) мы прове-
дем нормализацию всей волновой формы к уровню 0 дБ, то результат будет соот-
ветствовать представленному на рис. 4.16.

Видно, что размах волновой формы увеличился. Прослушав ее, мы убедимся,
что звук стал громче. Теперь наибольший из отсчетов левого фрагмента составля-
ет 9 дБ, а правого — 0 дБ. Так и должно быть, ведь нормализуя к 0 дБ отсчет, уро-
вень которого составлял —ЗдБ, мы фактически увеличили значения всех отсчетов
волновой формы (подняли уровень сигнала) на 3 дБ — 0 дБ - (-3 дБ).

Разобравшись в сущности классической нормапизаиии, перейдем к команде Group
Waveform Normalize..., которая позволяет в полуавтоматическом режиме совместно
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Не Eta View Effects Generate АГйугв Favorites Optior.s Wrido

Рис. 4.16. Результат нормализации волновой формы

нормализовать несколько открытых файлов с волновыми формами. Правда, в отли-
чие от классической процедуры, в данном случае нормализация осуществляется не
по максимальному значению отсчета, а по вычисленному для всех отсчетов волновой
формы среднеквадратическому значению, то есть, по реальной громкости сигнала.
В процессе рассматриваемой нормализации можно также осуществлять динамичес-
кую обработку сигнала и многополосную амплитудно-частотную коррекци ю.

Команда Group Waveform Normalize...повышает эффективность использования
персонального компьютера и вашего личного времени за счет того, что список
файлов, подлежащих обработке, составляется заранее, и пока программа выпол-
няет ваше задание, вы можете заниматься другими делами.

Однако советуем соблюдать осторожность и не увлекаться применением этой
команды до тех пор, пока хорошо не разберетесь в ее функционировании. Иначе
побочным результатом ваших неосознанных действий могут стать сильные искаже-
ния обработанных аудиосигналов. Особенно в тех случаях, когда выбранные для
совместной нормализации волновые формы значительно отличаются уровнями.

Команда Group Waveform Normalize... открывает одноименное окно диалога,
содержащее три вкладки: Choose Files, Analyze Loudness и Normalize.

Вкладка Choose Files представлена на рис. 4.17. Она предназначена для выбора
тех файлов с волновыми формами (из числа открытых), которые требуется под-
вергнуть совместной нормализации.

На вкладке показывается список всех открытых в настоящее время волновых
форм. Для выбора нескольких волновых форм нужно нажать клавишу <Shift> (либо
<Ctrl>) и выделить щелчками левой кнопкой мыши необходимые строки.
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iGroup Waveform Normalize

Step Т CfiuQte SQUrce fil«

CHORD.WAV
DopeOigati eel

NewAnnouncei.cd

TrapiDrurflLoop eel

_*!

Bun N mmatze

Close

Рис. 4.17. Вкладка Choose Files окна диалога Group Waveform Normalize

Работа с вкладкой Choose Files составляет первый шаг процесса подготовки к
нормализации — выбор файлов-источников обрабатываемого материала (Step 1:
Choose source files).

Второй шаг процесса носит название Step 2: Analyze selected files for loudness
information. Реализуется этот шаг с помощью вкладки Analyze Loudness (рис. 4.18),
которая позволяет проанализировать числовые значения ряда параметров, харак-
теризующих громкость выбранных волновых форм.

Group Waveform Могтайге

Step? ftec'ed FJes la business hfoimaiion

DopeO loaned
Fur*;Gwlai1 cd
ok (mastei).ww

ruydj .'Had.....'Avg j ftCte'J
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-12.73 -11.35 -Э.58 -10.86 05

Рис. 4.18. бкучадка Analyze Loudness окна диалога Group Waveform Normalize
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Для того чтобы начать анализ, нажмите кнопку Scan for Statistical Information.
Поскольку звуковой сигнал содержит в себе признаки случайного процесса, то

при работе с ним приходится использовать традиционные параметры, характери-
зующие именно случайные процессы. Одним из таких параметров является сред-
не квад рати ческое значение сигнала (RMS). Для его получения задают временной
интервал интегрирования, который, не изменяя своей длины, «скользит» вдоль
сигнала: начало интервала фиксируют в некоторой точке, проводят необходимые
измерения и расчеты, получают одно значение RMS, перемещают начало интер-
вала в следующую точку и т. д. Вычисляя каждое значение RMS, отсчеты сигнала,
попадающие в интервал интегрирования, возводят в квадрат и складывают. Далее
из суммы извлекают квадратный корень и в заключение делят полученное число
на количество отсчетов.

Понимание сути вычисления RMS в дальнейшем вам еще не раз пригодится, а
несколько числовых параметров, основанных на RMS, встретятся уже сейчас.

После того как программа проверит все отсчеты выбранных волновых форм, в
таблице появятся результаты анализа:

> Eq-Loud — кажущаяся громкость (вычисляется с учетом особенностей слу-
хового аппарата человека)

> Loud — реальная громкость
> Мах — максимальное значении RMS

Avg — среднее значение RMS сигнала
% Clip— процент клиппированных отсчетов

Примечание Percent over clipping when normalizing to the average of _ dB напоми-
нает о том, что в столбце % Clip* приводится процент клиппированных отсчетов с
учетом выбранного на вкладке Normalize уровня нормализации.

С помощью опций вкладки Normalize (рис. 4.19) реализуется третий шаг про-

Group Waveform Normalize
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Рис. 4.19. Вкладка Normalize окно диалоге Group Waveform Normalize
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цесса — выбор параметров нормализации выбранных файлов к одному и тому же
уровню громкости (Step 3: Normalize selected files to the same loudness level).

Рассмотрим опции данной вкладки.
В группе Normalization устанавливается способ выбора уровня, к которому бу-

дет производиться нормализация:

> Normalize to Average Level of Source Files — нормализация аудиофайлов с
использованием среднего уровня каждого из них

> Normalize to a Level of _ dB — нормализовать к уровню, заданному в поле
ввода (в децибелах)

Напомним, что действие команды классической нормализации Effects >
Amplitude > Normalize основано на том, что к заданному уровню приравнивается
пик — максимальное значение отсчета, встречающееся в выбранной волновой
форме. В отличие от этой команды, рассматриваемая процедура нормализации
оперирует не пиковыми, а среднеквадратическими (RMS) значениями отсчетов.

Если установлен флажок Use Equal Loudness Contour (mid frequencies more
important), то при нормализации будет осуществляться автоматическая коррекция
уровня нормализации различных частотных составляющих сигнала с учетом ли-
нии равной громкости [2]. Напомним, что слуховой аппарат человека менее чув-
ствителен к очень высоким и очень низким частотам и намного более чувствите-
лен к частотам в интервале 2 кГц —- 4 кГц. Линия равной громкости, по существу,
как раз и описывает зависимость чувствительности слуха от частоты. Разработчи -
ки рекомендуют не сбрасывать флажок Use Equal Loudness Contour (mid frequencies
more important). На практике это будет означать, что при нормализации высокочи -
стотные и низкочастотные составляющие будут усилены по сравнению со средне-
частотными.

Опции группы Out of Band Peaks позволяют выключить или включить ограниче-
ние сигнала в процессе нормализации, а также выбрать параметры ограничителя.

Если выбрана опция No Limiting (Clip), то ограничение сигнала производиться
не будет. В этом случае не исключено клиппирование сигнала в пиках из-за пере-
полнения разрядной сетки цифрового представления отсчетов звуковых данных.

Если выбрана опция Use Limiting, то перед нормализацией программа произ-
ведет динамическую обработку записанного аудиосигнала, а конкретно, его огра-
ничение. После этого пики сигнала окажутся сглаженными, а динамический диа-
пазон (см. гл. 6) суженным.

В том случае, когда выбран вариант обработки с ограничением, можно задать
два параметра виртуального ограничителя (лимитера).

1. Lookahead Time — интервал времени упреждения включения ограничителя
(в миллисекундах), который необходим, чтобы ослабить звук раньше, чем
возникнет громкий пик. При малых значениях (менее 5 мс) этого парамет-
ра могут возникнуть искажения. Значение по умолчанию составляет 12 мс.

2. Release Time — время выключения ограничителя: интервал времени, необ-
ходимый для перехода к нормальному усилению после завершения пика
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сигнала. Разработчики рекомендуют выбирать значение данного параметра
в окрестностях 100 мс, хотя по умолчанию установили 200 мс. При значи-
тельном увеличении Release Time может наблюдаться нежелательный по-
бочный эффект: громкость звучания участка волновой формы, следующего
непосредственно за пиком, будет меньше номинальной.

Подробнее о приборах динамической обработки и их параметрах можно про-
читать в [8, 30]. Речь об этом пойдет и в главе 6.

В группе Advanced имеется единственная опция: поле ввода Statistics RMS Width_ms.
В нем при желании можно изменить предусмотренную по умолчанию протяженность
временного окна (интервала интегрирования), в пределах которого производится ос-
реднение статистических данных о нормализуемой волновой форме.

А теперь возвратимся к вкладке Analyze Loudness (см. рис. 4.18). Двойным щел-
чком на любом из файлов в списке вы можете открыть окно диалога Advanced
Statistical Report (рис. 4.20), в котором статистические данные о звуковых отсче-
тах представлены в графической форме.

В окне располагаются два графика:

Advanced Statistical Repoii - ob (master ).wav

Loud
[Peek Clustei
MaxFtMS

UvgRMS
SMinRMS
iToWRMS
Peak Amp
Е»Я Range
Used Range

Рис. 4.20. Окно диалога Advanced Statistical Report

Complete RMS Histogram — гистограмма распределения, которая показывает
относительные количества звуковых отсчетов, соответствующих каждому значе-
нию уровня громкости. Об использовании информации, содержащейся в гистог-
рамме, для выбора параметров динамической обработки читайте в гл. 8.

В левом нижнем углу окна располагается диаграмма Clipping Profile, которая
показывает, сколько (в процентном отношении) отсчетов сигнала окажутся клип-
пированными при увеличении уровня сигнала от 0 до значения, соответствующе-
го выбранному уровню нормализации.
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В поле Statistics для режима Normal представлены следующие статистичес-
кие данные:

> Loud — громкость
> Peak Cluster — локальный максимум гистограммы, ближайший к максималь-

ному значению RMS сигнала
> Max RMS — максимальное значение RMS сигнала
> Avg RMS — среднее значение RMS сигнала
> Min RMS — минимальное значение RMS сигнала
> Total RMS — суммарное значение RMS сигнала
> Peak Агар — максимальная амплитуда сигнала
> Dyn Range, Used Range — динамический диапазон сигнала

Для режима Eq-Loudness в таблице представлены значения только двух пара-
метров: Loud и Peak Cluster.

Итак, осталось закрыть окно диалога Advanced Statistical Report, открыть вкладку
Normalize и нажать кнопку Run Normalize.

4.14. Adjust Sample Rate — изменение частоты
дискретизации

Команда Adjust Sample Rate... позволяет изменить частоту дискретизации. Этой ко-
мандой открывается окно Adjust Sample Rate (подобное окну New \\kveform, представ-
ленному на рис. 2.7), в котором вы можете задать новую частоту дискретизации. На-
пример, если первоначально аудиофайл был записан с частотой дискретизации 44 3 00 П [,
и вы изменили частоту на значение 22 050 Гд, то при воспроизведении тон звука будет
ниже на одну октаву, а длительность фонограммы увеличится в два раза, т. е. теперь вол-
новая форма воспроизводится со скоростью в два раза ниже первоначальной,

Данная команда не производит никаких преобразований отсчетов, а просто изме-
няет информацию о частоте сэмплирования, которая хранится в звуковых файлах.

Выбирать значения частот дискретизации можно только из числа тех, которые
поддерживаются вашей звуковой картой.

4.15. Convert Sample Type.,. — преобразование
типа сэмплирования

Выбор команды Convert Sample Туре... (конвертировать, или преобразовать тип
сэмплирования) вызывает появление окна диалога, изображенного на рис. 4.21.

В отличие от предыдущей команды, эта команда никак не влияет ни на дли-
тельность звучания волновой формы, ни на высоту звука. Единственное, что мо-
жет измениться (хотя и не всегда), — это качество записи, причем в худшую сто-
рону. Сейчас вы поймете почему.
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Рис. 4.21. Окно диалога Convert Sample Type

В группе Sample Rate можно задать новую частоту дискретизации для звуковых
данных.

Если новая частота выше старой, то на качестве звучания волновой формы это
не скажется. Оно будет определяться той частотой, с которой производилось пер-
воначальное сэмплирование. Ведь никакой новой информации о поведении зву-
ковой волны при этом не прибавится.

Если задать новую частоту ниже, чем частота, с которой производилась запись.
то сузится частотный диапазон звукового сигнала (пропадут верхние частоты).

Подробное описание окна диалога Convert Sample Type приведено в разд. 3.8.
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МЕНЮ VIEW - УПРАВЛЕНИЕ
ОТОБРАЖЕНИЕМ

В меню View входят команды и подменю, с помощью которых осуществляется
управление отображением элементов интерфейса программы:

> Multitrack View — включить мультитрековый режим редактирования
> Waveform View — включить режим просмотра и редактирования пары сте-

реотреков (или одного монотрека)
> Spectral View — включить режим просмотра и редактирования мгновенного

спектра сигнала
> Show Organizer Window — показать панель органайзера
> Show Cue List — открыть окно диалога Cue List / Ranges
> Show Play List — открыть окно диалога Play List
> Show Transport Buttons — показать транспортную панель
> Show Zoom Buttons — показать панель управления масштабом отображения

волновых форм
> Show Time Window — показывать окно отображения текущего времени
> Show Sel/View Controls — показать панель управления выделением и ото-

бражением волновых форм
> Show Level Meters — показать измеритель уровня сигнала
> Show a Placekeeper — показать панель-раздлитель
> Display Time Format — подменю выбора формата отображения времени
> Vertical Scale Format — подменю выбора формата вертикальной шкалы
> Toolbars — подменю для выбора отображаемых панелей инструментов
> Status Ваг — подменю для выбора элементов, отображаемых в строке статуса
> Wave Properties... — открыть окно свойств волновой формы
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Работу в мультитрековом редакторе (Multitrack View) мы рассмотрим в главе
12. Все, о чем мы рассказывали до сих пор, происходит в режиме Waveform View.
С панелями главного окна, которые открываются командами Show Transport
Buttons, Show Zoom Buttons, Show Time Window, Show Sel/View Controls, Show Level
Meters, вы познакомились в главе 2. О применении остальных подменю и команд
меню View речь пойдет сейчас.

5.1, Spectral View — отображение мгновенного
спектра сигнала

Команды Multitrack View, Waveform View и Spectral View переключают режим
отображения звуковой информации. Первому из перечисленных режимов посвя-
щена глава 12. Со вторым режимом вы уже знакомы, в нем мы работали до сих
пор. В этих двух режимах звук представляется в виде волновых форм.

В третьем режиме отображается мгновенный спектр сигнала в виде градаций
яркости и цвета. О спектральной форме представления сигнала и, в частности, о
мгновенном спектре детально рассказывается в книге [8]. Здесь же ограничимся
лишь пояснением основных терминов.

5.1.1. Классический спектр
Начать разбираться в сущности спектральных представлений лучше с разло-

жения в ряд Фурье периодического сигнала. Всякая периодическая функция (с ог-
раничениями, носящими абстрактный характер) может быть представлена в виде
разложения в ряд по тригонометрическим функциям

-фй). (5Л)

Таким образом, периодическая функция s(t) представлена суммой слагаемых,
каждое из которых есть не что иное, как косинусоидальное колебание с амплиту-
дой СА и начальной фазой <pk.

Совокупность коэффициентов Ck называется амплитудным спектром сигнала,
a npk — фазовым спектром.

Частоты всех синусоидальных колебаний, из которых составляется периоди-
ческая функция s(t), кратны основной частоте F= 1/T. Отдельные составляющие
называются гармониками. Колебание с частотой /•'называется первой гармоникой
(/с = 1), с частотой 2/г— второй гармоникой (к = 2) и т. д.

Ряд Фурье дает разложение периодической функции по тригонометрическим
функциям. Это разложение можно применить и к непериодической функции,
которую рассматривают как предельный случай периодической функции при
неограниченном возрастании периода.

Если Т —* °°, то F-ъ df, а 2я&/7~-> со (параметр ш — круговая текущая частота,
изменяющаяся непрерывно). Не хотелось бы здесь рассказывать подробно обо всех
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математических преобразованиях, которые необходимо выполнить при таком пре-
дельном переходе. Поэтому сразу приведем итоговые формулы, которые являют-
ся основными соотношениями теории спектров. Они представляют собой пару
преобразований Фурье, связывающих между собой две функции: вещественную
функцию времени s(t) и комплексную функцию частоты G((u):

= — J<7( (5.2)

(5.3)

Формула (5.2) называется интегралом Фурье в комплексной форме. В данном слу-
чае предполагается, что функция непериодическая, поэтому она может быть пред-
ставлена только суммой бесконечно большого числа бесконечно близких по час-
тоте колебаний с бесконечно малыми амплитудами.

Если ряд Фурье представляет периодическую функцию суммой хотя и беско-
нечного числа синусоид, но с частотами, имеющими определенные дискретные
значения, то интеграл Фурье представляет непериодическую функцию суммой
синусоид и косинусоид с непрерывной последовательностью частот. Иногда гово-
рят, что в составе непериодического сигнала есть колебания всех частот. В случае
непериодического сигнала говорить об амплитудах отдельных спектральных со-
ставляющих нет смысла, т. к. это бесконечно малые величины. На самом деле па-
раметр G(co) выражает не непосредственно амплитуду, а так называемую спект-
ральную плотность. Обычно эту деталь опускают и называют G(co) комплексным
спектром непериодической функции, а абсолютное значение этой величины -
просто спектром.

В специальной литературе можно найти теоремы, позволяющие облегчить спек-
тральные преобразования сигналов, а также соотношения и графики, описываю-
щие спектры сигналов различной формы.

5. 1 .2. Текущий спектр
Классическое определение спектра основывается на преобразовании Фурье,

причем интегрирование по времени выполняется в бесконечных пределах и спектр
зависит только от частоты. Однако бесконечная длительность какого-либо про-
цесса — это абстракция, не имеющая ничего общего с реальностью.

Если анализируемая функция есть отображение некоторого реального физичес-
кого процесса, то сведения о функции G((o) мы получаем лишь в результате наших
наблюдений. Следовательно, при вычислении спектра мы можем выполнить ин
тегрирование лишь от момента начала анализа до текущего момента времени /.

Текущий спектр определяется как результат преобразования Фурье, но с перемен-
ным верхним пределом интегрирования, в качестве которого фигурирует текущее вре-
мя. Поэтому текущий спектр является функцией не только частоты, но и времени.
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В начале раздела мы воспользовались понятием периодической функции. На
самом деле периодическая функция —лишь весьма полезная математическая аб-
стракция. Ведь всякий природный процесс имеет начало и конец,

Принято называть реальный циклический процесс периодическим, если он
длится достаточно долго. Мерилом длительности служит число «периодов», кото-
рое должно быть намного больше единицы. Периодичность процесса проявляет-
ся лишь с течением времени, когда прорисовываются его характерные черты. Те-
кущий спектр и отражает это развитие процесса.

Спектр процесса (за короткий отрезок времени) однороден, так как короткий
отрезок процесса — это просто короткий одиночный импульс. Если в дальнейшем
происходит периодическое повторение некоторого цикла явления, то в текущем
спектре начинают формироваться максимумы на основной частоте и ее гармони-
ках. Эти пики становятся все более острыми и высокими, а значение спектральной
плотности в интервалах между максимумами убывает и при / ->»(сплошной теку-
щий спектр вырождается в линейчатый спектр периодического процесса [8,33,34],

Конечно, и при достаточно большой (не обязательно бесконечной) длительнос-
ти процесса пики делаются настолько узкими, что их можно трактовать как линии.

Таким образом, периодический процесс — это предел, к которому может стре-
миться с течением времени реачьн ый повторяющийся процесс. Аналогично и спектр
(в его классическом определении) такого процесса есть предел, к которому стре-
мится текущий спектр при увеличении времени интегрирования до бесконечности.

Проиллюстрируем сказанное примером текущего спектра синусоидального
колебания.

При интегрировании в бесконечных пределах спектр синусоиды представляет
собой единственную линию на частоте, равной частоте этой синусоиды (рис. 5.1).

Рис. 5,1. Спектр
синусоидального
сигнала при
интегрировании на
интервале,
стремящемся к
бесконечности
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Но как на практике измеряется текущий спектр, например, той же синусоиды?
Мы включаем анализатор спектра, а спустя какое-то время выключаем его. Полу-
чается, что измеряется не спектр бесконечного синусоидального колебания, а
спектр его более или менее протяженного отрезка. Это значит, что фактически
исследуется спектр прямоугольного импульса с синусоидальным заполнением.
Сказанное объясняет причину того, что даже для синусоидального колебания при
уменьшении времени интегрирования спектральная линия расширяется, появля-
ются боковые лепестки спектральной функции, ее нули все более удаляются друг
от друга (рис. 5.2). Ведь именно так и должен вести себя спектр прямоугольного
импульса при уменьшении его длительности [8, 34].

Рис. 5.2. Спектр
прямоугольного
импульса конечной
длительности с
синусоидальным
заполнением

Таким образом, текущий спектр в большей степени отражает свойства сигна-
лов, проявляющиеся в реальных условиях их генерирования и обработки, нежели
спектр, полученный на бесконечном временном интервале.

5.1.3. Мгновенный спектр

Текущий спектр — только мостик от частотного к временному описанию про -
цесса. Представьте себе, что вы анализируете текущий спектр от начала до конца
музыкального произведения, не слыша его. Вполне возможно, вы получите такой
график спектральной функции, что в среднем за время анализа спектр будет выг-
лядеть относительно широким. Рассматривая график можно прийти, например, к
следующему выводу: произведение исполняется одновременно на нескольких
инструментах. В тембре звучания одних инструментов преобладают низкочастот-
ные, других — средне- и высокочастотные составляющие.

Потом вы выводите сигнал на акустическую систему и... оказывается, что это
запись дуэта мужчины и женщины в сопровождении фортепиано. На самом деле

5 Зак MS2
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тембр звука периодически меняется. Пока звучит баритон, в нем преобладают бар-
хатные низкочастотные составляющие, а когда диалог продолжает сопрано, ка-
жется, что звенит колокольчик. Но все эти нюансы оказались усреднены, сглаже-
ны, завуалированы в ходе спектрального анализа.

Для чего же нужны тогда все эти измерения спектра, если они не дают досто-
верной картины реального развития тембра музыкального произведения? На ос-
нове такого анализа трудно построить детальную стратегию последующей обра-
ботки фонограммы. Все дело в том, что не только спектр, вычисленный на
бесконечном временном интервале, но и текущий спектр — слишком грубый ин-
струмент в тех случаях, когда анализируемый процесс не стационарен. Для того
чтобы сблизить частотное и временное представления сигнала, было введено по-
нятие мгновенный спектр. Мгновенный спектр — это спектр короткого отрезка
процесса длительностью Л Г, непосредственно предшествующего данному момен-
ту времени л

В этом определении мы имеем дело со скользящим интегрированием: интер-
вал интегрирования имеет постоянную длину, но перемещается по оси времени.
А вот относительно текущего времени этот интервал расположен неизменно.

Страшно далеко это определение спектра от того, что давно придумали великие
математики. И все же в руках звукорежиссера именно мгновенный спектр является
наиболее эффективным инструментом анализа свойств записываемого или уже за-
писанного звука. Все дело в том, что реальные звуковые сигналы, с которыми нам
приходится сталкиваться, одинаково непохожи на обе крайние математические аб-
стракции — бесконечное во времени сверхузко полосное синусоидальное колеба-
ние и бесконечный в частотной области (сверхширокополосный) белый шум.

Музыка, которую создают с помощью синтезатора, отличается особенно за-
метной нестационарностью тембра. Может быть, именно поэтому в звуковых ре-
дакторах уже давно используются средства анализа мгновенного спектра. В этом
вопросе создатели музыкального программного обеспечения, можно сказать, опе-
редили радиоинженеров. Во всяком случае, если перелистать современные учеб-
ники по теории сигналов, то упоминание понятия «мгновенный спектр» едва ли
обнаружится хотя бы в каждом десятом из них.

5.1.4. Сколько весит спектр?
Вы познакомились с тремя подходами к вычислению спектра, и даже вынуж-

дены были вникать в непростые математические соотношения. Но это еще не
финал. Продолжим погружение в суть спектральных преобразований. И вновь речь
пойдет о влиянии времени на результаты спектрального анализа.

Как вычисляется одна-единственная точка графика спектра? Исчерпывающий
ответ на этот вопрос дают формулы. Хочется, однако, чтобы их вид не приводил
вас в состояние священного трепета. Главное, чтобы вы понимали их смысл, по-
этому попытаемся разъяснить обычными словами то, что записано математичес-
кими символами.

Итак, сначала выбирается частота Г0. Реальный или виртуальный генератор фор-
мирует синусоиду этой частоты и условно единичной амплитуды. Исследуемый
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сигнал нормируется по амплитуде. Начиная с какого-то определенного момента
to, с шагом At (чем меньше At, тем лучше) в моменты времени t0, tj, /j, tj,..., /,-,..., f j V _ j
с этой синусоидой и исследуемым сигналом проделываются следующие операции:

> Берется отсчет синусоиды
> Берется отсчет исследуемого сигнала
> Эти отсчеты перемножаются
> Результаты перемножения суммируются с накоплением

В некоторый момент процесс измерения спектра на частоте /0 завершается.
Накопленная сумма делится на общее число отсчетов. Вычисленное значение G(fo)
запоминается и, возможно, отображается как одна точка графика. Затем накоп-
ленная сумма обнуляется, значение частоты изменяется на величину Л/(выбира-
ется новое значение частоты//). И вся последовательность операций повторяется
до тех пор, пока «пробежкой» по ряду частот/0,//,/2,...,./лг../не будет перекрыт весь
заданный диапазон.

Описанная выше процедура вычисления спектрального коэффициента одно-
временно есть не что иное, как вычисление взаимокорреляционной функции ис-
следуемого сигнала и синусоиды заданной частоты. Иными словами, в процессе
вычисления спектральной составляющей выясняется степень сходства исследуе-
мого сигнала со стандартным (базисным) сигналом, в данном случае с синусои-
дой. Или можно сказать еще и так: выясняется, в какой пропорции синусоида «со-
держится» в исследуемом сигнале.

Если исследуемый сигнал уже записан, и в нашем распоряжении есть цифро-
вой анализатор спектра, способный сколь угодно долго хранить результаты про-
межуточных вычислений, то измерение текущего спектра и мгновенного спектра
вполне осуществимо по описанной выше процедуре.

Все значительно сложнее, когда анализ ведется в реальном времени. В самом
деле, допустим, что одна спектральная составляющая вычислена. Изменяем час-
тоту синусоиды и хотим приступить к вычислению следующей спектральной со-
ставляющей. Но анализируемый фрагмент сигнала остался в прошлом. Его не
повторить. Поэтому вторая спектральная составляющая будет вычислена для вто-
рого фрагмента сигнала, третья — для третьего и т. д. Это уже не текущий спектр,
а просто разрозненный набор отдельных спектральных коэффициентов, каждый
из которых в ничтожно малой степени характеризует совершенно разные и, воз-
можно, не связанные между собой фрагменты сигнала. Получается примерно сле-
дующее: вместо того, чтобы в деталях рассмотреть одну картину, мы увидели по
одной точке на каждой из картин Эрмитажа.

Конечно, спектральный анализ можно проводить по параллельной схеме, од-
новременно вычисляя множество значений спектральной функции для различ-
ных частот. Однако это в значительной степени усложнит аппаратуру.

Уместен и такой вопрос: насколько адекватен описанный математический ал-
горитм тому спектральному анализу, который проводится реальными анализато-
рами спектра, и тому который выполняется органами слуха и мозгом человека?
Ответ: не вполне.
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Основная проблема состоит в том, что прибор, анализирующий спектр, и че-
ловек обладают конечной памятью. Былые события,, подробности хода любого
процесса постепенно стираются из нее. Это означает, что чем более удалены в про-
шлое отсчеты анализируемого сигнала, тем меньший вклад они вносят н накопле-
ние той самой суммы произведений отсчетов, которая, в конце концов, определя-
ет значение спектрального коэффициента.

Учет реальных свойств памяти анализаторов спектра осуществляется с помо-
щью весовых функции. Весовая функция описывает зависимость вклада предше-
ствующих отсчетов исследуемого сигнала в вычисляемый спектр. Наглядное пред-
ставление о весовой функции дает форма так называемого спектрального окна.

Тот спектральный анализ, о котором мы вели речь до сих пор, соответствует
спектральному окну прямоугольной формы: весовая функция равна единице в
пределах спектрального окна и равна нулю вне его. При анализе текущего спектра
начало спектрального окна совпадает с началом отсчета времени, а конец прихо-
дится на текущий момент времени. Текущее время идет вперед, правая граница
спектрального окна смещается, поэтому каждому конкретному моменту времени
завершения анализа соответствует своя ширина спектрального окна. Если вычис-
ляется мгновенный спектр, то спектральное окно скользит вдоль оси иремени, не
изменяя своей ширины.

Однако в большей степени суть реального спектрального анализа отражает эк-
споненциальная весовая функция. Кстати говоря, экспонента и синусоида — пря-
мо-таки магические функции. Многие существующие в природе колебательные
процессы описываются экспонентой при их возникновении и затухании, а сину-
соидой — на этапе продолжительного существования. В частности, по экспонен-
циальному закону затухают колебания в колебательном контуре, который служит
основой реальных анализаторов спектра, т, е. как раз по экспоненте колебатель-
ный контур «забывает» величину спектральной составляющей, некогда возбудив-
шей его. И именно по экспонен икать ному закону стирается в памяти человека
информация о прошедших событиях.

Прямоугольное и экспоненциальное спектральные окна используючтся при
вычислении спектра наиболее часто. Первое соответствует идеальному анали-
затору с бесконечно большой памятью, второе удачно отражает свойства чело-
веческого мозга и реальных анализаторов спектра на основе резонансных филь-
тров. Вместе с тем, хотя не столь широко, применяются и другие весовые
функции. Трудно дать конкретные рекомендации по поводу предпочтительно-
сти использования той или иной весовой функции для спектрального анализа
звуковых сигналов (за исключением экспоненциальной функции, о пользе ко-
торой сказано уже достаточно). Пожалуй, единственный совет может состоять
в том, что следует остановиться на какой-то одной весовой функции. Только
тогда у вас будет уверенность в том, что различия результатов анализа обуслов-
лены различием свойств сигналов, а не методов расчета. Целесообразно также
выбирать одну и туже весовую функцию, когда при работе с одним и тем же
сигналом вы решаете несколько задач, в которых применяются спектральные
преобразования.
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5.1.5. Отображение мгновенного спектра в Cool Edit Pro

Команда View > Spectral View включают режим отображения мгновенного спек-
тра сигнала в виде градаций яркости и цвета (рис. 5.3).

К Untitled* - Cool Edit Pro
£dit View Effiecjs generate analyze Favoptes Options J îndaw ЦЫ

(Ш647 -44100-16-bit-Mono 15 87 MB )1344MBftee

Рис. 5.З. Представление звукового сигнала в виде мгновенного спектра

О чем говорит картинка, которую мы видим в режиме Spectral View? Как можно
использовать информацию, полученную путем наблюдения мгновенного спектра1J

По горизонтальной оси отложено время, по вертикальной — частота. Цвет
и яркость отображения зависят от уровня спектральной составляющей в ана
лизируемой волновой форме на той или иной частоте (чем ярче — тем выше
уровень).

Рассматривая спектральную диаграмму, можно составить представление о ча-
стотной области сосредоточения основной доли энергии сигнала в различных точ-
ках волновой формы. Эта информация полезна при сведении нескольких треков в
микс. Желательно, чтобы спектры сигналов треков существенно не перекрыва-
лись по частоте. Добиться этого можно путем фильтрации. В процессе обработки
сигналов фильтрами можно увидеть и сравнить с помощью спектральных диаг-
рамм спектр сигнала, полученного в результате обработки, со спектром исходно-
го сигнала и, тем самым, оценить, верно ли ведется обработка.
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Чрезвычайно важно то обстоятельство, что Cool Edit Pro в режиме Spectral View
позволяет не только наблюдать за спектром сигнала, но и редактировать волно-
вую форму. Не понравившийся вам чем-либо фрагмент можно выделить и осно-
вательно с ним поработать (вплоть до вырезания).

В качестве примера на рис. 5.4 показан мгновенный спектр небольшого участ-
ка волновой формы. Для того чтобы лучше разглядеть детали, масштаб увеличен.

Это мгновенный спектр сигнала, представляющего собой дикторский текст
к одному из выпусков нашей радиопередачи «Музыкальный компьютер». Обла-
сти с относительно широким спектром соответствуют словам, с узким — паузам
между ними. Видно, что в начале второго слова (правее маркера) мгновенный
спектр шире, чем средний спектр всего слова. В этом месте наблюдается некий
неестественный, подозрительный выброс, пик спектральной функции. Широ-
кий спектр всегда соответствует быстрому перепаду значений сигнала или ко-
роткому импульсу. Скорее всего, в этом месте есть щелчок. В принципе, можно
было бы выделить участок, посредине которого находится этот пик, подравнять
область выделения по нулевым уровням сигнала и нажать клавишу <Delete>.
Щелчок был бы удален. Когда вы наберетесь опыта, в подобных случаях можно
так и поступать. А пока нелишним будет посмотреть на предполагаемый пик.
Для этого вменю View выберем команду Waveform View. В главном окне появится
знакомое изображение звуковой волны (рис. 5.5), Отображается тот же фрагмент

Рис. 5.4. Пример мгновенного спектра, содержащего аномалию
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волновой формы, спектр которого мы видели на рис. 5,4, причем маркер не из-
менил своего местоположения.

А вот и «герой нашей повести» — маленький остренький пичок правее марке-
ра. Конечно, когда знаешь, что и где искать, найти это не очень трудно. Но пред-
ставьте себе, что мы пытались бы заметить этот выброс, просматривая звуковую
волну. Скорее всего, даже если искать очень тщательно и неспешно, он бы так и
остался незамеченным.

Может быть, ничего страшного и не произошло бы, пропусти мы эту ано-
малию? Чтобы ответить на этот вопрос, достаточно прослушать участок вол-
новой формы, включающий обнаруженный объект. Звучит он очень неприят-
но; «плямк» — звук при резком размыкании губ, склеившихся в паузе между
словами.

Изучая спектральное представление, можно обнаружить любые ненормаль-
но быстрые перепады значений сигнала. Часть из них может быть вызвана вне-
шними причинами: щелчки, трески, дефекты речи и т. п. Иногда скачки значе-
ний отсчетов появляются в самой программе в результате неграмотного монтажа
фонограммы. Например, монтируются фрагменты разных сигналов, и хотя бы
один из них имеет постоянное смещение или сверхнизкочастотную составляю-
щую. Или при нарезке фрагментов звукооператор не позаботился о том, чтобы
точки разрезов совпадали с нулевыми точками звуковой волны.

F05 О 4.«dy-Cool Edit Pro
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Рис. 5.5. Загадочный пик обнаружен



Глава 5

5.2. Show Organizer Window — панель органайзера
Командой View > Show Organizer Window открывается панель органайзера,

предназначенная для создания комфортной обстановки при работе с файлами и
эффектами.

Панель напоминает записную книжку, в которую всегда можно подсмотреть,
чтобы освежить в памяти некоторые детали редактирования волновых форм. Но
самое главное состоит в том, что посредством панели Organizer, не обращаясь к
главному меню, можно выполнить очень много операций.

Панель составляют три вкладки:

> Files — опции работы с файлами
> Effects — вызов окна эффекта
> Favorites — вызов операций-фаворитов

5.2.1. Вкладка Files - опции работы с файлами
Вкладка Files панели Organizer представлена на рис. 5.6.
Основную часть вкладки Files занимает поле, в котором отображаются имена

открытых файлов. В верхней части вкладки расположены кнопки

А йд1, нажимая которые можно выполнить несколько наиболее

«популярных» операций с файлами.

Organizer

Рис. 5.6. Панель Organizer, вкладка
Files
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(Open File) — открыть файл.

(Close Files) — закрыть файлы, выделенные в списке на вкладке Files.

(Insert Into Multitrack) — вставить выделенные файлы в мультитрековый ре-
дактор. В процессе вставки программа может запросить у вас разрешение на пре-
образование формата файлов.

(Edit File) — сделать текущей (отображаемой и доступной для редактирова-
ния) страницу с файлом, выделенным в списке. Кнопка недоступна, когда в спис-
ке выделен файл, отображенный на текущей странице. Переключаться между стра-
ницами можно также двойными щелчками на именах необходимых файлов в
списке.

i
(Advanced Options) — включение дополнительных опций вкладки.

Вид вкладки Files после включения дополнительных опций представлен на рис. 5.7.
В левой нижней части вкладки находится фильтр типов файлов, отображае-

мых в списке. Предполагается, что вы можете работать с аудио-, MIDI- и видео-
файлами. В списке будут отображены имена файлов только тех типов, которые вы
пометите галочкой в группе Show File Types: .

Рис. 5.7. Панель Organizer, вкладка
Files, включены дополнительные опции
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В раскрывающемся списке Sort By: выбирают признак, по которому файлы
будут упорядочены (отсортированы) в списке.

Если нажата кнопка Auto-Play, то при выделении очередного файла в списке он
будет автоматически воспроизведен.

При нажатой кнопке Full Patchs кроме имен и расширений файлов в списке
будут также отображаться полные пути к ним.

5.2.2. Вкладка Effects - вызов окна эффекта
На вкладке Effects (рис. 5.8) панели Organizer представлен список эффектов,

доступных программе Cool Edit Pro 2.

Dynamics Processing

Envelope

Hard Limiting

TJormdce

Generate DTf-F Signals

Chorus
Oekry

Dynamic Delay
Echo

Echo Chamber

Ranger

Рис. 5.8. Панель Organizer, вкладка Effects

Для вызова окна эффекта нужно щелкнуть на его имени в списке. О работе с
эффектами, доступными в режиме Waveform View, рассказывается в гл. 6. С не-
сколькими встроенными эффектами, работающими в мультитрековом редакторе,
мы познакомим вас в гл. 12.

Система организации списка зависит от состояния кнопок Group By Category и
Group Real-Time Effects.

Если ни одна из кнопок не нажата, то все доступные эффекты перечисляются в
списке в алфавитном порядке (в пределах подгруппы) — см. рис. 5.8.

При нажатой кнопке Group By Category эффекты оказываются сгруппирован-
ными по признаку функционального предназначения (рис. 5.9).

Если нажать кнопку Group Real-Time Effects, то группы эффектов будут представ-
лены в виде дерева, имеющего три ветви. Опустившись на нижний иерархический
уровень, вы обнаружите там перечень эффектов. Те эффекты, имена которых выделе-
ны более ярким цветом {рис. 5.10), могут быть применены и реальном времени.
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Рис. 5.9. Панель Organizer, вкладка Effects,
нажата кнопка Group By Category

Рис. 5.10. Панель Organizer, вкладка Effects,
нажата кнопка Group Real-Time Effects

5.2.3. Вкладка Favorites — вызов операций-фаворитов
Вкладка Favorites (рис. 5.11) панели Organizer предназначена для вызова опери

иий-фаворитов.

1 Organizer

Effects
Reverb
Chorus
Edit
Compressor
filter

^Scripts
•Crossfada '
Tool

•Son»

Word

Рис. 5.11. Вкладка Favorites панели Organizer

Под операциями-фаворитами понимаются те функции редактирования, эф-
фекты, сценарии обработки и внешние программы, которыми вы чаше всего
пользуетесь. У вас есть возможность сосредоточить команды вызова фаворитов в
одном списке и в одном меню. О том, как это сделать, вы узнаете в гл. 9, когда,
описывая главное меню, мы дойдем до меню Favorites.
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Сейчас ограничимся замечанием о том, что меню Favorites и вкладка Favorites
панели Organizer полностью дублируют друг друга. А окно диалога, предназна-
ченное для редактирования списка фаворитов, можно открыть как из меню
Favorites, так и с одноименной вкладки панели Organizer. Для этого следует вос-
пользоваться либо кнопкой Edit Favorites..., расположенной на вкладке Favorites
панели Organizer, либо командой Edit Favorites..., которую вы обнаружите в меню
Favorites.

5.3. Show Cue List — редактирование
списка отметок

Следующая команда меню View — Show Cue List — вызывает окно диалога
Cue List, показанное на рис. 5.12.

Рис. 5.12. Окно диалога
Cue List

Cue List — это список отметок (временных установок), присутствующих в зву-
ковом файле. Такими отметками, например, являются начален конец лупа, нача-
ло и конец выделенной области или просто позиция курсора. Используя список
отметок, два раза щелкнув кнопкой мыши на нужной вам отметке, можно быстро
переместиться в соответствующую позицию волновой формы. Максимальное чис-
ло отметок в списке — 96.

На рис. 5.12 список отметок чист. Но стоит вам, например, создать петлю
(см. разд. 5.10.4), как она автоматически попадет в этот список. Чтобы сохра-
нить в списке отметок позицию маркера или выделенную область, нажмите
кнопку Add (добавить новую отметку). На рис. 5.13 мы создали шесть времен-
ных отметок.
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2;3i,OQ2 ' 2:59.999 0:28,997 Basic .,Lou*i

L:-G.4dB@ 1:5S.S26 144100 16-t*' Steeo : 43.88MB 3225GBftee

Рис. 5.13. Пример списка отметок

Все созданные с помощью окна Cue List отметки отображаются в главном окне
программы в виде вертикальных пунктирных линий, пересекающих волновые
формы, и цветных флажков (красный флажок соответствует началу выделенного
интервала, синий — концу) или треугольных стрелок (если помечен не интервал,
а позиция).

Как видно из рисунка, отметки отсортированы в порядке возрастания време-
ни. Но, воспользовавшись кнопками, расположенными в верхней части окна,
порядок можно изменить;

> Label — в алфавитном порядке имен отметок
> Begin — в порядке возрастания значений начальных моментов выделенных

интервалов или моментов расположения отметок
> End — в порядке возрастания значений конечных моментов выделенных

интервалов
> Length— в порядке возрастания длительности выделенных интервалов
> Туре — в алфавитном порядке названий типов отметок
> Description — в алфавитном порядке примечаний

Нажав кнопку Del, можно удалить текущую отметку из списка. С помощью
кнопки Merge можно объединить несколько отметок в одну. Для этого их предва-
рительно нужно выделить в списке.
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Нажав кнопку Auto-Play, вы включите воспроизведение волновой формы, при-
чем начнется оно с момента, в котором установлена выделенная отметка, или с
начала текущего выделенного интервала.

Кнопкой Edit Cue Info вид окна Cue List преобразуется (рис. 5.14).

Verse I
Refrain 1

0:17.293 0:53.146 0:35,852 Basic Calmly
0:53,146 1-55-993 {'№.S*7 Basic
1:31 .Ш1 3:do.QOO 1:23.993 " Basic Loudly'

"Y:S6"837 "2:32.268 '"о'йБ^ЗО Basic
j::i7.:j4 0:00,000 Baste
4:00,000 0:00.000 Basic

Рис. 5.14. Окно Cue List

в режиме редактирова-

ния атрибутов отметок

Begtn |'31 ОСИ

End З'ОО 000
Type Basic

Length 1'28.99:3

Label Refrain 2

По умолчанию отметки обозначаются словом Cue и их порядковым номером.
Однако для каждой из отметок в поле данных Label можно задать произвольное
название. Например, на рис. 5.13 помечены куплеты (Verse I, Verse 2) и припевы
(Refrain I, Refrain 2) песни.

В поле Desc можно сделать примечание, например, указать стиль исполнения
того или иного фрагмента песни,

В полях Begin, End и Length можно не только узнать значения начального, ко-
нечного моментов времени выделенного (помеченного) интервала и его продол-
жительность, но и отредактировать перечисленные атрибуты отметки. Внесенное
вами изменение тут же проявится в списке отметок окна Cue List. Одновременно
изменится и расположение (или обозначение) отметки в главном окне.

В раскрывающемся списке Туре выбирают одно из 4-х слов (Basic, Beat, Track,
Index), которыми обозначается тип отметки.

Нажав кнопку Batch, вы откроете окно Batch Process Phrases (рис. 5.15).
Пользуясь опциями данного окна, можно в автоматическом режиме разделить

заранее размеченную волновую форму на отдельные фрагменты (фразы) или со-
хранить выделенные фразы в отдельных файлах. Поясним сказанное на примере.

Пусть имеется волновая форма, размеченная так, как показано на рис. 5.16.
Окно Cue List здесь пристыковано к обрамлению главного окна. Все строки спис-
ка отметок в окне Cue List выделены.

Выберем в окне Batch Process Phrases (см. рис. 5.15) опцию Set Amount Of Silence
и нажмем ОК. На наших глазах волновые формы левого и правого каналов в глав-
ном окне начнут преображаться. Один за другим размеченные фрагменты станут
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(Batch Process Phrases :"£^

<* ^etAmounFbf Sil ЭГЙ5»
1 ' ''"' —————— ~~~~~~~~-~~~~~~ --rllr.fi 111 .1111.11.»™»». __. „

j Add sifence before: JO-1 seconds

1 Add sitence after: JO 1 seconds

С Saveto£3es

.p1 Ujec«elab(

FJename Prefix

Destination Foid

j OulpuE Format

y;^d^SPCN

J as filename prefin

Ынасе

Seq. Statt JT"
и

3ro№

^yV'3V~S " " **" I UD'iti

OK Qose | Cancel |

-
s !

j

'J

Рис, 5.15. Окно Batch Process Phrases

t LOGOFF.WAV» - Cool Edit Pro

Fie Edit View Effects - Generate ftnaVze Favorites Sibons Window
...101x1

|L-U.3dB'@ 0:02.323 ; 22050- 16-bit Stereo 304 К

Рис. 5.16. Пример размеченной исходной волновой формы
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отодвигаться друг от друга вправо. Между ними появятся участки абсолютной ти-
шины (рис. 5.17).

Длительность участков, разделяющих фразы, в секундах можно задавать в полях:

> Add silence before seconds — длительность паузы перед фразой
Add silence after seconds — длительность паузы после фразы

Теперь вернемся в окно Cue List, вновь выделим все строки списка отметок,
откроем окно Batch Process Phrases и выберем в нем опцию Save to Files. В резуль-
тате нам стали доступны те опции, с помощью которых можно каждую фразу за-
писать в отдельный файл.

Если установлен флажок Use cue label as filename prefix, то в качестве имен со-
храняем ых'файло в будет использован атрибут Label. Иными словами, для рассмат-
риваемого примера на диске будут сохранены 5 файлов с именами CUE1. WAV-
CUE5. WAV.

Если флажок Use cue label as filename prefix сброшен, то становятся доступными
поля ввода Filename Prefix и Seq. Start. В первом из них можно ввести префиксную
часть имени сохраняемых файлов (по умолчанию это слово phrase). В поле Seq.
Start можно ввести начальный номер последовательности сохраняемых файлов
(по умолчанию это 1). Если не изменять содержимое этих полей, предусмотрен-
ное по умолчанию, то в нашем примере будут сохранены файлы с именами
PHRASE1. WAV - PHRASES. WAV.

Effects generate findyze Fayortes Options Vtfndow

R MlcE'a COOOD8 "28380 IE-bit Stem'I 333 К

Рис. 5.17. Пример волновой формы, разделенной на отдельные фразы
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В поле Destination Folder отображается путь к папке, и которую будут сохране-
ны файлы с размеченными фразами. Воспользовавшись кнопкой Browse..., вы
можете выбрать другую папку.

В раскрывающемся списке Output Format выбирают формат, в котором следует
сохранять файлы. Кнопкой Options... открывается окно диалога, предназначен-
ное для выбора некоторых параметров формата. О преобразовании формата мы
рассказали в разд. 3.8.

5 A Show Play List — редактирование очередности
воспроизведения фрагментов волновой формы

Команда View > Show Play List вызывает окно диалога Play List, показанное на
рис. 5.18. С его помощью можно подготовить список фрагментов волновой фор-
мы, воспроизвести фрагменты, включенные в этот список. При воспроизведе-
нии между отдельными фрагментами не будет никаких пауз. Фрагменты волно-
вых форм, из которых составлен список, будут звучать как одна сплошная
волновая форма.

В нашем примере список не содержит ни одного элемента, зато доступна
кнопка Show Cue List, с помощью которой можно открыть список временных
отметок (см. разд. 5.3). Щелкните на ней, и кнопка сменит свое название. Теперь
она будет именоваться Insert Cue(s). Далее следует разметить волновую форму в
соответствии с вашим замыслом, например так, как показано на рис. 5.16. В спис-
ке отметок окна Cue List выберите интересующий вас элемент. Нажав кнопку
Insert Cue(s), вы поместите текущий элемент списка Cue List перед текущим эле-
ментом списка Play List. В нашем примере таковым является фиктивный эле-
мент [End], символизирующий окончание воспроизведения. Если в окне Cue List
выделены несколько строк, то после нажатия кнопки Insert Cue(s) все они ока-
жутся вставленными в окно Play List.

Рис. 5.18. Окно диалога Play List
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На рис. 5.19 показан возможный нид окон Play List и Cue List после нажатия
кнопки Insert Cue(s): список отметок вставлен в Play List.

Рис, 5.19. Пример совместного использования окон диалога Play List и Cue List

Далее работаем только в окне Play List. Теперь в нем стали доступны несколько
кнопок и поле вода. Кнопкой Remove удаляют выделенные элементы списка. Кноп-
кой Play запускается воспроизведение фрагментов из списка. В поле ввода Loops можно
задавать число повторов воспроизведения для каждого из звуковых фрагментов.

Кнопкой Autocue воспроизводится текущий элемент списка Play List (или са-
мый первый элемент этого списка, если ни один из элементов не выбран) столько
раз, сколько задано в поле Loop. Воспроизведение останавливается на следующем
элементе.

Кнопки Move Up и Move Down служат для изменения первоначального поряд-
ка воспроизведения размеченных фрагментов. Нажимая эти кнопки, выделенный
элемент можно перемещать по списку вверх или вниз (рис. 5.20).

Play List

) Cue 4
J Cue 2

I
I i) Cue 1
13) Cue 3
16) Cue5
{EndJ

Рис. 5.20. Пример списка фрагментов для
воспроизведения

ToMTime: 0.05.7Э1
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Напомним, что пример размеченной волновой формы представлен на рис. 5.17.
Список, приведенный в окне Play List на рис. 5.20, соответствует следующему по-
рядку воспроизведения фрагментов волновой формы:

> Дважды воспроизводится фрагмент Cue 4
х- Четыре раза воспроизводится Cue 2
> Один раз воспроизводится Cue I
> Три раз воспроизводится Cue 3
> Шесть раз воспроизводится Cue 5

Таким образом, окно Play List позволяет многократно и в произвольном порядке
воспроизводить любые предварительно размеченные фрагменты волновой формы.

5*5. Show a Placckeepcr — панель-разделитель
Командой View > Show a Placekeeper открывается панель, без которой вообще--

то вполне можно обойтись. В заголовке панели, кроме имени программы (Cool
Edit Pro), приведен совет: (dock this anywhere you like). Перевести рекомендацию
можно приблизительно так: «Закрепите это там, где захотите». Это плавающая
панель, которая по умолчанию выглядит так, как показано на рис. 5.21.

Серый прямоугольник — и ничего более. Щелчком правой кнопкой мыши
вызывается контекстное меню, с помощью которого вид панели можно изменить:
заполнить ее клеточками (рис. 5.22) или вызвать изображение логотипа Cool Edit
Pro (рис. 5.23).

Рис. 5.21. Панель-разделитель. Вид по
умолчанию

Рис. 5.22. Панель-разделитель. Вариант
дизайна
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Рис, 5.23. Логотип Cool Edit Pro на
па нели-разделителе

Панель-разделитель действительно можно пристыковать к главному окну в
том месте, где вам понравится. Например, ею можно отделить друг от друга
рабочее поле главного окна, на котором программа прорисовывает волновые
формы и какую-либо плавающую панель. На рис. 5.24 панель, о которой сей-
час идет речь, отделяет рабочее поле главного окна от плавающей панели ана-
лизатора спектра.

Мы специально уделили команде View > Show a Placekeeper больше внимания,
чем она, возможно, заслуживает. Теперь у вас не должно остаться напрасных на-
дежд. И вы не станете тратить время на безрезультатные эксперименты в стремле-

е Bit Sew Effects generate Analyse Favorites 2рСигк Window Help

Рис. 5.24. Пример использования панели-разделителя
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нии приспособить эту панель непосредственно для обработки звука. Пользуйтесь
ею как элементом, который всего лишь позволяет немного трансформировать
дизайн главного окна программы.

5.6. Display Time Format — подменю выбора
формата представления времени

В подменю Display Time Format (рис. 5.25) можно задать формат представления
времени, используемый при отображении волновых форм.

Decimal (mm:ss.ddd;

Compact Disc 75 fps
SMPTE 30 fps

SMPTE Drop (29,97 fps}

SMPTE 29.97 fps

5MPTE 25 fps (EBU)

SMPTE 24 fps (Film)

Samples

Bars and Beats

Custom (30 frames/sec)

Edit Tempo...

Define Custom Frames..,

Рис. 5.25. Подменю Display Time Format

Доступны следующие форматы представления времени:

> Decimal (mm: ss: ddd) (в привычной форме (минуты: секунды: миллисекунды)
> Compact Disc 75 ips (в стандарте CD Digital Audio с частотой 75 кадров в секунду
> SMPTE 30fps (в стандарте SMPTE (часы: минуты: секунды: кадры) с часто-

той 30 кадров в секунду
> SMPTE Drop(29.97 fps) (в стандарте SMPTE с частотой 29,97 кадра в секунду
> SMPTE 25 fps (EBU) (в стандарте SMPTE с частотой 25 кадров в секунду
> SMPTE 24 fps (Film) (в стандарте SMPTE с частотой 24 кадра в секунду
> Samples (при помощи номеров цифровых отсчетов звука (от начала волно-

вой формы)
> Bars and Beats (в музыкальных тактах и долях тактов
> Custom (в пользовательском формате SMPTE, для которого можно задать

произвольную частоту кадров

При выборе в этом подменю новой строки меняется:

> Оцифровка горизонтальной оси рабочего поля главного окна
> Формат отображения времени на табло, в полях ввода, в информационных

полях главного окна и окон диалога
Кроме перечисленных команд, предназначенныхдля изменения формата пред-

ставления времени, в подменю Display Time Format имеются еше две команды:
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> Edit Tempo... — редактирование темпа
> Define Custom Frames... — определение частоты кадров для пользователь-

ского формата

Есть смысл кратко рассмотреть каждую из двух названных команд.

5.6.1. Edit Tempo... — редактирование темпа
Командой Edit Tempo... открывается одноименное окно (рис. 5.26), предназна-

ченное для вычисления и редактирования темпа музыкального произведения, со-
держащегося в файле. Единицей измерения темпа является количество долей в
минуту (Beatsper Minute, BP№). Темп измеряется путем автоматического анализа
частоты пульсаций уровня сигнала в выделенном фрагменте волновой формы.
Результаты измерения темпа используются, например, для отображения волно-
вой формы в формате представления времени Bars and Beats: по оси времени в
этом случае откладываются такты и доли тактов.

В поле Bars Higlighted группы Extract from Selection следует ввести количество
тактов, приходящихся на выделенный фрагмент. По умолчанию программа пред-

[Edit Tempo - ok (master}.wav

• £«tfact fmm Sefe'dion-

f

Beats per Bat J4

Ticks pet Beaf [Те

Рис. 5.26. Окно диалога Edit Tempo

лагает проводить анализ темпа, исходя из того, что выделен фрагмент волновой
формы, совпадающий с одним тактом. Руководствуясь звучанием композиции,
мы и выделили точно один такт (рис. 5.27).

В поле Beats per Bar группы Tempo следует ввести число дол ей в такте (по умол-
чанию 4), а в поле Ticks per Beat — число тиков в доле. После этого нужно нажать
кнопку Extract, и программа автоматически измерит длительность выделенного
фрагмента, а также произведет необходимые вычисления.

В поле Beats per Minute группы Tempo появится вычисленное значение темпа, в
поле Current Beat At группы Offset — расстояние от начала волновой формы до
маркера или левой границы выделенного фрагмента в формате Такт: Доля.Тик, а в
поле Song Start — это же расстояние, но только в миллисекундах.

Нажав кнопку ОК, вы тем самым скорректируете шкалу времени главного окна
в соответствии с вычисленным темпом (рис. 5.28).
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Fie gdfc View Effects ueneiafe Дна!

Br-5.5d8(a34:2,03 • = 441Ш-1Ш Staeo

Рис. 5.27. Волновая форма, в которой выделен один такт

Effects Generate Analyze' Favorites Qptkn* Whdew Це1р

Рис. 5.28. Шкала времени скорректирована
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Теперь границы выделенного фрагмента совпадают с началом и концом так-
та. Если нажать еще и кнопку Reset I: I to Cursor, то выделенный такт будет счи-
таться первым. Такт, находящийся слева него, станет нулевым. Остальные так-
ты, расположенные левее, окажутся пронумерованными отрицательными
числами (рис. 5.29).

Рис. 5.29. Изменена нумерация тактов

Видно, что некоторые поля ввода в этом окне доступны для изменения па-
раметров, отображенных в них. Все вычисления строятся, исходя из предполо-
жения, что выделен интервал, соответствующий целому числу тактов, которое
указано в поле Bars Higlighted. Однако не во всякой композиции ударные ин-
струменты будут столь же выделяться, как в примере, приведенном на рис. 5. 27.
Поэтому возможна неточность в аудиовизуальном выделении такта, что повле-
чет возникновение погрешности в вычислениях и может привести к совершенно
нелепым результатам (скажем, вычисленный темп будет составлять пару ты-
сяч долей в минуту). В этих случаях и потребуется ручная корректировка вы-
числений.

5.6.2. Define Custom Frames... - определение частоты кадров для
пользовательского формата

Для того чтобы определить частоту кадров для пользовательского формата, сле-
дует в подменю Display Time Format выбрать команду Define Custom Frames.... От-
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кроется вкладка General окна диалога Settings (рис. 5.30), в котором будет подго-
товлено для редактирования поле ввода Custom Time Code Display _ frames/sec.

Укажите новое значение частоты кадров и нажмите кнопку ОК.
Напомним, что о назначении опций вкладки General окна диалога Settings мы

рассказали в разд. 1 . 1 .

General | System j Colors j Display ]- Data j Muftlrack j SMPTE j

T~ [Showtipof theDayj p Mouse Wheel~-~~ -̂
W Use shbny look

P Auto-play on command-ihe toad

R Live update during recording

• W Auto-scraB during playback and recording

.--Upon a manial scrotL'aJorTw'selection change:—|

i * AJwrt auto-scioBhg Lrtteneid play/iecotd i . £df y|ew Right-Clicks

, 1 <* Resume auto-serollfrig only after, ! $ Popup Menu
p&? cursor enters view fuse shift+Cfck !o extend]

; f Resume auto-scroing immediate^

Mouse.Cursor Ovei Di

Г

Custom JirAe Code Display. 130 iidmes/sec

Restore D âilt Window Layouts

Г" Ctilkey alows dockable windows to dock
(normally, Cul key forces undockhg)

(hold Ctrl /of popup menu]

- Default Sefection Range —

i P View С Entire Wave
I -

P Highlight after Paste

Cancel

Help

Рис. 5.30. Вкладка General окна диалога Settings

5.7. Vertical Scale Format — подменю выбора
формата вертикальной шкалы

Следующая команда меню View — Vertical Scale Format служит для выбора еди-
ниц измерения и масштаба вертикальной шкалы при отображении волновых форм.
Она вызывает подменю, состоящее из четырех команд:

> Sample Values — по вертикальной оси откладываются цифровые значения
звуковых отсчетов

> Normalized Values — по вертикальной оси откладываются нормализованные
значения звуковых отсчетов (находящиеся в пределах or — 1 до 1)

> Percentage — вертикальная ось будет отградуирована в процентах
> Decibells — вертикальная ось будет отградуирована в децибелах

Если в главном окне установлен режим отображения текущего спектра волно-
вой формы Spectral View (разд. 5.1), то возможен единственный вариант градуи-
ровки вертикальной шкалы — в герцах.
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5.8. Toolbars — подменю выбора отображаемых
панелей инструментов

Подменю Toolbars (рис. 5.31) предназначено для настройки пользовательского
интерфейса.

Пометив галочкой одну или несколько строк в подменю, вы тем самым сдела-
ете видимыми в главном окне соответствующие панели инструментов.

В отличие от многих других Windows-приложений, в Cool Edit Pro панели ин-
струментов располагаются только в верхней части главного окна. А в отличие от
плавающих окон инструментальные панели нельзя оторвать от обрамления глав-
ного окна и перенести на другое место экрана.

Если выбрана команда 1 Row limit, то независимо от общего числа выбранных для
отображения инструментальных панелей реально будут видны только те, которые уме-
щаются в одну строку. Соответственно выбор команд 2 Row Limit или 3 Row Limit озна-
чает, что для отображения инструментальных панелей выделяется 2 или 3 строки.

Инструменты, расположенные на панелях, дублируют собой основные команды
главного меню. Можно узнать назначение каждого из инструментов, прочитав подсказку,
появляющуюся, если нацелить курсор мыши на инструмент, вас интересующий.

На рис. 5.32 представлена панель File. На ней собраны инструменты, предназна-
ченные для работы с файлами (см. главу 3), и кнопка переключения главного окна в
мультитрековый режим (и обратно в режим редактирования волновой формы).

File
Edit

View
Options

Analyze
Generate

Amplitude
Delay Effects

N6ise Reduction

'Special

Time/Pitch

Unsupported

Window Toggles

1 Row Limit
2 Row Limit

3 Row Limit

Рис. 5.32. Инструментальная панель File

Рис. 5.33. Инструментальная панель Edit

Рис. 5.34. Инструментальная панель View

Рис. 5.35. Инструментальная панель Options

Рис. 5.31. Подменю Toolbars Рис. 5.36. Инструментальная панель Analyze
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Панель Edit (рис. 5.33) содержит инструменты для выполнения основных опе-
раций редактирования, которые рассмотрены в главе 4.

Панель View (рис. 5.34) предназначена для управления отображением волно-
вой формы.

Панель Options (рис. 5.35) содержит инструменты, дублирующие команды
Settings... (см. гл. 1), Scripts and Batch Processing... (см. разд. 10.1) меню Options, и
кнопку вызова справочных сведений об элементах интерфейса программы.

Инструменты панели Analyze (рис. 5.36) дублируют команды одноименного
меню, рассмотренного в главе 8.

Панель Generate (рис. 5.37) дублирует все без исключения команды одноимен -
ного меню, рассмотренного в главе 7.

Инструменты панели Amplitude (рис. 5.38) дублируют команды Invert, Reverse и
Silence меню Effects, а также команды Amplify..., Channel Mixer..., Dynamics
Processing..., Envelope..., Hard Limter..., Normalize..., Pan/Expand.., и Stereo Field
Rotate... подменю Effects > Amplitude (см. гл. 6).

Панель Delay Effects (рис. 5.39) дублирует команды подменю Effects > Delay
Effects (см. гл. 6).

Панель DirectX не открывается, хотя вызов ее вроде бы предусмотрен в меню
View > Toolbars. Наверное, программа не находит способа отобразить кнопки для
вызова гигантского количества установленных DX-плагинов.

Панель Filters (рис. 5.40) дублирует команды подменю Effects > Filters
(см. гл. 6).

Рис. 5.37. Инструментальная панель Generate

Рис. 5.38. Инструментальная панель Amplitude

Рис. 5.39. Инструментальная панель Delay Effects

Рис. 5.40. Инструментальная панель Filters
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Рис. 5.41. Инструментальная панель Noise
Reduction

Рис. 5.42. Инструментальная панель Special

Рис. 5.43. Инструментальная панель Time/Pitch

Рис. 5.44. Инструментальная панель Window Toggles

Панель Noise Reduction (рис. 5.41) дублирует команды подменю Effects > Noise
Reduction (см. гл. 6).

Панель Special (рис. 5.42) дублирует команды подменю Effects > Special (см. гл. 6).
Панель Time/Pitch (рис. 5,43} дублирует команды Pitch Bender... и Stretch... под-

меню Effects > Time/Pitch (см. гл. 6).
Панель Unsupported, в которой должны бы находиться инструменты для вызо-

ва окон эффектов, не поддерживаемых программой Cool Edit Pro, не открывается,
также как и панель DirectX.

На последней инструментальной панели Window Toggles (рис. 5.44) собраны
кнопки, управляющие отображением нескольких панелей главного окна. Они дуб-
лируют ряд команд меню View.

Сколько и каких именно инструментальных панелей следует «держать» перед гла-
зами, решать вам. В принципе, в трех строках все перечисленные панели умещаются.

5,9. Status Bar — подменю выбора полей,
отображаемых в строке статуса

Командой View > Status Bar открывается подменю выбора полей, отображае-
мых в строке статуса (рис. 5.45).

i/ Data Under Cursor

^Sample Format

File Size (K)

Fib Size (time)

Free Space (K)

Free Space (time)

Keyboard Modifiers

Рис. 5.45. Подменю Status Bar
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О смысле информации, содержащейся в полях строки статуса, мы рассказали в
разд. 2.2.

Если в подменю Status Bar помечена строка Show, то строка статуса будет видна
на экране. В противном случае она скрыта.

5.10. Wave Properties... — окно свойств волновой
формы

Команда View > Wave Properties... вызывает окно диалога Wave Properties, вое
пользовавшись которым можно не только словами описать свойства файла, со-
держащего волновую форму, но и определить ряд его атрибутов.

Окно Wave Properties организовано в виде 6 вкладок:

> Text Fields — стандартизированные формы с полями для ввода текстовое)
информации

> Loop Info — параметры лупа
> EBU Extensions — дополнительные сведения об аудиофайле, предусмотрен

ные стандартом EBU
>• Sampler — подготовка сэмпла для использования его в сэмплере
> Misc — выбор иконки файла и цвета волновой формы
> File Info — общие сведения о редактируемом файле

Рассмотрим каждую из перечисленных вкладок.

5.10.1. Вкладка Text Fields — информация о редактируемой волновой
форме

На вкладке Text Fields можно получить и изменить информацию о редактируе-
мой волновой форме. Вид вкладки и смысл информации, отображаемой в ее по-
лях, зависит от того, какая строка раскрывающегося списка Text Field Names выб-
рана вами. В текущей версии Cool Edit Pro возможен выбор одного из трех
вариантов:

> Standard RIFF — стандартные сведения о файле
>• Radio Industry — сведения о файле, которые нужно сообщать при взаимо-

действии с радиостанциями
> МРЗ (ID3 Tag) — набор сведений, которыми целесообразно сопровождать

файлы, преобразованные в формат МРЗ

На рис. 5.46 вкладка Text Fields представлена для того случая, когда выбран ва-
риант Standard RIFF.

Перечислим поля окна и поясним смысл содержащейся в них информации.

> Display Title — отображаемый заголовок (например, при отображении звука
в виде OLE-объекта). Позволяет пользоваться полным наименованием фай-
ла д.аже при наличии в операционной системе ограничения на дли ну имени
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> Original Artist — имя исполнителя
> Name — название аудиофайла
> Genre — жанр
>• KeyWords — ключевые слова (используемые, например, для поиска файлов

в базе звуковых данных)
> Digitization Source — источник звука (компакт-диск, магнитофон, радио, ви-

ниловая пластинка, микрофон и т. п.)
> Original Medium — тип звука (шум дождя, звучание флейты и др.)
> Engineers — инженеры звукозаписи, то есть, имена людей отредактировав-

ших волновую форму (например, ваше имя)
> Digitizer — имя человека, занимающегося оцифровкой звука
> Source Supplier — имя человека или организации, предоставивших исход-

ный звуковой материал
> Copyright — информация об авторских правах
> Software Package — название программного обеспечения, использованного

для оцифровки и редактирования звука
> Creation Date — дата создания файла
> Comments — комментарии
> Subject — описание содержимого звукового файла. Иногда сюда помещают

информацию об авторских правах

iWave Properties

Text Fields I Loop Infa

••text Field Names,

Ofeplay Jilte

GrigiiatAftist

'/Name

6er*e

gey Watte:

DigSjzatbfiSouice

Oriswaltfe*»:

Engneer?

£jgili?et

Source SuppKer

Copyright

Softw«e Package'"

Cj;eaUonDaie"

I 'Fi "fields auiomafk

-

EBU Exlenskmsj Sarnplefj Hisc j Fileinfo]

Standard RIFF _^J

,

;•

1

*fc

-

^ommerrfs

£J '

Subject . ^ •

-d : ;

^

$

| QK I

Cancel

• Help l

Рис. 5.46. Вкладка Text Fields, выбран вариант Standard RIFF
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Как вы уже догадались, совершенно не обязательно заполнять все эти поля. Но,
тем не менее, возможность хранения указанной выше информации в звуковых фай-
лах предусмотрена и порой она бывает очень полезна. Хорошо, если у вас имеется
всего несколько созданных звуковых файлов. Наверняка вы помните содержимое
каждого из них. А если речь идет о звуковой базе данных, в которой хранятся тыся-
чи файлов, то без подобной информации обойтись просто невозможно.

Если установлен флажок Fill* fields automatycally, то поля, помеченные звездоч-
кой (Software Package и Creation Date), будут заполняться программой автомати-
чески при создании нового файла.

Если в раскрывающемся списке Text Field Names выбрана строка Radio Industry,
то вкладка Text Fields примет другой вид (рис. 5.47).

Этот вариант вкладки Text Fields отличается от представленного на рис. 5.46
смыслом содержания большинства полей:

> Description — описание аудиоматериала, содержащегося в файле
> Advertiser — рекламодатель
> Outcue — описание окончания файла; например, в этом поле могут быть

приведены слова, которыми заканчивается записанное интервью
> Start Date — дата первого выхода материала в эфир
> End Date — дата последнего выхода материала в эфир
> Intro Time (ms/begin) — время начала звучания материала

Wave Properties

Те* Fields | Loop |nfo| EBU Extensions ( Sarrpteij Misc | FfeMo}

TerffieldNameE 1|ДЦ Я: ДИМ
*

fiescfiption j

Sdveitisei J
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Statt Date j

End Date |

lrlfoTin)e(rns/begid] j

.'" SecToheims/end) |

Reducer 1

latent |

Caiegorp [
: v . " - • AgefiCj» j

Account Executive }

Creation Date " |

; T~ Fi " fields automata ly -

jommerils

1

iH
Copy -' . .

±]

»l

2£J

| — oiT~l

Cancel I

Help j

Рис. 5.47. Вкладка Text Fields, выбран вариант Radio Industry
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> Sec Tone (ms/end) — время окончания звучания материала
> Producer — продюсер
> Category — категория
'> Agency — агентство
> Account Executive — делопроизводитель
'> Creation Date* — дата создания

Такой информацией вам придется сопровождать аудиоматериал, если доведет-
ся готовить его для радиостанции.

Если в раскрывающемся списке Text Field Names выбрана строка МРЗ (ID3 Tag),
то вкладка Text Fields опять преобразится (рис. 5.48).
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Рис. 5.48. Вкладка Text Fields, выбран вариант МРЗ (ID3 Tag)

В этом случае на вкладке Text Fields вам предстоит заполнить совсем мало
полей:

> Song Title — название песни
5> Artist — имя исполнителя
'> Album Name — название альбома
> Year — год выхода альбома

А вот название жанра вам даже и придумывать не понадобится. Его следу-
ет выбрать из вариантов, предложенных программой в раскрывающемся спис-
ке Genre.
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5.10.2. Вкладка Loop Info — параметры лупа

На вкладке Loop Info (рис. 5.49} окна Wave Properties расположены параметры
зацикливания волновой формы (параметры лупа).

Wave Properties

Text Fields. Loop Info | Egy gstensbns j Samplei! Шс I f1e.lnfo

Source Waveform Information —

^ |pog <~ OneSHot

Humbef of Beats jl

Tempoj159.5 beatsAntnufe

Key j Non-voiced ĵ j FbdNje=gest j

т~ I CnipO M^Cfft^ L~1^™""""'̂  " —•—-— ^_-—-_ ,

.j Sbeich Method!Fixed Length (no strelching) *l

These loop seffingswil be used
when inserting Sits waveform hto

I a Muftrtiack session.

Рис. 5.49. Вкладка Loop Info окна Wave Properties

На всякий случай напомним о том, что же такое лупы. Классический барабан-
ный луп — это фрагмент барабанной партии, записанный в определенном темпе,
длина которого кратна целому числу тактов. Если воспроизводить такой фрагмент
в цикле (отсюда и название лупа — «Loop» — существительное «петля*, глагол
^двигаться по кругу»), то создастся ощущение непрерывной игры. Лупы могут быть
и не барабанными. Это может быть любой грув (последовательность мелодичес-
ких звуков), зацикливание которого приведет к ощущению непрерывной игры.

В настоящее время на дисках и в Internet можно найти множество коллекций
лупов. Композиция будет звучать очень монотонно, если на всем ее протяжении
будет «крутиться» всего один луп. Поэтому лупы обычно поставляются наборами, в
пределах которых все лупы записаны в одном темпе на одних инструментах, но со-
ответствуют разным частям композиции. Например, вступлению, переходам и т. п.

Несмотря на большое количество коллекций лупов, имеющихся в продаже,
найти луп, подходящий для вашей композиции, не просто. Допустим, вам понра-
вился какой-то луп, который был записан в темпе 120 долей в минуту. Да вот беда,
темп вашей композиции равен 130. Ктомуже вы не уверены, что вам не придется
изменить темп до какого-то третьего значения. Что делать?

В Cool Edit Pro проблема преобразования темпа лупов решена полностью. На
вкладке Loop Info окна Wave Properties вы укажете программе, что редактируемая
волновая форма является именно лупом, и зададите различные сопутствующие

63ак 1152
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параметры. В дальнейшем вы сможете свободно использовать такую волновую
форму в многодорожечных проектах (гл. 12} с произвольным темпом.

А теперь поговорим о работе с лупами подробнее. Было бы неплохо, если бы в
вашем распоряжении имелся какой-либо луп. Если его нет, в качестве наглядного
примера возьмите файл NEWDRUMS, CEL, входящий в демонстрационный про-
ект, поставляемый вместе с Cool Edit Pro.

В принципе, необходимости в зацикливании барабанной партии может и не
возникнуть (если она записана целиком). В этом случае следует выбрать опцию
One Shut. Если же вы хотите использовать барабанную партию или грув именно в
качестве лупа, выберите опцию Loop.

В поле Number of Beats следует указать количество музыкальных долей в лупе.
В барабанном лупе началу каждой доли обычно соответствует удар барабана. В
файле NEWDRUMS. CEL, взятом в качестве примера, 4 доли. Как можно опреде-
лить количество долей? Варианта два:

> Слушать музыку и считать
> Посмотреть на волновую форму, визуально выделить доли (хотя это не так-

то и просто) и сосчитать их

В поле Tempojbeats/minute отображается темп, в котором был записан луп. Его
значение рассчитывается программой автоматически. Чтобы программа не оши-
балась, вы, в свою очередь, должны указывать правильное количество долей.

В данном случае мы работаем с лупом, поэтому в списке Key следует выбрать
Non-voiced. Тем самым вы дадите программе знать, что луп не содержит мелоди-
ческих звуков. Если бы луп содержал мелодические звуки (т. е, являлся грувом),
в поле Key следовало бы указать тон, которому соответствует грув. Ну а в том слу-
чае, когда вы не сможете определить тон на слух, — нажмите кнопку Find Nearest
и программа сделает это за вас.

В группе Tempo Matching задаются параметры алгоритма, который будет ис-
пользоваться для изменения темпа лупа в многодорожечном проекте.

В списке Stretch Method задается метод изменения длительности звучания од-
ного периода лупа и, соответственно, его темпа. В большинстве случаев подходит
метод Beat Splice. Данный метод заключается в том, что в волновой форме автома-
тически и незаметно для пользователя выделяются фрагменты, соответствующие
долям. Изменяя расположение этих долей на оси времени, программа может из-
менять длительность звучания всего лупа. При этом ни длительность, ни тон от-
дельных долей изменяться не будут.

Для алгоритма Beat Splice доступны следующие опции (рис. 5.50):

> Use file's beat markers — использовать маркеры долей, информация о кото-
рых, в принципе, может присутствовать в аудиофайле

> Auto-Find beats — осуществлять автоматический поиск долей

Последней опции соответствуют два параметра: если уровень сигнала изменится
на X dB за Yms, то данная позиция волновой формы будет считаться «ударным»
звуком, соответствующим началу доли.
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[Wave Properties
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Рис. 5.50. Вкладка Loop Info окна Wave Properties, выбран алгоритм Beat Splice

Следующий метод изменения темпа — метод ресэмплирования, названный
Resample (affects pitch), связан с воздействием на тон лупа или грува (рис. 5.51).

Собственно ресэмплирование и используется в сэмплерах для получения за-
данного тона из звука, записанного совсем в другом тоне. При этом, естественно,

[Wave Properties

Text Fields Loop Info j £BU Extensions | Sampler j Misc j File Info |

veform Information ——-—

Loop f* One Shot

Number of Beat? |l

Tempo |159^5 beatsAnhute

Key I Non-voiced И .. FindNearest

• Tempo Matching •: •-

Stretch Helhod Inesamole faffects

Quality High

[ These bop settings will be used
when in setting this waveform into

| a Multitrack session. :

JSl

Cancel Л:

Рис. 5.51. Вкладка Loop Info окна Wave Properties, выбран алгоритм Resample (affects pitch)
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изменяется и длительность звучания сэмпла: чем быстрее воспроизводится
сэмпл, тем короче звучание, и наоборот. В данном случае изменение длитель-
ности звучания одного цикла лупа является основной задачей, а изменение его
тона — побочный эффект, который, впрочем, можно использовать в художе-
ственных целях.

Для метода Resample (affects pitch) доступен всего один параметр: в списке Quality
вы можете выбрать качество работы алгоритма от низкого (Low) до высокого (High).

Метод Time-Scale Stretch (рис. 5.52) позволяет изменять темп лупа/грува без
изменения его тона. На первый взгляд это может показаться странным, но имен-
но такой алгоритм больше всего подходит именно для мелодического грува.

iWave Properties

Text Fields Ьзор Into j;£BU Extensiora | Sampta | Mtsc | fite infoj

•SouceWavelorm inlwnafon —
**• loop Г Q^Shet,

Numfeei of feats [T "

Tempo [l 59 5 beals/mnufe

These bpp settirajs ни beuserf
v*ien inserting this wavefam into
a Muffitoacfc session.

Keu Non-voiced H FinciMe«est
•' ,. * — J :;M v-

High

Fiame S^e (spfcesAjeat) j32

Рис. 5.52. Вклада Loop Info окна Wave Properties, выбран алгоритм Time-Scale

Вообще, метод Time-Scale Stretch по своей сути похож на Beat Splice. Однако в
случае Time-Scale Stretch волновая форма разбивается на гораздо большее коли-
чество фрагментов (splices).

Если выбран метод Time-Scale Stretch, то вам доступны следующие параметры:

> Quality — тяри градации качества работы алгоритма от низкого (Low) до вы-
сокого (High)

> Frame size (splices/beat) — количество фрагментов, на которое будет разби-
ваться каждая доля

> Frame Overlapping (%) — степень «нахлёста» фрагментов долей друг на друга

Последний элемент раскрывающегося списка Stretch Method (речь идет о Fixed
Length (no stretching), см. рис. 5.49) —это, по сути дела, не метод изменения темпа
лупа, а указание программе как раз на то, что темп лупа не следует подгонять под
темп многодорожечного проекта.
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5.10.3. Вкладка EBU Extensions — дополнительная информация об
аудиофайле

Вкладка EBU Extensions (рис. 5.53) окна диалога Wave Properties предназначена
для ввода дополнительной информации об аудиофайле, предусмотренной EBU
(European Broadcasting Union — Европейский Вещательный Союз).

WaveProperties

ТЫРиИз) Loop Into EBUE*te^aTs|saffipte«j Wise | RteHnfo]

•.;,0esaptiofl time Reference (jrice midnight]

f* hh:mm:ss.ddd
Г samples

OrigsiatO!

Dtî natot Reference

2002-07-05
Cancel

help

Рис. 5.53. Вкладка EBU Extensions окна Wave Properties

Поясним назначение полей этой вкладки:

> Description — описание аудиоматериала, содержащегося в файле
> Originator — имя автора аудиоматериала (продюсера)
> Originator Reference — имя составителя описания аудиоматериала
> Origination Date (yyy-mm-dd) — дата создания аудиоматериала
> Origination Time (hh: mm: ss) — время создания аудиоматериала
> Time Reference (since midnight) — привязка по времени (от полуночи) в фор-

матах «часы: минуты: секунды* или «номер отчета»
> Coding History — код изменений, внесенных вами в существовавший аудио-

материал

5.10.4. Вкладка Sampler — подготовка звука для сэмплера

С помощью опций вкладки Sampler (рис. 5.54) окна диалога Wave Properties
можно подготовить сэмпл для использования его в сэмплере.

При подготовке сэмплов для использования в сэмплере удобно пользовать-
ся средствами Cool Edit Pro, специально предназначенными для этой цели. Сле-
дует предупредить заранее, что в реальной жизни вам вряд ли потребуется ис-
пользовать все возможности этого окна. Но некоторые из них могут оказаться
очень полезными.
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v/ave Properties *i
Tetf Fields} Looplnfo| EBUExtensions Sampler JMisc | Ffclnfoi

Target Manufactwer ID JOODOOOOO

Рис. 5.54. В*ладка

Sampler окна диалога

Wave Properties

Итак, рассмотрим опции вкладки Sampler окна диалога Wave Properties.
Поля ввода Target Manufacturer ID и Target Product Code недоступны для редак-

тирования, но в них будут отображаться соответствующие коды> если вы работае-
те с сэмплом, созданным на сэмплере, который эти коды формирует и сохраняет в
файле сэмпла.

Sample Period — величина, обратная частоте сэмплирования, т. е. временной
шаг дискретизации. Значение в поле Sample Period по умолчанию соответствует
частоте дискретизации сэмпла, но его можно изменять для того, чтобы «обмануть»
сэмплер: заставить его «воспринимать» не истинную частоту сэмплирования, на
которой был оцифрован звук, а частоту, заданную вами.

В группе MIDI Unity Note можно указать, какой ноте соответствует звучание
сэмпла (Note). Обычно этого не достаточно и звучание сэмпла требуется подстра-
ивать с точностью до цента (словно гитарные струны). Подстройка осуществляет-
ся в поле Fine Tune__cents. Однако сэмплер — это все-таки не гитара, и пользовать-
ся камертоном для его настройки не потребуется. Достаточно нажать кнопку Find
using Analysis, и программа самостоятельно определит, какой ноте соответствует
сэмпл, найдет параметр его подстройки (чтобы соответствие было идеальным).

В группе SMPTE Offset можно выбрать формат SMPTE (раскрывающийся спи-
сок SMPTE Format) и смещение в соответствии с этим форматом (SMPTE Offset).
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Последний параметр может использоваться в некоторых сэмплерах, но нам с вами
он вряд ли понадобится. А вот знакомство с элементами группы Sampler Loops
может пригодиться. Речь идет о «зацикливании» сэмплов (звук будет повторять-
ся, словно у испорченной пластинки). Сэмпл начинает воспроизводиться от на-
чала до конца петли или, точнее говоря, до метки конца петли. Затем воспроизве-
дение возобновляется от начала петли, опять доходит до ее конца и так до тех пор,
пока не будет отпущена MIDI-клавиша. То есть, пока MIDI-клавиша нажата, сэм-
плер воспроизводит непрерывный звук. Память сэмплера не бесконечна, и в нее
невозможно загружать сэмплы произвольной длины. Самое естественное реше-
ние — воспроизводить звук в цикле. Очень важно подобрать параметры петли так,
чтобы зацикливание действительно не было похоже на звучание испорченной
пластинки.

Из вышеизложенного не совсем понятно, как будет воспроизводиться сэмпл
после отпускания MIDI-клавиши. Возможны три варианта:

> Звучание закончится сразу по окончании сэмпла
> Звук будет воспроизводиться в цикле до тех пор, пока сэмплер не отработа-

ет фазу затухания (снижение громкости после отпускания MIDI-клавиши)
> Сэмплер выйдет из текущей петли и сразу же попадет в другую

Третий вариант воспроизведения сэмпла может поддерживаться далеко не каж-
дым сэмплером. Да и наше утверждение о том, что в таких сэмплерах после отпус-
кания MIDI-клавиши звук попадает в следующую петлю, не совсем точно. В прин-
ципе, таких петель может быть больше двух. Чтобы сэмплер попал, например, в
третью по счету петлю, нужно еще раз отпустить клавишу? Но для этого ведь по-
требовалось бы прежде нажать ее еще раз. Дело в том, что в различных сэмплера*
возможности зацикливания могут использоваться по-разному, а возможности Cool
Edit Pro универсальны. Эта программа рассчитана «на все случаи жизни». Потре-
буются, например, пользователю две петли — пожалуйста, три — тоже не пробле-
ма. Сколько угодно пользователю, столько петель и будет.

Итак, попробуем вместе подготовить сэмпл для использования в сэмплере.
Начнем с того, что вернемся в главное окно программы и, как обычно, с помощью
мыши выделим ту область волновой формы, которая должна зацикливаться при
воспроизведении. Очень важно, чтобы звуковая волна в начале этой области была
как бы естественным продолжением волны в конце цикла.

Разберемся в самом процессе подготовки сэмпла. Допустим, вы выделили об-
ласть волновой формы, предназначенную для зацикливания. Теперь откройте
вкладку Sampler окна диалога Wave Properties и нажмите кнопку Find using Analysis.
В поле ввода Note появится обозначение ноты, на которую больше всего похож;!
тональность звучания сэмпла, а в поле ввода Fine lUne — значение точной под-
стройки, произведя которую, вы добьетесь полного соответствия звучания сэмп--
ла данной ноте.

Следующий шаг (если вы планируете зацикливать сэмпл) — в группе Sampler
Loops нажмите кнопку New. Будет создана первая петля. Причем ее начало и ко-
нец, а значит, и длина (Start, End и Length), будут соответствовать той области вол-

I
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новой формы, которую вы выделили в главном окне. Включив опцию Sustain, вы
сообщите программе о том, что выделенный фрагмент будет воспроизводиться в
цикле до бесконечности (пока не прекратится по какой-либо причине воспроиз-
ведение всего сэмпла). После проделанной работы окно диалога Sampler Information
будет выглядеть примерно так, как показано на рис. 5.55.

(Wave Properties

i«*F*Hs| L<wpWo| EBUEKtensiom 'Sampler [wise |:F$e№|

Target Manufacturer ID JQMGGQOG

' Target PraductCodej

-FineTtineiO cents

•Samplei Loops-

SMPTE Offset

SMPT££cnmal

I (no offset)

SMPTE Ojfset

[00:00:00; 00

(* jSustain M|nfce loop]
""~ г ; ' " " "

*"-î s3 |1 times .

(•" ForwaiiS

f Backward

Start 12418155

Nev* v.Renyive-:-], Length [22764=

Рис. 5.55. Пример
подготовки сэмпла к

загрузке а сэмплер

Для некоторых сэмплеров можно задать не бесконечное повторение петли, а
прохождение выбранного участка сэмпла заданное количество раз (Loop n times.
где n (количество проходов).

Существуют три способа прохождения петли.

> Forward — прохождение от начала петли до конца, мгновенный возврат к
началу, вновь проход от начало до конца и т. д. Этот способ используется по
умолчанию.

> Forward/Backward — прохождение от начала до конца, мгновенная смена
направления и воспроизведение цикла «задом наперед» (от конца к нача-
лу). При достижении начала цикла направление вое произведения вновь
меняется (от начала до конца) и т. д.

> Backward — воспроизведение петли «задом наперед» (всегда с конца до начала).
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Любой из этих способов прохождения петли можно выбрать при помощи со-
ответствующих переключателей. Но не каждый сэмплер поддерживает все три
способа воспроизведения.

Например, микросхема EMU8000, на базе которой создан WT-синтезатор зиу-
ковых карт семейства AWE, воспроизводит сэмплы только первым способом. А не-
обходимость в использовании второго способа прохождения петли возникает ча-
сто. Дело в том, что при этом способе воспроизведения (иногда его называют
«пин-понг») легче зациклить сэмпл без неприятных побочных эффектов (той са-
мой «испорченной пластинки»). Даже если сэмплер не поддерживает зациклива-
ние Forward/Backward, данную схему можно эмулировать вручную. Делается это
очень просто: например, при помощи того же самого Cool Edit Pro. Выделите за-
цикливаемую область, скопируйте ее в буфер обмена, вставьте блок звуковых дан-
ных из буфера в позицию, соответствующую концу зацикливаемой области. В ре-
зультате получите два абсолютно одинаковых звуковых фрагмента, следующие друг
за другом. Теперь остается второй фрагмент зеркально отобразить при помощи
команды Effects > Reverse. Цикл готов, задайте его начало и конец (петля теперь
охватывает оба звуковых фрагмента) и выберите способ воспроизведения Forward.
Теперь, даже при использовании синтезатора EMU8GOO будет реализован способ
воспроизведения Forward/Backward. Плата за это — расход памяти на хранение до-
полнительных данных.

Аналогичным образом можно создавать произвольное количество петель. Уда-
лить их всегда можно при помощи кнопки Remove.

При выполнении всех описанных выше операций, как и вообще при любой
работе со звуком, вам потребуется терпение и аккуратность. Стоит ошибиться на
один отсчет при задании позиции сэмпла — и раздастся режущий слух щелчок.
Но зато с приобретением знаний и опыта, удовольствие, получаемое от создания
собственного сэмпла (а затем и музыки), многократно окупит все ваши первона-
чальные неудачи.

Остается добавить, что информация о размеченных петлях (заготовках буду-
щих сэмплов) появляется в окне Cue List (рис. 5.56).

О работе с окном Cue List мы подробно рассказали в разд. 5.3. Здесь же лишь
обратим ваше внимание на то, что разметка, созданная автоматически средства-
ми вкладки Sampler окна диалога Wave Properties, отличается от обычной разметки

Begin
0:53.833 0:59,999

Length! Type I Description I
0:05.166 Basic Sampler loop Рис. 5.56. В окне Cue

List появилась
информация о
размеченном лупе
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волновой формы. Размеченная область именуется не Cue, a Loop (столбец Label),
и в столбце Description указывается примечание Sampler loop.

5.10.5. Вкладка Misc — выбор ярлыка файла и цвета волновой формы
Вкладка Misc (рис. 5.57) окна диалога \Vbve Properties служит инструментом

выбора ярлыка редактируемого аудиофайла. Кроме того, здесь можно выбрать ивет,
который будет использоваться при отображении волновой формы.

Wave Properties

Тек* fields | loopirf&l £8U Extensions j Saroplei

Bitmap

Fitetnfo

Г* iQse^fadtwavecotoii

Рис. 5.57. Вкладка
Misc окна Wave
Properties

Для загрузки файлов с расширением BMP, в которых хранятся графические
изображения, необходимо нажать кнопку Bitmap. Откроется стандартное окно для
загрузки файлов. Как только вы выберете один из таких файлов, изображение по-
явится на рабочем поле вкладки (рис. 5.58).

| Wave Properties ШП)

Test» fields j i oap Info. j.EBU Extensions) Sampler Wise [RleWoj

j

' ' ' ' M K . '

It

f~ Use default wave edm Choose wave cola...

OK J

• • Cancel J

Help

Рис. 5.58. Вкладка
Misc окна Wave
Properties,
выбрана иконка
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Обращаем ваше снимание на то, что не всякий файл с расширением BMP вам
удастся загрузить посредством опций вкладки Misc окна диалога Wave Properties,
Картинка должна иметь размеры 32x32 пиксела, а ее глубина цвета должна со-
ставлять 16 бит, т. е. файл должен соответствовать стандартной иконке.

Загрузив графический файл, вы получите в свое распоряжение ярлык, кото-
рый в дальнейшем можно использовать для обозначения связанного с ним аудио-
файла в мультимедиа-просмотрщиках.

Если вы захотите поупражняться с рассматриваемой вкладкой, то имейте в виду,
что файл иконки МК.ВМР, которым мы воспользовались, формируя рис. 5.58,
находится на прилагаемом к книге CD-ROM в папке SAMPLES. Такую иконку
мы иногда используем для обозначения звуковых файлов, относящихся к радио-
и телепередачам «Музыкальный компьютер».

Если на вкладке Misc окна диалога Wave Properties установлен флажок Use default
wave color, то при отображении волновой формы в главном окне программы будет
использован цвет, предусмотренный по умолчанию. Если флажок сбросить, то
откроется стандартное окно выбора цвета, с помощью которого вы сможете рас-
красить волновую форму в любой оттенок.

5.10.6. Вкладка File Info - общие сведения о файле
Вкладка File Info окна диалога Wave Properties представлена на рис. 5.59.

'Wave Properties -

Т ей Fields j Loop Info j

General fite information:

Filename:

File Type:
Uncompressed Size:
File Format

Sbe on Disk:
Lad Written (beaty
Length;

EBU Extensions | Sampte] Mtsc Be Info j

ok (maste^ wav
imGoodQk

4410QH2, 16-bit. Stereo
42.85 MB (44,940.472 bytes)
Windows PCM . . .
Windows PCM
42.85 MB {45,940,516 bytes)
3/17/2002 221142.000
4:14.764

.11,235,118 samples

Cancel j

Help [

Рис. 5.59. Вкладка
File Info окна диалога
Wave Properties

На ней содержатся следующие общие сведения о редактируемом файле:

> Filename: — имя файла
> Folder: — путь к папке, в которой хранится файл
> File Type: — тип файла
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> Uncompressed Size: — размер несжатого файла
> File Format: — формат файла
> Size on Dick: — объем дискового пространства, занятого файлом
> Last Written (local) — дата и время внесения последних изменений
> Length — длина файла в минутах, секундах, кадрах, а также в количестве

звуковых отсчетов

Вкладка File Info лишь информирует вас о некоторых параметрах редактируе-
мого файла. Средств для изменения этих параметров на вкладке нет.



Глава

МЕНЮ EFFECTS - ПРЕОБРАЗОВАНИЕ
ЗВУКА

Нисколько не преувеличивая, можно назвать меню Effects основным меню зву-
кового редактора Cool Edit Pro. Именно в этом меню сосредоточены все команды,
позволяющие проделывать со звуком настоящие чудеса. Остальные меню в основ-
ном обеспечивают хоть и важные, но все же вспомогательные операции, а все пре-
образования звука, создание эффектов осуществляются с помощью меню Effects.

Чтобы проникнуться уважением к программе и ее разработчику, достаточно
бегло просмотреть перечень команд и подменю, приведенный ниже.

Invert — инвертирование звукового сигнала.
Reverse — реверсирование звукового сигнала.
Silence — установление абсолютной тишины на заданном участке волновой

формы.
DirectX — доступ к окнам аудиоэффектов, подключенных посредством DirectX.
Amplitude — преобразование амплитуды. Подменю, в которое входят следую-

щие команды:

> Amplify... — преобразование уровня звукового сигнала
> Channel Mixer... — канальный микшер
> Dynamics Processing... — динамическая обработка
> Envelope... — управление формой огибающей амплитуды
> Hard Uniting...— жесткое ограничение
> Normalize,.. — нормализация
> Pan/Expand... — расширение стереобазы, преобразование стереообраза ис-

точника звука
> Stereo Field Rotate... — вращение стереополя
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Delay Effects — эффекты, основанные на задержке. Подменю, в которое входят
следующие команды:

> Chorus... — хорус
> Delay... — дилэй (задержка)
> Dinamic Delay — дилэй с динамическим изменением задержки и обратной связи
> Echo... — эхо
> Echo Chamber... — имитация акустики помещений
> Flanger... — флэнжер
> Full Reverb... — универсальный процессор реверберации
> Multitap Delay... — многоканальная задержка
> QuickVerb... — реверберация с упрощенным набором регулируемых па-

раметров
> Reverb... — реверберация
> Sweeping Phaser... — перестраиваемый фазовращатель (фейзер)

Filters — фильтрация звукового сигнала. Подменю, в которое входят команды,
открывающие окна следующих эффектов:

> Dynamic EQ... — эквалайзер с динамическим управлением частотой настрой-
ки, усилением и полосой

> FFT Filter... — фильтр на основе быстрого преобразования Фурье
> Graphic Equalizer... — универсальный графический эквалайзер
> Graphic Phase Shifter... — графический фазовращатель
> Notch Filter... — пятиполосный фильтр выреза
> Parametric Equalizer... — семиполосный параметрический эквалайзер
> Quick Filter... — 8-полосный графический эквалайзер
> Scientific Filters... — фильтры Бесселя, Баттеворта, Чебышева

Noise Reduction — шумоподавление. Подменю, в которое входят следующие
команды:

> Click/Pop Eliminator... — обнаружение и исправление щелчков и/или выпа-
дений отсчетов

> Clip Restoration... — устранение клиппирования
> Hiss Reduction... — спектральное пороговое шумоподавление
> Noise Reduction... — шумоподавление на основе анализа свойств образца

шума

Special — специальные эффекты

> Brainwave Synchronizer... — синхронизация с ритмами головного мозга
> Convolution... — свертка
> Distortion... — дистошн (ограничение амплитуды)
> Music — исполнение мелодии

Time/Pitch — преобразование длительности и высоты тона волновой формы.
Подменю, в которое входят следующие команды;
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> Doppler Chifter... — имитатор эффекта Доплера (изменение частоты колеба-
ния, излученного движущимся источником)

> Pitch Bender — сдвиг высоты тона волновой формы
> Stretch — преобразование длительности волновой формы

Теперь понятно, какая работа ожидает нас с вами во время освоения материала
этой главы?

Большинство операций, связанных с преобразованием звука, доступных из того
или иного пункта меню, применяется к выделенному участку волновой формы.
Если же фрагмент звука не указан, то перед выполнением операции автоматичес-
ки выделяется вся волновая форма.

Первые три команды меню предназначены для выполнения довольно простых,
но очень интересных преобразований звукового сигнала.

6*1. Invert — инвертирование звукового сигнала
Invert — операция инвертирования звукового сигнала. Каждый звуковой от-

счет умножается на — 1.
Разумеется, предварительно нужно выделить тот фрагмент волновой формы, в

котором звуковые волны требуется инвертировать.
Сравните две картинки: исходный сигнал, представленный на рис. 6.1, и ре-

зультат инвертирования сигнала (рис. 6.2).
Видно, что положительные полуволны звуковых колебаний стали отрицатель-

ными и наоборот. В этом суть инвертирования.
Операция Invert идентична функции кнопки Invert, имеющейся среди средств

коммутации каналов у хороших микшеров.
В каких случаях может пригодиться эта операция?
Инвертировать сигнал требуется тогда, когда при записи стереофонического

аудиофайла нарушено фазирование сигналов из-за ошибок коммутации или невер-
ной распайки кабелей и разъемов. Сигналы правого и левого стереоканалов оказы -
ваются записанными в противофазе. Это в корне меняет стереообраз и приводит к
мононесовместимости фонограммы. Проще говоря, если такую фонограмму, на-
пример, воспроизвести в концертном зале с монофоническим акустическим обо-
рудованием или передавать посредством радиостанции стереофонического веща-
ния, а принимать на монофонический приемник, то в худшем случае кроме редких
хрипов и скрежета ничего услышать не удастся. Противофазные (для основных
спектральных составляющих) сигналы двух стереоканалов при сложении в моно-
сигнал почти компенсируют друг друга. Чтобы избежать этого, нужно тщательн о
контролировать идентичность преобразования фазы в стереоканалах микшера,
устройствах коммутации и обработки. Если ошибки избежать не удалось, приме-
ните команду Invert к одному из сигналов стереопары.

Вторая задача, которую можно решать с применением инвертирования сигна-
лов, — расширение стереобазы. Сигналы правого и левого каналов инвертируют-
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Рис. 6.1. Исходный сигнал
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Рис. 6.2. Результат инвертирования
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ся и фильтруются. Затем обработанные сигналы в определенной пропорции пере-
крестно смешиваются с исходными сигналами. Конечно, стереообраз при этом
искажается, но создается ощущение расширения стереобазы. В некоторых маг-
нитофонах есть кнопка расширения стереобазы, подключающая схему, которая и
выполняет все перечисленные преобразования. Предельный случай такой опера-
ции — конвертирование моносигнала в псевдостереосигнал.

6.2. Reverse — реверсирование звукового сигнала
Reverse — следующая команда меню Effects. После выполнения этой операции

звук оказывается записанным в обратном порядке. Начало и конец волновой фор-
мы меняются местами. Команда применяется к выделенному фрагменту волно-
вой формы.

На рис. 6.3 представлен пример исходного сигнапа, а на рис. 6.4 — сигнал пос-
ле обработки с помощью команды Reverse.

Команда Reverse пригодится для создания специальных эффектов и подготов-
ки звуков для сэмплера (разд. 11.6). Следите за тем, чтобы границы выделенного
участка сэмпла приходились на те точки, в которых звуковая волна пересекает
нулевой уровень.

РЙе £d* View Effects generate -£па1уге Favortes. 2ptionS Window Help

IS-btl • Stereo • 2.4,0 MS 31,8Б GS tee ,.

Рис. 6.3, Пример исходного сигнала
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Рис. 6.4. Сигнал после обработки командой Reverse

6.3. Silence — формирование абсолютной тишины на
заданном участке волновой формы

После применения команды Silence формируется абсолютная тишина на за-
данном участке волновой формы. Значения всех звуковых отсчетов в этом фраг-
менте приравниваются нулю.

На рис. 6.5. представлен исходный сигнал, а на рис. 6.6 —этот же сигнал после
обработки командой Silence.

Функция может пригодиться в том случае, когда части полезного сигнала (сло-
ва, фразы) отделены друг от друга протяженными паузами, в которых ничего, кроме
шума, нет (см. рис. 6.5).

Если допускается смещение фрагментов полезного сигнала во времени, то мож-
но просто вырезать паузы из фонограммы или применить средство автоматиза-
ции этого процесса, имеющееся в Cool Edit Pro (команда Delete Silence... меню
Edit рассмотрена в разд. 4.8). Однако в случае, когда все фрагменты полезного зву-
кового сигнала должны оставаться на своих местах, а удаление пауз недопустимо,
шум в паузе следует заменить абсолютной тишиной (см. рис. 6.6).

Если паузы коротки и их много, то становится хлопотно выделять вручную каж-
дую из них с целью последующей замены шума абсолютной тишиной. Разумнее
применить шумоподавление (разд. 6.33—6.36). Нужно, однако, понимать, что пу-
тем применения алгоритмов шумоподавления нельзя достичь абсолютной тиши-
ны, а можно только более или менее эффективно снизить уровень шума.
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Рис. 6.5. Пример исходного сигнала
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Рис. 6.6. Сигнал после обработки командой Silence
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6.4, DirectX — применение аудиоэффектов,
подключенных посредством DirectX

Команда DirectX меню Effects позволяет использовать совместно с Cool Edit
Pro модули эффектов (plug-in-модули), подключаемые к основной программе по-
средством DirectX, что существенно расширяет и без того немалые возможности
обработки звука, заложенные в Cool Edit Pro.

Команда появляется в меню Effects только в том случае, когда в вашей системе
имеются установленные DirectX-плагины. Если установка некоторых плагинов
произведена после установки Cool Edit Pro, то в подменю Effects вы их можете и не
увидеть. Для того чтобы Cool Edit Pro сумел распознать все DirectX-плагины, нужно
подать команду Effects > Refresh Effects List.

Заметим, что в подменю DirectX отображаются названия всех тех эффектов,
которые по завершении процедуры распознавания программа сочла именно
DirectX-эффектами, совместимыми с Cool Edit Pro 2. Однако на практике это оз-
начает, что некоторые из эффектов, перечисленных в подменю DirectX, могут не
иметь никакого отношения к работе со звуком. Например, здесь могут оказаться
плагины, предназначенные для оцифровки и сжатия изображения.

Чтобы не возвращаться к вопросу о внешних плагинах, обратим ваше внима-
ние еще на одну строку (Unsupported) меню Effects, которая также может при оп-
ределенных обстоятельствах отсутствовать в программе. Unsupported представля-
ет собой подменю и появляется в меню Effects лишь в случае, когда в системе
имеются такие плагины, которые программа Cool Edit Pro 2 хотя и обнаружила,
но сочла непригодными для совместной работы. Подменю Unsupported — своеоб-
разное средство «развеивания иллюзий», вестник, сообщающий пользователю
горькую правду. Устанавливая плагины, вы рассчитывали применять их вместе с
Cool Edit Pro, надеялись на них, а, не сумев в решающий момент заставить их ра-
ботать, неожиданно оказались бы в трудной ситуации. Но, к счастью, подменю
Unsupported вас вовремя предупредило.

Итак, команда Effects > DirectX открывает подменю DirectX. Дальнейшее зави-
сит от того, какие DirectX plug-in-модули установлены на вашем компьютере и
как они организованы.

На компьютере, где готовился графический материал данной книги, установ-
лены все эффекты, входящие в комплект Sonar 2 и еще несколько отдельных plug-
in-модулей. Поэтому система подменю, с помощью которой организуется доступ
к ним, выглядит так, как представлено на рис. 6.7.

На вашем компьютере могут быть установлены другие DirectX plug-in-модули,
тогда вид этого меню тоже будет другим.

До начала работы с plug-in-модулем нужно выделить материал, подлежащий обра-
ботке (вся волновая форма или ее часть). Затем следует отыскать в системе подменю
требуемый эффект и щелчком кнопкой мыши открыть соответствующее окно. В каче-
стве примера мы открыли plug- in -модуль Cakewalk Amp Sim (рис. 6.8) — симулятор
аналогового магнитофона, входяший в комплект поставки программы Sonar [7, 9].
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Рис. 6.7. Система подменю DirectX
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Рис. 6.8. Окно plug-m-модуля Cakewalk Amp Sim

Еще раз отметим, что Cool Edit Pro 2, в отличие от предыдущих версий про-
граммы, поддерживает режим реального времени для DirectX plug-in-модулей.
Однако подключить эффект реального времени можно только к треку мультитре--
кового редактора (гл. 12).

В окне Waveform View применение DirectX-эффектов возможно только путем
пересчета звуковых данных для выделенных фрагментов текущей волновой фор-
мы. Кроме того, чтобы подобрать параметры эффекта, можно воспользоваться
кнопкой предварительного прослушивания, если она имеется в окне эффекта. Ни
рис. 6.8 такая кнопка называется Preview. После того как вы на слух убедитесь, что
установили именно те значения параметров эффекта, которые позволят получить
ожидаемый результат, нажмите кнопку ОК в окне эффекта. Данные в выделенном
участке волновой формы будут пересчитаны.
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Следующий пункт меню Effects — не отдельная команда, а подменю Amplitude.
Оно состоит из группы команд, влияющих на амплитуду звука: Amplify..., Channel
Mixer..., Dynamics Processing..., Envelope..., Hard Limter..., Normalize..., Pan/Expand...
и Stereo Field Rotate....

Рассмотрим подробно каждую из команд.

6.5, Amplify... — преобразование уровня звукового
сигнала

Хоть эта команда и носит название Amplify (от Amplification — усиление), но на
самом деле имеется в виду не только усиление звукового сигнала, но и вообще,
изменение амплитуды звукового сигнала — ее увеличение или уменьшение. Дан-
ная команда вызывает окно диалога Amplify, содержащее две вкладки: Constant
Amplification (рис. 6.9) и Fade (рис. 6.10).

Constant Amplification {Fade

Arnoificaiion

Center Wave
Fade In
Fade In Lett
Fade In Right
Fade Out
Pan Haid Left
'-•-- ' '---•"--'-

Г"

Г Lock Left/Right

Gafculate NtumaSzation Vafoes —'-.— ~̂

Peak Level JT55 % Calculate How

Рис. 6.9. Вкладка Constant Amplification окна диалога Amplify

При помощи вкладок Constant Amplification и Fade можно выбрать способ воз-
действия на амплитуду: фиксированное или регулируемое изменение амплитуды на
заданном участке.

При фиксированном изменении амплитуды коэффициент усиления задается с
помощью регуляторов Amplification (L и R) или численно в соответствующих полях
ввода. Например, если в каждом из этих полей ввести число 50, то для всего выде-
ленного фрагмента амплитуды сигналов в правом и левом каналах уменьшатся вдвое.
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Рис. 6.10. Вкладка Fade окна диалога Amplify

С помощью флажка Lock Left/Right можно «связать» друг с другом регуляторы
усиления левого и правого каналов. Если флажок установлен, изменение положе-
ния одного из них будет вызывать изменение положения другого.

При регулируемом изменении амплитуды можно задать способ перестройки
коэффициента усилителя от начального значения (Initial Amplification) до конеч-
ного (Final Amplification). К вашим услугам регуляторы или поля ввода. При выбо-
ре переключателя Linear Fades происходит линейное изменение коэффициента, а
при выборе переключателя Logarithmic Fades — логарифмическое.

В зависимости от состояния выключателя View all settings in dB значения коэф-
фициентов усиления задаются либо в процентах, либо в децибелах.

В группе DC Bias вы сможете отрегулировать смешение звукового сигнала от-
носительно заданного уровня. Для этого нужно установить флажок DC Bias Adjust
и задать смещение в процентах. Регулировка смешения сигнала бывает очень по-
лезна. Если звук записан со смешением или смешение возникло в результате пре-
образований сигнала каким-либо звуковьга редактором (кроме Cool Edit Pro, в
котором все преобразования выполняются корректно) или сигнал содержит боль-
шую постоянную составляющую либо низкочастотные составляющие с больши-
ми амплитудами, то перед выполнением дальнейших преобразований нужно из-
бавиться от этой, в некотором смысле, аномалии. Центрирование сигнала
относительно заданного уровня позволит в ходе дальнейших преобразований уст-
ранить нежелательные низкочастотные составляющие, которые, как правило, дают
о себе знать щелчками при монтаже фонограммы.
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В группе Calculate Normalization Values расположены элементы управления нор-
мализацией сигнала. В поле ввода Peak Level задается пиковый уровень сигнала.
Например, 0 dB (или 100%) означает, что звуковой сигнал должен занять весь ди-
намический диапазон.

Нажимая кнопку Calculate Now, вы предписываете программе произвести рас-
чет такого коэффициента усиления, при котором сигнал будет иметь заданный
динамический диапазон после выполнения операции Amplify. Затем регуляторы
усиления автоматически установятся в соответствующее положение.

В группе Presets можно выбрать стандартные схемы настроек (пресеты) орга-
нов управления, расположенных в окне диалога Amplify:

> 10dB Boost — повышение уровня сигнала на 10 дБ
> 10dB Cut — понижение уровня сигнала на 10 дБ
> 3dB Boost — повышение уровня сигнала на 3 дБ
> 3dB Cut — понижение уровня сигнала на 3 дБ
> 6dB Boost — повышение уровня сигнала на 6 дБ
> 6dB Cut — понижение уровня сигнала на 6 дБ (см. рис. 6.9)
> Center Wave — центровка звукового сигнала относительно нулевого уровня
> Fade In — постепенное увеличение громкости от 0% (-240 дБ) до 100% (0 дБ)
> fade In Left — постепенное увеличение громкости в левом канале от 0% (—240 дБ)

до 100% (0 дБ); громкость в правом канале не изменяется (см. рис. 6.30)
> Fade In Right — постепенное увеличение громкости в правом канале от 0%

(-240 дБ) до 100% (0 дБ); громкость в левом канале не изменяется
> Fade Out — постепенное уменьшение громкости от 100% (0 дБ) до 0%

(-240 дБ)
> Pan Hard Left — полное панорамирование звука в левый канал
> Pan Hard Right — полное панорамирование звука в правый канал
> Pan L->R — панорамирование звука слева направо; тот звук, что был в нача-

ле выделенного фрагмента слышен, слева, к концу фрагмента «перетечет» в
правый канал

> Pan Left 3dB — панорамирование звука в левый канал (с разницей уровней в
каналах 3 дБ)

> Pan R->L — панорамирование звука справа налево
> Pan Right 3dB — панорамирование звука в левый канал (с разницей уровней

в каналах 3 дБ)

При помощи кнопок Add и Del можно добавлять ваши собственные схемы на-
строек и удалять из списка уже существующие. Над этими кнопками расположе-
но поле, в котором необходимо набрать имя новой схемы настроек, а уж потом
нажать кнопку Add.

Если при создании или преобразовании аудиофайла вами выбран монофони-
ческий формат, то вкладки станут выглядеть проще: уменьшится количество регу-
ляторов, полей ввода и вариантов стандартных схем настройки органов управле-
ния. На рис. 6.11 показана вкладка Constant Amplification, а на рис. 6.12 — вкладка
Fade для монофонического аудиофайла.
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Рис. 6.12. Вкладка Fade при монофоническом формате аудиофайла
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6.6. Channel Mixer... - открыть канальный микшер
Channel Mixer... (следующая команда подменю Amplitude) вызывает окно диа-

лога канального микшера (рис. 6.13).

Channel Mixer

1" New Left Channel'- --•"•-
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Рис. 6.13. Канальный микшер

Канальный микшер позволяет смешивать сигналы стереоканалов аудиофайла
произвольным образом. Группы New Left Channel и New Right Channel содержат
регуляторы пропорций смешивания звуков для новых (получаемых после выпол-
нения операции микширования) левого и правого каналов. Регуляторами L и R
устанавливаются уровни звука левого и правого каналов. Регулировка осуществ-
ляется в пределах от -100 до 100. Отрицательное значение пропорции означает,
что звук будет инвертирован относительно нулевого уровня (сигнал как бы умно-
жается на -1). Флажки Invert позволяют инвертировать любой из результирую-
щих сигналов новых стереоканалов.

Как и большинство других функций программы, канальный микшер предус-
матривает работу со стандартными схемами настроек. В поле Presets расположе-
ны список настроек и кнопки Add и Del, позволяющие добавлять и удалять эле-
менты этого списка. Перечислим стандартные схемы настройки.

> Average — усреднение, взаимное проникновение стереоканалов друг в дру-
га. Эта операция превращает стереофонический звук в монофонический.
Сигналы смешиваются в пропорции 50% на 50%.

> Both = Left — в оба канала нового аудиофайла поместить сигнал левого ка-
нала исходного аудиофайла.

> Both = Right — в оба канала нового аудиофайла поместить сигнал правого
канала исходного аудиофайла.

> Full Mix — эта операция подобна операции Average: стереофонический звук
превращается в монофонический, однако сигналы смешиваются в пропор-
ции 100% на 100%. Можно применять при заведомо малом уровне сигнала.
Иначе после смешивания возникнут искажения.
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> Inverted Average — инвертированное усреднение. Стереофонический сигнал
превращается в монофонический. Сигналы в левом и правом каналах оди-
наковы, но противоположны по фазе. Разницу между инвертированным
усреднением и просто усреднением вы можете ощутить на слух. Возможно,
это будет звучать страшновато, но при инвертированном усреднении у слу-
шателя создается впечатление, будто источник звука расположен в его го-
лове.

> LR to Mid Side — сумма сигналов правого и левого каналов помешается и
новый левый канал, разность — в новый правый. Смешивание происходит
в пропорции 50% на 50%. Создается впечатление расширения стереобазы
со смещением центра в новое положение.

> Mid Side to LR — пресет, аналогичный предыдущему. Смешивание в про-
порции 100% на 100%.

> No Mixing — канальные сигналы изменений не претерпевают.
> Pan Center Left — смещение центра стереообраза влево.
> Pan Center Right — смещение центра стереообраза вправо.
> Swap Channels — поменять местами левый и правый каналы.
>• Vocal Cut— вырезать источник звука, находящийся в середине панорамы

(рис. 6,14).
> Wide Stereo Field — расширение стереопанорамы (два варианта).
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C îcel j
I •i.;,,— J

Help

Рис. 6.14. Установки регуляторов канального микшера для варианта Vocal Cut

Мы не случайно выдели стандартную схему настройки Vocal Cut. При тех зна-
чениях параметров, что представлены на рис. 6.14, Channel Mixer превращается в
воровской инструмент. Вырезается источник звука, находящийся в середине па-
норамы. А что обычно находится в окрестностях этой точки? Голос солиста. Запи-
сываете с компакт-диска в Cool Edit Pro самую любимую композицию (чужую).
Обрабатываете ее Channel Mixer со стандартной настройкой Vocal Cut. Звучание
музыкальных инструментов и бэк-вокала остается практически неизменным, а
голос солирующего вокалиста исчезает. В вашем распоряжении оказывается ми-
нусовая фонограмма с прекрасной первозданной аранжировкой. Можете петь под
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нее сами. Таким способом можно обеспечить себе весьма солидный разноплано-
вый репертуар и выступать с ним.

К счастью, не из всякой фонограммы удастся «начисто» удалить голос вокалис-
та. Как правило, в тех песнях, которые нам с вами нравятся, все прекрасно: и мело-
дия, и вокал, и аранжировка, и сведение. А это значит, что голос вокалиста обяза-
тельно обработан стереоэффектами (реверберацией, дилэем). Голос рождается не
из одной точки стереопанорамы. Он стереофоничен,т. е. распределен по панораме.
То, что мы слышим из точки, находящейся чуть левее центра, отличается от того,
что исходит из симметрично расположенной точки. Поэтому, чтобы избавиться от
голоса, нужно применить более серьезную и тонкую обработку, чем сложение в про-
тивофазах правого и левого каналов с последующим инвертированием одного из
вновь сформированных канальных сигналов (в этом суть пресета Vocal Cut).

Честно говоря, трудно описать результат применения какого-либо пресета ка-
нального микшера. Одно можно сказать: стереообраз фонограммы существенно
меняется, а в отдельных случаях меняется и тембр.

Лучше поступить следующим образом. Загрузите в Cool Edit Pro какой-нибудь
короткий и ясно звучащий аудиофайл. Создайте копию этого аудиофайла и обра-
батывайте ее с помощью канального микшера, поочередно выбирая каждый из
пресетов. Можно прослушивать то, что получается, по отдельности, но результат
будет заметнее, если объединить обработанные аудиофайлы в цепочку и слушать
их последовательно в едином цикле. Таким образом, вы получите ясное представ-
ление о реальных последствиях обработки звука канальным микшером.

Есть смысл хотя бы однажды протестировать аналогичным способом и другие
обработки и эффекты, предоставляемые программой.

6.7. Dynamics Processing... —универсальная
динамическая обработка

Командой Effects > Amplitude > Dynamics Processing... открывается окно диало-
га Dynamic Range Processing (рис. 6.15). В этом окне реализован виртуальный уни-
версальный прибор динамической обработки. О сущности динамической обра-
ботки мы подробно рассказали в книге [8"|. Поэтому сейчас ограничимся лишь
изложением кратких сведений о назначении приборов динамической обработки,
работа которых моделируется в Cool Edit Pro.

В зависимости от выполняемых функций различают следующие приборы ди-
намической обработки:

> Ограничители уровней
> Автостабилизаторы уровня
> Компрессоры динамического диапазона
'#• Экспандеры динамического диапазона
> Компандерные шумоподавители
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>* Пороговые шумоподавители (гейты)
» Устройства со сложным преобразованием динамического диапазона

Ограничитель уровня (лимитер) — это авторегулятор уровня, у которого коэффи-
циент передачи изменяется так, что при превышении номинального уровня вход-
ным сигналом уровни сигналов на его выходе остаются практически постоянными,
близкими к номинальному значению. При входных сигналах, не превышающих
номинального значения, ограничитель уровня работает как обычный линейный
усилитель. Лимитер должен реагировать на изменение уровня мгновенно.

Автостабилизатор уровня предназначен для стабилизации уровней сигналов.
Это бывает необходимо для выравнивания громкости звучания отдельных фраг-
ментов фонограммы. Принцип действия автостабилизатора аналогичен принци-
пу действия ограничителя. Отличие заключается в том, что номинальное выход
ное напряжение автостабилизатора приблизительно на 5 дБ меньше номинального
выходного уровня, в то время как у ограничителя оно составляет 0 дБ.

Компрессор — такое устройство, коэффициент передачи которого возрастает по
мере уменьшения уровня входного сигнала.

Действие компрессора приводит к повышению средней мощности и, следова-
тельно, громкости звучания обрабатываемого сигнала, а также к сжатию его ди-
намического диапазона.

Экспандер имеет амплитудную характеристику, обратную по отношению к ам-
плитудной характеристике компрессора. Экспандер применяют в том случае, когда
необходимо восстановить динамический диапазон, предварительно преобразован-
ный компрессором. Система, состояшая из последовательно включенных комп-
рессора и экспандера, называется компандером. Она используется для снижения
уровня шумов в трактах записи или передачи звуковых сигналов.

Пороговый шумоподавитель (гейт) — это авторегулятор, у которого коэффици-
ент передачи изменяется так, что при уровнях входного сигнала меньше порого-
вого амплитуда сигнала на выходе близка к нулю. При входных сигналах, уровень
которых превышает пороговое значение, пороговый шумоподавитель работает как
обычный линейный усилитель.

Авторегулятор, обеспечивающий сложное преобразование динамического ди-
апазона, может, например, состоять из ограничителя, автостабилизатора, экспан-
дера и порогового шумоподавителя, Такое сочетание позволяет стабилизировать
громкость звучания различных фрагментов композиции, выдерживать максималь-
ные уровни сигнала и подавлять шумы в паузах.

Любой прибор динамической обработки в своем составе имеет два функцио-
нальных элемента — основной канал и канал управления.

Задача канала управления заключается в обнаружении момента пересечения
аудиосигналом порогового значения, измерении уровня аудиосигнала относитель-
но порога и выработке управляющего напряжения.

Характер обработки зависит от вида характеристики регулируемого элемента
основного канала. Например, если с ростом управляющего напряжения, подавае-
мого на регулируемый элемент, его коэффициент передачи уменьшается, то полу-
чается компрессор, если увеличивается, то — экспандер.
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Оценку инерционности устройств динамической обработки осуществляют на
основе анализа двух временные характеристик: времени срабатывания и времени
восстановления.

Для регулируемых звеньев всех устройств динамической обработки, кроме шу-
моподавителя, срабатыванием принято считать реакцию устройства на увеличение
уровня сигнала, а восстановлением — на его уменьшение. Время срабатывания —
это интервал между моментом, когда от источника начинает подаваться сигнал с
уровнем на 6 дБ выше номинального значения, и моментом, когда выходной уро-
вень уменьшается с 6 дБ до 2 дБ по отношению к номинальному значению.

Время восстановления — это интервал между моментом, когда уровень сигна-
ла от источника снижается с 6 дБ до номинального значения 0 дБ, и моментом,
когда выходной уровень увеличивается от —6 до —2 дБ по отношению к номиналь-
ному значению.

Для шумоподавителя срабатыванием принято считать уменьшение усиления
при пропадании полезного сигнала, а восстановлением — восстановление усиле-
ния при появлении полезного сигнала.

Одной из наиболее часто применяемых разновидностей динамической обра-
ботки является компрессия — сжатие динамического диапазона.

Субъективно компрессия проявляется как увеличение громкости звука. Он ста-
новится более плотным! И это не удивительно. Ведь в результате компрессии можно
достичь увеличения средней мощности неискаженного сигнала. По сути дела ком-
прессия сводится к автоматическому управлению усилением. Когда уровень сиг-
нала становится слишком большим, усиление уменьшается, а при нормальном
уровне сигнала усилению возвращается исходное значение,

Результат компрессии зависит от правильного выбора значений нескольких
основных параметров. К важнейшим из них относятся;

> Порог срабатывания (Threshold)
> Коэффициент компрессии или коэффициент сжатия (Compression Ratio)
> Компенсирующее усиление (Makeup Gain)
> Время атаки (Attack Time)
> Время восстановления (Release Time)

Рассмотрим подробнее перечисленные параметры.
Порог срабатывания определяет уровень, при превышении которого компрес-

сор начинает управлять усилением (иногда говорят, что он находится в активном
состоянии). До тех пор пока значение уровня сигнала меньше порогового, комп-
рессор не воздействует на сигнал (компрессор находится в пассивном или выклю-
ченном состоянии). От величины порога зависит, коснется ли обработка только
отдельных пиков или сигнал будет подвергаться компрессии постоянно.

Коэффициент компрессии (сжатия) определяет степень сжатия динамического ди-
апазона сигнала, имеющего уровень выше порогового. Численно он равен отношению
уровня сигнала на выходе работающего компрессора к уровню сигнала на его входе.

Например, коэффициент компрессии 2:1 означает, что изменение уровня вход-
ного сигнала на 2 дБ вызовет изменение уровня выходного сигнала только на 1 дБ.
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На практике именно такое отношение часто применяется, хотя иногда приходит-
ся устанавливать более высокие значения. Если коэффициент компрессии уста-
новлен, скажем, в пропорции 20:1 и больше, то получается режим ограничения.
Это значит, что если на входе появляется сигнал, превышающий установленный
уровень, то сигнал на выходе практически не будет усилен.

Абсолютному ограничению соответствует коэффициент компрессии «Беско-
нечность:!», но на практике величины отношений больше, чем 20:1, дают такой
же эффект.

Время атаки определяет, насколько быстро компрессор будет реагировать на
сигналы с уровнем выше порогового.

При больших значениях параметра Attack Time компрессор, вероятнее всего,
не будет успевать отслеживать резкие увеличения уровня входного сигнала. В сиг-
нале на выходе компрессора будут присутствовать пики.

Если значение параметра Attack Time мало, то можно практически исключить
возникновение пиков сигнала при скачкообразном увеличении его уровня. Одна-
ко при этом звучание может стать недостаточно акцентированным.

Время восстановления — это время, за которое компрессор выходит из актив-
ного состояния после падения уровня сигнала ниже порогового.

Если время восстановления слишком велико, то компрессор дольше находит-
ся в активном состоянии и воздействует на динамический диапазон даже тогда,
когда это нежелательно. Это дает заметный на слух эффект пульсации звука, так
как компрессия не приводит к сглаживанию сигнала.

При малом времени восстановления обеспечивается более существенное сгла-
живание. Но в тех ситуациях, когда уровень входного сигнала постоянно колеб-
лется в окрестностях порогового значения, возможно возникновение эффекта
«захлебывания».

Подбор оптимального времени восстановления основан на поиске компромис-
са. Обычно рекомендуется для инструментальной музыки в качестве грубого при-
ближения и отправной точки для более тонкой настройки выбирать время восста-
новления порядка 500 мс. Это соответствует промежутку между двумя тактами при
темпе 120 четвертей в минуту.

Восприятие музыки зависит от динамического диапазона, так как динамика
позволяет передать эмоциональное содержание. Если совершенно сгладить дина-
мику, сделать один неизменный средний уровень, то получится музыка, которую
неинтересно слушать.

Неопытный вокалист обычно допускает большие перепады в громкости. В ре-
зультате некоторые слова тонут в общем звучании музыки, а другие, наоборот, слыш-
ны слишком громко. Поэтому при записи вокала всегда используется компрессия.

Когда у вокалиста есть проблемы с шипящими звуками, а смена типа микро-
фона и его расположения не приводит к исправлению ситуации, тогда при сведе-
нии стоит использовать компрессор в режиме деэсера, и котором устраняются сви-
стящие и шипяшие согласные в вокальной партии.

Если путем фильтрации при помоши внешнего эквалайзера подавить все низ-
кие частоты, поступающие на вход канала управления, компрессор будет реаги-
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ровать только на высокочастотные з'вуки. В таком случае сигнал, управляющий
компрессором, формируется только из тех компонентой исходного аудиосигнала,
что составляют свист и шипение. В этом и заключается принцип действия деэсе-
ра. Выбор частотных составляющих, на которые надо повлиять, производится на
слух. Эквалайзер, включенный в канал управления компрессором, должен усиливать
частоты в области 4—10 кГд. Однако нужно подобрать точную АЧХ. Для этого можно
сначала прослушивать аудиосигнал без компрессии, пропуская его только через эк-
валайзер и настраивая его фильтры до тех пор, пока свистящий призвук не будет мак-
симально слышен. Для этих целей подходят параметрические эквалайзеры.

В составе виртуального прибора динамической обработки программы Cool Edit
Pro имеется фильтр, позволяющий реализовать деэсер. Несколько вариантов деэ-
сера содержатся в фирменных лресетах, входящих в поставку программы.

Выбор частоты эквалайзера около 50 Гц поможет устранить «плевки» в записи
вокала, вызванные взрывными согласными, из которых самая неприятная — «п».
Но лучше все же постараться уменьшить «плевки» на этапе записи (при помощи
микрофона, имеющего акустические фильтры, или сетчатого экрана), чем потом
пытаться исправить это при сведении.

Познакомившись в общих чертах с назначением реальных приборов динами-
ческой обработки, возвратимся к окну диалога Dynamics Range Processing, которое
представляет собой внешнюю, видимую частъ виртуального динамического про-
цессора. В зависимости от выбранных значений параметров он может быть гейтом,
компрессором, экспандером, лимитером и деэсером. Причем вид обработки и зна-
чения параметров вы можете задавать как графическим путем, так и численно.

В окне диалога Dynamic Range Processing имеются 4 вкладки:

> Graphic — служит для изменения графическим путем характера и парамет-
ров динамической обработки

> Traditional — служит той же пели, что и вкладка Graphic, но управление па-
раметрами производится традиционным (численным) способом

> Attack/Release — предназначена для выбора параметров, влияющих на про-
цесс включения и выключения процедуры динамической обработки

> Band Limiting — обеспечивает выбор обрабатываемого частотного диапазона

6.7.1. Вкладка Graphic окна диалога Dynamic Range Processing
Рассмотрим вкладку Graphic окна диалога Dynamic Range Processing, представ-

ленную на рис. 6.15.
Значительное пространство на этой вкладке занимает координатное поле. По

горизонтали отложены значения уровня входного сигнала в децибелах, а по вер-
тикали (тоже в децибелах) — выходного. Таким образом, график показывает, ка-
кой уровень выходного (обработанного) сигнала соответствует некоторому задан-
ному уровню входного (необработанного) сигнала. По сути дела, этот график —
амплитудная характеристика устройства динамической обработки.

Если график представляет собой прямую линию, проходящую из нижнеголе-
вого угла рабочего поля в его верхний правый угол (см. рис. 6.15), это означает,
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Рис. 6.15. Вкладка Graphic окна диалога Dynamic Range Processing

что динамической обработки сигнала нет. Каков уровень входного сигнала, такой
и уровень сигнала выходного.

Щелкнув левой кнопкой мыши на графике, вы создадите узел (точку возмож-
ного перегиба графика). Не отпуская кнопку мыши, перемещайте курсор. При
этом координаты узла будут отображаться под рабочим полем. Отпустив кнопку
мыши, вы тем самым зафиксируете положение узла, а параметры динамической
обработки, соответствующей созданному вами графику, появятся в информаци-
онном поле, находящемся справа от координатной плоскости. Каждый узел опи-
сывается двумя строками. В начале строки приводится вид динамической обра-
ботки: сшр (компрессирование) или ехр (экспандирование), далее -
коэффициент преобразования динамического диапазона. В конце строки ука-
зывается диапазон значений уровня входного сигнала, в котором производится
об!работка. Например, запись

ехр 2 : 1 above -30 dB
означает расширение динамического диапазона с коэффициентом 2:1 для зна-

чений входного сигнала выше -30 дБ. Запись
стр 1 . 7 : 1 below -30 dB

следует понимать так: для значений входного сигнала ниже —30 дБ произво-
дится компрессия с коэффициентом 1,7:1.
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Рис. 6.16. Пример графика

График с такими параметрами представлен на рис, 6.16.
Сделав двойной щелчок левой (или одинарный щелчок правой) кнопкой мыши

на узле графика, вы откроете окно диалога Edit Point (рис. 6.17), в котором можно
совершенно точно численным способом задать координаты узла.

Edil Point

l Leve

QulpiA Signal Level 1-60

Рис. 6.17. Окно диалога Edit Point

Для этого в поле Input Signal Level нужно ввести значение уроиня входного сиг-
нала (координату узла на горизонтальной оси), а в ноле Output Signal Level — зна-
чение уровня выходного сигнала {координату узла на вертикальной оси). Допус-
тимый диапазон значений этих координат меньше нуля. Если вы ошибетесь и
забудете ввести знак (минус), например, вместо -40 введете 40, тогда программа
заменит недопустимое значение нулем. Чтобы узел исчез с графика, ничего не вво-
дите в эти поля.
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1'ис. 6.18. Результат применения кнопки Invert

Кнопка Invert, расположенная на вкладке Graphic окна диалога Dynamic Range
Processing, позволяет инвертировать график, т. е. заменить график на такой, кото-
рый будет точной противоположностью исходному: там, где раньше производилась
компрессия, будет экспандирование и наоборот. На рис. 6.18 представлен результат
изменения графика, приведенного на рис. 6.16, после применения кнопки Invert.

Инвертирование графика возможно только в том случае, когда он проходит
через две угловые точки (точки с координатами -100, —100 и 0, 0) и каждый узел
расположен выше по сравнению со своим ближайшим соседом слева.

Если установлен флажок Splines, то «угловатый» график заменяется его сплайн--
аппроксимацией (сглаживается). График, представленный на рис. 6.18, после за-
мены реальной функции ее сплайн-аппроксимацией будет таким, как показано
на рис. 6.19.

Важно понимать, что при этом изменяется не только характер графика, но и
фактическая зависимость выходной величины от входной.

Кнопка Flat возвращает график в состояние по умолчанию (превращает его в
прямую линию, все промежуточные узлы уничтожаются).

Установив флажок Create Envelope Only и нажав кнопку ОК, вы создадите оги-
бающую амплитуды волновой формы. Для того чтобы лучше представить себе, что
такое огибающая амплитуды, сравните рис. 6.20 (исходный сигнал) и рис. 6.21
(огибающая амплитуды сигнала).
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Рис, 6.19. Результат применения кнопки Splines

Рис. 6,20. Исходный сигнал
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Рис. 6.21. Огибающая амплитуды сигнала

Видно, что полученный сигнал лишен тонального заполнения, характерного
для исходной волновой формы. Исчезли все периодические колебания. Осталась
только функция, график которой описывает закон изменения во времени ампли-
туды исходной волновой формы. Можно сравнить не только графики, но и звуча -
ние исходного и полученного аудиофайлов. Скорее всего, вам не понравятся но -
вые слуховые ощущения: кроме тресков и шелеста ничего не слышно. Ни
огибающая и не предназначена для того, чтобы ее слушали отдельно от тонально
го заполнения. Не случайно под надписью у флажка Create Envelope Only имеется
приписка (preview as noise), означающая пояснение того, что при предваритель-
ном прослушивании с помощью кнопки Preview в качестве заполнения огибаю-
щей используется шум. Это очень удачное решение, позволяющее на слух оце-
нить «чистое», не замаскированное тональным заполнением слуховое впечатление
от огибающей.

Огибающая может быть скопирована или сохранена в файле. Это ведь все рав
но волновая форма, правда, звучащая специфически. Возникает закономерный
вопрос: какая польза от этой,, образно говоря, «кожи, снятой со звука»?

В дальнейшем огибающую можно использовать для синтеза качественно но-
вых звуков, модулируя ею амплитуду другого звука. Например, можно взять на
фортепиано ноту, записать этот звук, сформировать огибающую и промодулиро-
вать ею волновую форму, содержащую запись голоса вокалиста, исполняющего
какую-нибудь ноту или даже целую фразу. В результате получится совершение!
фантастический звук, который вряд ли сможет спеть даже человек, оченьхорошо
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•Ч Untitled* - Cool Edit Pro
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Рис. 6.22. Обрабатываемая волновая форма

Рис. 6.23. Синтезированная волновая форма
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владеющий своим голосом. Атака, поддержка, затухание — все фазы звука харак-
терны для фортепиано, но вместо струны зазвучит человеческий голос.

Осталось только рассказать, как эти чудеса реализовать на практике. Итак, в
буфере обмена есть огибающая. Сначала нужно загрузить файл, содержащий вол-
новую форму, подвергаемую обработке (рис. 6.22). К слову сказать, содержимое
этой волновой формы — чистый, без обертонов звукля.

А затем командой Edit > Mix Paste... открыть окно Mix Paste (разд. 4.4). В нем
следует выбрать опции Modulate, From Clipboard, задать глубину модуляции и на-
жать кнопку ОК. Допустим, в буфере обмена хранилась волновая форма с огибаю-
щей, изображенной на рис. 6.21. Тогда результат будет напоминать то, что пред-
ставлено на рис. 6.23.

Отметим, что вы можете использовать опцию Create Envelope Only независимо
от того, применяется ли динамическая обработка.

6.7.2. Вкладка Traditional окна диалога Dynamic Range Processing
Вкладка Traditional (рис. 6.24) содержит ту же информацию о преобразованиях

динамического диапазона, что и вкладка Graphic, но информация представлена в
числовой, а не графической форме.

Переключатели, пронумерованные (от 2 до 6), соответствуют узлам графика.
Правда, узлов может быть и больше чем 6.

{Dynamic Range Processing
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De-Esser Hard

De-Esset Medium

crnp 1.7: Т. below -30>ffi
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F'KC- 6.24. Вкладка Traditional окна диалога Dynamic Range Processing
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Справа от каждого из переключателей находится раскрывающийся список, в
котором отображается характер преобразования динамического диапазона на
участке графика, расположенном выше соответствующего узла. Содержимое это-
го списка можно редактировать, выбирая один из трех видов преобразования
динамического диапазона: Expand (расширение), Compress (сжатие) и Flat (не
изменяется).

В полях ввода столбца Ratios отображены значения коэффициента преобразо-
вания динамического диапазона. Их можно изменять, не только редактируя со-
держимое полей ввода, но и регулируя углы наклона отрезков прямых линий, со-
ставляющих график.

В полях ввода столбца Thresholds можно отредактировать значения порогов
(уровней, которым соответствуют узлы графика).

В поле Output Compensation (gain) вы можете изменить, значение коэффипиента
усиления выходного сигнала для того, чтобы скомпенсировать изменение уровня
сигнала при обработке эффектом.

6.7.3. Вкладка Attack/Release окна диалога Dynamic Range Processing
На вкладке Attack/Release (рис. 6.25) вы можете отредактировать параметры

усилительного и детекторного каналов (глава 4) виртуального прибора динами-
ческой обработки.

В группе Gain Processor содержится опция Joint Channels (обрабатывать оба ка-
нала совместно) и следующие поля для ввода:

; Dynamic Range Processing .
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Рис. 6.25. Вкладка Attack/Release окна диалога Dynamics Range Processing
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> Output Gain — коэффициента усиления на выходе
> Attack Time — времени атаки (для выходного сигнала)
> Release Time — времени спада (для выходного сигнала)

В группе Level Detector содержатся следующие поля для ввода:
> Input Gain — коэффициента усиления на входе детектора уровня
> Attack Time — времени атаки (для входного сигнала)
> Release Time — времени спада (для входного сигнала)

С помощью переключателей Peak или RMS вы можете выбрать вид амплитуд-
ного детектора: пиковый или среднеквадратический соответственно.

В поле Lookahead Time следует ввести время, на которое включение устройства
динамической обработки должно опережать появление резкого перепада уровня
сигнала. Данный параметр достоин более подробного комментария.

В режиме Waveform View программа Cool Edit Pro не позволяет обрабатывать
аудиоданные в реальном времени. Иногда это обстоятельство ставится в вину со-
здателям программы. Однако критики забывают, что некоторые атгоритмы обра-
ботки в принципе невыполнимы в реальном времени. Как реагировала бы программа
динамической обработки, функционирующая в реальном времени, обеспечиваю-
щая, например, ограничение сигнала, на появление в сигнале резкого выброса, скач-
ка уровня? Был бы обнаружен резкий перепад уровня сигнала и выполнена команда
уменьшения усиления (точнее, пересчета значений амплитуды сигнала). Для этого
понадобилось бы некоторое время. Поэтому амплитуда сигнала была бы уменьше-
на не точно в момент появления скачка уровня, а с некоторым запаздыванием. Это
значит, что на выход виртуального устройства обработки успел бы «проскочить» им-
пульс, длительность которого определяется временем реакции программы. Если ис-
кусственно не вводить задержку выходного сигнала по отношению ко входному, то
невозможно избежать искажений сигнала при включении и выключении обработ-
ки. В реальном времени царит принцип причинно-следственной связи, нарушить
который можно лишь при наличии машины времени.

Если обработка ведется не в реальном времени, то рассмотренной проблемы
не существует. Программа анализирует и преобразует хранящиеся в файле звуко-
вые данные за несколько проходов. Вовремя первого прохода выявляются отсче-
ты, соответствующие заданному критерию, Например, отмечаются точки резкого
изменения значений отсчетов. Во время следующих проходов обработка ведется
либо начиная точно с выявленных отсчетов, либо даже с некоторым упреждени-
ем. Таким образом, можно получить результат, характерный для безынерционных,
идеальных устройств обработки, которых не существует в природе.

6.7.4. Вкладка Band Limiting окна диалога Dynamic Range Processing

На вкладке Band Limiting следует задать нижнюю (Low Cutoff) и верхнюю (High
Cutoff) граничные частоты обрабатываемого диапазона.

Опции этой вкладки позволяют подвергать динамической обработке не весь сиг-
нал в целом, а только отдельные его спектральные составляющие. Так, например,
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при тех значениях параметров, что установлены на вкладке, представленной на
рис. 6.26, динамическая обработка будет вестись в диапазоне частот, характерном
для свистящих звуков в речи человека. Так реализован виртуальный деэсер.

[Dynamic Range Processing

Graphic] Traditional | AHack/Reteesa Band Limiting j
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Рис. 6.26. Вкладка Band Limiting окна диалога Dynamic Range Processing

В списке стандартных установок окна диалога Dynamic Range Processing теку-
щей версии программы вы найдете реализации всех актуальных методов динами-
ческой обработки. Приведем их перечень и краткую характеристику.

> 2:1 Compressor < 20 dB — компрессия сигналов с уровнем ниже —20 дБ
(коэффициент компрессии 2:1).

> 3:1 Compressor < 10 dB — компрессия сигналов с уровнем ниже —10 дБ
(коэффициент компрессии 3:1).

> 3:1 Compressor > 30 dB — компрессия сигналов с уровнем выше —30 дБ
(коэффициент компрессии 3:1).

> 3:1 Expander < 10 dB — расширение динамического диапазона сигналов с
уровнем ниже -10 дБ (коэффициент экспандирования 3:1).

> 4:1 Compressor > 20 dB — компрессия сигналов с уровнем выше -20 дБ (ко-
эффициент компрессии 4:1).

> De-Esser (High S) — подавление свистящих звуков; компрессия сигналов с
уровнем больше— 30 дБ (коэффициент компрессии 3:1) в диапазоне частот
5,5-14 кГц.
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> De-EsserHard —подавление свистящих звуков; компрессия сигналов с уров-
нем больше —35 дБ (коэффициент компрессии 2,99:1) в диапазоне частот
4-12 кГц.

> De-Esser Light — подавление свистящих звуков. Компрессия сигналов с уров-
нем больше —24 дБ (коэффициент компрессии 1,5:1) в диапазоне частот 4—
12 кГц.

> De-Esser Medium — подавление свистящих звуков в диапазоне частот4— i 2 кГц.
> Gate That Compressor! (—50 thr) — сложная динамическая обработка, соче-

тающая гейт, экспандер и компрессор. Полное подавление сигналов с уров-
нем меньше —50 дБ; расширение динамического диапазона сигналов с урои-
немот— 50до— 45,7 дБ (коэффициентэкспандирования 14,38:^расшире-
ние динамического диапазона сигналов с уровнем от -45,7 до -24 дБ (ко-
эффициент экспандирования 1,62:1); Компрессия сигналов с уровнем боль-
ше —24 дБ (коэффициент компрессии 5,45:1). При этом отсекаются шумы,
поднимается уровень тихих звуков, снижается уровень громких звуков.
Может пригодиться для улучшения качества звучания фонограмм, записан-
ных на магнитную ленту.

> Limiter 20: 1 @ 9 dB — ограничение сигнала на уровне —9 дБ.
** Noise Gate @ 10 dB — обработка «шумовые ворота». Компрессия сигналов с

уровнем меньше -19,6 дБ (коэффициент компрессии 18,7:1); расширение
динамического диапазона сигналов с уровнем от -19,6 до -10 дБ (коэффи-
циент экспандирования 8,93:1).

> Noise Gate @ 20 dB — обработка «шумовые ворота». Компрессия сигналов с
уровнем меньше -30,8 дБ (коэффициент компрессии 18,7:1); расширение
динамического диапазона сигналов с уровнем от -30,8 до -20 дБ (коэффи-
циент экспандирования 7,06:1). Подходит для обработки фонограмм с уров-
нем шума, менее высоким, чем в предыдущем случае.

> RialAudioB Compander — специальная динамическая обработка. Полное по-
давление сигналов с уровнем меньше —71,9 дБ; компрессия сигналов с уров-
нем от —40 до —9 дБ (коэффициент компрессии 1,14:1). Обработка позво-
ляет улучшить качество сигналов, записанных с микрофона, в условиях не-
достаточной звукоизоляции студии.

> Vocal Compressor (great!) — расширение динамического диапазона сигналои
с уровнем от-100 до-24 дБ (коэффициент эксландирования 1,26:1); ком-
прессия сигналов с уровнем больше —24 дБ (коэффициент компрессии
5,45:1). Подходит для обработки записей, выполненных в хорошей студии с
низким уровнем шума. Позволяет «навести глянец» на голос вокалиста, сгла-
живаются случайные перепады уровней при громком пении.

> Vocal Compressor II — разновидность динамической обработки голоса вока-
листа. Компрессия сигналов с уровнем от-100 до-67,4 дБ (коэффициент
компрессии 1,69:1); расширение динамического диапазона сигналов с уров-
нем от -67,4 до —24 дБ (коэффициент экспандирования J ,76:1); компрес-
сия сигналов с уровнем больше -24 дБ (коэффициент компрессии 5,45:1).
Снижает уровень шумов, вызванных недостаточной звукоизоляцией студии,
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увеличивает разборчивость тихих звуков, сглаживает неравномерность уров-
ней относительно громких звуков, обусловленную, например, изменением
расстояния от микрофона до рта певца.

> Vocal Limiter — расширение динамического диапазона сигналов с уровнем
от-100 до— 24 дБ (коэффициент экспандирования 1,26:1); ограничение на
уровне -4 дБ сигналов с уровнями, превышающими -24 дБ. Подходит для
обработки записей, выполненных в хорошей студии с низким уровнем шума.
Улучшается выразительность голоса и разборчивость нюансов в тихих мес-
тах партии. Полностью устраняется различие уровней в громких местах
партии.

Чтобы не затруднять понимание сути обработок, среди характеристик стан-
дартных установок мы не стали приводить временные параметры виртуального
усилителя и детектора уровня сигнала. Их можно увидеть на вкладке Attack/Release.

6*8* Envelope*.* —управление формой огибающей
амплитуды

Команда Envelope меню Amplitude вызывает окно диалога Create Envelope
(рис. 6.27). С его помощью вы можете придать огибающей амплитуды волновой
формы выбранную конфигурацию.

Create Envelope
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jSplme Curvesi 5.0Э see -> 42 %

ADSR Envelope
Bell Curve
Cufve - Pulse
Keep Attack Qnl

j Quick Slope In
Remove Attack
Smooth Attack
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Smooth Fade In

Рис. 6.27. Окно
диалога Create
Envelope
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И опять перед вами координатная плоскость. На этот раз по горизонтали отло-
жено время, по вертикали — уровень сигнала. Обратите внимание на то, что дли-
на огибающей равна длительности фрагмента волновой формы, выделенного в
рабочем поле главного окна.

Здесь можно «нарисовать» огибающую любой формы, например, такую как на
рис. 6.27. Как обычно, щелчками кнопкой мыши на линии, находящейся на рабо-
чем поле, вы создадите узлы. Перемещая их (также с помощью мыши), можно
придать огибающей желаемый вид.

Для чего это нужно? От формы огибающей существенно зависит спектраль-
ный состав сигнала, а значит, и тембр звука. Чистый тон ля — синусоидальное ко-
лебание'с частотой 440 Гц (см. рис. 6.22) — звучит гнусаво, нудно и совершенно
немузыкально. Но если у волновой формы, представленной на рис. 6.22, прямо-
линейную огибающую заменить, например, на ту, что видна на рис. 6.27, тембр
звука станет совсем другим. Появится и музыкальность, и «полетность», и жизнь,
а волновая форма будет выглядеть так, как показано на рис. 6.28.

Отметим, что тембр синтезированного звука зависит не только от формы оги-
бающей, но и от соотношения периода колебания тонального заполнения и дли-
тельности характерных фрагментов огибающей. Например, на рис. 6.28 можно
увидеть, что в каждом «лепестке» волновой формы умещается только по несколь-
ко периодов заполняющего колебания. По классификации, принятой в современ -
ной радиотехнике, это широкополосный и даже сверхширокополосный сигнал.
Тембр его очень богат. При его воспроизведении колебания огибающей не про-

View Effects generate analyze Fav îtra

F'HC. 6,28. Колебание со сложной огибающей амплитуды (широкополосное)
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явят себя как изменение громкости. Они происходят столь быстро, что отдельных
колебаний не различить. Если ту же самую форму огибающей (см. рис. 6,27) при-
дать более длинному аудиофайлу, то в каждом ее лепестке уместятся уже не едини-
цы, а десятки или даже сотни колебаний тонального заполняющего сигнала. На
рис. 6.29 глаз даже не в состоянии различить отдельные колебания тонального за-
полнения. Тембр такого звука немногим богаче тембра идеальной синусоиды. Здесь
колебание огибающей проявляют себя как хорошо различимые изменения гром-
кости звука.

Рис. 6.29. Колебание с огибающей сложной формы (узкополосное)

С флажком Spline Curves вы уже знакомы. Когда он установлен, ломаные линии
будут заменены сплайн-аппроксимацией. Изменение огибающей станет плавным.

В поле ввода Amplification (Усиление) можно задать значение наивысшей точки
огибающей.

Если нажать кнопку Flat, то с кривой будут удалены все узлы, она превратится
в прямую.

Для того чтобы сохранить удачно подобранную огибающую, нажмите кнопку
Add. Затем в открывшемся окне диалога наберите имя пресета.

Пока ваша фантазия ограничена недостатком опыта общения с этим программ-
ным инструментом, можно воспользоваться фирменными предустановками.

Мы не будем перечислять все пресеты, все равно соответствующие им кривые
трудно описать словами. Только о двух элементах списка следует сказать особо.
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ADSR Envelope — огибаюшая, на использовании которой основана работа
многих музыкальных синтезаторов (рис. 6.30). Процесс звукоизвлечения (и
огибаюшая) условно делится на 4 фазы: Attac, Desay, Sustain, Release (отсю-
да и сокрашение ADSR). От длительности и уровня каждой из фаз зависит
тембр синтезированного звука.

reate Envelope

Create envelop* by clicking con'rot points betow

Bell Curve
Cuive - Pulse
Keep Attack Only
P01
Quick Slope In
Remove Attack
Smooth Attack
Smooth Ends
Smooth Fade In

Г e№a«" ...****
Erevtew Help

Рис. 6.30. Огибающая ADSR
Envelope

uic ope n
Remove A Hack
Smooth At lack
Smooth Ends
Smooth Fade !n
Smooth Fade Out
Smooth Release
Soft Curve

Рис. 6.31. Модернизирован-
ная огибающая Tremors
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> Tremors — огибающая, с помошью которой можно реализовать амплитуд-
ное вибрато или тремоло. Целесообразно модернизировать эту огибающую
так, как показано на рис. б.ЗКт- е. сместить начальную и конечную точку к
нулевому уровню. Это позволит гарантированно избежать щелчков в мес-
тах склейки фрагментов волновой формы.

6,9. Hard Limiting.., — жесткое ограничение
Командой Hard Limiting... открывается окно диалога Hard Limiting (рис. 6.32), с

помощью которого можно уменьшать до заданного уровня амплитуду звуковых
колебаний при условии превышения ею некоторого порога, оставляя неизменной
амплитуду всех звуковых выборок, находящихся ниже этого порога.

Hard Limiting

Limit Иах Amplitude to j-1 dB

Доой Input by JG ей

. ; Look Ahead T«JIB J7 ms(5...20)

Вйвэ»Ш8 [lOO ms|40...300J

R УГ*: Left-arid Right.

p'C ĵping S tafisfics - —

Left Flight

MfiSarrtplfe j-31651 1-Э2446i i
Мак Sample [зТбЬо [32386

Pac№t Dipped [2-223 ̂  |2.Ж ̂

1 ——— - л, г ; • ~~ - -

' viX]

Preview j

Г" Rmass

tf t

Close |

Cancef 1

Рис. 6.32. Окно диалога Hard Limiting

Это чрезвычайно удобно, если вы, например, объединяете все треки в один
аудиофайл и имеется только несколько участков, где наблюдается клиппирова-
ние. В принципе, вы могли бы нормализовать всю волновую форму (разд. 6.10).
Однако в данном случае пользы будет не очень много: из-за наличия в сигнале
больших пиков его средний уровень окажется мал. Hard Limiting воздействует имен-
но на те части, которые были клиппированы (или могли бы быть клиппированы
при сведении аудиофайла).

Рассмотрим опции окна диалога Hard Limiting.
Limit Max Amplitude to — максимально допустимая амплитуда волновой фор-

мы. Чтобы избежать клиппирования 16-битной волновой формы, введите в этом
поле значение в пределах от-0,1 до—0,5 дБ, что даст небольшой запас по ампли-
туде, необходимый в будущем для выполнения любых операций редактирования.
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Перед выполнением ограничения звук может быть предварительно усилен.
Чтобы сделать выбранную волновую форму громче и гарантировать, что при этом
не происходит клиппирование, можно использовать поле ввода Boost Input by, в
котором следует ввести в децибелах величину предварительного усиления.

В поле Look Ahead Time вы должны ввести время упреждения срабатывания ог-
раничителя при появлении пика сигнала. Если значение этого параметра слиш-
ком мало, могут появиться слышимые искажения. Рекомендуются значения 4—
10 мс (значение по умолчанию 7 мс).

В поле ввода Release Time указывают время, необходимое для восстановления
нормального уровня звука после обработки чрезвычайно громкого пика. Для со-
хранения низкочастотного баса рекомендуется устанавливать параметр Release Time
равным 100 мс. Если его значение слишком велико, звук может оставаться ненор-
мально тихим очень долго. Например, ввод значения 2000 мс дает эффект автома -
тнческой регулировки усиления.

Если установлен флажок Link Left and Right, то уровни сигналов обоих каналов
будут изменяться совместно (по одинаковому закону), за счет чего сохраняется
стереообраз источника звука. Но можно разрешить и независимую раздельную
обработку левого и правого стереоканалов, сбросив флажок.

После нажатия кнопки Gather Statistics Now в группе Clipping Statistics отобра-
жается текущая статистика клиппирования. Для каждого из каналов приводятся
максимальное и минимальное значения отсчетов, а также доля (в процентах) от-
счетов, которые были бы клиппированы, если бы ограничение не выполнялось.
Нажимать кнопку Gather Statistics Now есть смысл всякий раз после изменения
любого из параметров этого окна.

6.1 (X Normalize*,. — нормализация
Очередная команда меню Amplitude — Normalize... (Нормализация). Она вызы-

вает маленькое окно диалога Normalize, изображенное на рис. 6.33.
В чем же суть нормализации волновой формы?

1. В поле ввода Normalize to в процентах или децибелах (зависит от состояния
флажка Decibels Format) вы задаете уровень, к которому следует нормализо-
вать волновую форму.

2. После нажатия кнопки ОК программа анализирует выделенный фрагмент
и выявляет отсчет оцифрованного звука, имеющий значение, максималь

Normalize

Т*1 iNorrnelize tft |100

Г" Decibeb Format.

Г? Normalize L/R Equally

Г "DC Bias Adjust

Рис. 6.33. Окно диалога Normalize
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ное по абсолютной величине. Таких отсчетов может быть и несколько. Это
не принципиально, поскольку максимальные значения отсчетов равны.

3. Автоматически вычисляется такой коэффициент, что при умножении на него
значение максимального отсчета становится равным заданному вами уровню.

4. Каждый из отсчетов выделенного фрагмента волновой формы умножается
на этот коэффициент.

В итоге оказывается, что максимальный отсчет принимает заданное вами зна-
чение, а значения остальных отсчетов пропорционально увеличиваются или
уменьшаются.

Обычно нормализацию применяют тогда, когда хотят, чтобы громкость звуча-
ния волновой формы стала максимальной, но при этом ни для одного из отсчетов
не произошло переполнение разрядной сетки. Можно, конечно, и просто усилить
сигнал, воспользовавшись опциями окна Amplify, но в этом случае не гарантиро-
вано, что переполнения разрядной сетки не произошло. Поэтому нормализация
равноценна оптимальному усилению сигнала: сигнал усиливается ровно во столько
раз, чтобы громкость стала максимально допустимой, а искажения не возникали.
Рассмотрим пример, иллюстрирующий такую нормализацию.

На рис. 6.34 представлен пример волновой формы, где максимальное значе-
ние имеет отсчет, находящийся около 3-й секунды (на рисунке эта область волно-
вой формы специально выделена).

ects generate ftnaiyM Favwites Options

Рис. 6.34. Пример волновой формы до нормализации
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Выделим всю волновую форму, откроем окно диалога Normalize, в поле Normalize
to введем 100% (или 0 дБ), нажмем кнопку ОК и рассмотрим полученный резуль-
тат (рис. 6.35).

Из рис. 6.35 видно, что теперь:

> График волновой формы в точке максимального отсчета (на рисунке эта
область волновой формы опять выделена) совпадает с линией, обозначаю-
щей уровень 100%

> Величины всех остальных отсчетов увеличились

Иногда появляется необходимость производить нормализацию более чем на 100%.
Может возникнуть справедливый вопрос: а не произойдет ли при этом переполнения
разрядной сетки и, соответственно, возникновения нелинейных искажений? Конеч-
но, произойдет. Но в некоторых случаях это не так уж и страшно. Приведем пример.

Допустим, в аудиофайле имеется одна или несколько импульсных помех, амп-
литуды которых значительно больше амплитуды полезного сигнала. После выпол-
нения 200%-й нормализации полезный сигнал станет значительно громче (чего и
добивались), а щелчки громче стать не смогут по той причине, что громче им ста-
новиться некуда вследствие введенного ограничения. Правда, возникнут допол-
нительные нелинейные искажения этих импульсных помех. Как от них избавить-
ся? Это другой вопрос. Но главная цель рассмотренного примера достигнута —
полезный сигнал стал громким.

L-7.7cB@ ,tf062*0' J 4 4 1 0 Q ' 16-bit -Stereo ! 3.88 MB j 31.85 GH(B«

Рис. 6.35. Пример волновой формы после нормализации
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Окно диалога Normalize содержит еще два флажка. Если флажок Normalize L/R
Equally установлен, то нормализация происходит по следующей схеме:

1. Из двух стереоканалов выбирается канал с сигналом, имеющим максималь-
ную амплитуду.

2. На основании этой информации производится нормализация одновремен-
но сигналов двух каналов.

В результате сигнал в одном из каналов вряд ли будет усилен до максимально
возможного уровня. В этом нет ничего страшного. На то он и стереозвук, чтобы
сигналы в разных каналах не были одинаковыми.

Иногда возникает необходимость раздельной нормализации стереоканалов. На-
пример, левый и правый каналы содержат совершенно разные сигналы от разных
источников звука. В этом случае было бы полезно снять флажок Normalize L/R Equally.

Флажок DC Bias Adjust вам уже знаком (разд. 6.5). С его помощью задается цен-
тровка сигнала относительно нулевого уровня, а заодно и подавление низкочас-
тотной составляющей.

Нормализация — не такая уж безобидная операция, как кажется. Применять
ее неоднократно к одному и тому же сигналу без особой нужды не следует. Дело в
том, что любые операции с числами, представленными конечным количеством
разрядов, приводят к возникновению погрешности. На слух погрешность вычис-
лений проявляется как искажение сигнала. При многократных вычислениях по-
грешность накапливается и искажения становятся более заметными.

6*11. Pan/Expand... — расширение стереопанорамы,
панорамирование среднего канала

Эффект Pan/Expand используется для расширения стереопанорамы и для сме-
щения по стереопанораме так называемого среднего канала.

Расширение панорамы производится за счет подмешивания сигнала из одного
канала в другой. При этом в подмешиваемых сигналах подвергаются коррекции
соотношения фаз. Средний канал формируется как сумма сигналов левого и пра-
вого каналов, это, по существу, монофоническая составляющая сигнала. Ширина
стереопанорамы и положение среднего канала можно изменять динамически. Для
этого нужно задать соответствующие графики зависимости этих параметров от
времени. В итоге создается эффект псевдообъемного звучания.

Изменение положения среднего канала на слух ощущается как перемещение
по стереопанораме тех источников звука, которые до обработки сигнала эффек-
том располагались в центре панорамы, причем другие источники звука (находив-
шиеся до обработки не в центре панорамы) кажутся неподвижными. Окно эф-
фекта Pan/Expand представлено на рис, 6.36.

Эффектом обрабатывается выделенный фрагмент волновой формы.
В поле Center Channel Pan с помощью мыши вы должны «нарисовать» график изме-

нения во времени положения среднего канала на стереопанораме. Вы можете исполь-
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CenierCn The Left [Wide]
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РИС. 6.36. Окно
эффекта Pan/
Expand

зовать график как для того, чтобы позиционировать средний канал в какой-нибудь точке
стереопанорамы в пределах от крайне левой (-100%) до крайне правой (100%), так и
для перемещения его справа налево или в противоположном направлении.

Перемешая по вертикали и по горизонтали узлы, добиваются изменения фор-
мы графика. Чтобы добавить узел к графику, щелкните в той точке координатной
сетки, где вы хотите создать изгиб графика. Когда курсор мыши будет совмещен с
узлом, вы увидите, что из стрелки он превратится в руку. Для перемещения узла по
графику щелкните на узле и, удерживая левую кнопку мыши нажатой, перемести-
те его к новому положению. Чтобы удалить узел, переместите его к правой или
левой оконечностям графика. Для того чтобы ввести время и значение стереопо--
зиции для узла графика в цифровой форме, щелкните правой кнопкой мыши на
узле. Откроется окно диалога, подобное представленному на рис. 6.17.

В поле Stereo Expand аналогичным образом вы можете нарисовать график из-
менения ширины стереопанорамы во времени. Значения, превышающие 100%,
соответствуют расширению стереопанорамы. Изменяя ширину стереопанорамы,
можно создать интересные эффекты, например, эффект постепенного преобра-
зования монофонического сигнала в сигнал с очень широкой стереопанорамой,

Флажками Spline Curves включается режим сглаживания сплайнами «углова-
тых» графиков. Вместо прямой линии между узлами графика формируется кривая
по методу наилучшего приближения. При сплайновой аппроксимации линия гра-
фика, как правило, не будет проходить непосредственно через узлы. В данном слу-
чае, используя узлы, вы получаете возможность управлять формой этой кривой.
Чтобы построить кривую, отображающую все нюансы вашего замысла, создайте
много узлов, расположенных близко друг к другу.
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Кнопка Flat служит для возврата графика в состояние, заданное по умолча-
нию. При этом удаляются все узлы, а график превращается в прямую линию.

Графикам, представленным на рис. 6.36, соответствуют следующие изменения
стереообраза обрабатываемого аудиофайла:

> Средний канал сначала будет находиться в центре панорамы, затем посте-
пенно переместится влево, вправо, влево, вправо и вновь возвратится в
центр

> Стереобаза в начале волновой формы будет сужена до 50% от исходной, за-
тем ее ширина будет постепенно увеличиваться и в конце волновой формы
достигнет 200% от исходной

В этом окне, также как и во многих, других предусмотрено средство для сохра-
нения созданных вами пресетов и использования готовых предварительных уста-
новок. Правда, готовых установок всего 7:

> Center On The Left (Wide) — смещение среднего канала влево с одновремен-
ным расширением стереобазы на 150%

> Center On The Right — смещение среднего канала вправо. Ширина стерео-
базы не меняется

> Mastering Width — расширение стереобазы выделенного участка волновой
формы на 150%. Положение среднего канала не изменяется. Подобную об-
работку иногда можно применять в процессе мастеринга

> MaxExpansion — максимальное (300%) расширение стереобазы выделенно-
го участка волновой формы. Положение среднего канала не изменяется

> Mono/ Expanding Effect — имитация стереофонического звучания исходно
монофонического аудиофайла. Ширина стереобазы периодически изменя-
ется относительно значения, несколько большего, чем 100%

> Pan Left to Right — панорамирование слева направо. Средний канал посте-
пенно перемещается из крайней левой точки панорамы в крайнюю правую

> Pan Right to Left — панорамирование справа налево. Средний канал посте-
пенно перемещается из крайней правой точки панорамы в крайнюю левую

Если вы займетесь экспериментальным исследованием действия эффекта Pan/
Expand, то обнаружите, что не всегда результаты совпадают с теоретически ожида-
емыми. Например, панорамируется не только средний канал, но и источники зву-
ка, смещенные относительно центра панорамы. В этом нет ничего удивительно-
го. Во-первых, на результат обработки в значительной степени влияют
стереофонические свойства исходного аудиофайла. Во-вторых, не следует ожи-
дать чуда, ведь в основе эффекта лежат не спектральные или какие-нибудь психо-
акустические преобразования, а всего лишь операции инвертирования, сложения
и вычитания значений отсчетов сигналов правого и левого каналов. То есть эф-
фект Pan/Expand преобразовывает звук так же, как и канальный микшер (разд. 6.6).
Принципиальная разница состоит только в том, что эффект Pan/Expand предостав-
ляет пользователю инструмент графического управления преобразованием пано-
рамы, а канальный микшер — нет.



Меню EFFECTS — преобразование звука 275

В главе 8 мы детально познакомим вас с инструментом анализа стереофони-
ческих свойств аудиофайла (речь идет об окне Phase Analysis). А сейчас, не вдава-
ясь в подробности, лишь поясним: чем больше горизонтальный размер картинки,
отображаемой в этом окне, тем шире стереобаза. Сначала исследуем с помощью
окна Phase Analysis одну из композиций Depeche Mode. Типичная диаграмма выг-
лядит так, как показано на рис. 6.37.

Мастера есть мастера. А теперь проанализируем одну из композиций (рис. 6.38),
присланную нам для участия в конкурсе (мы имеем в виду сборник на диске, при-
ложенном к книге). Сведение выполнял достаточно опытный, но все же непро-
фессиональный звукорежиссер.

Выделим трек с композицией и обработаем его, выбрав в окне Pan/Expand пре-
сет Mastering Width (рис. 6.39).

Рис. 6.37. В композици Depeche Mode стереоба- Рис. 6.38. В такой композиции стереофоничность
ЗЁ! достаточно широка почти не используется

Рис. 6.39. Стереобаза расширена
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Сравнение рис. 6.39 и рис. 6.37 свидетельствует о том, что, применив эффект
Pan/Expand на этапе мастеринга, можно в какой-то степени исправить ошибки,
допущенные при сведении.

6.12. Stereo Field Rotate... — вращение стереополя
Комадой Effects > Amplitude > Stereo Field Rotate... открывается одноименное

окно (рис. 6.40).

Pan Left to Righl
Pan Right to Lefl
Stow 360

Г" Spline Curves

Г" Invert Left/Right

Range

Рис. 6.40. Окно Stereo Field Rotate

С помощью опций окна Stereo Field Rotate можно не только создать эффект
одновременного перемещения всех источников звука по стереопаораме вправо-
влево, но и действительно заставить вращаться стереополе вокруг головы слуша-
теля. Если прослушивать обработанную таким эффектом композицию с помощью
высококачественных наушников и при этом еще закрыть глаза, то вы непременно
поймаете себя на том, что подсознательно будете напрягать глазные мышцы, пы-
таясь «отследить» перемещение того источника звука, на котором сконцентриру-
ете свое внимание. Столь силен эффект. Но и это еще не все. Задав траекторию
движения стереополя, охватывающую все 360° (рис. 6,40), вы получите действи-
тельно звук, вращающийся вокруг вашей головы. Конечно, это не настоящий
surround, требующий не менее 6 каналов воспроизведения. Это его имитация, ос-
нованная на внесении небольших относительных задержек (фактически фазовых
сдвигов) в компоненты сигналов, поступающие в правый и левый стереоканалы.
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Но все равно результат впечатляет, хотя в моменты, когда средний канал оказыва-
ется в тылу, ощущение бывает не из приятных. Кажется, будто граница всего зву-
кового мира совпадает с затылочной частью головы, барабанщик отбивает ритм
буквально «по мозгам» и даже приятный женский вокал вполне может «проесть
плешь», если надолго зафиксируется в задней акустической полусфере.

Итак, рассмотрим окно Stereo Field Rotate. По традиции, сложившейся в Cool
Edit Pro, основную работу по преобразованию аудиофайла выполняют в коорди
натном поле с помощью интерактивного графика. Изменение формы графика про
изводится известным вам способом: щелчком на линии создается узел, который за
тем буксируется мышью в точку с необходимыми координатами. Чем больше узлов,
тем более сложный закон перемещения стереополя вы можете задать. При установ
ленном флажке Spline Curves график аппроксимируется гладкими кривыми.

По горизонтальной оси координат отложено время. Если флажок Loop Graph
сброшен, то пределы изменения времени совпадают с протяженностью выделен-
ного участка волновой формы. По вертикальной оси в градусах отложены значе-
ния угла поворота стереополя. Середина вертикальной оси помечена нулем. Вер-
хняя половина оси соответствует движению стереополя влево, нижняя — вправо
Пределы изменения максимального углового перемещения стереополя задаются
в раскрывающемся списке Range. Возможные значения — 45°, 90°, 180° и 360°. Ре-
зультат применения данного эффекта отчасти зависит от стереофонически?!
свойств исходной фонограммы. Большинство композиций, созданных непрофес-
сионалами, не отличается широкой стереобазой (см. пример на рис. 6.38). Пере-
мещение поля в пределах первых двух значений углов для таких фонограмм озна-
чает «качание» стереообраза в границах традиционной стереопанорамы. Предел
180° вероятнее всего, будет соответствовать кажущемуся расширению стереобазы.
И лишь изменение графика в пределах 0" — 360° или 0° —360" действительно при-
ведет к вращению стереополя.

Если на уровне нулевой отметки нарисовать горизонтальную линию (рис. 6.41),
то такой график будет соответствовать отсутствию вращения стереополя.

Не поймите, что при этом сигнал станет монофоническим. Если вы прослуша-
ете композицию, обработанную эффектом с параметрами, соответствующими
рис. 6.41, то убедитесь, что в нее просто не внесено никаких изменений. Музы-
кальные инструменты, располагавшиеся в левой части панорамы, остались слева,
в правой — справа, а центр как был, так и остался «прямо по курсу».

Заставить всю звуковую картину, все стереополе сдвинуться с места, можно,
отклонив весь график или хотя бы отдельные его точки от горизонтальной линии
нулевого уровня. Например, график, представленный на рис. 6.42, соответствует
ситуации, когда стереообраз смещен влево на угол 20° и статичен во времени.

А если нарисовать график, подобный показанному на рис. 6.43, то стереообраз
в процессе развития композиции будет совершать колебательное перемещение по
панораме в пределах ±20°.

Рассмотрим оставшиеся элементы интерфейса окна Stereo Field Rotate.
При установленном флажке Invert Left/Right левая и правая половины стерео-

панорамы поменяются местами.
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Рис. 6.41. Окно Stereo Field Rotate, стереополе не изменяется
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Pan Left to Right
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Рис. 6.42. Окно Stereo Field Rotate, стереообраз смещен влево на 20° и статичен

Кнопка Flat служит для приведения графика в исходное состояние (прямая
горизонтальная линия, расположенная на нулевом уровне, см. рис. 6.41).

В поле, расположенном справа от кнопки Flat, отображаются координаты кур-
сора (когда он находится в пределах координатного поля).
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Pan Left to Right
Pan Right to Left
Slow 360

Рчс. 6.43. Окно Stereo Field Rotate, стереообраз колеблется в пределах ±20'

Если установить флажок Loop Graph, то становятся доступными раскрываю-
щийся список и поле ввода, находящееся под этим флажком. Вместе взятые дан-
ные три опции позволяют организовать циклическое повторение на протяжении
всей композиции такого перемещения стереополя, которое задано для отдельно-
го ее фрагмента.

Расскажем об этой возможности подробнее. Обратите внимание: как только вы
установите флажок Loop Graph, пределы горизонтальной шкалы тут же изменятся.
По умолчанию в раскрывающемся списке выбрана строка Period (sec), а в поле введе-
но число 1 (рис. 6.44). Горизонтальная шкала при этом отградуирована в долях секун-
ды, а ее предел равен I с. Это означает, что все перемещения стереополя. заданные
фафиком, будут укладываться в одну секунду. В течение второй и последующих се-
кунд они будут периодически повторяться (до самого окончания композиции).

График и параметры, представленные на рис. 6.44, соответствуют следующему
перемещению стереополя: в начате каждой очередной секунды стереополе будет
находиться в исходном состоянии, к середине каждой секунды оно будет повернуто
влево на 10°, к концу секунды возвратится в исходное состояние. Сколько таких
циклов уложится на всем протяжении композиции? Узнать ответ на данный вопрос
вы можете, выбрав в раскрывающемся списке строку Total Cycles. В нашем примере
по длине композиции уложится 274,7646 односекундных циклов (рис. 6.45).

Когда в раскрывающемся списке выбрана строка Total Cycles, вы можете не
только узнать, сколько циклов перемещения стереополя будет в композиции, но
и задать это число. А длительность периода цикла программа сосчитает автомати-
чески. Например, мы задали 100 циклов, и программа сосчитала, что период будет
равен 2,5476 с. А узнали мы это, вновь выбрав в раскрывающемся списке строку
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Рис. 6.44. Окно Stereo Field Rotate, организовано циклическое перемещение стереопо-\я

Period (sec). Причем в данном случае программа не только выступила в роли без-
душного калькулятора, она еще и подправила нас, учтя установленный интервал
разрешения. Убедиться в этом можно, вернувшись к строке Total Cycles раскрыва-
ющегося списка. В поле окажется записанным не число 100, введенное нами, а
число 100,0018, которое рассчитана программа. Конечно, на практике цифры в
третьем и четвертом знаках после запятой не играют никакой роли, но в Cool Edit
Pro 2 точность превыше всего!

В раскрывающемся списке есть еще две строки. Вы можете, например, задать
частоту циклических колебаний стереополя, выбрав строку Freqency (Hz). Если
вы хотите, чтобы пульсации стереополя усиливали воздействие на слушателей
ритма композиции, есть смысл синхронизировать их с темпом, выбрав строку
Tempo (bmp).

Все четыре параметра: период, частота, темп и количество циклов перемещения поля
жестко взаимосвязаны. При изменении одного из них программа автоматически пере-
считывает остальные. Правда, по горизонтальной оси графика в любом случае откла-
дывается время, а максимальное его значение соответствует текущему периоду цикла,

В списке пресетов содержится 5 строк:

> ISO-degree Slow Turn — медленное вращение стереополя в пределах 180°
> 360-degree Rotation — вращение стереополя вокруг слушателя
> Pan Left to Right — панорамирование стереополя слева направо
> Pan Right to Left — панорамирование стереополя справа налево
> Slow 360 — перемещение стереополя в пределах 360" по сложной траектории

Прослушав результаты обработки композиции, соответствующие перечислен-
ным пресетам, мы пришли к выводу, что, вероятно, в пресетах сохраняются, но не
отображаются в окне, параметры группы Loop Graph. Оказалось, что, на самом
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Рис. 6.45. Окно Stereo Field Rotate, выбрана строка Total Cycles

деле, пресеты 180-degree Slow l\irn и Slow 360 циклические: перемещения стерео--
поля, заданные графиком, в пределах выделенного участка волновой формы по-
вторялись во время наших экспериментов по несколько раз. Во-первых, это мож-
но ясно услышать, а во-вторых — пронаблюдать в окне Phase Analysis.

Разбираясь с функцией Pan/Expand, в разд. 6.11 мы уже использовали фазовую
форму представления свойств звуковых колебаний. Еще раз напомним, что деталь-
ному изучению возможностей окна Phase Analysis посвящен разд. 8.2, но сейчас мы.
забегая вперед, вновь воспользуемся им. В окне Phase Analysis фазовый образ теку-
щего колебания выглядит как сложная фигура, форма и ориентация которой спо-
собна сказать звукорежиссеру о многом. В данный момент достаточно знать, что
если фонограмма сведена без существенных ошибок, то большая ось такой фигуры
ориентирована в направлении центра стереопанорамы. Применим эти знания для
того, чтобы на примере пресета 360-degree Rotation убедиться, что и в самом деле его
параметры соответствуют вращению стереополя вокруг слушателя.

Выделим какой-нибудь завершенный фрагмент (например, припев) компози-
ции, сведенной в стерео. Откроем окно Stereo Field Rotate, выберем пресет 360-degree
Rotation и нажмем кнопку ОК. Программа пересчитает значения аудиоданных в со-
ответствии с алгоритмом данного эффекта. Командой Aiialize > Show Phase Analysis
откроем окно Phase Analysis и включим воспроизведение обработанного фрагмента.
В начале фрагмента большая ось фигуры ориентирована вертикально, а по ходу вос-
произведения будет происходить ее вращение почасовой стрелке до тех пор, пока к
концу фрагмента она не совершит полный оборот. Несколько последовательных фаз
этого процесса запечатлены в серии копий экрана (рис. 6.46 a — рис. 6. 46 к).

Перед тем как обрабатывать волновую форму эффектом Stereo Field Rotate,
необходимо несколько понизить общий уровень аудиосигнала, например, восполь-
зонаьшись окном Amplify. В большинстве случаев будет достаточно применения
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Рис. 6.46. Иллюстрация вращения стереополя с помощью окна Phase Analysis

пресета 3dB Cut. Если не сделать этого, то могут появиться искажения сигнала,
вызванные переполнением разрядной сетки при сложении значений отсчетов. Ис-
кажения (в случае их возникновения) можно заметить в главном окне. На них не-
посредственно будет указывать изменение вида волновой формы (появятся учас-
тки, где она ограничена по амплитуде). Искажения такого типа видны и в окне
Phase Analysis. В сложном переплетении фигур появятся отдельные штрихи, со-
держашие отрезки прямых линий (см. рис. 6.46 з, рис. 6.46 и).

На этом мы завершаем знакомство с возможностями средств обработки аудио-
файлов, сосредоточенных в подменю Amplitude, и переходим к подменю Delay
Eflects. Речь пойдет об эффектах, получаемых путем подмешивания к звуковому
сигналу его же копий, обработанных и задержанных во времени.

Cool Edit Pro обладает мощнейшим инструментарием для создания эффектов
задержки. Число потенциально возможных эффектов, которые можно получить,
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используя этот редактор, не поддастся счету. А это значит, что вам предстоят но*-
вые знакомства и новые впечатления от общения с программой.

В подменю Delay Effects входят следующие команды:

> Chorus... — хорус
> Delay... — дилэй (задержка)
> Dinamic Delay — дилэй с динамическим управлением задержкой и обратной

связью
> Echo... — эхо
> Echo Chamber... — имитация акустики помещений
> Flanger... — флэнжер
> FuU Reverb... — универсальный процессор реверберации
> Multitap Delay... — многоканальная задержка
> QuickVerb..* — реверберация с упрощенным набором регулируемых параметров
> Reverb... — реверберация
> Sweeping Phaser.,. — перестраиваемый фазовращатель (фейзер)

Этими командами открываются окна эффектов, основанных на задержке сиг-
нала. Рассмотрим их.

6.13. Chorus», — хорус
Хорус (Chorus) проявляется как эффект исполнения одного и того же звука или

всей партии не одним-единственньш инструментом или певцом, а несколькими.
Искусственно выполненный эффект является моделью звучания настоящего хора.
В том, что хоровое пение или одновременное звучание нескольких музыкальных
инструментов украшает и оживляет музыкальное произведение, сомнений, веро-
ятно, нет ни у кого.

С одной стороны, голоса певцов и звуки инструментов при исполнении оди-
наковой ноты должны звучать одинаково, и к этому стремятся и музыканты и ди-
рижер. Но из-за индивидуальных различий источников звук все равно получается
разным. В пространстве, тракте звукоусиления и в слуховом аппарате человека
эти слегка неодинаковые колебания взаимодействуют, образуются так называе-
мые биения. Спектр звука обогащается и, самое главное, течет, переливается.

Можно считать, что предельным случаем хоруса является одновременное зву-
чание слегка отличающихся по частоте двух источников — унисон. Унисон был
известен задолго до появления синтезаторов. В основе сочного и живого звуча-
ния двенадцатиструнной гитары, аккордеона, баяна, гармони лежит унисон.
В аккордеоне, например, звук каждой ноты генерируется узлом, содержащим два
источника колебаний (язычка), специально настроенных «в разлив» — с неболь-
шой (в единицы герц) разницей в частотах. В двенадцатиструнной гитаре звук
извлекается одновременно из пары струн. Разница в частотах образуется есте-
ственным путем из-за невозможности идеально одинаково настроить струны
инструмента.
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Вот именно наличие этой ничтожной разницы в частотах голосов певцов или
инструментов и служит причиной красивого звучания унисона (для двух голосов)
или хоруса (для голосов, числом более двух).

В цифровых электромузыкальных инструментах, напротив, частоты пары ге-
нераторов могут быть получены абсолютно равными друг другу. В таком звучании
отсутствует жизнь, потому что оно слишком правильное. Для оживления элект-
ронного звучания и для создания впечатления игры нескольких инструментов и
используют хорус.

Существует довольно много разновидностей алгоритмов хоруса. Но все они
сводятся к тому, что:

> Исходный сигнал разделяется на два или несколько каналов
В каждом из каналов спектр сигнала сдвигают по частоте на определенную
для каждого канала величину. Частотные сдвиги очень малы, они составля-
ют доли герца

> Сигналы, полученные таким способом, складывают

В итоге получается сигнал, в котором звуковые волны как бы «плывут» с раз-
ными скоростями. Один раз за время, пропорциональное произведению перио-
дов колебаний разностных частот, сигналы сложатся в фазе, и образуется «девя-
тый вал» — максимум огибающей звуковых колебаний, один раз за это же время
канальные сигналы сложатся в противофазе, и получится «впадина между волна*
ми» — минимум огибающей. В итоге получается сигнал, спектр которого непре-
рывно изменяется, причем период полного цикла этого изменения столь велик,
что повторяемость спектральных свойств сигнала не ощущается.

Хорус настолько украшает звучание инструментов, что ныне он стал одним из
эффектов, имеющихся практически в каждом синтезаторе и многих звуковых кар-
тах. Обработка аудиосигнала звуковыми редакторами позволяет получить очень
много разновидностей этого эффекта. Вместе с тем, не следует чрезмерно увле-
каться им, так как это может привести к ухудшению разборчивости звучания го-
лоса, к «засорению» акустической атмосферы композиции.

Командой Effects > Delay Effects > Chorus... открывается окно эффекта Chorus
(рис. 6.47). Вы можете обогатить звучание партии композиции, имитируя ее од-
новременное исполнение несколькими голосами или инструментами. Хорус — это
один из способов создания эффекта присутствия, т. е. выделения голоса певца или
звука инструмента на фоне аккомпанемента. Вы можете также использовать хо-
рус, чтобы создать эффект псевдостереофонического звучания монофонического
аудиофайла или обогатить гармонию вокальной партии.

В Cool Edit Pro применяется метод прямого моделирования эффекта Chorus:
из каждого исходного голоса формируются новые голоса, звучание которых отли-
чается от оригинала за счет неглубокой модуляции частоты и сдвига по времени, а
также псевдослучайного интонирования. Пространственную протяженность и
даже некоторую объемность эффекту придает наличие обратной связи в алгорит-
ме обработки.

Рассмотрим опции окна Chorus, представленного на рис. 6.47.

83ак П52
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Рис. 6.47. Окно эффекта Chorus

В группе Chorus Characteristics сосредоточены опдии, которые определяют па-
раметры эффекта.

В поле Thickness_Voices указывается количество голосов, участвующих в фор-
мировании эффекта Chorus.

Для управления параметрами хоруса служат следующие движковые регулято-
ры и поля ввода:

> Max Delay — максимальное временное рассогласование (задержка) голосов.
Рекомендуется устанавливать эту величину в пределах 15—35 мс. Если уста-
новлено очень маленькое значение, то все голоса начнут объединяться в
оригинал и может возникнуть неестественный эффект, напоминающий
флэнжер (см. разд. 6.18). При слишком больших значениях параметра вам
может показаться, что запись воспроизводится магнитофоном, который
начал «зажевывать» ленту

> Delay Rate — частота модуляции задержки
> Feedback — глубина обратной связи
> Spread — дополнительная задержка каждого голоса (до 200 мс). При боль-

ших значениях этого параметра отдельные голоса начинают звучать ц раз-
ное время. Малые значения дополнительной задержки придают эффекту
характер унисона нескольких голосов

> Vibrato Depth — глубина вибрато (модуляции по частоте)
>> Vibrato Rate — частота вибрато
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В группе Stereo Chorus Mode находятся опции, от которых зависят стереофо-
нические свойства эффекта.

Если флажок Average Left & Right сброшен, то исходные сигналы левого и пра-
вого каналов будут обрабатываться эффектом по отдельности. Существовавший
до обработки стереообраз звука претерпит минимальные искажения. При уста-
новленном флажке сформируется некий усредненный стереообраз, т. к. обраба-
тываться будет смесь канальных сигналов. По сути дела, сначала программа сфор-
мирует моносигнал, а затем придаст ему стереофоничность за счет разноса
отдельных голосов по панораме.

Если обрабатывается монофонический аудиофайл, то флажок следует сбросить
для того, чтобы избежать бессмысленной траты времени на преобразование мо-
носигнала в моносигнал же.

При установленном флажке Add Binaural Cues в сформированный сигнал до-
бавляются задержки, различные для правого и левого каналов, тогда голоса, исхо-
дящие из различных точек панорамы, будут появляться в различные моменты вре-
мени. Если фонограмму предполагается прослушивать через стереонаушники,
флажок рекомендуется установить, а сбросить его, если не исключено ее воспро-
изведение посредством колонок.

Расположенные ниже рассмотренных флажков движковый регулятор и поле вво-
да предназначены для выбора протяженности эффекта настереопанораме (ширины
стереополя). Если движок находится в положении Narrow Field (введено число 0), все
голоса будут помещены в центр стереопанорамы. При установке движка в поло-
жение 50% все голоса расположатся на панораме равномерно слева направо. На-
пример, если имитируется хор, состоящий из 5-и голосов, то голоса панорамиру-
ются, т. е. будут находиться:

> Первый голос — в крайней левой точке панорамы
> Второй голос — посредине левой части панорамы
> Третий голос — в центре панорамы
> Четвертый голос — посредине правой части панорамы
> Пятый голос — в крайней правой точке панорамы

Если выбирать значение параметра, определяющего протяженность стереоэффек-
та, больше 50%, то по мере перемещения движка вправо голоса начнут перемещаться к
к]эайним точкам панорамы: левые голоса переместятся еще левее, а правые — правее.

Если вы работаете с нечетным числом голосов, в этом случае один голос будет
всегда находиться точно в центре панорамы.

При четном числе голосов в центре нет ни одного голоса. Половина голосов
сосредоточена в правой части панорамы, половина — в левой.

Если движок находится в положении Wide Field (значение параметра составля-
ет 100%), все левые голоса помешены в крайнюю левую точку, правые — в край-
нюю правую точку.

В группе Output сосредоточены регуляторы и поля вода, с помощью которых
можно выбрать пропорцию с м е ш и в а н и я обработанного эффектом (Wet Out) и
исходного (Dry Out) сигналов.
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При установленном флажке Bypass на выход эффекта независимо от состоя-
ния регуляторов группы Output подается только обработанный сигнал.

Если установить флажок Highest Quality (but slow), то для реализации эффекта
будет использован алгоритм, обеспечивающий более высокое качество (меньший
уровень искажений), однако время, необходимое для вычислений, возрастет.

Как обычно, охарактеризуем установки, предусмотренные стандартной поставкой:

> 5 Voices (Pro), 5 Voices Sing, Another Dimension — варианты хора из пяти голосов
> Amateur Chorus, Thick Chorus — варианты хора из 12-и голосов
> AcousticDuet, Duo — варианты дуэтов
> Electro-Voice — имитация электронного звучания голоса
> Flying Saucers — такие звуки, по мнению разработчика, издают летающие

тарелки
> More Sopranos, Soprano Chorus — варианты хора из голосов сопрано
> Quadra Chorus, Quartet — варианты квартета
> Rich Chorus, Rich Chorus In Unison — варианты хора с насыщенным звучанием
> Thick Chorus, Wide & Thick — варианты хора большого состава с широким

стереополем
> TrippyVox — хор из 5 голосов, необработанный сигнал на выходе эффекта

отсутствует

6.14. Delay. * — задержка
Следующей командой подменю Delay Effects является команда, реализующая

собственно задержку — Delay.
Необходимость в этом эффекте возникла с началом применения стереофонии.

Сама природа слухового аппарата человека предполагает в большинстве ситуаций
поступление в мозг двух звуковых си гналов, отличающихся временами прихода. Если
источник звука находится «перед глазами»: на перпендикуляре, проведенном к ли-
нии, проходящей через уши, то прямой звук от источника достигает обоих ушей в
одно и то же время. Во всех остальных случаях расстояния от источника до ушей
различны, поэтому либо одно, либо другое ухо воспринимает звук первым.

Дилэй применяется, прежде всего, в том случае, когда запись голоса или акус-
тического музыкального инструмента, выполненную с помощью единственного
микрофона, «встраивают» в стереофоническую композицию. Этот эффект служит
основой технологии создания стереозаписей. Но дилэй может применяться и для
получения эффекта однократного повторения каких-либо звуков. Какая именно
задержка должна быть выбрана? Ответ на этот вопрос определяется несколькими
факторами. Прежде всего, следует руководствоваться эстетическими критериями,
художественной целью и здравым смыслом. Для коротких и резких звуков, время
задержки, при котором основной сигнал и его копия различимы, меньше, чем для
протяженных звуков. Для произведений, исполняемых в медленном темпе, задер-
жка может быть больше, чем для быстрых композиций.
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При определенных соотношениях громкостей прямого и задержанного сигна-
ла может иметь место психоакустический эффект изменения кажущегося распо-
ложения источника звука на стереопанораме. Согласитесь, что, например, «пере-
скоки» рояля с места на место по ходу прослушивания произведения очень трудн о
обосновать как с эстетических позиций, так и с точки зрения верности воспроиз-
ведения реального звучания. Как и любой эффект, дилэй нужно применять в ра-
зумных пределах и не обязательно на протяжении всей композиции.

Этот эффект реализуется с помощью устройств, способных осуществлять за-
держку акустического или электрического сигналов. Таким устройством сейчас
чаще всего служит цифровая линия задержки, представляющая собой цепочку
из элементарных ячеек — триггеров задержки. Для наших целей достаточно знать,
что принцип действия триггера задержки сводится к следующему: двоичный сиг-
нал, поступивший в некоторый тактовый момент времени на его вход, появится
на его выходе не мгновенно, а только в очередной тактовый момент. Общее вре-
мя задержки в линии тем больше, чем больше триггеров задержки включено к
цепочку, и тем меньше, чем меньше тактовый интервал (чем больше тактовая
частота). В качестве цифровых линий задержки можно использовать запомина-
ющие устройства. Известны специальные алгоритмы адресации ячеек запоми
нающих устройств, обеспечивающие «скольжение» информации «вдоль» адрес-
ного пространства.

Разумеется, для применения цифровой линии задержки сигнал должен быть
сперва преобразован в цифровую форму. А после прохождения копией сигнала
линии задержки происходит цифро-аналоговое преобразование. Исходный сиг-
нал и его задержанная копия могут быть раздельно направлены в различные сте-
реоканалы, но могут быть и смешаны в различных пропорциях. Суммарный сиг-
нал может быть направлен либо в один из стереоканалов, либо в оба.

В звуковых редакторах дилэй реализуется программным (математическим) путем за
счет изменения относительной нумерации отсчетов исходного сигнала и его копии.

Возможны такие, например, разновидности задержки, при которых формиру-
ются несколько задержанных на различное время копий сигнала,

В виртуальных дилэях, так же как и в их аппаратных прототипах, обязательно
имеются регуляторы глубины и частоты модуляции задержанного сигнала, а также
регулятор коэффициента обратной связи (Feedback). Сигнал с выхода подается опять
в линию задержки. Время затухания устанавливается регулятором обратной связи.
Чтобы однократное повторение превратилось в настоящее повторяющееся эхо, ко-
эффициент обратной связи надо увеличить. Как правило, и в реальных, и в вирту-
альных устройствах имеется регулятор, при помощи которого можно подобрать та-
кое время задержки, чтобы оно соответствовало темпу композиции.

Напомнив суть дилэя, обратимся к команде Effects > Delay Effects > Delay...,
которой открывается окно эффекта Delay (рис. 6.48).

В группах Left Channel и Right Channel находятся элементы настройки задержек
для каждого из стереоканалов.

С помощью регулятора Delay или непосредственно в поле ввода, расположен-
ном справа от него, вы можете задать время задержки в миллисекундах.
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Рис. 6.48. Окно эффекта Delay

Аналогичные элементы интерфейса, но на этот раз под названием Mixing по-
зволяют задавать в процентах уровень задержанного сигнала, добавляемого в ис-
ходный. Состояние флажка Invert определяет, будет ли инвертирована фаза под-
мешиваемого сигнала.

Традиционно для Cool Edit Pro в окне этого эффекта имеется список предва-
рительных установок Presets, однако мы не станем его комментировать. Словами
не описать все предусмотренные варианты микширования в различных пропор-
циях исходных сигналов левого и правого каналов с задержанными сигналами.
Будет лучше, если вы сами опробуете и оцените пресеты эффекта Delay.

6Л 5. Dynamic Delay.,. — дилэй с динамическим
управлением задержкой и обратной связью

Командой Effects > Delay Effects > Dynamic Delay... открывается окно эффекта
Dynamic Delay (рис. 6.49).

По существу, в окне Dynamic Delay реализован дилэй, однако имеющиеся сред-
ства управления позволяют динамически с помощью графикой изменять значе-
ния двух важнейших параметров эффекта: задержку (координатное поле Delay) и
коэффициент обратной связи (координатное поле Feedback).

Нет необходимости рассказывать о назначении движка Original — Delayed,
флажков Spline Curves, Invert и списка пресетов. Перечисленные элементы нео-
днократно встречались вам в рассмотренных окнах эффектов. Знакомы вы и со
способом изменения формы графиков.

Пожалуй, следует обратить ваше внимание только на особенности функцио-
нирования эффекта при различных состояниях флажка Loop Graphs. Если фла-
жок сбошен, то графики описывают изменение задержки и коэффициента обрат-
ной связи на всем протяжении выделенной области волновой формы. При
установленном флажке Loop Graphs графики относятся к единственному циклу.
Подобную технологию мы подробно описали в разд. 6.12. Как и в случае окна Stereo
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PMC. 6.49. Окно эффекта Dynamic Delay

Field Rotate, в данном случае вы работаете с фрагментом, временные параметры
которого задаются в полях ввода группы Loop Graphs:

> Frequency — частота повторения циклов
> Period — период повторения циклов
> Total Cycles — общее число циклов в выделенной области волновой формы

Перечисленные три параметра жестко связаны друг с другом. У вас есть воз-
можность независимо задать только один из них (любой), два остальных рассчи-
тываются программой.

В поле Stereo Curve Delay вводится величина временного сдвига между соответству-
ющими парами графиков в правом и левом каналах. Положительное число соответ-
ствует запаздыванию пары «правых» графиков, отрицательное — пары «левых». Обра-
щаем ваше внимание на то, что сами сигналы правого и левого каналов при этом не
претерпевают никаких дополнительных задержек. Разработчики рекомендуют приме-
нять такой прием в процессе мультитрекового редактирования (см. гл. 12) к различным
трекам, тогда, по их мнению, эффект получается очень ярким и необычным.

В списке пресетов 7 строк. Нет смысла описывать словами звучание музыки,
обработанной эффектом с параметрами, которые сохранены в пресетах. Отметим
только тот факт, что параметры группы Loop Graphs запоминаются в пресете и (в
отличие от эфекта Stereo Field Rotate) после загрузки пресета отображаются в окне.
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6,16. Echo..* — эхо
Следующий и более сложный эффект — Echo (Эхо). Основное отличие это-

го эффекта от простой задержки состоит в том, что задержанные копии сигна-
ла подвергаются дополнительной обработке: изменяется их спектр. Звук, об-
работанный эффектом Echo, более натурален по сравнению с обработанным
эффектом Delay. В природе эхо образуется в результате переотражения звуко-
вых волн от препятствий (например, от домов, стен помещения, гор и т. п.).
Различные спектральные составляющие звука (как и любого другого волново-
го явления, например, света) различным образом отражаются от препятствий.
Чем ниже частота (больше длина волны), тем легче волна преодолевает пре-
пятствия, огибая его. Высокочастотной волне, наоборот, очень сложно пре-
одолеть любую, даже самую простую преграду. Такая волна не проходит сквозь
препятствие, а отражается от него и частично поглощается, превращаясь, в ко-
нечном счете, в тепловую энергию. Но нельзя упускать из вида и тот факт, что
высокочастотные звуковые волны при распространении в воздухе затухают
быстрее низкочастотных.

Подводя итог этим рассуждениям, можно предположить, что эхо содержит сме-
щенный во времени исходный сигнал, у которого будут ослаблены и низкие, и
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высокие частоты. Как именно они изменятся, зависит уже от конкретных условий
распространения звука (расстояние до препятствия, его материал и т. п.). С помо-
щью окна эффекта Echo (рис. 6.50) можно смоделировать эти условия. Окно от-
крывается командой Effects > Delay Effects > Echo....

Регуляторами Decay в процентах относительно исходного сигнала задается уро-
вень задержанного сигнала — уровень эха, а значит, и время его существования.
Delay — время в миллисекундах, на которое будет задержан сигнал.

Initial Echo Volume — уровень, с которым эхо будет подмешиваться к исходно-
му сигналу.

Группа Successive Echo Equalization — эквалайзер, с помощью которого можно
изменять спектр задержанного сигнала.

Флажок Continue echo beyond selection следует установить в том случае, если же-
лательно оставить постепенное затухание эха за пределом выделенного фрагмен-
та волновой формы.

При установленном флажке Lock Left/Right соответствующие регуляторы ле-
вого и правого каналов объединяются.

Если установить флажок Echo Bounce, то звучание эха будет акцентировано.
Группа Presets содержит список предустановок для различных видов эха.

6.17. Echo Chamber.. — имитация акустики
помещений

Некогда для создания различных эффектов, основанных на задержке сигнала,
радиостудии и солидные концертные залы содержали эхо-камеры. Эхо-камера
представляет собой комнату с сильно отражающими стенами, в которую поме-
щен источник звукового сигнала (громкоговоритель) и приемник (микрофон). По
сути дела, такая эхо-камера является уменьшенной моделью реального зритель-
ного зала, в котором, к сожалению, не всегда удается создать необходимую акус-
тическую атмосферу. В эхо-камере с трудом, но можно в некоторых пределах уп-
равлять распределением интенсивностей и времен распространения
переотраженных сигналов, устанавливая отражающие или поглощающие звук пе-
регородки. Преимущество эхо-камеры состоит в том, что затухание звука проис-
ходит в ней естественным путем (что очень трудно обеспечить другими способа-
ми). Недостатки эхо-камер связаны с их относительно малыми размерами, при
этом вследствие собственных резонансов спектр сигнала искажается в области
средних частот. Определенную проблему представляет надежная звукоизоляция
помещения эхо-камеры. Но самое главное заключается в том, что эхо-камера не
может служить распространенным инструментом получения эффектов задержки,
так как она слишком громоздка и дорога.

Что же делать тем музыкантам, которые хотели бы применять в своем творче-
стве эхо-камеру, но не имеют такой возможности? Убедительный ответ на этот воп-
рос содержится в программе Cool Edit Pro. В нее встроена эхо-камера. Конечно,
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не само гулкое помещение втиснуто в компьютер, а его математическая модель.
Для чего это понадобилось делать? Эхо-камера принципиально отличается от всех
остальных устройств тем, что реверберация (см. разд. 6.19) пней настоящая: трех-
мерная, объемная. Во всех же остальных устройствах этой не реверберация даже,
а ее жалкое, плоское, двумерное (а то и одномерное) подобие. Модель эхо-камеры
позволяет воссоздавать акустику любого помещения. Она даже лучше, чем насто-
ящая эхо-камера, потому что допускает оперативное изменение размеров моде-
лируемого помещения и отражающих свойств стен, пола, потолка. Более того, это
не одна, а как бы две эхо-камеры, с отдельно устанавливаемыми координатами
источников и приемников звука.

Отметим также, что подобный эффект реализован в виде плагина к програм-
мам Cakewalk Pro Audio, Sonar и описан в 15, 7].

Окно диалога, открываемое командой Effects > Delay Effects > Echo Chamber..., по-
казано на рис. 6.51. Оно имеет заголовок 3-D Echo Chamber (Камера трехмерного эха).

Рассмотрим назначение опций окна Echo Chamber. В группе Room Size (feet) зада-
ются размеры комнаты (в метрах): Width (Ширина), Length (Длина) и Height (Высота).

В группе Settings (Установки) задаются интенсивность (Intensity) и количество
моделируемых отражений (Echoes).

В группе Damping Factors задаются коэффициенты поглощения материалов, из
которых сделаны стены, пол и потолок:

> Left — для левой стены
> Right — для правой стены
> Back — для задней стены
> Front — для передней стены
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Рис. 6.51. Окно моделирования распространение зеуха в трехмерном помещении
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> Floor — для пола
> Ceiling — для потолка

В поле Damping Frequency вводится верхняя граничная частота обрабатываемо-
го спектра сигнала. Частоты, превышающие ее, подавляются.

В группе Signal and Microphone Placement (feet) задается расположение в вирту-
альной комнате источника сигнала (Source Signal), а также микрофона или слуша-
теля (Microphone). Вернее было бы сказать, что источник не один, а два — сигнал от
исходных левого и правого каналов. Да и микрофонов (ушей слушателя) имеется
тоже два, и можно задать расположение каждого из них тремя координатами:

> Dx From Left Wall — расстояние от левой стены
> Dx From Back Wall — расстояние от задней стены
> Dx Above Floor — высота над полом

Опция Mix Left/Right Into Single Source позволяет объединять исходные левый
и правый каналы в единственный точечный источник звука.

6,18. Flanger., — флэнжер
В основу звуковых эффектов флэнжер (Flanger) и фэйзер (Phaser) также поло-

жена задержка сигнала. В чем заключается отличие этих эффектов от дилэя?
Название флэнжер (flange — гребень) происходит от способа реализации этого

эффекта в аналоговых устройствах — при помощи гребенчатых фильтров, имею-
щих амплитудно-частотную характеристику (АЧХ) такого же вила. Гребенчатые
фильтры могут строиться на линиях задержки. Характерная форма АЧХ создается
за счет сдвига фазы при распространении сигнала в линии задержки и сложения
реализаций задержанного сигнала.

Меняя параметры гребенчатого фильтра, можно в значительной степени изме-
нять первоначальный тембр звука.

Гребенчатая АЧХ фильтра обусловлена тем, что для некоторых частот задер-
жанные копии сигнала складываются в фазе и поэтому усиливаются, для другил
частот — в противофазе и поэтому взаимоуничтожаются. Периодическая струк-
тура АЧХ определяется периодическим характером составляющих аудиосигнала
(синусоид).

Совершенно не случайно в старые времена флэнжером часто пытались за-
менить реверберацию. Реверберация возникает за счет многократного отраже-
ния звуковых волн от стен, потолка и пола помещения (см. разд. 6.I9). При
этом звуковые колебания по пути к слушателю претерпевают различные по
величине задержки (фазовые сдвиги). Имеет место интерференция колебаний.
Если исследовать любое помещение с заметными реверберационными свойства-
ми, то обнаружится, что его АЧХ имеет гребенчатую форму.

Как мы уже сказали, дилэй имитирует эффект неодновременного восприятия
мозгом человека звуковых сигналов, поступающих в уши. Эффект повторного
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звучания может быть вызван и распространением звука от источника к приемни-
ку различными путями (например, звук может приходить, во-первых, напрямую
и, во-вторых, отразившись от препятствия, находящегося чуть в стороне от пря-
мого пути). И в том, и в другом случаях время задержки остается постоянным. В
реальной жизни этому соответствует маловероятная ситуация, когда источник зву-
ка, приемник звука и отражающие предметы неподвижны друг относительно дру-
га. При этом частота звука не изменяется, каким бы путем и в какое бы ухо он не
приходил.

Если же какой-либо из трех элементов подвижен, то частота принимаемого
звука не может оставаться той же, что и частота звука переданного. Это есть не что
иное, как проявление того самого эффекта Доплера, который в школьных учеб-
никах традиционно поясняется на примере изменения высоты звучания гудка дви-
жущегося паровоза.

Итак, реальные музыкальные звуки при распространении претерпевают не
только расщепление на несколько волн и различную (для каждой из них) за-
держку, но и неодинаковое для различных спектральных составляющих изме-
нение частот.

И флэнжер, и фэйзер имитируют (каждый по-своему) проявления взаимного
перемещения упомянутых трех элементов: источника, приемника и отражателя
звука. По сути дела, и тот, и другой эффекты представляют собой сочетание задер-
жки звукового сигнала с частотной или фазовой модуляцией. Разница между ними
чисто количественная. Флэнжер отличается от фейзера тем, что для первого эф-
фекта время задержки копии (или времена задержек копий) и изменение частот
сигнала значительно большее, чем для второго. Упомянутые количественные от-
личия эффектов приводят и к отличиям качественным: во-первых, звуки, обрабо-
танные ими, приобретают различные акустические и музыкальные свойства, во-
вторых, эффекты реализуются различными техническими средствами.

Значения времен задержек, характерных для флэнжера, существенно превы-
шают период звукового колебания, поэтому для реализации эффекта использу-
ют многоразрядные и многоотводные цифровые линии задержки. С каждого из
отводов снимается свой сигнал, который в свою очередь подвергается частот-
ной модуляции.

Для фэйзера, наоборот, характерно очень маленькое время задержки. Оно столь
мало, что оказывается сравнимо с периодом звукового колебания. При столь ма-
лых относительных сдвигах принято говорить уже не о задержке копий си гнала во
времени, а о разности их фаз. Если эта разность фаз не остается постоянной, а
изменяется по периодическому закону, то мы имеем дело с эффектом Phaser. Так
что можно считать фейзер предельным случаем флэнжера. Но если внимательно
прочитать еще раз этот абзац, то можно увидеть, что фейзер — это не что иное, как
фазовое вибрато.

Чего только не придумывали в относительно старые времена, чтобы реализо-
вать эти эффекты!

Например, чтобы получить флэнжер, вместо одной акустической системы ис-
пользовали несколько систем, размещенных на различных расстояниях от слуша-
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телей. В необходимые моменты производили поочередное подключение источ-
ника сигнала к акустическим системам таким образом, что создавалось впечатле-
ние приближения или удаления источника звука. Задержку звука выполняли и с
помощью магнитофонов со сквозным трактом запись/воспроизведение. Одна го-
ловка записывает, другая — воспроизводит звук с задержкой на время, необходи-
мое для перемещения ленты от головки к головке. Для частотной модуляции осо-
бых мер можно было и не придумывать. Каждому аналоговому магнитофону
присущ естественный недостаток, называемый детонацией, которая проявляется
в виде «плавания звука». Стоило чуть-чуть специально усилить этот эффект, изме-
няя напряжение, питающее двигатель, — и получалась частотная модуляция.

Для реализации фэйзера методами аналоговой техники использовали цепочки
электрически управляемых фазовращателей. А иногда можно было наблюдать и
такую картину: в акустической системе, подключенной к ЭМИ или электрогита-
ре, вдруг начинало вращаться что-то вроде вентилятора. Звук пересекался под-
вижными лопастями, отражался от них, получалась фазовая модуляция. Представ-
ляете, сколько усилий предпринималось только ради того, чтобы оживить тембр
звучания инструментов! Сколько это все стоило!

Окно эффекта Flanger (рис. 6.52) открывается командой Effects > Delay Effects >
Hanger....

Рассмотрим опции этого окна. С помощью движка Original-Expanded (или
Original-Delayed, в зависимости от режима, заданного в группе Mode), устанавли-
вается соотношение смешиваемых сигналов исходного и искаженного (плаваю-
щего) звука. Initial Mix Delay и Final Mix Delay — начальное и конечное запаздыва-
ние «плывущего» звука за один полупериод «плавания». Звуки левого и правого
сгереоканалов могут задерживаться по-разному. С помощью движка Stereo Phasing
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задают разность фаз для стереоканалов. Положение регулятора Feedback опреде-
ляет глубину обратной связи.

В группе Mode можно задать различные комбинации трех режимов: Inverted — ин-
вертирование обработанного сигнала; Special EFX — микширование сигналов (спе-
циальный режим); Sinusoidal — отставание обработанного сигнала от исходного по
синусоидальному закону. Если этот режим не задан, то отставание будет изменяться
от начального знамения до конечного (и в обратную сторону) по линейному закону.

В группе Rate задаются параметры обработанного сигнала Frequency (Частота)
или Period (Период) прохождения полного цикла «отставание начальное-конеч-
ное-начальное» и Total Cycles — общее количество таких периодов.

Как обычно, имеется пополняемый список предварительных установок Presets.

6.19. Full Reverb... —универсальная реверберация

Реверберация (Reverb) относится к наиболее интересным и популярным зву-
ковым эффектам. Сущность реверберации состоит в том, что исходный звуковой
сигнал смешивается со своими копиями, задержанными относительно него на
различные временные интервалы. Этим реверберация напоминает дилэй. Отли-
чие заключается в том, что при реверберации число задержанных копий сигнала
может быть значительно больше, чем для дилэя. Теоретически число копий может
быть бесконечным. Кроме того, при реверберации чем больше время запаздыва-
ния копии сигнала, тем меньше ее амплитуда (громкость). Эффект зависит оттого,
каковы временные промежутки между копиями сигналов и какова скорость умень-
шения уровней их громкости. Если промежутки между копиями малы, то получа-
ется собственно эффект реверберации. Возникает ощущение объемного гулкого
помещения. Звуки музыкальных инструментов становятся сочными, объемными
с богатым тембровым составом. Голоса певцов приобретают напевность, недостат-
ки, присущие им, становятся малозаметными.

Если промежутки межу копиями велики (более IOO мс), то правильнее гово-
рить не об эффекте реверберации, а об эффекте «эхо». Интервалы между соответ-
ствующими звуками при этом становятся различимыми. Звуки перестают сливать-
ся, кажутся отражениями от удаленных преград.

Пусть, например, первичный аудиосигнал, излученный акустической систе-
мой, представляет собой короткий импульс. Акустическая система расположена
на сцене зала. Первым ушей слушателя достигает прямой звук. Этот сигнал при-
ходит к слушателю по кратчайшему пути. Поэтому интенсивность его больше, чем
интенсивности других сигналов. Прямой сигнал несет информацию только о рас-
положении источника звука справа или слева от слушателя.

Несколько отстав от прямого сигнала, к слушателю приходят ранние (первич-
ные) отражения. Эта составляющая звукового поля претерпевает одно-два отра-
жения от ограждающих поверхностей (стен, пола, потолка). Взаимодействуя с ог-
раждающими поверхностями, звуковая полна не только отражается от них, но и
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отдает им часть своей энергии. Энергия расходуется на нагрев поверхностей. По-
этому интенсивность ранних отражений меньше (но не на много) интенсивности
прямого сигнала. Ранние отражения проявляются как ясно различимые эхо-сиг-
налы. Временные промежутки между ними достаточно велики, т. к. велики разно-
сти длин путей, по которым сигналы доходят до слушателя- Например, волна мо-
жет отразиться от боковой или от тыльной стены. Возможно, что часть волн,
относящихся к ранним отражениям, испытают не одно, а несколько отражений.
Ранние отражения содержат в себе информацию не только о месте расположения
исполнителя, но и о размерах помещения. Именно ранние отражения вносят наи-
больший вклад в пространственное ощущение акустики зала. К ранним отраже-
ниям относят те копии первичного сигнала, которые отстают от прямого сигнала
не более чем на 60 мс.

Вторичные и последующие (поздние) отражения — это звуковые волны, мно-
гократно отраженные от каждой из поверхностей. По мере увеличения числа пе-
реотражений интенсивность аудиосигналов заметно уменьшается. Кроме того,
изменяется спектральный состав звуковых колебаний. Дело в том, что из-за раз-
личий в конфигурадии отражающих поверхностей и в свойствах материалов по-
крытий разные спектральные составляющие аудиосигнала отражаются не одина-
ково. Какие-то из них поглощаются сильнее, поэтому затухают быстрее.

По мере возрастания номеров вторичных отражений они рассеиваются, их чис-
ло увеличивается. Постепенно они перестают восприниматься как отдельные зву-
ки, сливаются в один сплошной постепенно затухающий отзвук. Это и есть соб-
ственно реверберация.

Теоретически затухание звука длится бесконечно. На практике для того, чтобы
можно было сравнивать между собой различные реверберационные процессы (а
главное — реверберационные свойства помещений), введено понятие времени ре-
верберации. Время реверберации — это такое время, за которое уровень ревербе-
ркрующего сигнала уменьшается на 60 дБ.

Основным элементом, реализующим эффект реверберации, является устрой-
ство, создающее эхо-сигнал. Интересна история развития таких устройств.

Наряду с эхо-камерами, о которых мы рассказали в разд. 6.17, для имитации
реверберации использовали стальные пластины, точнее довольно-таки большие
по размеру листы. Колебания в них вводили и снимали с помощью устройств,
по конструкции и принципу действия похожих на электромагнитные головные
телефоны. Для получения удовлетворительной равномерности амплитудно-ча-
стотной характеристики толщина листа должна быть выдержана с точностью,,
которую не позволяют достичь обычные технологии проката стали. Ревербера-
ция здесь была не трехмерной, а плоской. Сигнал имел характерный металли-
ческий призвук.

В середине 60-х годов для получения эффекта реверберации стали применять
пружинные ревербераторы. С помощью электромагнитного преобразователя,
соединенного с одним из концов пружины, в ней возбуждаются механические ко-
лебания, которые с задержкой достигают второго конца пружины, связанного с дат-
чиком. Эффект повторения звука обусловлен многократным отражением волн ме-



24О Глава б

ханических колебаний от концов пружины. Качество звука в пружинном ревербе-
раторе чрезвычайно низкое. Пружина воспринимает любые колебания воздуха и
пола, между акустической системой и пружиной существует практически неуст-
ранимая обратная связь, звук имеет ярко выраженную «металлическую» окраску.
Время реверберации не регулируется.

На смену этим несовершенным устройствам пришли ревербераторы магни-
тофонные (описание эффекта, моделируюшего подобный ревербератор, вы най-
дете в разделе 6.20). Принцип формирования эхо-сигнала в магнитофонных ре-
вербераторах состоит в том, что исходный сигнал записывается на ленту
записывающей магнитной головкой, а через время, необходимое для перемеще-
ния данной точки ленты к воспроизводящей головке, считывается ею. Через цепь
обратной связи уменьшенный по амплитуде задержанный сигнал вновь подает-
ся на запись, что и создает эффект многократного отражения звука с постепен-
ным затуханием. Качество звука определяется параметрами магнитофона. Не-
достаток магнитофонного ревербератора заключается в том, что при приемлемых
скоростях протяжки ленты удается получить только эффект эха. Для получения
собственно реверберации требуется либо еще сильнее сблизить магнитные го-
ловки (чего не позволяет сделать их конструкция), либо значительно увеличить
скорость движения ленты.

С развитием цифровой техники и появлением интегральных микросхем, со-
держащих в одном корпусе сотни и тысячи цифровых элементов задержки, по-
явилась возможность создавать высококачественные цифровые ревербераторы.
В таких устройствах сигнал может быть задержан на любое время, необходимое
как для получения реверберации, так и для получения эха. Ревербератор отлича-
ется от цифрового устройства, реализующего дилэй, только тем, что содержит об-
ратную связь (feedback), необходимую для формирования затухающих повторе-
ний сигнала. Такие ревербераторы широко используются сейчас музыкантами и
звукорежиссерами.

Цепь обратной связи отсылает часть сигнала с выхода обратно в линию задер-
жки, тем самым получается повторяющееся эхо. Коэффициент обратной связи
должен быть меньше единицы, иначе каждое новое эхо будет возрастать по уров-
ню, а не затухать. Может получиться эффект, подобный самовозбуждению акус-
тической системы.

В некоторых виртуальных ревербераторах предусмотрен модулятор фазы. Его
действие проявляется в том, что при коротком времени затухания возникает едва
заметное изменение тона.

Во многих программах, предназначенных для синтеза голосов новых музыкаль-
ных инструментов, смоделирован и эффект реверберации, как бы реализуемый с
помощью того самого стального листа.

Наблюдая такое развитие средств реверберации, можно предположить, что
когда-нибудь появятся и математические модели пружинных и магнитофонных
ревербераторов. Ведь совсем не исключено, что есть люди, испытывающие нос-
тальгические чувства к звукам музыки, окрашенным дребезгом пружин или ши-
пением магнитной ленты.
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Итак, универсальная реверберация Full Reverb используется в Cool Edit Pro для
того, чтобы в деталях моделировать акустическое пространство. Эффект обладает
некоторыми уникальными возможностями:

> Реалистичное моделирование сигналов ранних отражений
> Изменение размеров и акустических свойств имитируемого помещения
> Моделирование любого материала отражающей поверхности
> Изменение поглощающих свойств пространства внутри помещения
> Коррекция частотного спектра сигнала реверберации с использованием

трехполосного параметрического эквалайзера

Командой Effects > Delay Effects > Full Reverb... открывается окно эффекта Full
Reverb, содержащее три вкладки: General Reverb (рис. 6.53), Early Reflections
(рис. 6.54) и Coloration (рис. 6.55).

Сначала рассмотрим элементы окна эффекта, общие для всех вкладок.
В группе Mixing имеются следующие элементы, которые регулируют:

> Original Signal (dry) — уровень необработанного сигнала
> Early Reflections — уровень ранних отражений
> Reverb (wet) — уровень сигнала, обработанного эффектом

Опция Include Direct — сдвиг фаз звуковых колебаний в левом и правом кана-
лах в целях согласования направлений прихода ранних отражений сигнала с по-
ложением источников звука на стереопанораме.

Флажок Combine Source Left and Right — объединение левого и правого каналов
источника звука перед обработкой эффектом с целью сокращения времени вы-
числений. Стереообраз источника звука при этом разрушается.

Флажок Bypass — отключение эффекта (передача сигнала в обход него).

F id! Reverb

ГймЯЯЩ EafrR**» | СсЮш.Ьп |

, -•..-........
TolalJ^enQth _U J"! 12636 \ms "

ftlleck Tine jj _J jJFEE ms

Siffuaon jj JJ .j] f^

!; Perception •_<! _£j МБ

S *t Reverb based on £ arly
Reflection Room Sise

; Двопа! Siiyial !dryj ^ I jjl'^'' ^ -•-.

; Rev«b{we(t j] 1 *J |31 5 К
U"T^" * ~ *.-̂ — J ,̂ J . --7*Г Э

-V Combine SoJce Left and Right

; xj

Presets -. .. Add [ Oet 1

FurnishedLivingRoom *
Grand Canyon
Great Hall
Gymnasium ; .
Gymnasium 2
In the Shower
In the Shower 2
Large Auditorium
LargePlate
Lult e-W dim Room
Mar ten Echo
Medium Conceil Hall [crispl :

Eieviewi.-r Heb 1

Рис. 6.53. Вкладка General Reverb окна эффекта Full Reverb
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В списке Preset содержатся имена, под которыми в программе сохранены зара-
нее созданные схемы эффекта (пресеты). Нажав кнопку Add, вы откроете окно
диалога, в котором следует указать имя нового пресета. Для удаления выделенного
имени пресета из списка следует нажать кнопку Del.

Кроме неизменной части, окно эффекта содержит три переключаемые вклад-
ки: General Reverb, Early Reflections и Coloration. Рассмотрим их.

На вкладке General Reverb (рис. 6.53) имеются элементы регулировки общих
параметров реверберации:

> Total Length — общее время реверберации
> Attack Time — время достижения максимального уровня эффекта
> Diffusion — поглощающие свойства среды распространения звука
> Perception — характер восприятия реверберации: от размытого звука, харак-

терного для его отражения от большого числа близкорасположенных пре-
пятствий, до ясно различимого многократного эха

> Set Reverb based on Early Reflection Room Size — автоматическое согласова-
ние общих параметров реверберации с параметрами ранних отражений,
помещения и среды распространения

Вкладка Early Reflections представлена на рис. 6.54.
Перечислим параметры, устанавливаемые на вкладке Early Reflections:

> Room Size — объем помещения в метрах кубических
> Dimension — отношение ширины помещения кдлине
> Left/Right Location — точка локализации источника звука на стереопанораме
> High Pass Cutoff— частота среза фильтра, пропускающего высокие частоты

Вкладка Coloration представлена на рис. 6.55.
График на вкладке Coloration — амплитудно-частотная характеристика (АЧХ) фил ь-

тра, через который пропускается сигнал реверберации. По горизонтальной оси отло-
жены значения частоты, по вертикальной — значения АЧХ в децибелах. По сути дела,
фильтр представляет собой трехполосный параметрический эквалайзер. Для редак-
тирования формы графика вы можете использовать следующие регуляторы и опции:

> Low Shelf — частота среза фильтра, управляющего прохождением низкочас-
тотных спектральных составляющих

> Mid Band — центральная частота (частота резонанса) полосового фильтра
> High Shelf — частота среза фильтра, управляющего прохождением высоко-

частотных спектральных составляющих
Три расположенные вертикально регулятора, которые находятся правее гра-
фика, — регуляторы уровня усиления/ослабления сигнала каждым из трех
фильтров параметрического эквалайзера

> Q — добротность полосового фильтра. Чем больше эта величина, тем острее
резонансный пик у полосового фильтра (тем уже его полоса пропускания)

> ms — время реверберации высокочастотных составляющих сигнала (чем
меньше эта величина по сравнению с общим временем реверберации, тем
быстрее в обработанном сигнале затухнут высокочастотные составляющие)
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6.20. Multitap Delay... — многократный дилэй
Командой Effects > Delay Effects > Multitap Delay... открывается окно эффекта

Multitap Delay (рис. 6.56).
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Рис. 6.56. Окно эффекта Multitap Delay

Эффект Multitap Delay — комбинация дилэя, эха, фильтра и реверберации.
Надиаграмме в верхней части окна Multitap Delay наглядно отображается алго-

ритм обработки звука эффектом. Алгоритм состоит из циклов. Каждому циклу на
графике соответствует линия со стрелкой на конце. Цифры, отображаемые у на-
чала линии, означают смешение эха относительно исходного звука. Цифры над
линией означают задержку сигнала в депи обратной связи.

Представленный на рис. 6.56 алгоритм эффекта состоит из двух циклов. На-
пример, в первом из них однократный дилэй формируется задержкой сигнала на
214 мс, а реверберация получается за счет подачи задержанного сигнала в цепь
обратной связи, время задержки которой, в свою очередь, составляет 170 мс.

Не очень понятно? Ничего удивительного, ведь и сам эффект комплексный,
сложный. Разобраться в нем поможет аналогия с классическим магнитофонным
ревербератором. Если в ревербераторе есть две магнитные головки — записываю-
щая и воспроизводящая, — то можно реализовать и простейший дилэй, и ревер-
берацию. Пусть скорость движения ленты и расстояние между головками такие,
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что задержка сигнала составляет 214 мс. Дилэй реализуется, если на выход уст-
ройства подавать необработанный (входной) сигнал и сигнал, снятый с головки
воспроизведения. Реверберация (или, в зависимости от величины задержки, мно-
гократное эхо) получится, если задержанный сигнал (меньшего уровня) возвра-
щать на головку записи. При этом получится многократное эхо, но задержка меж-
ду каждым «отражением» звука будет составлять также 214 мс. Теперь представим
себе, что в воображаемый магнитофон добавлена еще одна записывающая голов-
ка. Причем от этой головки до воспроизводящей головки лента перемещается за
170 мс и на нее подается не входной сигнал, а сигнал с воспроизводящей головки
(задержанный сигнал). Получится полный аналог той схемы, которая представле-
на на рис. 6.56: однократная задержка на 214 мс и многократное эхо с повторени-
ем через 170 мс.

Иначе говоря, один цикл эффекта как бы соответствует магнитофону, имею-
щему две записывающие головки и одну воспроизводящую. На рис. 6.56 алго-
ритм состоит из двух циклов — это уже 5 головок (обшей является одна записы-
вающая головка).

Всего может быть создано до 10 циклов, каждый с собственной задержкой, об-
ратной связью и установками параметров фильтрации. Чтобы аппаратным путем
с помощью магнитофона получить тот же результат, понадобилось бы 29 магнит-
ных головок.

Если один цикл помещен внутри другого (это видно на диаграмме), будет реа-
лизована много кратный дилэй.

Выберите вариант схемы эффекта в списке Presets. После этого в списке Delay
Units отобразятся параметры каждого из циклов задержки. С помощью регулято-
ров группы Delay или соответствующих им полей ввода можно подстроить следу-
ющие параметры каждого цикла:

s* Offset — смещение относительно исходного звука
> Delay — задержка в цепи обратной связи
> Feedback — глубина обратной связи

Изменение положений двух первых регуляторов отображается на графиках
циклов. Отметим, что все регуляторы поля ввода и опции управляют параметрами
текущего цикла: того, который в данное время выделен в списке Delay Units.

Очередную строчку в этот список добавляют путем нажатия кнопки Add New.
Если уже существовал хотя бы один цикл, то вновь созданный цикл будет иметь те
же параметры. Если ни одного цикла не существовало, то после нажатия кнопки
Add New нужно еще щелкнуть на любом элементе группы Delay, чтобы появился
график цикла.

Чтобы удалить цикл, необходимо выделить его в списке Delay Units и нажать
кнопку Remove.

ФлажокА11ра55 Feedback следует устанавливать для предотвращения возникно-
вения постоянной составляющей в обработанном эффектом сигнале.

В группах Low-Cut Filter и High-Cut Filter содержатся поля, в которых вводят
частоту среза (Cutoff) и усиление (Boost) фильтра, вырезающего нижние частоты
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(Low-Cut Filter), и фильтра, вырезающего верхние частоты (High-Cut Filter), соот-
ветственно. Правда, если в полях Boost ввести значения, превышающие 0, то со-
ответствующие частоты будут не вырезаться, а усиливаться. Но мы не рекоменду-
ем этого делать потому, что может возникнуть я в л е н и е , аналогичное
самовозбуждению акустической системы: уровень каждого очередного задержан-
ного сигнала будет выше, чем предыдущего. Иногда для получения эффекта неза-
тухающего и даже возрастающего эха со специфическим тембром, возможно, вы
и захотите ввести в полях Boost положительные числа. Заметим, однако: чтобы
смоделировать самовозбуждение акустической системы, можно установить зна-
чение параметра Feedback, превышающим 100%.

Переключателями Left Channel, Right Channel и т. д. выбираются исходные об-
рабатываемые каналы или характер панарамирования обраюотанных сигналов,

Описывать словами алгоритмы обработки, предусмотренные в списке Presets,
совершенно безнадежное дело. Лучше подыщите какой-нибудь подходящий аудио-
файл и попробуйте эти алгоритмы на нем.

6.21. QuickVerb. *. — реверберация с упрощенным
набором регулируемых параметров

Командой Effects > Delay Effects > Quick\erb... открывается окно QuickVerb (рис. 6.57).
По сравнению с ранее описанными окнами эффектов окно, представленное

на рис. 6.57, выглядит не очень впечатляюще. Думается, что название эффекта не
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Рис. 6.57. Окно эффекта QuickVerb
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случайно. И в самом деле, с его помощью можно довольно быстро выбрать пара-
метры обработки, ведь их совсем не много:

> Room Size — размер (длина) моделируемого помещения
> Decay — время затухания реверберирующего сигнала
> Diffusion — характер реверберации; Echoey — отраженный звук, больше по-

хожий на эхо; Smooth — размытый звук, отраженный от множества пред-
метов

> High Cutoff Frequency — верхняя граничная частота обрабатываемого ревер-
бератором диапазона частот

> Low Cutoff Frequency — нижняя граничная частота обрабатываемого ревер-
бератором диапазона частот

> Mixing — элементы регулировки соотношения амплитуд исходного (Original
Signal (dry)) и обработанного эффектом (Reverb (wet)) сигналов

6,22. Reverb... — реверберация
Следующий эффект — тоже реверберация. Установка параметров эффекта про-

изводится с помощью опций окна эффекта Reverb, показанного на рис. 6.58. Это
окно можно открыть командой Effects > Delay Effects > Reverb....

Рассмотрим опции окна эффекта Reverb. В левой части окна, сверху вниз рас-
полагаются следующие движковые регуляторы и поля ввода:
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Рис. 6.58. Окно эффекта Reverb
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> Total Reverb Length — время реверберации в миллисекундах
V Attack Time — время нарастания реверберации (возникновения звука, отра-

женного от удаленных на различные расстоянии предметов)
> High Frequency Absorption Time — время затухания высокочастотных состав-

ляющих спектра звука из-за их поглощения средой распространения и от-
ражающими препятствиями

> Perception — характер реверберации: Smooth — размытый звук, отражен-
ный от множества предметов; Echoey — отраженный звук, больше похо-
жий на эхо

В группе Mixing задаются параметры микширования сигналов исходного
(Original Signal (Dry)) и обработанного эффектом реверберации (Reverb (wet)).

Установленный флажок Combine Source Left and Right позволяет объединять
сигналы стереоканалов в один, а затем производить расчет реверберации и после-
дующее микширование обработанного и исходного (стереофонического) сигна-
лов. При этом расчет происходит в два раза быстрее, но исходный стереообраз
звука разрушается.

В списке Presets предусмотрен традиционный набор вариантов реверберации:
имитация акустических свойств различных помещений, популярные алгоритмы
искусственной реверберации.

6.23. Sweeping Phaser... — перестраиваемый
фазовращатель

Последняя команда подменю Delay Effects — Sweeping Phaser... — открывает окно
эффекта Sweeping Phaser Effects (рис. 6.59).

Новое звучание аудиофайла достигается в основном за счет внесения измене-
ний в фазовые соотношения либо между сигналами правого и левого каналов, либо
между отдельными составляющими этих сигналов. Среди эффектов, реализуемых
с помощью данного окна, есть, конечно, флэнжер, фейзер, а также бесчисленное
множество безымянных обработок, основанных на преобразованиях фазы звуко-
вых колебаний.

В группе Filter Characteristics собраны регуляторы и поля ввода, предназ-
наченные для изменения параметров фильтра, используемого для реализа-
ции эффекта:

> Sweep Gain — усиление
> Center Frequency — центральная частота

Depth — глубина эффекта
Resonance — глубина резонанса (добротность)
Sweeping Rate — частота перестройки

В поле Stereo Phase Difference вводится разность фаз сигналов в стереоканалах
(в градусах).
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Рис. 6.59. Окно эффекта Sweeping Phaser Effects

В группе Sweep Modes можно выбрать режим перестройки (закон изменения фазы);

> Sinusoidal — синусоидальный
> Triangular — треугольный
> Log Frequency Sweep — логарифмический
> Linear Frequency Sweep — линейный

В группе Filter Type выбирают тип фильтра:

> Band Pass — полосовой пропускающий фильтр
> Low Pass — фильтр, пропускающий нижние частоты

В поле Master Gain вы можете скорректировать общее усиление, компенсируя
изменение уровня сигнала при обработке его эффектом.

Если установлен флажок Bypass, то исходный сигнал не подвергается обработ-
ке эффектом ни при предварительном прослушивании, ни при пересчете данных
аудиофайла. Такой флажок или аналогичная по назначению кнопка есть в окнах
многих эффектов. Им удобно пользоваться для обеспечения контрастности срав-
нен ия звучания исходного и обработанного аудиофайлов.

В списке Presets предусмотрен ряд интересных предварительно установленных
схем эффекта:
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> Awash in Bass, Crimchy — варианты эффекта флэнжер
> Heavy Phasing, Slo Heavy Phasing, Synth Phasing, Vocal Phasing - варианты

эффекта фейзер
> Heavy Vibrato — выраженное вибрато
> Leslie-Fast, Leslie-Slo, Spacey — варианты эффекта лесли
> Light Tremolo — тремоло
> Wah-Wah-Wahs, Wishy-Washy — варианты эффекта вау-вау

На этом мы завершаем анализ эффектов, доступ к которым осуществляется из
подменю Delay Effects меню Effects.

6*24. Фильтрация
Очередным пунктом меню Effects является подменю Filters (фильтры), кото-

рое включает в себя следующие команды:

> Dynamic EQ... — эквалайзер с динамическим управлением частотой настрой-
ки, усилением и полосой

> FFT Filter... — фильтр на основе быстрого преобразования Фурье
> Graphic Equalizer... — универсальный графический эквалайзер
> Graphic Phase Shifter... — графический фазовращатель
> Notch Filter... — многополосный фильтр выреза
> Parametric Equalizer... — семиполосный параметрический эквалайзер
> Quick Filter... — восьмиполосный графический эквалайзер
> Scientific Filters... — фильтры Бесселя, Баттеворта, Чебышева

Итак, в этом подменю собраны команды, связанные с фильтрацией. Подробно
о ней мы рассказали в книгах [8, 34], поэтому в данном разделе ограничимся лишь
предельно краткими сведениями о сути фильтрации и классификации используе-
мых фильтров.

Фильтрация — это процесс обработки электрического звукового сигнала час-
тотноизбирательньши устройствами с целью изменения спектрального состава
(тембра) сигнала. Задачами такой обработки могут быть:

> Амплитудно-частотная коррекция сигнала (усиление или ослабление от-
дельных частотных составляющих)

> Полное подавление спектра сигнала или шумов в определенной полосе
частот

Например, если микрофон, акустическая система или еще какой-либо элемент
звукового тракта имеют неравномерную амплитудно-частотную характеристику,
то с помощью фильтров эти неравномерности могут быть сглажены. Если в ре-
зультате анализа спектра выяснилось, что в некоторой области частот в основном
сосредоточена энергия помех, а энергии сигнала совсем немного, то посредством
фильтрации все колебания в этом диапазоне частот можно подавить.



Меню EFFECTS ~ преобразование звука 251

Для осуществления фильтрации созданы самые различные устройства: отдель-
ные корректирующие и формантные фильтры, устройства для разделения звука
на несколько каналов по частотному признаку (кроссоверы), двухполосньге и мно-
гополосные регуляторы тембра (эквалайзеры), фильтры присутствия и т. д.

Основой фильтров, реализованных программным путем в составе звуковых
редакторов, служит спектральный анализ. В гл. 5 мы рассказали о том, как лю-
бой реальный сигнал может быть представлен в виде набора коэффициентов раз-
ложения в ряд по гармоническим (синусоидальным и косинусоидальным) фун-
кциям. Фильтрация сводится к умножению спектральных коэффициентов на
соответствующие значения передаточной функции фильтра. Если спектр пред-
ставлен в комплексной форме, то сигнал описывается совокупностью ампли-
тудного и фазового спектров (АС и ФС), а фильтры — амплитудно-частотными
и фазо-частотными характеристиками (АЧХ и ФЧХ). АЧХ представляет собой
зависимость коэффициента передачи фильтра от частоты. ФЧХ отражает сдвиг
фазы выходного сигнала по отношению ко входному в зависимости от частоты.
Б этом случае фильтрация эквивалентна перемножению АС на АЧХ и алгебраи-
ческому сложению ФС с ФЧХ.

Классический спектральный анализ из-за наличия большого количества опе-
раций перемножения занимает очень много процессорного времени и при значи-
тельном числе отсчетов сигнала неосуществим в реальном темпе обработки. Для
сокращения времени спектрального анализа дискретных сигналов разработаны
специальные алгоритмы, учитывающие наличие связей между различными отсче-
тами сигнала и устраняющие повторяющиеся операции. Одним из таких алгорит-
мов является быстрое преобразование Фурье (БПФ) [8, 34].

В зависимости от расположения полосы пропускания на оси частот фильтры
подразделяются на:

> Фильтры нижних частот (ФНЧ) (Low Pass), типичные АЧХ и ФЧХ которых
показаны на рис. 6.60.

>• Фильтры верхних частот (ФВЧ) (High Pass), их АЧХ и ФЧХ показаны на
рис. 6.61

> Полоснопропускающие (полосовые) фильтры (Band Pass) (рис. 6.62)
> Полоснозадерживающие (режекторные) фильтры (Band Stop) (рис. 6.63)

На рисунках по горизонтальным осям отложено значение частоты, по верти-
кальным осям отложены значения передаточных функций Кф или фазовых сдви-
гов (p(f) в зависимости от частоты.

Тот участок АЧХ, где коэффициент передачи не равен нулю, соответствует полосе
пропускания фильтра. В полосе задерживания (или подавления), напротив, коэффи-
циент передачи фильтра должен быть минимальным (в идеальном случае нулевым).

Характеристики, представленные на рис. 6.60—рис. 6.63 являются идеализи-
рованными: реальные фильтры, строго говоря, не позволяют обеспечить равен-
ство передаточной функции нулю вне полосы пропускания. Колебания в полосе
задерживания, пусть и значительно ослабленные, все равно проникают через
фильтр. В разд. 6.32 рассмотрены синтезированные аналитические фильтры, ам~
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Рис. 6, 60. АЧХ и ФЧХ фильтра
нижних частот

Рис. 6.61. АЧХ и ФЧХ фильтра
верхних частот

Идеальная АЧХ Идеальная АЧХ

Рис. 6.62. АЧХ и ФЧХ полосового
фильтра

Рис. 6.63. АЧХ и ФЧХ режекторно-
го фильтра
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плитудно-частотные характеристики которых являются приближениями к харак-
теристикам идеальных фильтров.

Реальные фильтры низких и высоких частот характеризуются следующими ос-
новными параметрами:

> Частотой среза
> Шириной полосы пропускания
> Неравномерностью характеристики в полосе пропускания
>' Крутизной ската характеристики в области перехода от полосы пропуска-

ния к полосе задерживания

Для полосового фильтра добавляется еще один параметр — добротность, под
которой понимают отношение центральной частоты фильтра к полосе его про-
пускания.

Весьма распространенной ошибкой является пренебрежение учетом влияния
на форму сигнала фазо-частотной характеристики фильтра. Фаза важна потому,
что сигнал, прошедший через фильтр без изменения амплитуды в полосе пропус
кания, может быть искажен по форме, если временное запаздывание при прохож-
дении через фильтр не будет постоянным для разных частот. Одинаковое время
задержки соответствует линейной зависимости фазы от частоты. Из рисунков вид-
но, что для ФНЧ и ФВЧ зависимость фазы от частоты можно считать линейной
лишь в окрестностях частот среза, а для полосового фильтра — в окрестностях ре-
зонансной (центральной) частоты. Применение режекторного фильтра, допустим,
для подавления узкополосной помехи приводит к тому, что колебания, частоты
которых расположены ниже частоты режекции, оказываются проинвертирован-
ными (умноженными на-J) .

Таким образом, следует ясно представлять себе, что фильтрация широкополос-
ных звуковых колебаний будет обязательно сопровождаться фазовыми искаже-
ниями, приводящими к изменению формы фильтруемого сигнала.

Примером устройства, в котором применяются ФНЧ и ФВЧ, являются ре-
гуляторы тембра (высоких и низких частот), которые есть почти в каждом бы-
товом усилителе, приемнике или магнитофоне. Одновременно данное устрой-
ство можно считать также простейшим эквалайзером. С его помощью можно
отрегулировать звучание системы таким образом, чтобы оно соответствовало
вашим вкусам.

Помимо регуляторов тембра НЧ и ВЧ во многих усилителях и других системах
встречается также регулятор тембра средних частот. По существу, этот регулятор
управляет полосовым фильтром. Он предназначен для усиления или ослабления
сигнала в сравнительно узкой полосе частот звукового спектра.

Работая с программой Cool Edit Pro, вы будете часто пользоваться эквалайзерами.
Эквалайзеры представляют собой устройства, объединяющие в себе несколь-

ко фильтров, предназначенных для изменения спектральных свойств (тембра) об-
рабатываемого сигнала. Первоначально эквалайзер (equalizer, EQ), в основном,
выполнял функции устройства, компенсирующего неравномерность того или ино-
го участка тракта усиления и преобразования звукового сигнала.
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При наличии эквалайзера можно как бы выровнять исходно неровную АЧХ.
Отсюда возникло и название «эквалайзер» — «выравниватель». Известны несколь-
ко различных по назначению и по устройству типов эквалайзеров, среди них:

> Графический эквалайзер
> Параметрический эквалайзер
> Фильтр присутствия
> Кроссовер

Графический эквалайзер — это набор полосовых фильтров с фиксированными
центральными частотами и переменным коэффициентом усиления, которым мож-
но управлять при помощи слайдера. В качестве регуляторов принято использо-
вать именно ползунки, так как положение их ручек представляет собой некое по-
добие графика АЧХ эквалайзера. Именно поэтому такие эквалайзеры принято
называть «графическими» — пользователь как бы рисует ползунками необходи-
мую ему кривую АЧХ.

Итак, графический эквалайзер — это набор полосовых фильтров, которые пол-
ностью отделяют друг от друга определенные полосы частот. Для того чтобы иметь
возможность управлять частотной характеристикой во всей области звуковых ча-
стот, такие фильтры соединены параллельно. На вход всех фильтров подается один
и тот же сигнал, и задача каждого фильтра состоит в том, чтобы усилить или осла-
бить «свой» участок спектра в соответствии с положением регулятора коэффици-
ента усиления (слайдера).

Частоты, на которых осуществляется регулирование в графических эквалайзе-
рах, унифицированы, и выбираются из ряда стандартных частот, перекрывающих
весь звуковой диапазон и отстоящих друг от друга на некоторый интервал. Этот
интервал может составлять октаву, ее половину или треть октавы. Наибольшие воз-
можности, естественно, имеют третьоктавные графические эквалайзеры, которые
в силу этого и получили наибольшее распространение.

Каждая октава соответствует степени двойки, поэтому шаг в октаву с централь-
ной частоты 100 Гц будет выглядеть следующим образом: 200 Гц, 400 Гц, 800 Гц
и т. д. Для шага в 1/3 октавы коэффициент умножения составит 21/3, что пример-
но равно 1,26. При первой центральной частоте в 100 Гц следующие частоты будут
равны 126 Гц, 159 Гц, 200 Гц и т. д.

Число полос регулирования может составлять до 31 в серьезных профессио-
нальных моделях.

Самый низкочастотный фильтр эквалайзера не обязательно должен быть по-
лосовым, он может быть и фильтром нижних частот. Аналогично самый высоко-
частотный фильтр может быть фильтром верхних частот.

Наиболее часто графические эквалайзеры применяются для обработки
суммарного сигнала, «доводки» общей картины, а не отдельных составляю-
щих, как другие виды эквалайзеров. С помощью графического эквалайзера
можно приближенно сформировать необходимую АЧХ системы обработки
звука или акустической системы: поднять усиление в одних областях спектра
и уменьшить его в других. Однако графический эквалайзер (даже многопо-
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лосный) мало пригоден для ювелирной частотной коррекции. Ведь централь-
ные частоты фильтров неизменны. Они могут и не совпадать в точности с течи
частотами, на которых следует подчеркнуть или, напротив, подавить спект-
ральные составляющие. В подобных случаях на помощь приходит парамет-
рический эквалайзер.

Параметрический эквалайзер позволяет управлять не только коэффициентом
усиления фильтра, но и ето центральной частотой, а также добротностью (по су-
ществу, шириной полосы пропускания). При наличии некоторого опыта вы смо-
жете точно устанавливать значения этих параметров таким образом, чтобы под-
черкнуть звук отдельного инструмента или удалить нежелательную помеху
(например, фон 50 Гц или частоту самовозбуждения акустической системы) с ми-
нимальным влиянием на остальные элементы звукового образа.

Для формирования АЧХ сложного вида применяются многополосные парамет-
рические эквалайзеры, параметры каждого из которых можно изменять независимо.

Фильтр «присутствия» (англ, presence) позволяет добиться впечатления, что
звучащий инструмент (или голос певца) находится в одной комнате со слушате-
лем. На самом деле это не что иное, как регулируемый полосовой фильтр, цент-
ральная частота которого лежит где-то в диапазоне от 2 до 6 кГц. Фильтр «присут-
ствия» в гитарном комбике помогает сделать звук гитары более ярким и заметным
на фоне звуков остальных инструментов.

Кроссовер — это устройство, которое разделяет входной сигнал на несколько
выходных, причем каждый выходной сигнал содержит колебания только опреде-
ленного диапазона частот. Кроссовер представляет собой набор полосовых и по-
роговых фильтров (по количеству выходных каналов) с общим входом и отдель-
ными выходами.

Хотя кроссоверы и не являются эквалайзерами в непосредственном значении
этого слова, их работа основана на тех же принципах.

Как известно, практически невозможно создать громкоговоритель, который
одинаково хорошо воспроизводил бы все диапазоны частот: и высокие, перед-
ние, и низкие. Если сузить диапазон воспроизводимых громкоговорителем ча-
стот, то его разработка упростится, однако для воспроизведения звука во всем
диапазоне потребуется несколько различных громкоговорителей. Самый боль-
шой из них служит для воспроизведения низких частот, а самый маленький —
для воспроизведения высоких. В высококачественных акустических системах
к ним добавляется третий — воспроизводящий средние частоты. Для нормаль-
ной работы громкоговорителя необходимо, чтобы на него подавались сигналы
только в том диапазоне частот, на который он рассчитан. В целях разделения
широкополосного сигнала на несколько полос с различными частотами и при-
меняются кроссоверы.

Освежив в памяти терминологию, связанную с фильтрацией аудиосигналов,
можно переходить к анализу средств Cool Edit Pro, доступ к которым осуществля -
ется посредством команд подменю Effects > Filters.
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6.25. Dynamic EQ... — эквалайзер с динамическим
управлением частотой настройки, усилением и
полосой

Команда Effects > Filters > Dynamic EQ... открывает одноименное окно диалога
(рис. 6.64), в котором реализован однополосный параметрический эквалайзер с
динамическим управлением частотой настройки, усилением и полосой пропуска-
ния (подавления) частот. Окно состоит из трех вкладок;

> frequency — графическое управление частотой настройки фильтра (рис. 6.64)
> Gain — графическое управление усилением фильтра в полосе пропускания

(подавления) частот (рис. 6,65)
> Q (bandwidth) — добротность; величина этого параметра при фиксирован-

ной центральной частоте настройки обратно пропорциональна полосе про-
пускания (подавления) фильтра (рис. 6.66)

Технология применения Dynamic EQ практически ничем не отличается от тех-
нологии использования Dinamic Delay (см. разд. 6.15). Точно так же работа сводит-
ся к «рисованию» графиков зависимости параметров от времени. Только парамет-
ры, которыми управляют посредством названных окон, разные.

В группе Filter Type можно выбрать один из типов фильтров: Lov Pass, Band Pass
или High Pass (см. разд. 6.24) и коэффициент передачи фильтра в полосе подавле-
ния сигнала, заданный в дБ (поле Stop Band_dB).

С опциями группы Loop Graph мы уже знакомили вас в разд. 6.12. Эти же пара-
меры задаются в окне Stereo Field Rotate. И служат они для организации циклов.

Dynamic EQ X]
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Рис, 6.64. Окно диалога Dynamic EQ, вкладка Frequency
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6.26. FR Filter.. — фильтр на основе быстрого
преобразования Фурье

Команда Effects > Filters > FFT Filter... открывает одноименное окно диалога
(рис. 6.67).

Из названия этого окна диалога следует, что здесь реализован БПФ-филыпр —
фильтр на основе быстрого преобразования Фурье. Это название досталось окну
диалога и, соответственно, фильтру в наследство от Cool Edit 96. В той версии про-
граммы были реализованы только два фильтра: рассматриваемый FFT Filter и Quick
Filter. Название последнего переводится как быстрый фильтр. Мы это понимаем в
том смысле, что с помощью Quick Filter можно быстро (и довольно грубо) отфиль-
тровать сигнал.

Нетрудно запутаться: здесь «быстрый» — это фильтр, там «быстрое» — преобра-
зование. На самом деле, в основе алгоритмов, реализующих любые фильтры в Cool
Edit Pro, обязательно лежит быстрое преобразование Фурье (БПФ).

Приближенно можно считать, что объем вычислений по алгоритму БПФ про-
порционален произведению Nxlog2N, где N — количество отсчетов сигнала. Если
решать задачу расчета спектра «в лоб», не пользуясь алгоритмами быстрых преоб-
разований, то объем вычислений ориентировочно будет пропорционален произ-
ведению NxN, Если бы не БПФ, то для фильтрации, спектрального анализа и син-
теза сигналов не хватило бы быстродействия самого современного компьютера.

С Major Tried
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Inharmonic Resonance
Inharmonic Resonance Slide
Kill The 60 N2 Ground Loop
Kill The Mic Rumble
KillTheSubhermonics
Mattering • Gentle & Narrow
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FFT Sire Windowing Funclbn

Time-Variable setting;---:

P Lod<.ta Constant Fitter

F? Mcrph

Ma* [200'~ Z

Minfo x

Г" Bypass

Рис. 6.67. Окно
диалога FFT Filter
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Не верится? Давайте прикинем. Очень скоро вы узнаете, что в примере установок
параметров, соответствующих рис. 6.67, сигнал представлен 4096-ю отсчетами.
Тогда для БПФ; 4096xlog24096 = 4096x12 = 49 152, а для «небыстрого» алгоритма:
4096x4096 = 16 777 216. Отношение 16 777 216/49 152 = 341,(3) приблизительно
равно выигрышу во времени выполнения вычислений по алгоритму БПФ.

О чем говорят эти цифры? Пусть на вашем компьютере для расчета фильтра по
алгоритму БПФ требуется 1 мин. Та же самая задача при использовании обычного
<шгоритма спектрального анализа заняла бы почти 6 часов. Какое уж тут может
быть творчество! Либо, чтобы все-таки уложиться в одну минуту, потребовался бы
компьютер, работающий в 341 раз быстрее, чем ваш.

Итак, все фильтры, представленные в подменю Filters, основаны на БПФ. По-
чему же тогда только рассматриваемый фильтр называется БПФ-фильтром? Ско-
рее всего, потому, что его окно (FFT Filter) оформлено так, что напоминает интер-
фейс математических программ, реализующих быстрое преобразование Фурье.
II нем даже есть специальная группа FFT and Windowing, где можно задать пара-
метры, существенно влияющие на результаты фильтрации.

Раскрывающийся список FFT Size содержит размеры выборок при БПФ. Чем
больше выборка, тем чище будет звук, но и тем дольше будет производиться расчет.

В раскрывающемся списке Windowing Function перечислены функции, опреде-
ляющие вид временного окна и, соответственно, характер учета предыстории ана-
лизируемого сигнала (см. разд. 5.1.4).

Самым заметным и привлекающим внимание элементом окна FFT Filter яв-
ляется координатное поле, на котором отображается амплитудно-частотная ха-
рактеристика фильтра. По горизонтальной оси откладываются значения часто-
ты, а по вертикальной — коэффициент передачи фильтра для каждого значения
частоты.

В режиме Passive вертикальная ось отградуирована в процентах. Например,
100% означает, что сигнал фильтром не ослабляется и не усиливается, 200% —
амплитуда конкретной спектральной составляющей увеличивается в 2 раза,
50% — уменьшается в 2 раза.

В режиме Logarithmic по вертикальной оси установлен логарифмический мас-
штаб (АЧХ измеряется в дБ).

Если установлен флажок Log Scale, то на оси частот выбирается логарифми-
ческий масштаб, позволяющий детально разглядеть АЧХ фильтра в области ма-
лых частот. Например, на рис. 6.67 наиболее информативная часть АЧХ находит-
ся в пределах частот от 55 до 110 Гц, причем она хорошо видна. Если флажок Log
Scale сброшен, то для горизонтальной оси выбирается линейный масштаб. Это
позволяет наблюдать АЧХ фильтра в наиболее естественном виде, с сохранением
всех пропорций, но в низкочастотной области разглядеть ничего не удастся. Все
детали графика сливаются. Оба режима не особенно пригодны для точного управ-
ления формой АЧХ графическим путем. Выручает информационное поле, нахо-
дящееся в левой части окна под графиком АЧХ. В нем отображаются текущие ко-
0]эдинаты курсора. Поэтому все же существует способ точного задания координат
у:итовой точки графика, а значит, и формы АЧХ в целом.
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Флажок Spline Curves позволяет включить сплайн-аппроксимацию графика. Тогда
знакомая по рис. 6.67 АЧХ фильтра будет выглядеть так, как представлено на рис. 6.68.
Учтите, что меняется не только вид графика, но и фактическая АЧХ фильтра.

При сброшенном флажке Lock to Constant Filter (в группе Time-Variable Settings)
амплитудно-частотная характеристика фильтра может изменяться на протяжении
обрабатываемого звукового участка в соответствии с вашими пожеланиями. Для
этого нужно выполнить несколько операций. Выбрав опцию View Initial Filter Graph,
с помощью мыши следует расставить узловые точки на графике характеристики
фильтра. Получим, например, такую АЧХ, как показано на рис. 6,69. Эта характе-
ристика будет начальной.

Включив режим View Final, нужно задать конечную характеристику фильтра
(например, такую, как на рис. 6.70).

Опциями группы Time-Variable Settings задается режим, в котором при обра-
ботке звукового фрагмента форма начальной АЧХ фильтра постепенно превра-
щается в конечную. Это делается с помощью опции Morph. В поле Precision Factor
задается точность обработки аудиоданных (степень плавности перехода АЧХ филь-
тра от начального значения до конечного).

При нажатии кнопки Transition Curve (кривая преобразования) возникает окно, в кото-
ром можно нарисовать график, определяющий характер трансформации АЧХ фильтра.

Здесь горизонтальная ось — ось времени, вертикальная — ось степени прибли-
жения характеристики фильтра к ее начальной (Initial) или конечной (Final) фор-

Presets Ada

QnHo!d40Q-->4k
OnHoldEQ
Only The Subwciofet

Telephone • Receiver
Telephone - Voice Mail
The Club Downstairs
Underwater • Deep
Underwater- Shallow

Г? Log Scale W Splrie Curves Fte
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P fclorph

г '•'"
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Мак J2QO %

Min JO %

Г" Sjpass

Рис. 6.70.
Конечная АЧХ
фи/> ьтра
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ме. Если включена опция Graph response at point, в нижней части экрана будет ото-
бражаться АЧХ фильтра, соответствующая устанавливаемой узловой точке графи-
ка. Нажатием кнопки Flat график всегда можно превратить в прямую линию.

На рис. 6.71 показано окно диалога Transition Curve после щелчка кнопкой мыши
на левой узловой точке графика преобразования АЧХ. В нижней части экрана ото-
бражается начальная АЧХ.

Рис. 6.71. Окно диалога
Transition Curve

Cursor 17375 sec--> 32%

Graph respoise

Рис. 6.72. АЧХ фильтра в промежуточный момент времени
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Если щелкнуть на второй слева узловой точке графика преобразования АЧХ, то в
нижнем поле отобразится АЧХ фильтра в промежуточный момент времени (рис. 6.72).

Щелчок кнопкой мыши на правой узловой точке графика преобразования АЧХ
приведет к тому, что будет отображена финальная АЧХ фильтра (рис. 6.73).

Transition Curve *!

Final

Initial

Help

Рис. 6.73. финальная АЧХ фильтра

Теперь вернемся к окну диалога FFT Filter. В списке Presets содержится до-
вольно большое количество интересных пресетов, причем по сравнению с преды-
дущей версией программы пресеты данного фильтра обновлены полностью. Пе-
речислим только наиболее интересные из пресетов:

> С Major Triad — гребенка узкополосных фильтров, настроенных на частоты
звуков аккорда До мажор нескольких соседних октав

> Cassette Tape Frequency Response — фильтр с частотной характеристикой,
соответствующей ленте аудиокассеты

> De-Esser — фильтр, подавляющий свистящие звуки, характерные для темб-
ра голоса некоторых людей

> Inharmonic Resonance — гребенка узкополосных фильтров, частоты настрой-
ки которых находятся в негармоническом отношении

> Inharmonic Resonance Slid — гребенка узкополосных фильтров, частоты на-
стройки которых находятся в негармоническом отношении и перестраива-
ются во времени

> Kit The 60 Hz Ground Loop — набор фильтров, подавляющий в аудиофайле
фон промышленной сети частотой 60 Гц и ее высшие гармоники
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> Kit The Mic Rumble — фильтр, подавляющий низкочастотные шумы, посту-
пающие в микрофон

> Kit The Subharmonic— фильтр, подавляющий сверхнизкочастотные шумы
> Mastering - Gentle & Narrow... Mastering - Heavy & Wide — варианты фильт-

ров, используемых в процессе мастеринга
> OnHold 400 ® 4, OnHoLd EQ — варианты полосового фильтра для выделения

на фоне помех речевого сигнала, записанного с телефонной линии.
> Only The Subwoofer — фильтр кроссовера, формирующий сигнал для низко-

частотной акустической системы
> Only The Tweeter — фильтр кроссовера, формирующий сигнал для высоко-

частотного излучателя акустической системы

6.27. Graphic Equalizer.. — графический эквалайзер
Команда Effects > Filtres > Graphic Equalizer... открывает окно многополосного

графического эквалайзера Graphic Equalizer (рис. 6.74 — 6.76).
Многополосный графический эквалайзер представлен в трех вариантах:

> 10-полосный эквалайзер, состоящий из октавных фильтров; вкладка 10
Bands (I octave) (рис. 6.74)

> 20-полосный эквалайзер (полуоктавные фильтры); вкладка 20 Bands (1/2
octave) (рис. 6.75)

> 30-полосный эквалайзер (третьоктавные фильтры); вкладка 20 Bands (1/3
octave), (рис. 6.76)

Назначение основных элементов этого окна должно быть интуитивно понятно.
Регуляторами (слайдерами) можно изменять уровень сигнала на той или иной часто-
те. Приближенное значение центральной частоты настройки конкретного элемен-
тарного фильтра указано над регулятором. Для крайних слева и справа регуляторов —
это не частоты настройки, а частоты среза. В принципе, в самом расположении регу-
ляторов графического эквалайзера содержится информация о форме АЧХ. Но для
удобства в этом окне имеется специальное поле, в котором отображается АЧХ.

Это окно организовано весьма разумно: верхняя частотная граница, доступная
для регулировки АЧХ, зависит от значения частоты дискретизации аудиофайла,
На рис. 6.76 отображено окно Graphic Equalizer, открытое в тот момент, когда ре-
дактировался аудиофайл, имеющий частоту дискретизации 44,1 кГц. Поэтому до-
ступны все 30 регуляторов. На рис. 6.77 показана та же самая вкладка, открытая
для аудиофайла с частотой дискретизации 22,05 кГц.

Видно, что три правых регулятора не доступны, у них попросту нет движков.
Так и должно быть, ведь в соответствии с теоремой Найквиста-Котельникова при
частоте дискретизации 22,05 кГц верхняя граничная частота воспроизводимой без
искажения полосы составляет не более 1 1 кГц. Нечего и пытаться поднимать уро-
вень усиления на частотах порядка 16—25 кГц, поскольку там, в данном случае,
нет полезного сигнала, а присутствуют лишь шумы и продукты искажений, выз-
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Рис-6.74. Вкладка 10
Bands (1 octave) окна
Graphic Equalizer

и! '.44 B2 «a ras m MO зо MO me IK 1.4 г гя" 4 "'ел : 8 и,з ш «̂к

J J d J
Graph Actual Response

Рис. 6.75. Вкладка 20
Bands (1/2 octave) окна
Graphic Equalizer

ванных плохим подавлением высоких частот при оцифровке. Их вряд ли можно
считать полезными составляющими сигнала.

Тот слайдер, на котором вы щелкните кнопкой мыши, становится выбранным.
Перемещать его вверх/вниз можно также с помощью мыши.
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Рис. 6.76. Вкладка 30
Bands {1/3 octave) окна
Graphic Equalizer

Graphic Equalizer

Рис. 6.77. Вкладка 30
Bands (1/3 octave) окна
Graphic Equalizer при
частоте дискретизации
аудиофайла 22,05 кГц

Кроме регуляторов усиления для каждой из полос, в окне имеются следующие
общие элементы:

> Кнопка Reset All to Zero — установка всех слайдеров в нейтрачьное положение
> Раскрывающийся список Band — точное значение центральной частоты (ча-

стоты среза) выбранного фильтра
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> Поле Gain— ввод точного значения коэффициента усиления сигнала на
центральной частоте (частоте среза) выбранного фильтра

> Кнопка Graph Actual Response — получение фактического графика АЧХ эк-
валайзера

> Поле ввода Accuracy — указание точности обработки (рекомендуемые зна-
чения параметра 500—5000; чем меньше нижняя граничная частота в спек-
тре сигнала, тем больше должно быть это значение)

> Поле ввода Range — выбор диапазона изменения параметра слайдером (стан-
дартные аппаратные эквалайзеры обычно имеют диапазон от 30 до 48 дБ)

> Поле ввода Master Gain — ввод общего усиления сигнала

Поясним назначение кнопки Graph Actual Response. Регуляторами вы задаете же-
лаемую форму АЧХ. Но для реализации каждого из элементарных фильтров, входя-
щих в эквалайзер, применяются численные алгоритмы, основанные на быстром пре-
образовании Фурье. При моделировании любых процессов (не обязательно только
электро-акустических) численный алгоритм всегда дает приближенный результат.
Погрешность зависит от многих факторов, особенно от формата представления чи-
сел и количества отсчетов. При моделировании эквалайзера точность результата, кроме
того, зависит от добротности каждого из фильтров и от выбранного закона измене-
ния данного параметра с увеличением центральной частоты настройки фильтра. В Cool
Edit Pro соотношение всех этих факторов таково, что позволяет получить приемле-
мый по точности результат за приемлемое время. Реальная АЧХ, особенно в области
низких частот, отличается от заданной вами. Такого рода погрешности принципиаль-
но имеют место в любой программе спектрального анализа/синтеза. Однако не все
разработчики признаются в этом, тем не менее, создатели Cool Edit Pro не только
обращают внимание пользователей на различия между желаемой и реальной АЧХ, но
и предоставляют в наше распоряжение своеобразный измерительный инструмент,
приводимый вдействие кнопкой Graph Actual Response. Нажав ее и подождав несколько
мгновений, пока программа выполнит необходимые расчеты, вы получите факти-
ческий график АЧХ эквалайзера (рис. 6.78).

Надписи Requested frequency response и Response using current accuracy и значки
рядом с ними напоминают, что желаемая АЧХ обозначается синим цветом на чер-
ном фоне, а фактическая — зеленым. Для амплитудно-частотной характеристи-
ки, приведенной на рис. 6.78 в качестве примера, характерны существенные раз-
личия между желаемым и действительным в области низких частот. С ростом
частоты различия сходят «на нет».

Независимо от области частот фактическая характеристика всегда будет точи о
совпадать с заданной, если характеристика изменяется плавно и в небольших пре-
делах. Кстати говоря, специалисты рекомендуют очень аккуратно пользоваться
существенной частотной коррекцией.

В списке Presets содержится свыше сорока различных предустановок. Пояс-
ним сущность некоторых из них:

> 20 Band Classic V и 30 Band Classic V — 20- и 30-полосные V-образные харак-
теристики (с подъемом нижних и верхних частот)
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Рис. 6.78. Вкладка 30
Bands (1/3 octave) окна
Graphic Equalizer после

> Presence (Music) — фильтр присутствия для выделения музыкального сопро-
вождения

> Simple Bass Cut — простой фильтр для снижения уровня баса
> Simple Bass Lift — простой фильтр для повышения уровня баса
> Simple Mid Boost — простой фильтр для повышения уровня средних частот
> Sloping High End Boost — фильтр для подъема средних и высоких частот с

наклонной характеристикой, возрастающей по мере роста частоты
> Sloping Low End Boost — фильтр для подъема низких частот с накланной ха-

рактеристикой, возрастающей по мере убывания частоты
> Vocal Presence (Boost) — фильтр присутствия для выделения вокала (подъем

уровня сигнала на частотах, характерных для вокала)
> Vocal Presence (Cut)— фильтр присутствия (снижение уровня сигнала на

частотах, характерных для вокала)

6,28, Graphic Phase Shifter... — графический
фазовращатель

Команда Effects > Filtres > Graphic Phase Shifter... открывает окно графического
фазовращателя Graphic Phase Shifter (рис. 6.79).

Координатное поле окна предназначено для построения фазо-частотной ха-
рактеристики (зависимости фазы колебаний от частоты). Окно Graphic Phase Shifter
может пригодиться либо для корректировки фазочастотных искажений, либо в
качестве специального эффекта.
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[Graphic Phase Shifter

+ 90 degrees
ISO-degree flipatlKHz
90-degree sep below 1QQHz
Linear Shift over 360 degrees

! Mono to Stereo

Рис. 6.79. Окно Graphic Phase Shifter

Ряд элементов окна вам уже хорошо знаком. Прежде всего, это флажки:
> Splines — включение сплайн-аппроксимации
> +/-360" Range — переключение пределов шкалы на вертикальной оси
> Log Frequency Scale — включение логарифмического масштаба по оси частот

Кнопка Flat возвращает график в исходное состояние.
С помощью раскрывающегося списка FFT Size для попедуры БПФ устанавли-

вают размер выборки.
В раскрывающемся списке Channel следует выбрать обрабатываемые каналы:

левый, правый или оба канала.
В списке пресетов содержится несколько вариантов фазо-частотных характе-

ристик.

6.29. Notch Filter.*, — многополосный фильтр выреза
Фильтр, окно которого открывается командой Notch Filter..., предназначен для

подавления нежелательных узкополосных составляющих в спектре сигнала. Он
особенно полезен для подавления фоновых составляющих с частотой промыш-
ленной электрической сети (50 Гц) и гармоник этой частоты, образующихся в ре-
зультате нелинейных преобразований.
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Notch Filter
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Рис. 6.80- Окно диалога Notch
Filter

Рассмотрим окно диалога Notch Filter (рис. 6.80).
В группе Tones to Notch можно выбрать значение частоты (frequency) и степень

подавления (Attenuation) для каждой из подавляемых составляющих спектра.
Флажки DTMF Lower Tones и DTMF Upper Tones — включение/отключение ре-

жима подавления спектральных составляющих на частотах, стандартных для сис-
темы тонального набора номера телефона. Степень подавления можно выбрать
отдельно для каждой группы низкочастотных и высокочастотных тонов.

Если флажок Fix Attenuations to установлен, то для всех частот уровень ослабления
будет одинаковым (вводится в соответствующем поле). Если этот флажок сброшен,
то есть возможность выбрать индивидуальные уровни ослабления каждой частоты.

В раскрывающемся списке Notch Width вы можете выбрать порядок фильтра
[8, 34] и, тем самым, ширину полосы его пропускания: узкую (Narrow), очень уз-
кую (Very Narrow) или суперузкую (Super Narrow). Рекомендуемые значения сте-
пени подавления для:

> Narrow — не более 30 дБ
> Very Narrow — не более 60 дБ
> Super Narrow — не более 90 дБ

В списке Presets содержатся следующие предустановки:
> 50 Hz + Harmonics (heavy), 50 Hz + Harmonics Removal — варианты фильтров

подавления фоновой составляющей от сети 50 Гц и 5-и гармоник этой частоты
> 60 Hz + Harmonics (heavy), 60 Hz + Harmonics Removal — варианты фильтров

подавления фоновой составляющей от сети 60 Гц и 5-и гармоник этой частоты
> DTMF Tones Removal — фильтр подавления спектральных составляющих на

стандартных частотах системы тонального набора номера телефона
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> Ice Cream Truck — фильтр, значительно (на 25 дБ) поднимающий уровень
спектральных составляющих с частотами 1000, 1333, 1500, 2000, 2666 Гц
и 3000 Гц

> Sihilance Softener (De-Ess) — вариант фильтра деэсера

Предпоследний из вариантов фильтров представляет особый интерес и нужда-
ется в пояснениях. По своему назначению каждый из элементов такого фильтра
напоминает контур ударного возбуждения, обладающий высокой добротностью.
При поступлении на такой контур короткого импульса или даже небольшого по
амплитуде колебания, частота которого совпадает с резонансной частотой конту-
ра, в нем возбуждаются долго незатухающие колебания большой амплитуды.

Сигнал, имеющий богатый спектр (например, речь человека), в результате об-
работки таким фильтром приобретает мелодический характер: появляется то за-
тухающий, то вновь возрождающийся призвук, напоминающий звучание аккорда
До мажор. В этом нет ничего удивительного, ибо частоты настройки элементов
фильтра, который в списке предустановок называется Ice Cream Truck, находятся
приблизительно в тех же соотношениях, что и частоты звуков до, ми, соль,

Рассматриваемое окно фильтра носит название Notch Filter, которое букваль-
но переводится как фильтр выреза. По смыслу названия фильтр должен только
подавлять определенные частоты. Но пресет Ice Cream Truck совершенно не ук-
ладывается в эту логику. Здесь не подавляются, а, наоборот, подчеркиваются оп-
ределенные частоты. Это привело нас к мысли, что Notch Filter обладает неоче-
видными свойствами, о которых ничего не сказано в руководстве пользователя.
После непродолжительных экспериментов с фильтром стало ясно, что характер
фильтра (ослабление или усиление частотных составляющих сигнала) зависит
от знака параметра, который вводится в полях Attenuation. Если ввести, напри-
мер, 25 дБ, тогда программа воспримет такой ввод, как: «Подавить частотную
составляющую на 25 дБ». Если ввести —25 дБ, это трактуется как подавление со-
ставляющей на —25 дБ, что эквивалентно указанию повысить уровень частот-
ной составляющей на 25 дБ.

Если вы сомневаетесь в возможности не подавлять, а усиливать с помощью
фильтра Notch Filter определенные спектральные составляющие, рекомендуем
провести следующий опыт. Загрузите любой записанный с микрофона аудиофайл.
Думается, что если в нем и будет слышен фон переменного тока с частотой 50 Гц,
то очень слабо. В списке пресетов выберите вариант 50 Hz + Harmonics (heavy), в
полях Attenuation поменяйте знаки (введите минусы) и обработайте аудиофайл.
Прослушав результат, вы убедитесь, что уровень фонового сигнала стал до безоб-
разия высоким.

Если взять в качестве обрабатываемого аудиофайла запись шума (как получить
шум, сказано в разд. 7.3), то с помощью фильтра Notch Filter можно синтезировать
звук с любым распределением пяти спектральных составляющих. Поскольку шум
является широкополосным процессом, в его спектре присутствуют составляющие с
любыми частотами (во всяком случае, в пределах от единиц герц до десятков кило-
герц), то всегда найдется частота, которую можно выделить фильтром Notch Filter.
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6.30. Parametric Equalizer,, —семиполосный
параметрический эквалайзер

Командой Effects > Filtres > Parametric Equalizer... открывается окно Parametric
Equalizer (рис. 6.81) — семиполосный параметрический эквалайзер, позволяющий
с высокой точностью задать практически любую форму АЧХ фильтра.

В верхней части окна по традиции отображается график АЧХ.
Регуляторы и поля ввода Low Shelf Cutoff и High Shelf Cutoff предназначены для

управления частотами среза низкочастотного и высокочастотного Shelf-фильтров,
а слайдеры, расположенные слева и справа от поля графика, — для регулировки
уровней усиления/ослабления сигнала этими фильтрами.

В группе Center Frequency сосредоточены 5 флажков для выбора фильтров и
пять слайдеров-регуляторов центральной частоты. Точное значение центральной
частоты отображается в поле, находящемся справа от слайдера.

В столбце Width находятся поля, в каждом из которых можно ввести новое зна-
чение добротности соответствующего фильтра, тем самым изменив ширину его
полосы пропускания.

Уровень усиления/ослабления сигнала каждым из этих фильтров регулируется со-
ответствующим слайдером. Эти слайдеры расположены в правой верхней части окна.

Parametric Equalizer
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Presets Added Dimension
High Boost with 16k notch
Highs Softener
Hum and Hiss Removal
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Рис. 6.81. Окно диалога Parametric Equalizer
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Если выбрана опция Constant Width, то при перестройке частоты фильтра его
полоса пропускания остается неизменной. Если выбрана опция Constant Q, то
сохраняется неизменной его добротность, т. е. при увеличении частоты настрой-
ки пропорционально будет расширяться и полоса пропускания.

Поле ввода Master Gain предназначено для изменения общего уровня усиления.
Рассмотрим содержимое списка Presets:

> 250 Hz Cut with Low End Shelf — ослабление сигнала на частоте 250 Гц и по-
нижение уровня низкочастотных составляющих

> Added Dimension — подчеркивание частот в окрестности 1 кГц при одновре-
менном понижении уровней низко- и высокочастотных составляющих спек-
тра сигнала

> High Boost with 16k notch —резкий подъем высоких частот, подавление час •
тоты 16 кГц

> Highs Softener — незначительное снижение уровней составляющих, распо
ложенных в окрестностях частот 1 и 8 кГц

> Hum and Hiss Removal — подавление составляющей на частоте 60 Гц, сниже-
ние уровня составляющих, расположенных выше 16 кГц

> Loudness — небольшой подъем низких и высоких частот
> Mackie High (Boost) — подъем высоких частот
> Mackie High (Cut) — завал высоких частот
> Mackie Low (Boost) — подъем низких частот
> Mackie Low (Cut) — завал низких частот
> Mackie Mid (Boost) — подъем средних частот
> Mackie Mid (Cut) — завал средних частот
> Old Time Radio — имитация звучания старого радиоприемника
> Remove 60 Hz plus odd harmonics — ослабление составляющей с частотой 60 Гц

и ее 5-й, 7-й и 9-й гармоник
> Reset to Zero (Flat) — сброс АЧХ в нейтральное состояние
> Resonant A's — выделение звуков ля большой, малой, первой, второй и тре-

тьей октав

Работать с регуляторами и другими элементами интерфейса окна очень удоб-
но, т. к. любые изменения параметров эквалайзера тут же отображаются на графи-
ке амплитудно-частотной характеристики.

6.31. Quick Filter... — 8-полосный графический
эквалайзер

С быстрым фильтром (Quick Filter) и в самом деле можно работать быстрее,
чем с любым из фильтров, рассмотренных выше. Плата за это — принципиальная
невозможность точной настройки его частотной характеристики, ведь быстрый
фильтр в Cool Edit Pro представляет собой восьмиполосный графический эква-
лайзер (рис. 6.82).



274

! Quick Filter

[Locked) (Locked) I

*

аэ О О О 1,7 59

d d :d d d d

J :86,-/17i::,344 -Ш'^Ж 2.9К 7.3k 22K

r-MasierGain-

Рис. 6.82. Окно Quick Filter

Достоинство этого фильтра — простота интерфейса, отсутствие «лишних» регу-
ляторов. Как и в остальные обработки и эффекты программы, в фильтр заложены
элементы интеллекта, т. е. при переходе кработе с аудиофайлом, имеющим другую
частоту дискретизации, изменяются частоты настройки (а для крайних сверху и снизу
регуляторов меняются частоты среза) всех элементарных фильтров.

Частота настройки указывается под соответствующим регулятором, а уровень
усиления/ослабления — над ним.

В текущей версии Cool Edit Pro есть более совершенный графический эква-
лайзер, вы уже познакомились с ним в разд. 6.27. Quick Filter был единственным
графическим эквалайзером в программе Cool Edit 96 [2]. Тем не менее, при всей
простоте и несовременности интерфейса, он кое в чем превосходит Graphic
Equalizer: для фильтра Quick Filter так же, как и для фильтра FFT Filter (разд. 6.26),
можно реализовать изменяющуюся во времени АЧХ. Для этого нужно задать вид
начальной и конечной АЧХ (начальные и конечные положения регуляторов эква-
лайзера). Флажок Lock to these settings only должен быть сброшен. Начальную АЧХ
задают, выбрав вкладку Initial Settings, а конечную — вкладку Final Settings.

При установленном флажке Lock to these settings only вид АЧХ не зависит or времени.
Регуляторами группы Master Gain устанавливают уровень общего усиления

сигналов после фильтрации. Традиционно с помощью флажка Lock L/R можно
связать друге другом регуляторы уровней левого и правого каналов.

В группе Presets можно выбрать предустановки, правда, их не так уж и много.
Видимо, этот фильтр разработчики не относят к числу перспективных и в новых
версиях программы список предустановок не расширяют. Их всего 5:

>
Bass Boost — подъем низких частот
Flat — установка регуляторов эквалайзера в нейтральное положение
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Loudness — подъем низких и высоких частот, завал сверхнизких частот
Old Time Radio — имитаиия звучания старого радиоприемника
Treble Boost — подъем высоких частот

6.32. Scientific Filters... — фильтры Бесселя,
Баттеворта, Чебышева

Командой Effects > Filtres > Scientific Filters... открывается окно Scientific Filters
(рис. 6.83).

В окне Scientific Filters собраны «теоретические» фильтры следующих классов:

> Фильтр Бесселя — вкладка JBessel (рис. 6.83)
> Фильтр Баттеворта — вкладка Butterworth (рис. 6.84)
> Фильтр Чебышева — вкладки Chebychev 1 (рис. 6.85) и Chebychev 2

Довольно подробные сведения о свойствах этих фильтров вы можете получить,
ознакомившись с материалами книг [8, 34]. Сейчас же речь пойдет о назначении
элементов интерфейса в окне Scientific Filters.

Вы видите два графика: один из них (желтый) — АЧХ фильтра, второй (крас-
ный) — либо фазочастотная характеристика (ФЧХ) (если выбран переключатель
Phase), либо зависимость задержки (запаздывания) сигнала в фильтре от частоты
(если выбран переключатель Delay).

ondsj
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Рис. 6.83. Вкладка
Bessel окна
Scientific Filters
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Рис. 6.85. Вкладка
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Scientific Filters

Под координатной плоскостью расположено поле, в котором отображаются
координаты курсора: частота, значение АЧХ и значение ФЧХ. Флажок Extended
Range служит для переключения отображаемого диапазона значений АЧХ. При
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сброшенном флажке пределы отображаемых значений АЧХ варьируются от —.54
до 12 дБ, при установленном флажке диапазон значений составляет -120—12 дБ.

Для каждого из четырех классов фильтров (Bessel, Butterworth, Chebychev I и
Chebychev 2) кнопками Low Pass, High Pass, Band Pass и Band Stop можно выбрать
тип фильтра:

> Low Pass — фильтр, пропускающий низкие частоты
> High Pass — фильтр, пропускающий высокие частоты
> Band Pass — полосовой пропускающий фильтр
> Band Stop — полосовой фильтр выреза (режекторный фильтр, фильтр-пробка)

Набор задаваемых параметров определяется классом и типом фильтра. Для филь-
тров Low Pass и High Pass можно задать только частоту среза (Cutoff). Адля фильтров
Band Pass и Band Stop этот параметр будет уже иметь смысл нижней частоты среза.
Для полосовых фильтров параметр High Cutoff— это верхняя частота среза.

Для всех классов фильтров, кроме Bessel, следует определить еще четыре параметра.

> Order — порядок фильтра
> Transition Bandwith — ширина полосы частот перехода (например, для поло-

сового пропускающего фильтра — от области подавления к области пропус-
кания). При выборе этого параметра порядок фильтра будет установлен ав-
томатически (и наоборот)

> High Width — ширина полосы частот верхнего перехода (например, для по-
лосового пропускающего фильтра — от области пропускания к области по-
давления). Этот параметр задается только для полосовых фильтров

> Stop Attn — ослабление спектральных составляющих в полосе подавления

Для фильтров Chebychev 1 и Chebychev 2 можно выбрать максимальное допус-
тимое значение неравномерности АЧХ в областях пропускания или подавления:
Pass Ripple и Actual Ripple.

В группе Master Gain можно задать общее усиление (отдельно для левого и пра-
вого каналов).

В списке Preset содержится 7 весьма поучительных схем предустановок:

> 60Hz Hum Notch Filter— фильтр Бесселя 2-го порядка, предназначенный
для подавления составляющей фона с частотой 60 Гц. От аналогичных по
назначению ранее рассмотренных фильтров он отличается тем, что практи ••
чески не влияет на соседние частотные составляющие

> Drop Off Bellow 250 Hz — фильтр Баттеворта 6-го порядка, обеспечивающий
подавление спектральных составляющих ниже 250 Гц

> Hiss Cut (above 10 kHz) — фильтр Чебышева 6-го порядка, обеспечивающий
подавление спектральных составляющих выше 10 кГц

> Leave the Bass (lOHz to 400 Hz) — фильтр Чебышева 2-го порядка, обеспечи
вающий подавление всех частот, кроме частот в полосе 10—400 Гц, харак-
терных для баса

> Notch around 1kHz by 6dB — фильтр Чебышева 7-го порядка, обеспечиваю-
щий вырез составляющих в ближайших окрестностях частоты 1 кГц
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> Remove Subsonic Rumble — фильтр Баттеворта 18-го порядка, обеспечиваю-
щий подавление инфразвуковых спектральных составляющих (ниже 27 Гц),

> Strictly I kHz — фильтр Баттеворта 40-го порядка, имеющий полосу про-
пускания, в точности равную 1 кГц

На примере фильтра Баттеворта 40-го порядка особенно заметно, насколько
неравномерна и сложна его фазочастотная характеристика. За счет усложнения
фильтра удается реализовать почти идеально прямоугольную АЧХ, и амплитуд-
ных искажений сигнала в полосе пропускания такого фильтра не будет совсем.
Однако фазы спектральных составляющих сигнала, попавших в полосу пропус-
кания такого фильтра, оказываются практически непредсказуемыми. Это обяза-
тельно повлияет даже на тембр монофонического аудиофайла, не говоря уж о
аудиофайле стереофоническом.

Мы закончили рассматривать имеющиеся в программе средства частотной
фильтрации сигналов. На очереди не менее интересная тема — шумоподавление —
подменю Noise Reduction, в которое входят следующие команды:

> Click/Pop Eliminator... — обнаружение и исправление щелчков и/или выпа-
дений отсчетов

> Clip Restoration... — устранение клиппирования
> Hiss Reduction... — спектральное пороговое шумоподавление
> Noise Reduction... — шумоподавление на основе анализа свойств образца

шума

6.33. Click/Pop Eliminator... — обнаружение и
исправление щелчков и/или выпадений
отсчетов

Каких только помех не встречается в записанных вами аудиофайлах! Перечис-
лим некоторые из них.

> Равномерный широкополосный почти белый шум (тепловой шум в цепях
звуковой карты, шум магнитной ленты, шум квантования, смесь наводок
от компонентов компьютера и внешних источников электромагнитного
излучения).

> Различные звуки заднего плана, проникающие в микрофон при записи,
которые, смешиваясь, превращаются в «окрашенный» шум.

> Хрипы, вызванные нелинейными искажениями при перегрузке АЦП.
> Щелчки, образовавшиеся из-за некорректного монтажа фрагментов волно-

вых форм в местах их стыка.
> Щелчки и выпадения отсчетов, обусловленные, в основном, ошибками в

считывании данных с дорожки диска.
> Щелчки, обусловленные царапинами на поверхности грампластинки.
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В программе Cool Edit Pro есть средства для борьбы со всеми перечисленными
помехами, но сейчас речь пойдет именно об инструменте автоматического поиска
и устранения щелчков и выпадений отсчетов: Click/Pop Eliminator.

Можно сказать, что выпадение отсчета — это «щелчок наоборот». На слух щел-
чки и выпадения отсчетов проявляются практически одинаково, т. е. как щелчки,
Для них характерно резкое отличие значений соседних отсчетов — скачки уровня
сигнала. Звук— волновой процесс, а, как известно, природа не терпит скачков,
особенно в волновых процессах. Скачки противоестественны. Контрастные пе-
репады уровня вы заметите на слух или даже «на глаз», рассматривая волновую
форму с высоким разрешением или анализируя ее текущий спектр (разд. 5.1). Од-
нако возникновение интенсивных щелчков или выпадений отсчетов маловероят-
но. Многие форматы хранения аудиоданных предполагают применение специ-
альных кодов, обнаруживающих и корректирующих определенное количество
ошибок. Структура этих кодов такова, что практически исключается возникнове -
ние существенных погрешностей при считывании данных. Погрешности, срав-
нимые с максимальным значением отсчетов оцифрованного звука, возникают
крайне редко, зато мелких ошибок — тьма-тьмушая. Устранять их вручную — со-
вершенно нетворческое занятие. Точно так же невозможно в ручном режиме визу-
ально обнаружить и устранить все щелчки, обусловленные царапинами на повер-
хности пластинки. Вот тут-то на помощь и приходит Click/Pop/Crackle Eliminator.

Окно Click/Pop Eliminator (рис. 6.86) открывается командой Click/Pop Eliminator...,
В этом окне имеется много элементов, и со всеми ними нам сейчас предстоит

разобраться.
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Рис. 6.86. Окно
Click/Pop
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В поле Detection прорисовываются графики распределения числа обнаружен-
ных (Detect) и устраненных (Reject) щелчков в зависимости от их уровня.

Кноп кой Auto Find АН Levels включают автоматический поиск щелков всех уров-
ней в соответствии с заданными параметрами: Sensitivity (Чувствительность) и
Discrimination (Различимость).

Кнопкой Find Threshold Levels Only включают автоматический поиск щелчков,
соответствующих пороговым уровням: максимальному (Max Threshold), среднему
(Avg Threshold) и минимальному (Min Threshold).

При установленном флажке Second Level Verification включается второй уро-
вень проверки, это позволяет избежать ошибочного признания щелчками неко-
торых «полезных» перепадов уровня сигнала.

Флажок Pulse Train Verification следует устанавливать в том случае, когда слиш-
ком часто происходит ошибочное выявление щелчков.

Если установлен флажок Link Channels, производится поиск щелчков в обоих
стереоканалах. Это увеличивает вероятность правильного обнаружения щелчков.

Установленный флажок Smooth Light Crackle позволяет уменьшить количество
однотипных ошибок. Флажок и поле ввода Detect Big Pops позволяют организо-
вать поиск и удаление длительных выбросов.

Если установлен флажок Multiple Passes, то включается режим многократной
повторной обработки. Количество проходов следует ввести в поле.

В группе Correction находятся перечисленные ниже поля ввода и опции.

> FFT Size — размер выборки при выполнении быстрого преобразования Фу-
рье. Число должно быть равно целой степени двойки. При установленном
флажке Auto размер выборки устанавливается программой автоматически.

> Pop Oversamples — расширение временного интервала обработки обнаружен-
ного щелчка.

> Run Size — несколько щелчков, расстояние между которыми меньше, чем указа-
но в этом поле ввода, обрабатываются программой как единственный щелчок.

> Fill Single Click Now — восстановление одиночных удаленных щелчков.

В безымянном поле, расположенном в нижней части окна, отображаются ре-
зультаты предварительной обработки, т. е. число скорректированных (Corrected)
и число подавленных (Rejected) щелчков.

В списке Presets содержатся предустановки, отличающиеся значениями пере-
численных выше параметров. Они позволяют очищать аудиофайлы, характеризу-
ющиеся различной насыщенностью щелчками и выпадениями отсчетов.

6.34. Clip Restoration... —устранение
клиппирования

Команда Clip Restoration... открывает одноименное окно (рис. 6.87).
Назначение этого окна — устранение клиппирования — поясним на примере.
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Clip Restoration
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Рис. 6.87, Окно Clip Restoration

На рис. 6.88 слева представлена волновая форма, записанная с нормальным каче
ством. Уровень записи был выбран таким, что ни один отсчет не достиг и, тем более,
не превысил максимально допустимого значения. Иными словами, в этой волно-
вой форме нет клиппированных отсчетов. Но не всегда удается верно подобрать
уровень записи, поэтому клиппированные отсчеты могут появиться в изобилии.

На рис. 6.88 справа представлена волновая форма, в котором клиппировано
большинство отсчетов. Правда, эта волновая форма получена не непосредствен-
но при записи звука, а путем копирования и усиления на 10 дБ отсчетов волновой
формы, представленной в левой части рисунка. Можно было бы записать какой-
либо другой аудиофайл, но тогда было бы труднее оценить эффективность рас-
сматриваемого средства устранения клиппирования. Итак, и слева, и справа —
один и тот же аудиофайл, но в правую волновую форму специально внесены иска-
жения. Сравним звучание. Пока воспроизводится левая волновая форма, мы слы-
шим приятный женский голос, когда звучит правая, раздается скрежет. Кажется.
что звук воспроизводится динамиком, у которого звуковая катушка деформиро-
вана и цепляется за магнит.

Рис. 6.88. Пример
волновой формы с
сильным клиппирова-
нием
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Можно попытаться уменьшить уровень искаженного сигнала, однако это не
поможет. Звук станет тише, а все искажения останутся.

В общем, аудиофайл следовало бы считать безнадежно испорченным, если бы
в Cool Edit Pro не было окна Clip Restoration. Выделив клиппированную волновую
форму и применив к ней это средство реставрации, мы получим приблизительно
то, что представлено справа на рис. 6.89 (слева показан все та же многострадаль-
ная исходная волновая форма).

Рис. 6,89. Результат
работы Clip
Restoration

Существенная часть огибающей клиппированной волновой формы представ-
ляет собой прямую линию (рис. 6.88), а огибающая обработанной волновой фор-
мы приобрела изгибы, стала напоминать огибающую исходной волновой формы.
Разумеется, при сравнении правой и левой волновых форм на рис. 6.89 заметны
различия. Да и звучание их отличается. Тембр женского голоса, конечно, изме-
нился, но голос вновь стал приятным, эффект заклинивающегося динамика ис-
чез. Слушать такой аудиофайл можно без отвращения и содрогания.

Мистика какая-то! Откуда Cool Edit Pro узнал, какова была форма огибающей? Ни
какой мистики, только сухая наука — интерполяция на основе статистических гипотез.

Все происходит примерно так. Сначала значения всех отсчетов волновой фор-
мы делятся на некое постоянное число, например, на 4, Тем самым обеспечивает-
ся возможность в дальнейшем увеличивать значения не всех, а уже отдельных от-
счетов. При этом преобразуется и порог клиппирования. Если раньше он
составлял, например, 100%, то после деления на 4 стал равен 25%.

Далее программа анализирует серии отсчетов, значение которых равно порогу
клиппирования. Допустим, обнаружено три подряд следующих таких отсчета.
Высказывается следующая гипотеза: вероятно, значения крайних отсчетов при
записи действительно были равны 25%, вероятно, что, если бы не произошло клип-
пирования, значение среднего отсчета было бы больше 25%.

Затем оценивается скорость изменения значений отсчетов слева и справа от
анализируемого клиппированного участка и на основе одного из известных алго-
ритмов интерполяции вычисляется значение этого самого среднего отсчета.

Данная процедура повторяется для каждой обнаруженной серии клиппирован-
ных отсчетов. В заключение аудиофайл нормализуется.
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Такая методика, безусловно, позволяет устранить клиппирование. Но ясно, что
реставрированный аудиофайл не будет точной копией того, который можно было
бы получить при правильном выборе режима записи.

Здесь предполагается наличие, по крайней мере, трех источников погрешностей:

> Гипотеза не обязательно отражает то, что происходило на самом деле. В на-
шем примере средний отсчет мог не превышать порог клиппирования, а быть
равен ему

> Скорость изменения значений отсчетов непостоянна
> В случае длинной серии клиппированных отсчетов характер изменения зна-

чений отсчетов, превышавших порог клиппирования, может быть любым.
Огибающая может монотонно возрастать и затем монотонно убывать, но ее
изменение может носить и колебательный характер

А теперь рассмотрим назначение опций окна Clip Restoration (рис. 6.87). Нач-
нем с полей ввода, перечисленных ниже.

> Input Attenutation — усиление сигнала перед обработкой. От этого парамет-
ра будет зависеть обшая громкость звучания аудиофайла после обработки.
По сути дела, в нем скрыта информация об уровне, к которому производит-
ся нормализация значений отсчетов аудиофайла. Чтобы сориентировать вас,
скажем, что в примере, представленном на рис. 6.89, значение Input
Attenutation выбрано равным —10 дБ.

> Overhead% — значение порога, при превышении которого сигнал считается
клиппированным. Например, если этот параметр равен 0, то клиппирован-
ными будут считаться только отсчеты, достигшие уровня 100%. Если пари-
метр Overhead^ равен 1%, то клиппированными будут считаться отсчеты,
достигшие уровня 99% от максимально возможного.

> Minimum Run Size — минимальное количество следующих подряд отсчетов,
достигших заданного порога, необходимое для того, чтобы считать текущий
фрагмент сигнала клиппированным.

> FFT Size — размер выборки при реализации быстрого преобразования Фу-
рье. Как всегда, чем больше выборка, тем точнее вычисления, и тем больше
времени требуется для них.

В группе Clipping Statistics для каждого из стереоканалов приводятся статистичес-
кие сведения: значение минимального отсчета (Min Sample), значение максимально-
го отсчета (Max Sample), и процент клиппированных отсчетов (Percent Clipped). Для
получения статистических сведений следует нажать кнопку Gather Statistics Now.

В списке Presets три строки:

> Restore Heavily Clipped — реставрация в значительной степени клиппирова--
ных волновых форм

> Restore Lightly Clipped — реставрация слегка клиппированных волновых форм.
> Restore Normal — обработка волновых форм, клиппирование которых на гла:!

незаметно. Такую обработку можно, на всякий случай, применять к любо
му аудиофайлу. Если клиппированных отсчетов в нем не было, то обработка
сведется к понижению уровня нормализации на 1%.
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6.35. Hiss Reduction... —спектральное пороговое
шумоподавление

В подменю Noise Reduction есть несколько команд, обеспечивающих примене-
ние различных средств шумоподавления. Некоторые из них универсальны, а неко-
торые узкоспециализированы. К последней категории и относится Hiss Reduction.
Научившись работать с этим окном, вы получите в свое распоряжение довольно
серьезное средство подавления специфического шума — шума магнитной ленты.

Окно Hiss Reduction (рис. 6.90) открывается командой Hiss Reduction....
Основную часть окна занимает координатное поле, на котором можно постро-

ить график амплитудно-частотной характеристики шумоподавителя. Это не со-
всем обычная АЧХ. Можно сказать, что это «АЧХ наоборот»: чем выше находится
какая-либо ее точка на координатном поле, тем сильнее ослабляется соответству-
ющая этой точке спектральная составляющая.

Если выбрана опция Viewing Left, то отображается график АЧХ левого канала,
если выбрана опция Viewing Right — правого. Создавая и перемещая узлы графи-
ка, можно редактировать график АЧХ.

В группе Reset имеются три кнопки, с помощью которых график АЧХ возвра-
щают в исходное состояние (превращают его в прямую линию). Тем самым задают
уровень подавления шума, одинаковый для всех частот;

> Hi — уровень подавления шума составляет -50 дБ (подходит для случая, когда
посторонний шум очень интенсивен)

> Med — уровень подавления шума составляет -70 дБ (для среднего по интен-
сивности постороннего шума)

> Low — уровень подавления шума составляет -90 дБ (для очень слабого по-
стороннего шума)

Hi*s Reduction
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Рис. 6,90. Окно Hiss Reduction
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Поочередно «ухватываясь» курсором мыши за оконечные узлы прямолинейно-
го графика, можно переместить график в вертикальном направлении, задав дру-
гой уровень подавления. Применяя Hiss Reduction с такой АЧХ подавления, вы
будете решать задачу шумоподавления «в лоб». Программа будет подавлять шум
на всех участках спектра звукового сигнала, вне зависимости от того, есть ли на
них шум.

Можно, конечно, сделать линию наклонной или вручную придать ей форму,
которая, по вашему мнению, соответствует спектру шума: на тех частотах, где шум
интенсивнее, график АЧХ фильтра подавления должен идти выше, там, где шум
менее интенсивен, — ниже. Но ваши представления о спектре шума могут не со-
ответствовать действительности. Тогда подавление шума не будет оптимальным:
на некоторых участках спектра шум окажется «недодавленным», зато на других
участках, где реальная спектральная плотность шума мала, напрасно пострадает
полезный звуковой сигнал.

В окне Hiss Reduction предусмотрен фантастически эффективный инструмент —
кнопка Get Noise Floor, включающая процедуру спектрального анализа образца
шума.

В начале ленты всегда бывает участок, содержащий только шум. Выделите та
кой участок реставрируемой фонограммы. Учтите, что чем протяженнее анализи
руемый фрагмент, тем точнее результат анализа.

В поле ввода drag points задайте количество узлов, которыми будет представлен
график, полученный в результате анализа образца шума.

Нажмите кнопку Get Noise Floor. Как обычно, появится прогресс-индикатор,
показывающий, что анализ идет нормально. Спустя небольшой период времени
на координатном поле прорисуется график амплитудно-частотной характеристи-
ки фильтра, которая соответствует огибающей спектра шума (рис. 6.91).

CjatHcaseFtogi | fU dragpomt! Reset 'Hi j ^Medj Loy<'j

J

Jjloise floor

'If. ,
Lovvw Пеки

Рис. 6.91. Пример реальной огибающей спектра шума магнитной ленты
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Если теперь выделить всю волновую форму, включая участки, содержащие толь-
ко шум, и участки, где имеется смесь полезного сигнала и шума, и применить Hiss
Reduction, то будет выполнено оптимальное подавление шума.

Выбрав режим детального просмотра волновой формы, вы можете убедиться,
что интенсивность шума уменьшилась. Если такое уменьшение оказалось недо-
статочным, воспользуйтесь регулятором Noise Floor Adjust или соответствующим
полем ввода. Эти элементы обеспечивают соответственно грубую и точную под-
стройку уровня подавления шума в пределах от —40 до 40 дБ. Разумеется, чтобы
увеличить степень подавления шума, нужно установить положительные значения
данного параметра. Когда вы проделаете все перечисленные операции, должен
получиться результат, подобный представленному на рис. 6.92.

Рис. 6.92. Пример фонограммы с подавленном шумом

Для большей убедительности в левой части оставлен участок волновой формы
с неподавленным шумом. Правее располагается то, что совсем недавно было шу-
мом, а еще правее — очищенный от шипящего призвука звуковой сигнал.

Чтобы удостовериться в том, что шум действительно подавлен, и проконтро-
лировать степень его подавления, можно опять выделить тот фрагмент волновой
формы, где раньше был только шум, открыть окно Hiss Reduction и вновь нажать
кнопку Get Noise Floor. Вы получите график огибающей спектра подавленного
шума (рис. 6.93).

Сравним полученный спектр с исходным спектром шума (см. рис. 6.91). В необра-
ботанном аудиофайле измеренный уровень шума находился в пределах от —80 до
-90 дБ. После обработки он не превышает—120 дБ. Ручаться за точность измере-
ния абсолютных значений этих уровней мы не беремся. Уровень шума ленты нео-
бработанного фрагмента на слух нами оценивался, как несколько более высокий,
чем тот, что показали измерения (см. рис. 6.91). Измеренное абсолютное значе-
ние уровня шума в значительной степени зависит от метода его измерения, в час-
тности, от того, к какой величине производится нормирование результатов изме-
рений. Но вот оценка относительного приращения качества, в данном случае,
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Рис. 6.93. Огибающая спектра подавленного шума

может считаться достоверной, т. к. оба графика (см. рис. 6.91 и рис. 6.93) получе-
ны одним и тем же методом. Таким образом, степень подавления шума в данном
примере составляет от 30 до 40 дБ.

Приведенный пример получен в процессе обработки реальной фонограммы,
представленной одним из участников нашей радиопередачи «Музыкальный ком-
пьютер». Технические требования, предъявляемые нами к качеству фонограмм,
таковы, что им удовлетворяют только записи в формате WAV или CD-DA. Записи
на кассетах мы принципиально не принимаем. Однако в данном случае, у автора с
самого начала не было возможности записать свою работу на CD, а сама компози-
ция оказалась очень интересной. Поэтому мы попытались ее отреставрировать.
С шумом, как вы видите, справиться удалось. Но от мысли воспроизвести эту му-
зыку в эфире все же пришлось отказаться из-за высокой детонации и неравно-
мерности уровня записи по причине неплотного прилегания ленты к магнитной
головке. С этими дефектами записи, конечно, в какой-то мере можно бороться,
однако нужно потратить слишком много времени. Не всегда игра стоит свеч.

Вернемся к окну Hiss Reduction. Работать с основными инструментами подав-
ления шума вы уже научились. Остались тонкости, способные, однако, повлиять
на качество конечного результата как в ту, так и в другую сторону.

В раскрывающемся списке FFT Size_points можно выбрать размер выборки при
реализации быстрого преобразования Фурье.

Precision Factor— это коэффициент, который определяет точность выполне-
ния расчетов в процессе уменьшения постороннего шума. Данный параметр ока-
зывает влияние на время затухания спектральных компонентов. Большие значе-
ния параметра дают лучшие результаты, но и увеличивают время обработки. При
малых значениях коэффициента точности вы можете получить несколько милли-
секунд постороннего шума перед громкими фрагментами звука и после них. Пред-
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почтительные значения параметра от 7 до 14. При коэффициенте точности более
20 дальнейшего улучшения качества практически не будет.

В поле Transition Width вводят параметр «диапазон перехода». Вместо того что-
бы понизить шум мгновенно, программа будет постепенно переходит]) от зашум-
ленного состояния к незашумленному. Это позволяет избежать изменений уров-
ня шума, заметных на слух. Кстати, полное отсутствие шума в паузах иногда
воспринимается человеком негативно, ибо это неестественно.

В поле Spectral Decay Rate вводят параметр «спектральная скорость затухания».
В аудиофайле отсчеты, в которых преобладает звук, всегда соседствуют с отсчета-
ми, содержащими шум, причем уровень звука в фазе затухания часто оказывается
сравним с уровнем шума. Правильный выбор значения параметра Spectral Decay
Rate (в диапазоне 40 - 75%) позволяет избежать и вырезания части полезного сиг-
нала, и «искусственного» характера звучания музыки, и противоестественно длин-
ных ре верберационных хвостов.

В поле Reduce Hiss by следует ввести величину ослабления тех шумовых компо-
нентов, которые не превышают уровень подавления шума, заданный в группе Reset.
При значении этого параметра порядка 3 дБ некоторые компоненты шума могут
оказаться неподавленными. При более высоких уровнях (особенно выше 20 дБ)
может быть получено существенное уменьшение постороннего шума, но не ис-
ключено искажение звука.

Если выбрана опция Remove Hiss, то будет удален шум, если выбрана опция
Keep Only Hiss, то именно шум и останется, а удаляется полезный сигнал. Для чего
может понадобиться последний режим? Подбирая параметры шумоподавителя,
обычно вы контролируете степень ослабления шума. Можно практически полно-
стью избавиться от шума, но при этом будет в значительной степени затронут и
сам полезный сигнал. Прослушивая обработанную фонограмму, легко убедиться
в отсутствии шума, а оценить, не поврежден ли сигнал, значительно труднее. Вот
здесь на помощь и приходит опция Keep Only Hiss. Включите ее, обработайте вол-
новую форму или ее фрагмент (главное — в ней должен быть не только шум, но и
полезный сигнал) и послушайте результат. Если ничего, кроме шума, не услыши-
те, значит, вы правильно подобрали значения параметры шумоподавителя. Отме-
няйте операцию, включайте опцию Remove Hiss и, не меняя значения параметров,
выполняйте окончательное шумоподавление.

Если не удалось найти наилучшее сочетание параметров, то после примене-
ния шумоподавления с включенной опцией Keep Only Hiss вы обязательно ус-
лышите, как сквозь шум пробиваются некие членораздельные звуки. Это озна-
чает, что при выбранных параметрах к шуму оказались причислены и некоторые
элементы полезного сигнала. Отмените операцию, выберите другие значения
параметров (например, передвиньте влево регулятор Noise Floor Adjust) и сде-
лайте еще одну пробу. Когда вы добьетесь исчезновения следов полезного сиг-
нала из выборки, можете прекращать эксперименты и приступать к настоящему
шумоподавлению.

Напомним, что рассмотренное средство снижения шума относится к специа-
лизированным. Прежде всего, оно ориентировано на снижение уровня квазибе-
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лого шума, подобного шуму магнитной ленты. В следующем разделе мы рассмот-
рим еще один, на этот раз универсальный, шумоподавитель.

6*36. Noise Reduction... — шумоподавление на
основе анализа свойств образца шума

Команда Noise Reduction... меню Effects выполняет одну из самых замечатель-
ных функций. Когда вы научитесь пользоваться этим простым и в то же время
мощнейшим инструментом, то, возможно, вас посетит чувство уверенности в не-
победимости полезного сигнала шумом. Какой бы зашумленной ни была запись,
с Cool Edit Pro не страшен никакой шум. Может показаться, что Cool Edit Pro уме-
ет подавлять шум без ущерба качества полезного сигнала, не искажая его спектра.
Конечно же, это не так. Автор Cool Edit Pro — не только программист, но и заме-
чательный специалист в области технологий обработки звука. Ему удалось создать
эффективную технологию шумоподавления с учетом психоакустических особен-
ностей слухового аппарата человека. Искажения при шумоподавлении, конечно
же, есть, но они находятся в разумных пределах, т. е. когда человек их не замечает.

Окно диалога Noise Reduction показано на рис. 6.94.
Для шумоподавления нужно иметь хотя бы немного информации о шуме. Чем

больше его статистических свойств известно, тем эффективнее подавление. От-
куда взять эту информацию? Функция Noise Reduction чем-то напоминает сыск-

Noise Reduction

Noise Profile. [гш$1 Load от Set proffe firs!) ' ~ -View: (? i ?:'• , ~C

LoarfPfofte

gel' Prrfte & am S election

yi profile J3QO

Мяе

f \У Live Update Flai

Nose Reducten Lsvef - ;

li
Low. : ; ' • - -";•'. '.;• ••:•

- Noise Reduction SeUtngs--

FFT Size J4036 _^j poinls
"П . . . . _.~ . : '

'• ̂ 'flefrrav^NoiSs '

Г" Ksap Onto Hoise

High

Reduce by MO

Рис. 6.94. Окно
диалога Noise
Reduction

ШЗак. 1152



29О Глава 6

ную собаку, которой нужен образен запаха. Cool Edit Pro нужен образец шума.
Прежде чем вызывать окно шумоподавления, вернитесь в главное окно програм-
мы и выделите фрагмент волновой формы без полезной информации, но содер-
жащий характерный для этой волновой формы шум (шипение микрофона, фоно-
вые звуки и т. п.). Желательно, чтобы этот фрагмент был подлиннее и программа
получила побольше информации о шуме. Программа будет считать, что тот фраг-
мент, который вы ей показали, содержит только шум. Теперь вызывайте окно Noise
Reduction. Нажмите кнопку Get Noise Profile from Selection. Произойдет сбор ин-
формации о шуме, которая отобразится в верхнем координатном поле (рис. 6.95).
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В принципе, здесь представлена знакомая вам по предыдущему разделу амп-
литудно-частотная характеристика подавления, которая совпадает со спектром
проанализированного фрагмента волновой формы. По горизонтальной оси отло-
жена частота, а по вертикальной — величина спектральных составляющих. При
реализации обработки порог шумоподавления будет непосредственно зависеть от
значения АЧХ. Правда, на этом координатном поле вы можете разглядеть целых
три графика:

> Верхний (красный) — амплитудно-частотная характеристика фильтра, ко-
торая соответствует максимальному порогу шумоподавления

> Нижний (зеленый) график — АЧХ фильтра, которая соответствует мини-
мальному порогу шумоподавления (эти графики программа формирует ав-
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тематически после сбора информации о волновой форме, изменить их вы
не можете)

> Средний (желтый) график— АЧХ фильтра, соответствующая реально ус-
тановленному вами уровню шумоподавления

Величина последнего параметра регулируется движком Noise Reduction Level
или вводится (в процентах) в расположенном рядом с ним поле. Поиграйте этим
движком, и вы увидите, как в левом его положении желтый график сливается с
зеленым, в правом — с красным. В промежуточном положении движка желтый
график имеет собственную форму.

При малом значении параметра Noise Reduction Level в спектр полезного сиг-
нала практически не вносится никаких изменений, а шум может подавляться на
десятки децибел. Однако не всегда складывается такая шумовая обстановка, мо-
жет потребоваться и глубокое шумоподавление. При этом спектр сигнала, скорее
всего, исказится, возникнут режущие слух эффекты. Мы пользуемся рассматри-
ваемым шумоподавителем для обработки вокальных партий своих композиций,
записанных далеко не в студийных условиях. Кроме того, с его помощью мы обра-
батываем дикторский текст и записи интервью с участниками передачи «Музы-
кальный компьютер». Как правило, при значении параметра Noise Reduction Level,
равном 60%, внешний записанный шум оказывается пониженным до уровня, хотя
и несравнимого с уровнем собственных шумов звуковой карты, шума квантова-
ния и шума дитеринга, но такого, что при средней громкости воспроизведения
шум в паузах не слышен. Если выбрать порог подавления более высоким, то даль-
нейшего улучшения субъективного ощущения тишины в паузах не будет, зато в
полезном сигнале появятся искажения в виде металлического призвука.

Итак, желтый график — это зависимость реального порога шумоподавления
от частоты. Вы в состоянии не только влиять на общий его уровень (с помощью
движка Noise Reduction Level), но и корректировать этот уровень для отдельных
частотных областей. Этой цели служит нижнее координатное поле. Для коррек-
ции зависимости уровня подавления от частоты можно воспользоваться имею-
щимся там графиком. Как обычно, мышью можно создать на нем узлы. Переме-
щая их по координатному полю, вы придадите графику любую желаемую форму.
Все ваши манипуляции с этим графиком незамедлительно будут изменять форму
желтого графика в верхнем координатном поле. Таким образом, в вашем распоря-
жении есть средство для корректировки той характеристики, которую программа
сформировала автоматически. Это может пригодиться в сложных случаях, когда
не удается осуществить глубокое автоматическое подавление шума во всей полосе
частот при сохранении высокого качества полезного сигнала и приходится искать
приемлемые компромиссы.

Характеристики шума можно сохранить в файле, воспользовавшись кнопкой
Save Profile. Теперь, если в будущем вы захотите очистить от шума аудиофайл, за-
писанный в той же шумовой обстановке, что и нынешний, достаточно нажать
кнопку Load Profile и загрузить соответствующий файл.

Однако мы не рекомендуем этим увлекаться, поскольку шумовые характерис-
тики помещения, где проводятся сеансы записи, можно считать стационарными
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только в случае хорошей звукоизоляции. Для домашних студий это нехарактерно.
Как ни увешивай стены и мебель коврами, одеялами, покрывалами, все равно
настоящую звукоизоляцию не создать. Во время одного сеанса записи под окном
долго прогревалась машина, во время другого — дальний сосед сверху сверлил сте-
ны. Это и есть нестационарные составляющие внешних шумов. Прелесть Noise
Reduction заключается в том, что это средство, в отличие от шумоподавителя, рас-
смотренного в разд. 6.35, способно устранять не только истинно шумовые поме-
хи, но и регулярные фоновые мешающие сигналы, стационарные в период време-
ни обработки волновой формы или ее фрагмента. Т. е. если двигатель автомобиля
тихо тарахтел на всем протяжении сеанса записи, то впоследствии этот звук мо-
жет быть удален практически полностью. Но если вы попытаетесь воспользовать-
ся образцом этого шума для обработки аудиофайла, записанного в том сеансе, когда
работала электродрель, это не только не избавит аудиофайл от ее звука, но и иска-
зит фонограмму, потому что программа будет удалять из нее несуществующий звук
двигателя автомобиля.

Для создаваемых файлов с данными о шуме можно задать количество выборок
(Number of Statistical Snapshots in Profile).

С принципиально важными элементами окна Noise Reduction мы разобрались.
Осталось рассмотреть еше несколько полезных опций.

Если установлен флажок Log Scale, то по оси частот выбирается логарифми-
ческая шкала. Вы уже знаете, что это позволяет разглядывать во всех подробнос-
тях низкочастотную часть спектра. При сброшенном флажке — шкала линейная,
больше пригодная для анализа высокочастотной области спектра.

Установленный флажок Live Update включает режим модификации АЧХ в ре-
альном времени. Это означает всего лишь то, что АЧХ будет изменяться непре-
рывно по мере перемещения узлов графика уровня подавления. В противном слу-
чае изменения в графике, расположенном в верхнем координатном поле,
произойдут лишь после того, как вы, переместив узел графика, находящегося в
нижнем координатном поле, отпустите кнопку мыши.

Нажатием кнопки Flat, как обычно, графику уровня подавления возвращается
его исходный вид: он превращается в отрезок прямой линии.

Правее кнопки Flat расположена область, в которой отображаются координа-
ты курсора мыши (частота и уровень в процентах), если курсор находится в преде-
лах нижнего координатного поля.

Группа Noise Reduction Settings содержит настройки самой процедуры шумопо-
давления. Со списком FTT Size вы уже знакомы. Он содержит объемы выборок
для выполнения операции БПФ, используемой при шумоподавлении. Чем боль-
ше параметр, выбранный из списка, тем лучше будет производиться обработка
звука и тем больше времени она займет.

С переключателями Remove Noise (Убрать шум) и Keep Only Noise (Убрать
полезный сигнал и оставить только шум) вы также познакомились в разд. 6.35.
Мы подробно рассказали о том, как использовать эти переключатели для того,
чтобы выяснить, не вырезали ли вы вместе с шумом и немножко полезного
сигнала.
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В поле Precision Factor вводится коэффициент, влияющий на точность расчета.
Чем больше коэффициент, тем лучше. Однако при увеличении значения этою
параметра свыше 10 заметного улучшения качества звука не происходит, а время
затрачивается значительно больше.

О поле ввода Transition Width мы рассказали в разд. 6.35.
С параметром Smoothing Amount связана степень сглаживания (осреднения)

АЧХ. Для помех с большой дисперсией (подобных белому шуму) можно оставить
в этом поле число 1 — значение по умолчанию. Для помех с регулярной структ}-
рой (подобных фону с частотой 50 Гц) следует попытаться увеличить значение
Smoothing Amount. Это может способствовать более полному подавлению регуляр-
ной помехи ценой некоторого повышения уровня шума. Более детальные реко-
мендации о предпочтительном значении этого параметра дать трудно. Стоит по-
экспериментировать, подбирая его, в том случае, если результаты шумоподавления
вас не вполне устраивают.

На этом мы завершаем описание команд подменю Noise Reduction и переходим
к следующей строчке меню Effects, а именно к подменю Special, в котором собра-
ны интересные специальные эффекты;

> Brainwave Synchronizer... — синхронизация пульсаций звучания аудиофайла
с ритмами головного мозга

> Convolution... — свертка
> Distortion... — дистошн (обогащение тембра за счет ограничения амшшту

ды); не вполне ясно, почему эта довольно распространенная особенно ере
ди гитаристов обработка попала в разряд специальных эффектов

> Music — исполнение мелодии (изменение высоты звучания любого предва
рительно записанного аудиофайла)

6.37. Brainwave Synchronizer.,. — синхронизация
пульсаций звучания аудиофайла с ритмами
головного мозга

Окно диалога, предназначенное для управления специальным эффектом
Brainwave Synchronizer, изображено на рис. 6.96. Оно открывается командой Effects
> Special > Brainwave Synchronizer. По утверждению разработчика программы, с
помощью этой функции можно, воздействуя на подсознание человека, ввести его
в состояние, похожее на медитацию. Для этого рекомендуется продолжительное
время прослушивать обработанный стереозвук через головные телефоны. Особен-
но сильный эффект разработчик обешает в том случае, когда в обрабатываемом
аудиофайле содержится широкополосный шум с равномерным спектром, а не хо-
рошо запоминающаяся мелодия. Впрочем, в широкополосном шуме и без всяких
спецэффектов каждый из нас может много чего услышать. Не случайно шум дож-
дя или морского прибоя способен вдохновить на прекрасные стихи и неповтори-
мые мелодии.
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Рис. 6.96. Окно
специального
эффекта Brainwave
Synchronizer

Так и хочется назвать этот эффект«о-о-очень специальным». Мы не раз пыта-
лись медитировать под звук, синхронизированный с ритмами головного мозга.
Но, признаемся честно, у нас не вышло. Возможно, получится у вас?

С помощью графика вы можете определить изменение свойств модулирующе-
го сигнала при воспроизведении аудиофайла. Но вначале нужно задать нижний
(Low Settings) и верхний пределы (High Settings) этих изменений.

Используя движки Frequency, можно задавать частоты волн активности мозга.
Самые нижние частоты — Delta (1-3 Гц) — соответствуют состоянию глубокого
сна, самые высокие (поддерживаемые программой) — Betta (больше 13 Гц) — со-
ответствуют состоянию стресса. Как пошутил сам разработчик программы, в прин-
ципе, бывают и более высокие частоты (Gamma), но он точно не знает, к чему при-
ведет их применение.

Движками Intensity регулируют интенсивность (глубину) модуляции. От поло-
жения движков Centering зависит кажущееся положение источника сверхнизко-
частотных пульсаций на стереопанораме. Существует предположение о том, что
таким путем можно избирательно воздействовать на левое или правое полушария
мозга, которые, считается, отвечают за разные составляющие личности человека.
Одно руководит эмоциональной сферой, другое — рациональной. Так что устано-
вите эти движки сначала в одно крайнее положение и пишите лучшую компью-
терную музыку всех времен и народов, а потом переместите их в другое крайнее
положение и приступайте к поиску покупателя для нее.

Вот и весь минимальный багаж знаний, необходимый для проведения экспе-
риментов над своей психикой.
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6.38. Convolution.,. — свертка двух сигналов
Командой Convolution... открывается окно эффекта Digital Convolution

(рис. 6.97).
В этом окне реализован специальный эффект, который назван разработчиком

программы Digital Convolution (Цифровая свертка). Свертка хорошо знакома спе-
циалистам в области обработки сигналов, математикам, радиоинженерам. Види-
мо, наступило время, когда и музыканты должны научиться выговаривать этот
термин, а главное — понимать и применять,

Что же представляет собой свертка? Прежде всего, это операция, выполняемая
над парой сигналов. В результате нее формируется третий сигнал — свертка двух
исходных. Первый отсчет свертки получают следующим образом: для каждого
момента времени (на интервале существования сигналов) отсчет одного сигнала
умножают на отсчет второго сигнала, результаты умножений складывают. Чтобы
получить второй отсчет, один из сигналов предварительно сдвигают на время, рав-
ное интервалу между отсчетами, затем опять следует серия перемножений и сум-
мирование. Остальные отсчеты свертки получают аналогичным образом: сдвиг,
перемножения, суммирование, сдвиг, перемножения, суммирование и т. п.

Результат в значительной степени зависит от того, насколько похожи или, на-
против, различны свертываемые сигналы (говорят: насколько они коррелированны).
Угадать заранее, как будет выглядеть свертка двух разных сигналов, в общем слу-
чае невозможно. Но для ряда сигналов известна их автокорреляционная функ-
ция, т. е. свертка самого сигнала и его сдвигающейся во времени копии. Если, на-
пример, свертывается реализация шума с ней же, то свертка будет выглядеть,
практически, как один пик — большой по величине и короткий по продолжител ь-

[Digital Convolution
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Рис. 6.97. Окно специального эффекта Digital Convolution
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ности. Если свертывается синусоидальный сигнал (чистый тон) с ним же, в ре-
зультате получится тоже синусоидальный сигнал. Если свертывается прямоуголь-
ный импульс с ним же, то получится импульс треугольной формы. Если свертыва-
ется конечный отрезок синусоидального сигнала (радиоимпульс) с ним же, то
получится сигнал с синусоидальным заполнением и огибающей, которая имеет
треугольную форму.

Все это бесспорные научные истины, и нужно отметить, что рассматриваемое
окно не только может служить средством получения специфических звуковых
эффектов, но и быть удобным инструментом исследования корреляционных
свойств сигналов.

Чтобы наглядно продемонстрировать вам действие Digital Convolution, свернем
радиоимпульс, имеющий синусоидальное заполнение, с его копией. Исходный
сигнал представлен на рис. 6.98 вверху.

На рис. 6.98 внизу представлен сигнал, получившийся в результате свертки.
Видно, что:

> У сигнала-свертки имеется синусоидальное заполнение с той же частотой,
что и у исходного сигнала

> Огибающая свертки имеет треугольную форму
> Длительность полученного импульса в два раза больше длительности ис-

ходного сигнала

Эта иллюстрация также подтверждает корректность выполнения Cool Edit Pro
операции свертки, т. к. полученный результат тождественен теоретически ожида-
емому. Естественно, тембры исходного и преобразованного сигналов различны.

Вообще говоря, в теории радиотехнических цепей для расчета отклика неко-
торой цепи на поступающий сигнал используют импульсную характеристику
цепи. Сигнал на выходе цепи получают путем свертки импульсной характерис-
тики с входным сигналом. Но при описании Digital Convolution вместо термина
импульсная характеристика разработчик программы широко использует термин
импульс, понимая под ним те данные, с которыми поочередно перемножается
каждая выборка в аудиофайле при выполнении операции свертки. Лишь в част-
ном случае импульс действительно здесь может быть импульсной характеристи-
кой. Таким образом, в Cool Edit Pro импульс — это, в конечном счете, просто

Рис. 6.98. Исходный сигнал и
его свертка
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аудиофайл. Как правило, импульсом будет служить не тот аудиофайл, который вы
обрабатываете. Хотя в предельном случае импульс может быть копией обрабатыва-
емого аудиофайла.

Можно сказать, импульсы отличаются от аудиофайлов только тем, что хранят-
ся в файлах с расширением IMP. С программой поставляется несколько таких
файлов (они находятся в папке COOLPRO/IMPS). Сверткой сигнала с импульса-
ми, хранящимися в них, можно получить различные варианты звучания.

Чтобы загрузить импульс в эффект, нажмите кнопку Load. Откроется стандарт-
ное окно диалога, настроенное на загрузку файлов с расширением IMP. Найдите
необходимый файл и нажмите кнопку Open (Открыть). Изображение импульса
появится в поле окна Digital Convolution (рис. 6,99).

Digital Convolution

Create Custom Impulse

i [LoadC] Save... I Ctea | ^ Mono I 30373-point МоТю IrrpdsetoadecT
"" Stereo . jlmpuJse File: C: \Ptogram fUesVcoolproS'jmpsMjoingy. imp

Add to Impulse

Add Sd. »Scaled byl/

Sandpassed Echoes i

Minimum (0 Hz i Add Echo»

Maximum|22Q50 Hz

• FIB Size [T28"

(use delay >

Globed Settings

Тшо" Shift fo ms

Рис. 6.99. Окно специального эффекта Digital Convolution с загруженным импульсом

Как уже говорилось, вместе с программой поставляется несколько файлов, каж-
дый из которых содержит импульс. Эти файлы, в основном, могут пригодиться
для иллюстрации возможностей Digital Convolution и при обучении работе с им-
пульсами. Для того чтобы получить действительно оригинальные результаты, сле-
дует накапливать коллекцию импульсов либо отыскивая их среди имеющихся у
вас аудиофайлов, либо выполняя их запись с микрофона.

Располагая соответствующими импульсами, можно смоделировать акустичес-
кие свойства любого реального помещения. Например, если имеется импульс,
записанный в вашем любимом концертном зале, и вы произведете свертку с ним
любого монофонического аудиофайла (сигналы левого и правого каналов долж-
ны быть сформированы одинаковыми), в результате создастся впечатление, будто
звук действительно был воспроизведен в этом зале.
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Правда, технология получения «импульса зала» довольно трудоемка. Вы долж-
ны расположить источник звука (акустическую систему) в какой-нибудь точке
сцены, а ненаправленный стереомикрофон в зрительном зале. Микрофон должен
быть поднят над полом на ту высоту, на которой обычно находятся уши зрителя.
Звук, который генерируется источником, не должен иметь тональной окраски.
Лучше, если это действительно будет очень короткий импульс (щелчок). Звук,
принятый микрофоном, нужно записать. Полученный аудиофайл следует исполь-
зовать как импульс при выполнении свертки. И свертка с этим импульсом моно-
фонического аудиофайла будет звучать так, как будто слушатель находится в точ-
ке размещения записывающей аппаратуры, а звук раздается из определенной точки
на сцене. Реверберационные свойства зала будут автоматически учтены.

Как самому создать импульс на основе имеющегося аудиофайла? Сначала в
главном окне нужно выделить требуемую часть волновой формы. Аудиофайл мо-
жет быть как монофоническим, так и стереофоническим. Последующая работа
проводится в окне Digital Convolution. Сначала необходимо нажать кнопку Add Sel.
Она доступна только в том случае, когда выделен короткий фрагмент волновой
формы, который по сравнению со всей волновой формой действительно кажется
импульсом. В координатном поле появится изображение выделенного фрагмента
волновой формы. Теперь он стал заготовкой импульса.

Обратите внимание на опции Mono и Stereo. Если исходный аудиофайл моно-
фонический и выбрана опция Mono, тогда импульс будет монофоническим. Из
стереофонического аудиофайла при выборе опции Stereo получится стереоим-
пульс. Это, наверное, интуитивно понятно. Сложнее обстоит дело в двух других
случаях. Если для монофонического аудиофайла выбрать опцию Stereo, получат-
ся два совпадающих импульса (для левого и правого канала). Фактический фор-
мат такого импульса — двухканальное моно.

Если для стереофонического аудиофайла выбрать опцию Mono, в результате по-
лучится монофонический импульс. Преобразование формата импульса необратимо.

Опции View Left, View Right и View Both доступны только в случае, если выбран
формат Stereo. Они управляют режимом отображения импульса:

> View Left — отображать импульс левого канала (синий цвет)
> View Right — отображать импульс правого канала (красный цвет)
> View Both — отображать импульсы обоих каналов

Нажав кнопку Save, вы откроете стандартное окно, настроенное на сохранение
файла с расширением IMP. Дайте имя файлу, содержащему импульс, и сохраните его.

Кнопка Clear служит для удаления импульса из окна Digital Convolution. При
этом очищается и координатное поле.

Импульс можно загрузить из файла с расширением IMP, можно получить его
как выделенный фрагмент волновой формы, но возможна также комбинация этих
двух способов. Т.е. к загруженному из файла импульсу можно подмешать отсчеты
аудиофайла. В поле Scaled by/1 показан знаменатель весового коэффициента, с
которым отсчеты аудиофайла будут подмешаны в импульс. По умолчанию уста-
навливается автоматически рассчитанное программой оптимальное значение этого



Меню EFFECTS — преобразование звука 299

коэффициента. При необходимости вы в состоянии самостоятельно ввести дру-
гое его значение.

Нажав кнопку Add Echo», вы переведете координатное поле в режим отобра-
жения структуры эха. При этом в алгоритм получения свертки будет добавлена
операция формирования задержанных копий сигналов правого и левого каналов.
В поле Delay_(ms) следует ввести величину задержки (в миллисекундах), а в полях
Left_(%) и Right_(%) — уровни задержанных сигналов (в процентах) соответственно
левого и правого каналов. График на рис. 6.100 соответствует задержке в 200 мс

Чтобы сформировать несколько копий сигналов с различными параметрами,
например, задержанных на различное время, нужно многократно ввести эти па-
раметры в полях Delay_(ms), Left_(%) и Right_(%). Ввод параметров в алгоритм об-
работки следует завершать нажатием кнопки Add Echo».

Формирование структуры задержки возможно лишь в том случае, если предва-
рительно был загружен импульс.

В группе Bandpassed Echoes сосредоточены поля ввода, определяющие пара-
метры фильтра, который формирует частотные свойства задержанного сигнала:

> MinimuinJHz — нижняя частота среза фильтра
> Maximum_Hz — верхняя частота среза фильтра
> FIR Size — размер временного окна фильтра

Ниже поля FIR Size отображаются автоматически вычисленные программой
допустимые значения задержки

В группе Global Settings содержатся следующие поля ввода:

Digital Convolution
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! Volume |100

Preview

Sealedt?1/9Q3

Bandpessed Echoes

f* View Lett
-Г View Right
f? View Both

Рис. 6.100. Окно специального эффекта Digital Convolution. Режим отображения структуры эха
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> Volurae_% — коэффициент усиления, определяющий общий уровень гром-
кости полученного сигнала (свертки)

> Shift — исходное смещение начала импульса относительно начала выделен-
ного фрагмента волновой формы

Если установлен флажок Normalized View, то вертикальный размер изображе-
ния импульса нормализуется таким образом, чтобы была задействована макси-
мально возможная площадь координатного поля, т. е. чтобы все изображение им-
пульса умещалось в нем, и были бы различимы детали изображения.

6.39* Distortion.,. — ограничение амплитуды
Следующий специальный эффект — Distortion (дистошн). Он основан на пред-

намеренном внесении в сигнал искажений, причем очень сильных. Чаще всего
этот эффект используется при обработке звучания электрогитары. Окно эффекта
представлено на рис. 6.101.

Характер искажений вы определяете сами с помощью графика. По горизон-
тальной оси откладывается уровень исходного сигнала в децибелах (его мгновен-
ное значение или, говоря иначе, значение очередного звукового отсчета, выра-
женное в децибелах). По вертикальной оси — новый уровень сигнала (новое
значение отсчета). Операция напоминает компрессию, но, в отличие от нее, вы

Positive j Negative'

Г" 'Symmetric

Spline Curves

Presets Add j .Del j j
high-level cut
hump 1
hump 2
Light Grunge
low-lev el cut
Maximum Jam!
mid-level boost
mid-level expansion 3
mid-level expansion 4
Hondo Messed Up
obliteration 2 a
Shatp Риггзг
Super Loud!

Рис. 6.101. Окно специального эффекта Distortion
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можете определить различные способы искажения как положительных значений
сигнала, так и отрицательных.

По умолчанию искажение задается симметрично для звуковых отсчетом раз-
ной полярности: включена опция Symmetric. Если эта опция отключена, при по-
мощи вкладок Positive и Negative можно выбрать и отредактировать два графика;
для положительных и отрицательных значений сигнала.

В списке Presets содержится много оригинальных схем настроек. Словами ре-
зультаты их применения не описать. Послушайте сами, сравните слуховые ощу-
щения с графическим представлением алгоритма обработки, это поможет вам со-
риентироваться. На рис. 6.101. показы график, соответствующий пресету1ЬЪе Drive.
Это приятный эффект, имитирующий мягкое ограничение амплитуды сигнала,
характерное для ламповых усилителей.

6.40* Music — исполнение мелодии
Возможность превращения практически любого звука в музыкальный — как

бы вам это понравилось? Допустим, вы совершенно не умеете петь, и у вас нет ни
слуха, ни голоса, но известна мелодия (имеются ноты). Попробуйте напеть, как
получится, запишите свой голосе помощью звуковой карты и, воспользовавшись
специальной программой обработки, прослушайте результат: какой-то певец поет
песню. Хорошо поет, не то, что вы... Как ни странно, этот певец поет вашим голо-
сом, нотолько... невероятно правильно. Даже не какой-то певец, авы сами поете,
хотя раньше вам это никогда не удавалось! И это не фантастика. Это реальные
компьютерные технологии XXI века.

Итак, специальная функция программы Cool Edit Pro — Music. Окно диалога
Making Music (рис. 6.102) позволяет, используя выделенный фрагмент волновой
формы, создать мелодию на его основе.

Делается это довольно просто. При помощи мыши берете символы нот или пауз
и помещаете их на нотные линейки.

£OrstarrCOuratkm

Рис. 6.102. Создание
мелодии на основе
фрагмента волновой формы



ЗО2 Глава g

Перед тем как приступить к записи мелодии нотами, следует выбрать тональ-
ность (раскрывающийся список Key). В начале нотоносца появятся соответству-
ющие ей ключевые знаки.

Записанную мелодию можно транспонировать на целое число октав вверх или
вниз (диапазон транспонирования составляет +/- 3 октавы). Для этого предус-
мотрен раскрывающийся список Octave. Выбор символа С в нем означает отсут-
ствие транспонирования.

Если потребуется записать аккорд, сначала выберите его тип в раскрывающемся
списке группы Chord Type, а переключателями задайте количество нот в аккорде (2 —
интервал, 3 — трезвучие, 4 — аккорд, состоящий из четырех нот с удвоением основного
тона). Предусмотрено формирование следующих интервалов и аккордов (рис. 6.103):

> maj 0-4-7 — для двух нот интервал большая терция, для трех нот мажорное
трезвучие (С, если строить аккорд от ноты до)

> maj 0-3-8 — для двух нот интервал малая терция, для трех нот минорное трез-
вучие с повышенной па полтона квинтой (Ст*5, если строить аккорд от ноты до)

> maj 0-5-9 — для двух нот интервал чистая кварта, для трех нот мажорное
трезвучие 4-й ступени (F, если строить аккорд от ноты до)

> min 0-3-7 — для двух нот интервал малая терция, для трех нот минорное трез-
вучие (Ст, если строить аккорд от ноты до)

> min 0-4-9 — для двух нот интервал большая терция, для трех нот аккорд С69,
если строить его от ноты до

> min 0-5-8 — для двух нот интервал чистая кварта, для трех нот аккорд Fm,
если строить его от ноты до

> 3 rd 0-3-9 — для двух нот интервал малая терция, для трех нот аккорд Ст6,
если строить его от ноты до

> 3 rd 0-6-9 — для двух нот интервал уменьшенная квинта, для трех нот аккорд
Ат6, если строить его от ноты до

> 3 rd 0-3-6 — для двух нот интервал малая терция, для трех нот аккорд Ebm6,
если строить его от ноты до

> ?? 0-4-8 — для двух нот интервал большая терция, для трех нот неклассифи-
цируемый аккорд, в котором между примой и терцией 4 полутона, а между
примой и квинтой 8 полутонов

> ?? 0-7-10 — для двух нот интервал чистая квинта, для трех нот неклассифи-
цируемый аккорд, в котором между примой и терцией 7 полутонов, а между
примой и квинтой 10 полутонов

Запись аккорда производится в два этапа. Сначала нужно перенести на нот-
ный стан отдельную ноту (от нее строится аккорд), и только после этого — символ
аккорда, взяв там же, где все остальные символы нотного письма.

Символ ноты или аккорда мышью можно перемещать по нотному стану в верти-
кальном направлении, при этом будет меняться высота отдельного звука или звуков,
составляющих аккорд, а знаки альтерации в необходимых случаях будут формировать-
ся программой автоматически в соответствии с интервалами между нотами аккорда.
Эти интервалы определяются типом аккорда, выбранным в списке группы Chord Type.
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Рис. 6.103. Аккорды,
которые можно сформиро-
вать в окне Making Music

Для удаления ноты, паузы или аккорда с нотоносца необходимо ухватиться
мышью за удаляемый символ и перетащить его за пределы рабочего поля.

Темп (Tempo) вы можете выбрать по вкусу.
Прежде чем нажать кнопку ОК, заставляя тем самым компьютер длительное

время заниматься выполнением арифметических задач, можно оперативно про-
слушать будущую музыку в исполнении какого-либо MIDI-инструмента. Для этого
в поле MIDI Quick Preview задайте номер пресета GM (номер инструмента) и на-
жмите кнопку Listen (слушать). Если ничего не услышите, то, вероятнее всего,
причина заключается в том, что неправильно выбран драйвер MIDI-выхода. Что-
бы поправить дело, командой Options > Devise Properties,., откройте окно Device
Properties, затем вкладку MIDI Out (см. рис. 1.10) и на ней в раскрывающемся спис-
ке MIDI Output: выберите драйвер.

Мы не рассмотрели еще две опции. С помощью опции Exact Tune включается
автоматическая настройка (если сэмпл содержит фальшивую ноту, то программа
это исправит).

При включении опции Constant Duration вычисления будут выполняться доль-
ше, но зато длительности всех нот будут «правильными». В противном случае, дли-
тельности нот могут оказаться короче, чем должны быть. Для того чтобы понять
причину этого, нужно знать (или хотя бы догадываться) о том, как работает функ-
ция Make Music. А работает она по принципу сэмплера: воспроизводит звуки нот с
разной скоростью, получая при этом различную высоту тона. Чем быстрее воспро-
изводится сэмпл, тем скорее он закончится, и нота оборвется раньше, чем положе-
но. Опция Constant Duration не дает сэмплу завершиться раньше времени.

На этом мы завершаем рассказ о не совсем обычных средствах редактирова-
ния, сосредоточенных в подменю Special.

В меню Effects осталось рассмотреть последнюю строку — Time/Pitch — под-
меню, в которое входят следующие команды:

> Doppler Chifter... — имитатор эффекта Доплера (изменение частоты колеба-
ния, излученного движущимся источником)
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> Pitch Bender... — сдвиг высоты тона волновой формы
> Stretch... — преобразование длительности и высоты тона волновой формы

6.41. Doppler Chifter.. — имитатор эффекта
Доплера

Командой Effects > Time/Pitch > Doppler Chifter... открывается окно Doppler
Chifter (рис. 6.104).

Перед вами — имитатор эффекта Доплера, суть которого заключается в том,
что частота колебания (звукового, электромагнитного, светового), излученного
источником, движущимся относительно приемника, изменяется, когда колеба-
ние достигает приемника.

Приемник и источник колебаний могут перемещаться друг относительно дру-
га по самым сложным траекториям, но величина доплеровского смещения часто-
ты зависит только от радиальной составляющей скорости. Это означает, напри-
мер, что если автомобиль мчится навстречу вам, и его водитель непрерывно
сигналит, то вы слышите звук, тон которого непрерывно повышается по мере при-
ближения автомобиля. Затем автомобиль благополучно разъедется с вами, и по
мере его удаления тон звукового сигнала будет понижаться. В этом примере ради-

Doppler Shifter

Path Type: (? {Straight Unjjj

Starting Distance Awap ]1

Velocity J

ComrtgFfOfn JO
î

. ;• • Passes affront by JO

Г"
O

Adpst Volume based on Distance

AdtustVofumebasedonDrrection 1QO*

*Level Good

Being Spun In Circles
D tippy
Eye of Tornado
Jet
Large Track
Merry-Go Round

Рис. 6.104. Окно Doppler Chifter, траектория движения - прямая линия
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альная составляющая скорости максимальна, потому что автомобиль едет на вас
(и от вас) по прямой линии.

Приведем еще один пример, соответствующий ситуации, когда радиальная
скорость равна нулю. Автомобиль с включенным звуковым сигналом с той же бе-
шеной скоростью мчится по трассе, имеющей форму идеальной окружности, а вы
стоите в ее центре. Звук гудка будет «вращаться» вокруг вас, но частота колеба-
ний, а, значит, и высота тона, будут оставаться неизменными.

Физики давно вывели точные формулы, связывающие величину доплеровско-
го приращения частоты с частотой излученного колебания и относительной ра-
диальной скоростью источника-приемника колебаний. Эффект Доплера широко
применяется на практике для измерения скорости в мореплавании, в авиации и в
астронавтике. Даже когда вас штрафуют за превышение скорости на дороге, знай-
те: и здесь не обошлось без эффекта Доплера. И вот теперь, благодаря разработчи-
кам Cool Edit Pro 2, этот элемент космических технологий пришел в музыку.

Давайте рассмотрим окно Doppler Chifter, представленное на рис. 6.104. В пра-
вой верхней его части расположено графическое поле, в котором отображается
траектория движения источника звука. Приемник звука находится в центре коор-
динат (в точке пересечения вертикальной и горизонтальной осей). Направление
0° — фронтальное, 180° — тыльное, 90° — правая сторона, 270" — левая сторона.
Непосредственно в графическом поле нельзя нарисовать траекторию движения
источника звука. Ее задают, пользуясь опциями окна. На рис. 6.104 траектория
имеет вид прямой линии, т. к. в группе Path Type выбрана опция Straight Line. Тем
самым смоделирован первый из приведенных выше примеров; автомобиль мчит-
ся на пешехода. Причем протяженность его пути от места старта до центра коор-
динат составляет 15 метров (Starting Distance Away_meters), а скорость движения
15 м/с (Velocity_ meters/second).

Объект, излучающий звуковые колебания, не обязательно должен двигаться
точно спереди. В поле Coming from_degrees в градусах вводится курсовой угол.
Пример, представленный на рис. 6.105, соответствует ситуации, когда курсовой
угол равен 45°.

В поле Passes in front by_meters вводится величина смещения траектории впе-
ред (для положительных значений числа) или назад по отношению к центру коор-
цинат. Поле Passes in right by_meters предназначено для ввода величины смещения
траектории вправо (число положительное) или влево (число отрицательное).

При установленном флажке Adjust Volume based on Distance громкость генери-
руемого сигнала будет зависеть от текущего расстояния до объекта.

Если установлен флажок Adjust Volume based on Direction, то громкость будет
определяться также и текущим направлением на движущийся виртуальный объект.

В раскрывающемся списке Quality Level можно выбрать один из алгоритмов
обработки. Разница между алгоритмами состоит в качестве моделирования. Пре-
делы выбора: от Low (fastest) (низкое качество, высокая скорость обработки) до
Perfect (slowest) (наивысшее качество, малая скорость обработки).

Если теперь, вернувшись к тем параметрам, что представлены на рис. 6.104. в
группе Path Type выбрать опцию Circular, то траектория движения превратится в
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Doppler Shifter
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Рис. 6.106. Окно Doppler Chifter, траектория движения - окружность
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окружность (рис. 6.106). Будет смоделирован второй из примеров, приведенных и
начале раздела.

Обратите внимание на то, что названия опций с изменением траектории также
изменились. Вместо Starting Distance Away_meters появилось поле Radius, в котором
вводится радиус окружности, а в двух нижних полях теперь нужно вводить парамет-
ры смешения центра окружности относительно начала системы координат.

В поле Presets содержится список установок, демонстрирующих проявление
эффекта Доплера для различных начальных условий.

6.42. Pitch Bender.. — сдвиг высоты тона волновой
формы

И преобразование длительности, и сдвиг высоты тона волновой формы, в прин-
ципе, позволяет реализовать команда Stretch..., которую мы рассмотрим в
разд. 6.43. В ранних версиях программы команды Pitch Bender... не было. На наш
взгляд, основным достоинством окна Pitch Bender (рис. 6.107), которое открыва
ется этой командой, можно считать наглядность представления и удобство ввода
зависимости высотного сдвига (или изменения темпа) от времени. Эта зависи-
мость задается графически в координатном поле. По вертикали в нем отложена
либо величина высотного сдвига (единица измерения — полутон), либо величина

Add | Del l t7 Spire

jDowraWhoieSlep
Qyality Level; Excellent

semitone:

BPM, with base of

Sq uir rely
Turntable Losing Power
Up a Whole Slep

t'mgtfi wit change from 10 sec'.te? aboU 15.12 sec

Рис. 6.107. Окно диалога Pitch Bender
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изменения темпа (единица измерения — число долей такта в минуту), по гори-
зонтали — время (в секундах). График соответствует тому участку волновой фор-
мы, который в главном окне вы выделили.

Формой графика можно управлять, мышью создавая и перемещая узлы. При
установленном флажке Spline график выглядит как гладкая кривая, при сброшен-
ном — как ломаная линия.

Кнопкой Flat сбрасываются все изменения, внесенные в исходный график: он
превращается в отрезок прямой линии, расположенный горизонтально.

Кнопкой Zero Ends крайняя правая точка графика совмещается с нулевым
уровнем. Эта функция полезна, когда нужно последовательно обработать не-
сколько фрагментов волновой формы. Если в конце каждого из фрагментов бу-
дет нулевой сдвиг высоты тона или одинаковый темп, то их легче будет соеди-
нить между собой.

Правее кнопки Zero Ends расположено поле, в котором отображаются коорди-
наты курсора (если вы нацелите его на одну из точек координатного поля). Значе-
ние высоты сдвига тона измеряется с точностью до цента {одной сотой доли полу-
тона). Темп измеряется с точностью до одной сотой доли такта в минуту. Время
измеряется с точностью до одной миллисекунды.

В раскрывающемся списке Quality Level вы можете выбрать качество выполне-
ния преобразований. Предусмотрено 6 градаций: от наиболее низкого качества
Low (fastest) до самого высокого Perefect (slowest).

Обращаем ваше внимание на то, что при редактировании звуковых данных в
рассматриваемом окне одновременно изменяется и высота звучания волновой
формы и ее длительность. Если после преобразований высота станет больше, то
волновая форма сожмется во времени, если меньше — то растянется.

Опциями группы Range устанавливается диапазон отображения параметра,
отложенного по вертикальной оси системы координат. Диапазон может быть ус-
тановлен в одном из следующих форматов.

> В формате полутонов, если выбрана опция Range_semitones. Изменение
высоты звука вверх и вниз связано с делениями шкалы логарифмическим
законом. В поле необходимо ввести максимальное значение пределов из-
менения высоты. Если требуется устранить мелкие огрехи в высоте звуча-
ния инструментальной или вокальной партии, то выберите предел в 1—2
полутона. Тогда график удастся нарисовать очень точно. Если обработка
ведется для получения эффекта значительного изменения высоты (глиссан-
до), то и пределы должны быть большими.

> В формате долей такта в минуту, если выбрана опция _ ВРМ, with base of _
ВРМ. Изменение высоты звука линейно связано с делениями шкалы на вер-
тикальной оси.

Каждый из вариантов оцифровки вертикальной оси по-своему полезен. Если
вы занимаетесь подгонкой высоты звучания вокальной партии (не секрет, что среди
«певцов» встречаются люди, не способные правильно воспроизвести мелодию,
точно попав в тональность), выберите в качестве единицы измерения полутон. На
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слух определите те фрагменты партии, где певец фальшивит. Затем скорректируй-
те высоту тона для каждого из таких фрагментов.

А вот при корректировке темпа игры (вы обязательно столкнетесь и с музы-
кантами, не попадающими в доли) удобно принять за единицу измерения число
долей в минуту. При этом в левом поле ввода_ ВРМ, with base of _ ВРМ вы должны
ввести величину максимального отображаемого отклонения реального темпа от
базового. В правом поле нужно ввести значение базового темпа композиции, к
которому вы собираетесь подгонять темп игры незадачливого музыканта.

В нижней части окна видна запись Length will change from_ sec to about_sec. В этой
строке содержится информация:

> О длительности исходного (выделенного) фрагмента волновой формы
> О том, насколько изменится длительность волновой формы после выпол-

нения преобразований, заданных графиком

Созданный вами график и установленные параметры можно сохранить в спис-
ке Presets. Разработчик предлагает нам несколько своих схем настроек, иллюст-
рирующих возможности рассматриваемого окна;

> Down a Whole Step — быстрое понижение высоты звучания на целый тон в на-
чале волновой формы и возврат к исходной высоте в конце волновой формы

> Just Winding Up — скачкообразное понижение высоты на две октавы в са-
мом начале волновой формы с последующим постепенным (по экспонен-
циальному закону) возвратом к исходной высоте

> Squirelly — глиссандо по сложному волнообразному закону в пределах от 8
до —6 полутонов с постепенным возвратом к исходной высоте

> Turntable Losing Power — понижение высоты по экспоненциальному закону
на 48 полутонов (4 октавы) от номинального значения

> Up a Whole Step — быстрое повышение высоты звучания на целый тон в нача-
ле волновой формы и возврат к исходной высоте в конце волновой формы

Итак, вы познакомились с удобным в работе окном, которое, однако, не лише-
но существенного недостатка: преобразование высоты тона вызывает изменение
длительности волновой формы и наоборот. Этот недостаток не позволяет решать
некоторые из встречающихся на практике задач коррекции высоты тона.

В следующем разделе мы рассмотрим средство, пользуясь которым можно из-
менять и высоту звучания, и длительность волновой формы независимо.

6.43, Stretch... — преобразование длительности
и высоты тона волновой формы

С помощью функции Stretch можно осуществлять фантастические преобразо-
вания протяженности и высоты звучания выделенного фрагмента волновой фор-
мы. А именно:
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> Изменение скорости воспроизведения волновой формы без изменения вы-
соты тона

> Изменение высоты тона без изменения длительности звучания фрагмента
волновой формы

> Независимое одновременное изменение высоты тона и скорости воспроиз-
ведения выделенного фрагмента волновой формы

Для чего нужен этот инструмент? Вернемся к рассмотренному недавно приме-
ру записи песни. Функция растяжения была бы очень полезна какдля коррекции
длительности слов или целых фраз песни, так и для подстройки фальшивых нот.
Может быть, вам захочется изменить диапазон вашего голоса или сделать свой
голос чрезвычайно низким, как у чудовища из триллера? Команда Streth... — все-
го лишь инструмент, результат применения зависит от вашей фантазии.

Метод растяжения основан на предварительном разбиении звукового фрагмен-
та на маленькие порции — выборки. Затем (при необходимости) каждая из этих
порций обрабатывается. Результирующий сигнал собирается из обработанных
выборок, причем любая из них может повторяться. При этом длительность звуча-
ния волновой формы увеличивается, а высота тона может оставаться неизменной.
Но это все теория, пора переходить к практике.

Окно диалога Stretch показано на рис. 6.108. Часть элементов управления на-
ходятся на вкладках Constant Stretch и Gliding Stretch, часть — непосредственно в
окне диалога Stretch. Вкладки соответствуют двум различным режимам преобра-
зования высоты звучания и длительности волновой формы.

Посредством опций вкладки Constant Stretch все участки выделенной волно-
вой формы можно обработать только одинаково (с одним и тем же коэффициен-
том трансформировать во времени или по высоте).

С помощью движка или непосредственно в цифровом поле ввода Ratio (Отно-
шение) задается изменение высоты тона волновой формы. При значении этого
параметра равном 100, изменение тона не произойдет. При значении меньше 100
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произойдет увеличение высоты тона, а при значении больше 100 — понижение. В
списке Transpose (Транспозиция) можно выбрать количество полутонов, на кото-
рое произойдет понижение или повышение тона. Содержимое поля Ratio изме-
нится при этом автоматически.

В поле ввода Length (Длина) задается коэффициент изменения длительности
звучания волновой формы (или темпа композиции). Изменять это значение мож-
но также при помощи регулятора Lower Pitch. Однако этот параметр (в зависимо-
сти от режима, установленного в группе Stretching Mode, может быть недоступен.

Можно постепенно изменять высоту тона и темп на протяжении выделенного
участка волновой формы. Для этого необходимо выбрать вкладку Gliding Stretch
(рис. 6.109) и задать начальные (Initial %) и конечные (Final %) значения рассмот-
ренных параметров.
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В группе Precision задается точность расчетов: Low Precision — низкая, Medium
Precision — средняя, Might Precision — высокая.

В группе Stretching Mode можно выбрать один из трех режимов работы;

> Time Stretch (preserves pitch) — растяжение (или сжатие) волновой формы во
времени с фиксированной высотой тона

> Pitch Shift (preserves tempo) — изменение высоты тона с фиксированной дли
тельностью звучания волновой формы

> Resample (preserves neitcher) — одновременное изменение длительности зву-
чания волновой формы и высоты тона

В группе Pitch and Time Settings задаются параметры, значения которых лучше
всего подбирать опытным путем для каждой конкретной волновой формы.

> Splicing Frequency — частота сращивания — параметр, определяющий раз
мер звуковых выборок. Для атональных, шумовых волновых форм с широ-
ким спектром значение этого параметра не так уж и принципиально. В этих
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случаях целесообразно оставить его установленным по умолчанию. Если же
преобразованию подвергается волновая форма, содержащая чистый тон
(синусоидальное колебание), то частоту сращивания лучше выбрать такой,
чтобы она была в целое число раз меньше частоты синусоидального колеба-
ния. Сначала вам придется найти частоту тонального заполнения волновой
формы, воспользовавшись окномдиалога Frequency Analysis (разд. 8.1). Затем
нужно разделить измеренное значение на целое число, чтобы получить пред-
почтительное значение параметра Splicing Frequency. Например, если изме-
ренная частота тона составляет 438 Гц, то деление этого числа на 20 даст
21,9 Гц. Установии такое значение частоты сращивания, вы значительно улуч-
шите качество преобразований за счет уменьшения фазовых искажений.

> Overlapping — степень перекрытия звуковых выборок. При растяжении или сжа-
тии выборки перекрываются друг с другом. Если после преобразования возник-
нет эффект, подобный хорусу, следует уменьшить степень перекрытия звуковых
выборок. Однако при этом можно впасть в другую крайность: выборки практи-
чески перестанут перекрываться, что приведет к нежелательной амплитудной
модуляции, проявляющей себя подобно эффекту вибрато. Поэтому корректи-
руйте степень перекрытия в таких пределах, чтобы добиться равновесия, при
котором глубина каждого из побочных эффектов будет минимальна.

> Choose appropriate defaults — установка значений двух вышеперечисленных
параметров по умолчанию.

Если вам трудно сразу сориентироваться в этой непростой программе, попро-
буйте поэкспериментировать с предустановками в группе Presets.

> Cutting Power — постепенное растяжение выделенного фрагмента (в начале
фрагмента растяжения нет, в конце — пятикратное). В случае однотонной
волновой формы преобразование создает впечатление звука выстрела и по-
лета снаряда.

> Double Speed — двукратное сжатие во времени с одновременным повыше-
нием тона.

> Fast Talker, Speed Up — варианты увеличения темпа (при условии выделения
всей волновой формы) или сжатия фрагмента волновой формы во времени
с сохранением высоты тона.

> Helium, Raise Pitch,— варианты повышение высоты звучания выделенной
волновой формы при ее неизменной длительности.

> Lower Pitch— понижение высоты звучания выделенной волновой формы
при ее неизменной длительности.

> Slow Down — уменьшение темпа (при условии выделения всей волновой
формы) или растяжение фрагмента волновой формы во времени в полтора
раза с сохранением высоты тона.

На этом мы завершаем рассказ о возможностях Cool Edit Pro в области транс-
форми рования уже существующего звука (меню Effects) и переходим к следующе-
му меню — Generate.
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МЕНЮ GENERATE- ГЕНЕРАЦИЯ ЗВУКА

До сих пор мы говорили только о редактировании оцифрованного звука. Но
звук можно синтезировать сразу в цифровом виде, рассчитывая его математичес-
кими методами. О том, как это делается в Cool Edit Pro, и пойдет речь ниже.

В меню Generate предусмотрены следующие команды:

Silence... — генерация тишины
DTMF Signals... — генерация звука тонального набора телефонного номера
Noise... — генерация шума
Tones... — генерация тона

Прежде чем перейти к рассмотрению конкретных функций, отметим, что на-
чало генерируемого сигнала будет размещаться в том месте волновой формы, в
котором находится в данный момент маркер.

7,1. Silence.» — генерация тишины
Название этой команды произошло не от той тишины, в которой иногда хо--

чется побыть, а от тишины в смысле последовательности звуковых отсчетов, зна-
чения которых соответствуют нулевому уровню сигнала. Часто возникает необхо-
димость размещения в пределах волновой формы такой последовательности
(фрагмента волновой формы, не содержащего звуковых колебаний), например,
для того чтобы увеличить паузу между двумя фразами. А делается это с помощью
окна диалога, показанного на рис. 7.1,

Generate Silence

SteneeTime J0.2 seconds
Рис. 7,1. Окно диалога для ввода длительности паузь
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Fife £dit View Effects Gerisrate Analyse Favorites Options Window I

Рис. 7.2. Выбор позиции начала паузы

ЕЯе Edit Vew Effects Generate Analyze Favontes Options

12.7dB@ 0.11909 44100 15-bit Mono 2QOOK 3233GBfme

Рис. 7.З. Тишина вставлена в волновую форму
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Перед выбором команды Generate > Silence... установите маркер в ту позицию
волновой формы, куда нужно вставить паузу (рис. 7.2.).

Сгенерировать тишину очень просто: в окне диалога Generate Silence задайте
продолжительность паузы в секундах и нажмите кнопку ОКили клавишу <Enter>.
В результате вставки паузы отсчеты исходной волновой формы окажутся раздви-
нутыми вправо и влево от позиции, где в исходной волновой форме находился
маркер (рис. 7.3.).

Напомним, что в Cool Edit Pro есть еще одно средство вставки тишины — ко-
манда Effects > Silence (разд. 12.3). Отличие состоит в том, что командой Generate
> Silence... можно вставить паузу заданной длительности, раздвинув существовав-
шие отсчеты звукового сигнала, а командой Effects >Silence тишину вставляют
вместо тех отсчетов, что находились в выделенном фрагменте волновой формы.

7.2. DTMF Signals.., — генерация звука тонального
набора телефонного номера

Честно говоря, полезность функции DTMF Signals... кажется нам несколько
сомнительной. Тем не менее, поскольку такая возможность существует, мы не
имеем права о ней умолчать. Генерация сигналов тонального набора происходит с
помощью окна диалога, изображенного на рис. 7.4.

i Generate D1MH Signals

I>ial String

•thrffc Ch*ad«s:

lone Tims J150 ю* PauseTjmeUOQ .

Si(sak 7 me 180 "is ;; Pause Chacactei j

f

нг

-f

-JS41 .
' ...

D !

Рис. 7.4. Генерация звука
тонального набора
телефонного номера

Чтобы сгенерировать тональные сигналы, в строке Dial String введите последо-
вательность цифр и специальных символов, В поле Usable Characters перечислены
разрешенные символы; 1, 2, 3, 4, 5, 6, 7, 8, 9, *, #, а, Ь, с, d.
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Поле Tone Time предназначено для ввода длительности тональной посылки.
В поле Break Time следует ввести длительность разделительной паузы, которая фор-
мируется автоматически между тональными посылками.

В поле Pause Time вводится длительность паузы, которая формируется в том
месте числовой последовательности, на которое указывает символ паузы. Пауза
бывает необходимой, например, при наборе кода междугороднего телефона. Если
в последовательность символов кода города и номера телефона не ввести паузу
после цифры, обозначающей выход на междугороднюю АТС (как правило, это
цифра 8), то АТС может не успеть произвести необходимую коммутацию. Сим-
вол, которым обозначается эта пауза, вы можете указать в поле ввода Pause
Character. По умолчанию таким символом является запятая (,).

Если выбрана опция DTMF Signals, то Cool Edit Pro будет генерировать DTMF-
сигналы, в которых используются комбинации частот 697, 770, 852, 941 , 1209,
1336, 1477 и 1633Гц.

При выборе опции MF Signals (CCITT R1) программа будет генерировать MF-
сигналы, характерные для телефонных сетей, использующие комбинации частот
700,900, 1100, 1300, 1500 и 1700Гц.

Каждому из разрешенных символов вы можете сопоставить пару произволь-
ных частот. Для этого следует выбрать опцию Custom. В результате станут доступ-
ными поля ввода значений этих частот. Символы организованы в таблицу. Каждо-
му символу соответствует пара частот, одной из которых обозначен столбец, а
второй — строка таблицы.

Поле Amplitude предназначено для ввода значения амплитуды генерируемого
сигнала (в процентах от максимально возможного).

В поле ввода Twist в дБ можно указать приращение громкости звучания более
высокочастотной тональной посылки по сравнению с менее высокочастотной.

Кнопкой Reset to DTMF осуществляется сброс значений пользовательских ча-
стот к исходным, которые соответствуют DTMF-сигналам.

7.3* Noise.., —генерация шума
Иногда возникает необходимость сгенерировать шум. Cool Edit Pro предос-

тавляет такую возможность. Окно диалога генерации шума Generate Noise пока-
зано на рис. 7.5.

В группе Color (Цвет) задается параметр, образно названный цветом шума:
Brown — коричневый, Pink — розовый или White — белый. Следует пояснить эти
«цветовые» термины. Здесь для удобства обозначения характера шума проводится
аналогия между восприятием световых и звуковых волн. Минимальная частота
оптического спектра, воспринимаемого человеческим глазом, соответствуют крас-
ному цвету (для звука это около 20 Гц), максимальная — фиолетовому цвету (для
звука — около 20 кГц).

У «коричневого» шума спектральная плотность распределена по закону \/f,
a y «розового» — 1//, где/— частота спектральных составляющих. Это означает,
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Рис. 7.5. Окно генератора
шума

что в «коричневом» шуме преобладают низкочастотные (красные) составляющие
В «розовом» шуме тоже больше красного цвета, но на долю остальных спектраль-
ных составляющих приходится значительно больше энергии, чем у «коричнево
го» шума. Шум, в котором присутствуют все воспринимаемые звуковые частоты
в равных пропорциях, по аналогии со светом называется белым. На самом деле
это идеализация. Истинно белый шум (как и свет) сгенерировать нельзя. Даже
солнечный свет не является по-настоящему белым.

В группе Style задается способ образования шума.
Spatial Stereo — пространственное стереозвучание. Звук формируется путем

смешения трех шумовых компонентов от одного генератора шума, выходной
сигнал которого задерживается на интервал времени, заданный пользователем
в поле ввода _u.Sekonds. Один источник на звуковой панораме помещается вле-
во, другой — вправо, а третий — посередине. За счет этого создается ощуще
ние пространственности: шумит со всех сторон. Минимальное значение задер-
жки — ноль, шум является монофоническим (сигналы от всех трех источников
одинаковы).

Другой способ генерации шума — Independent Channels. Как следует из на-
звания, используются два независимых генератора шума для каждого стерео-
канала. Mono — монофонический шум (один генератор шума для стереока-
налов). Inverse — используется один генератор шума, но сигналы в левом и
правом каналах противоположного знака (инвертированы относительно друг
друга). У слушателя создается ощущение, что источник шума расположен у
него в голове.

С помощью движка или поля ввода Intensity задается интенсивность шума
(в процентах от максимального значения отсчета в генерируемом шумовом сиг-
нале). Фактически этот параметр соответствует дисперсии формируемого случай-
ного процесса. Не случайно верхний предел регулятора интенсивности составля-
ет 40%. На самом деле уже при 10—20% очень многие отсчеты в сформированном
шуме будут клиппированными.

В поле Duration (sekonds) вводят длительность формируемой шумовой волно-
вой формы.
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Рис. 7.6. Сгенерированный белый шум

Волновая форма, содержащая белый шум, может выглядеть так, как показано
на рис. 7.6.

Белый шум, формируемый программой, можно считать широкополосным
сигналом, спектр которого равномерно распределен в области звуковых час-
тот. Иными словами, в таком шуме содержатся колебания всех звуковых частот.
Любую из этих частот или любую область частот можно выделить с помощью
фильтра. Это означает, что в вашем распоряжении имеется субтрактивный ме-
тод синтеза звука [1, 3].

Если вы хотите синтезировать звук, основой которого является шумовой про-
цесс (например, шум ветра, грохот взлетающего космического корабля), то може-
те поступить следующим образом. Сгенерируйте волновую форму, содержащую
шум (см. рис. 7.6). Командой Transform > Filters >FFT Filter., .откройте окно филь-
тра на основе быстрого преобразования Фурье (разд. 12.21). Сформируйте график
исходной АЧХ фильтра (рис. 7.7).

При такой АЧХ в начале обрабатываемой шумовой волновой формы будут вы-
делены низкие частоты.

Затем сформируйте финальную АЧХ (рис. 7.8).
В конце волновой формы окажутся подчеркнутыми высокочастотные состав-

ляющие спектра сигнала.
В промежуточных точках волновой формы будет как бы происходить скольже-

ние максимума АЧХ вдоль оси частот.
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Рис. 7.10. Пример АЧХ фильтра для выделения музыкальных зеуков из шума
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В итоге получится волновая форма (рис. 7.9), звучание которой действительно
напоминает стартующую ракету.

Описанным способом можно синтезировать не только шумоподобные звуки.
Например, если в том же самом окне FFT Filter выбрать пресет С Major Triad
(рис. 7.10) и обработать шум фильтром с такой АЧХ, то вместо атонального шума
вы услышите мелодичные звуки, складывающиеся в аккорд До мажор.

В следующем разделе мы рассмотрим еше одно средство синтеза музыкальных зву-
ков, в котором реализован второй из классических методов синтеза — аддитивный [ 1,31 -

7 A Tones», — генерация тона
Эта функция может быть полезна при создании своих собственных музыкальных

сэмплов, предназначенных для последующей загрузки в сэмплер. Вы можете генериро-
вать звук с довольно сложным тембром. Откройте окно диачога Generate Tones (рис. 7.11).
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Рис. 7.11. Окно
диалога Generate

Традиционно для Cool Edit Pro можно изменять параметры генерации на протя-
жении генерируемой волновой формы. Чтобы задать начальные значения парамет-
ров, выберите вкладку Initial Settings (см. рис. 7.11), Финальные параметры задаются
опциями вкладки Final Settings. А если вы хотите сделать параметры генерации неиз-
менными для всего создаваемого звука, установите флажок Lock to these settings only

Теперь рассмотрим опции окна Generate Tones.
Base Frequency (0) — частота базового сигнала (основной гармоники). Modulate By —

частота сигнала, модулирующего базовый. Modulation Frequency — частота модуляции.

II Зак 1 1 5 2
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В группе frequency Components задаются уровни и частоты пяти спектральных
составляющих генерируемого сигнала (гармоник). Частота каждой гармоники
определяется косвенно, т. е. относительно базовой частоты. Например, если базо-
вая частота 220 Гц и задан коэффициент 4 (для четвертой гармоники), то частота
этой гармоники будет равняться 220 х 4 = 880 Гц.

Сами коэффициенты также можно задавать в полях ввода О х, расположенных
под регуляторами амплитуды гармонических составляющих формируемого сиг-
нала. Это означает, что синтезированный на основе, например, синусоид, сигнал
не обязательно должен складываться лишь из первых 5--и следуюших подряд гар-
моник. Если в полях, о которых сейчас идет речь, ввести, например 1, 3, 5, 7,9, то
сигнал будет сформирован из синусоиды основного тона и первых четырех ее не-
четных гармоник. Если ввести числа 1. 2,4, 6, 8, то сигнал будет сформирован из
синусоиды основного тона и первых четырех ее четных гармоник. Тембры этих
сигналов будут заметно отличаться.

В принципе, для синтеза можно выбрать любой ряд гармоник, например 1, 4,
7, 12, 23. Если вы хотите, чтобы синтезированные звуки не были совершенно не-
реальными, то следует учитывать, что в природных физических процессах, когда
генерируются звуки, как правило, амплитуда спектральных составляющих умень-
шается с ростом частоты (номера гармоники).

Группа dB Volume предназначена для регулировки уровня генерируемого сигнала.
В группе General вы можете задать форму сигнала-заполнения (Flavor) и дли-

тельность сигнала в секундах (Duration_seconds). Здесь, наверное, следует пояс-
нить, что именно подразумевается под словом «заполнение». В данном случае этим
словом обозначается форма волны, используемая при генерации звука.

От формы волны в значительной степени зависит тембр звучания. Самое «мяг-
кое» и «холодное» звучание соответствует синусоидальной (Sine) вол не (рис. 7.12).

Значительно грубее и «электроннее» воспроизводится пилообразная треуголь-
ная волна (Triangle/Sawtooth, рис. 7.13).

Прямоугольная волна (Square, рис. 7.14) звучанием напоминает звучание дина-
мика в корпусе компьютера. Интересно, что при моделировании прямоугольной
волны разработчик учел даже тот факт, что настоящие формирователи колебаний,
построенные на двоичных логических элементах, не могут создать идеально прямо-
угольные импульсы. В моменты смены логических уровней оба выходных транзис-
тора схемы оказываются открытыми одновременно. Возникают броски тока. На
рис. 7.14 они выглядят, как острые пики на передних и задних фронтах импульсов.
В сигналах такой формы подчеркнуты высокочастотные составляющие.

Доступно и более сложное заполнение: «вывернутая» синусоида (Inv Sine), ко-
торая похожа на гребешки волн на поверхности воды (рис, 7.15).

Однако лучше один раз услышать, чем сто раз прочитать. Сгенерируйте звук с
различным заполнением и внимательно рассмотрите форму сигнала, воспользо-
вавшись кнопкой изменения масштаба, расположенной в главном окне.

В группе Phasing задаются параметры управления фазами сигиапов стереоканалов.
Поскольку фазы сигналов левого и правого каналов отличаются, то и создается ощуще-
ние стереофоничности звучания. Start Phase — начальная фаза звуковых колебаний с
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заданной формой волны. Phase Difference — разность фаз (или, иначе говоря, сдвиг но
фазе) между сигналами в левом и правом каналах. Change Rate — частота изменения
сдвига по фазе (количество полных оборотов на 360° фазового сдвига за секунду).

Кроме описанных возможностей, при генерации тона существует еще одна: не ге-
нерировать звук, а модулировать (Modulate) или демодулировать (DeModulate) выде-
ленный фрагмент волновой формы генерируемым сигналом с заданными параметра-
ми, получая при этом самые фантастические звуки. Отметим, что если вы выделили

фрагмент волновой формы, но не выбрали в группе Source Modulation ни одной опции,

тогда сгенерированный сигнал заменит собой выделенный звуковой фрагмент.
Мы обещали вам привести пример синтеза колебания сложной структуры ад-

дитивным методом. Складывать можно колебания различной формы, а не только
синусоидальной. В электромузыкальных инструментов 70-х — 80-х годов синтез
тембра обычно осуществлялся на основе сложения прямоугольных колебаний,
частоты которых отличаются в 2, 4, 8, 16,... раз. И не удивительно. Ведь получить
прямоугольные исходные колебания не составляет особого труда. Достаточно со-
брать цепочку из нескольких счетных триггеров, каждый из которых делит в дна
раза частоту импульсной последовательности, поступающей на вход. Затем сиг-
нал можно пропустить через формантный фильтр, подчеркивающий характерные
составляющие спектра и придающий тембру инструмента требуемое качество.

Если вам в порыве ностальгии сейчас захочется послушать, например, звук
ЭМИ «Юность», то знайте, что Cool Edit Pro избавил вас от необходимости конст-
руировать какие-либо устройства. Просто откройте окно диалога Generate Tones
и установите в нем такие, например, параметры, как показано на рис. 7.16.
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Результат работы можно увидеть в главном окне (рис. 7.17). Сумма последова-
тельностей импульсов прямоугольной формы дала пилообразный сигнал с боль-
шой интенсивностью высокочастотных составляющих.

441ГО-16-bit Steieo j" 1720К siTIGBfes

Рис. 7.17. Синтезированное колебание

Теперь вы можете поэкспериментировать, комбинируя способы синтеза звука
и различные параметры. Число нсех вариантов звукогенерации (а значит и темб-
ров) безгранично. Может быть, вам удастся получить совершенно новый тембр,
который станет очень популярным у музыкантов и будет звучать в хит-парадах.
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ANALYZE - АНАЛИЗ ЗВУКА

Было бы странно, если бы такой редактор, как Cool Edit Pro, позволяя записы-
вать, редактировать, обрабатывать и генерировать звуки, не предоставлял бы
пользователю средств для их анализа. И действительно, такие средства имеются.
В меню Analyze находятся три команды:

> Show Frequency Analysis — проведение частотного (спектрального) анализа
> Show Phase Analysis — проведение фазового анализа (контроль качества сте-

реополя и моносовместимости)
> Statistics... — получение статистической информации о волновой форме и

построение гистограммы значений отсчетов

8.1. Frequency Analysis — проведение частотного
(спектрального) анализа

Окно диалога частотного (спектрального) анализатора звука Analysis показано
на рис. 8.1.0 сущности спектрального анализа мы подробно рассказали в книге [8],
Некоторая информация о спектральной форме представления звуковых сигналов
содержится в главах 5 и 6.

Когда вы открываете окно Frequency Analysis, происходит предварительный рас-
чет спектра короткого фрагмента волновой формы, начато которого совпадает с
позицией маркера. Если же выделен фрагмент волновой формы (или даже вся вол-
новая форма), анализируется выборка сигнала, расположенная посередине выде-
ленного фрагмента. Понятно, что на основании выборки невозможно получить
полное представление о спектре сигнала.

Чтобы произвести спектральный анализ всего выделенного звукового фрагмен-
та (или всей волновой формы), нажмите кнопку Scan. Спустя некоторое время
после завершения расчета спектра изображение изменится.
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Рис. 8.1. Окно анализатора спектра

Расчет производится раздельно для правого и левого каналов. На графике кри-
вые спектрограмм для разных каналов отображаются разными цветами.

Обладая некоторым опытом общения с анализатором и профессиональным
чутьем, по спектру сигнала вы сможете, например, разыскать на графике даже
небольшой выброс, в котором сосредоточена основная энергия помехи, а затем, с
помощью фильтра удалить этот выброс из спектра сигнала, существенно улучшив
при этом отношение полезного сигнала к шуму.

Если окно с графиком спектра покажется мелковатым, вы можете увеличить
его традиционным способом с помощью мыши.

Атеперь рассмотрим график внимательнее. По горизонтальной оси откладывается
частота в герцах, по вертикальной — уровень компонентов сигнала на этой частоте.

При установленном флажке Linear View горизонтальная ось размечается в ли-
нейном масштабе. Так удобнее рассматривать весь спектр в целом, включая и его
высокочастотную область. Если этот флажок сброшен, то по горизонтали уста-
навливается логарифмический масштаб. Напомним, что логарифмический мас-
штаб позволяет в деталях наблюдать низкочастотную часть спектра. Для сравне-
ния на рис. 8.2 при логарифмической шкале по оси частот показан спектр того же
самого сигнала, для которого на рис. 8.1 выбран линейный масштаб.

Слева под шкалой частот располагается поле, в котором отображаются данные
о значениях спектральной функции сигналов правого и левого канала для той ча-
стоты, на которую в данный момент указывает курсор мыши. Сама частота также
отображается в поле. Сказанное справедливо при условии, что курсор находится в
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Рис. 8.2. Спектр сигнала при логарифмическом масштабировании оси частот

пределах координатного поля. При перемещении курсора значения параметров
изменяются. Если курсор находится вне пределов координатного поля, то значе-
ния трех отображаемых параметров не меняются, причем они соответствуют той
частоте, при которой курсор, покидая координатное поле, пересек его границу.

Обратите внимание на то, что числа, отображаемые в поле Cursor, строго гоио-
ря, не являются координатами курсора мыши. В этом поле вы видите координату
курсора мыши на оси частот и соответствующее ей значение спектра. Это упро-
щает процесс численного измерения значений спектра. Вам не нужно прицели-
ваться в конкретную точку на координатной плоскости. Достаточно добиться, что-
бы в поле Cursor появилось искомое значение частоты, а значение спектра для нее
программа предъявит вам автоматически.

В поле, расположенном правее рассмотренного, показаны частоты спектраль-
ных составляющих сигналов левого и правого каналов, в окрестностях которых со-
средоточена максимальная энергия (частоты максимальных пиков на графике).

В правом верхнем углу окна расположена группа Hold, включающая в себя 4
разноцветные кнопки. Если не нажата ни одна из кнопок, то огибающие спект-
ральных функций сигналов правого и левого каналов отображаются линиями раз-
ного цвета. Если нажата хотя бы одна кнопка, то огибающие спектральных функ-
ций сигналов правого и левого каналов отображаются различными оттенками
одного и того же цвета. Предусмотрено 4 цвета: зеленый, красный, синий и жел-
тый. Если нажать несколько кнопок, то высшим приоритетом будет обладать та
из них, которая находится правее.
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В левом нижнем углу окна расположен раскрывающийся список, предназна-
ченный для выбора одного из 5 стилей отображения спектральной функции.

1. Lines — отображается только огибающая спектральной функции (рис. 8.3)
2. Area (Left on top) — отображается и огибающая спектральной функции и ее

заполнение: область координатной плоскости, находящаяся под огибаю-
щей, залита цветом, спектр сигнала левого канала отображается в верхнем
слое рисунка, правого — в нижнем (см. рис. 8.2).

3. Area (Right on top) — отображается и огибающая спектральной функции нее
заполнение, спектр сигнала правого канала отображается в верхнем слое
рисунка, левого — в нижнем.

4. Bars (Left on top) — заполнение спектральной функции отображается в виде
вертикальных полосок. Спектр сигнала левого канала отображается в верх-
нем слое рисунка, правого — в нижнем (рис. 8,4).

5. Bars (Right on top) — заполнение спектральной функции отображается в виде
вертикальных полосок. Спектр сигнала правого канала отображается в вер-
хнем слое рисунка, левого — в нижнем.

Если анализируется монофонический сигнал, то возможен выбор только од-
ного из трех вариантов отображения. Ведь в этом случае нет слоев изображения.

Нажав кнопку Advanced, вы увеличите число доступных опций окна. Дополни-
тельно появятся:

> Поле Reference_dBFS
> Раскрывающийся список FFT Size
> Безымянный раскрывающийся список, предназначенный для выбора типа

весовой функции (см. гл. 6)
> Кнопка Copy to Clipboard, позволяющая в текстовом формате переслать зна-

чения частот и соответствующие им значения спектральной функции в бу-
фер обмена

Возможно, вам понадобится сместить график по вертикали, чтобы рассмот-
реть в подробностях поведение спектральной функции на каком-либо ее конк-
ретном участке. В поле Reference_dBFS вы можете задать величину смещения гра-
фика спектра по вертикали относительно нулевого уровня. Не забудьте установить
нулевое значение этого параметра перед тем, как приступить к численному изме-
рению абсолютных значений спектральной функции для тех или иных частот.
В противном случае в измерениях будет присутствовать систематическая погреш-
ность, по абсолютной величине равная введенному вами смещению.

В раскрывающемся списке FFT Size предусмотрено несколько стандартных
значений размера выборки для БПФ, а в раскрывающемся списке, расположен-
ном правее, — различные вариации этого преобразования, каждая из которых
имеет свои плюсы и минусы (см. гл. 6).

Окно спектрального анализатора не является модальным, т. е. оно существует
как бы независимо от главного окна программы. Иными словами, окно Frequency
Analysis может находиться в открытом состоянии и в то время, когда вы работаете в
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Рис. 8.3. Отображение спектра сигнала в стиле Lines

Рис. 8.4. Отображение спектра сигнала в стиле Bars (Left on top)



i; • Глава в

главном окне (выделяете фрагмент волновой формы, перемещаете маркер, генери-
руете звуковые колебания и т. д.)- Все изменения волновой формы немедленно от-
ражаются и на спектре. Это сделано специально для удобства пользователя: вы мо-
жете работать с волновой формой и тут же видеть результат спектрального анализа.
Кроме того, если размер выборки при БПФ задан относительно небольшим, на-
пример 4096 или менее (для процессора с тактовой частотой 800 МГц), можно вос-
производить звук и одновременно наблюдать за динамикой изменения его спектра.

Следует отметить, чтоокно Frequency Analysis является плавающим. При жела-
нии его можно пристыковать к границам главного окна, и тогда последнее примет
вид, показанный на рис. 8.5.
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Рис. 8.5. Главное окно с пристыкованным окном Frequency Analysis

Обращаем ваше внимание на то, что предел изменения частоты по горизон-
тальной оси в окне Frequency Analysis устанавливается автоматически. Он зависит
от частоты дискретизации анализируемой волновой формы. Так, например, на
рис. 8.1 анализируется волновая форма с частотой дискретизации 22,05 кГц и мак-
симальная частота, отображаемая в окне, составляет 11 кГц. Это разумно, ведь все
равно в соответствии с теоремой Котельникова [8] высшая из достоверно измеря-
емых спектральных составляющих располагается на частоте, вдвое меньшей по
сравнению с частотой дискретизации. На рис. 8.5 представлен спектр сигнала,
частота дискретизации которого равна 44,1 кГц. Поэтому и диапазон отображае-
мых частот вдвое больше, чем на рис. 8 .1 . Он составляет 22 кГц.



ANALYZE — анализ звука 3.53

Присмотревшись, можно заметить, что при переходе от линейного к логариф-
мическому масштабу, максимальная отображаемая частота изменяется.

Нажав кнопку Copy to Clipboard, вы пере шлете результаты измерения спектра в
буфер обмена. Если вы затем вставите данные из буфера обмена в MS Word или в
WordPad, то убедитесь, что они представлены в текстовом формате и выглядят как
два (для монофонического аудиофайла) или три столбца (для аудиофайла стерео-
фонического). В первом столбце располагаются значения частоты, а во втором и
третьем — соответствующие им значения спектральных функций.

Если объем выборки, установленный в раскрывающемся списке FFT Size, ве-
лик, то шаг приращения по частоте будет очень маленьким, а значений спект-
ральной функции будет чрезвычайно много. Документ MS Word со вставленным в
него набором данных в таком случае может насчитывать сотни страниц. В ряде
случаев вставка в MS Word столь объемного документа даже вызывала ошибку в
работе данного текстового редактора. К счастью, вставлять данные из Cool Edit
Pro в MS Word нет необходимости. Зачем же тогда нужна кнопка Copy to Clipboard?
Дело в том, что алгоритм, заложенный в Cool Edit Pro, позволяет вычислить спектр
с очень высокой точностью и разрешающей способностью, а вот отобразить ре-
зультаты вычислений с должной детализацией программа почему-то пока не спо-
собна. Например, нельзя выбрать по своему усмотрению произвольный узкий
диапазон частот и в нем рассмотреть тонкие особенности поведения спектраль-
ной функции. Если такая необходимость возникнет, вот тогда-то и пригодится
способность Cool Edit Pro к импортированию вычисленных данных в другие про-
граммы. Единственное требование к таким программам — возможность построе-
ния графиков для выбранного фрагмента данных.

8*2. Show Phase Analysis — проведение фазового
анализа (контроль качества стереополя
и моносовместимости)

Если вы планируете воспроизводить музыку в монофоническом режиме (напри-
мер, по телевидению, которое в нашей стране станет стереофоническим еще очень не
скоро), то должны быть уверены в моносовместимости вашего звукового материала.

Моносовместимость важна и при воспроизведении музыкальных композиций
по радио, даже если передача ведется радиостанцией, осуществляющей стереофо-
ническое вешание. Все дело в том, что определенная часть аудитории любой ра-
диостанции принимает ее программы с помощью монофонических приемников.
Разработчики существующих стандартов формирования стереосигналов исходи-
ли из необходимости выполнения требования совместимости стереофонической
передачи с монофоническим оборудованием. Не случайно в эфир передаются не
сигналы левого и правого каналов (А и В), а их сумма (А + В) и разность (А — В).

В низкочастотный тракт монофонического приемника попадает лишь суммар-
ный сигнал, и вы можете, хоть и в монофоническом формате, но все же без каких-



334 _ Главе В

либо других потерь слышать все звучащие инструменты и голоса, в какой бы точ-
ке исходной стереопанорамы они не находились.

В декодер стереофонического радиоприемника попадают и суммарный, и раз-
ностный сигналы. Там эта парочка разводится по двум каналам обработки. В од-
ном канале сигналы, поступившие из эфира, складываются, а в другом — вычита-
ются. Не нужно быть профессиональным математиком для того, чтобы убедиться
в справедливости элементарных преобразований:

> (А + В) + (А - В) = 2А — выделен и усилен в 2 раза сигнал канала А
> (А + В) — (А - В) = 2В — выделен и усилен в 2 раза сигнал канала В

Несовместимость музыкальной композиции с монофоническим оборудованием
появляется тогда, когда компоненты звукового сигнала левого и правого каналов
оказываются в противофазе. При преобразовании стереосигнала в монофоничес-
кий сигналы левого и правого каналов суммируются и звуковые компоненты, на-
ходящиеся в противофазе, «гасят» друг друга, в результате чего возникают непри-
ятные на слух искажения. Партии некоторых инструментов могут вообще
«исчезнуть» из композиции. В первую очередь это утверждение относится к тем
партиям, которые панорамированы в центр.

В компьютерной музыке такая ситуация не может возникнуть сама по себе.
Как правило, она является следствием применения специальных эффектов, из-
меняющих фазу звукового сигнала.

При подготовке радио- и телепередач «Музыкальный компьютер» мы сталки-
ваемся с тем, что среди композиций, присланных нам, мононесовместимые встре-
чаются довольно часто. Возможно, это случайное совпадение, но особенно много
подобного брака приходится на треки тех авторов, которые используют програм-
му Fruity Loops, а также применяют обработки, расширяющие стереобазу.

Определить на слух моносовместимость фонограммы способен далеко не каж-
дый звукорежиссер. Для этой цели существуют специальные устройства — конт-
рольные дисплеи стереозвука, позволяющие анализировать множество параметров
звукового сигнала, в том числе и фазовые соотношения между одноименными
спектральными компонентами в разных каналах.

Один из таких приборов, выпускаемый фирмой DK-Audio, показан на рис. 8.6.
Большую часть его экрана занимает звуковой векторный осциллограф, или стерео-
гониометр, отображающий в реальном времени фазу и амплитуду стереосигнала в
виде фигур Лиссажу. Кроме того, фазовое соотношение сигналов левого и правого
канала отображается в виде столбиковой диаграммы в правой части дисплея.

Конечно, такие приборы имеются далеко не в каждой звукозаписывающей студии.
Когда в 1999 году мы работали над книгой «Музыка на PC. Cakewalk» [5], то,

посетовав на отсутствие программных аналогов подобных приборов, предложили
несложную и, конечно, грубую «бесприборную» методику выявления и устране-
ния мононесовместимости. Позже, в 2001 году, в книге «Музыкальный компью-
тер. Секреты мастерства» [8] мы привели краткое описание плагина PhaseScope,
который, являясь программной реализацией контрольного дисплея стереозвука,
входит в пакет Steinberg Mastering Edition. И вот теперь в Cool Edit Pro 2 появилась
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Рис. 8.6. Контрольный дисплей стереозвука
фирмы DК-Audio

Рис. 8.7. Окно Phase Analysis. Выбрана
система координат М — S

возможность контроля моносовместимости композиций с помощью встроенного
в программу виртуального стереогониометра — окна Phase Analysis (рис. 8.7), ко-
торое открывается командой Analize > Show Phase Analysis.

Виртуальный фазовый анализатор программы Cool Edit Pro 2 обладает функ-
циональными возможностями, которые реализованы далеко не во всех его «же-
лезных» собратьях (разве что в самых дорогих). Судите сами. С помощью окна
Phase Analysis можно:

> Проводить анализ в реальном времени
> Получать усредненную картину для всей волновой формы
>• Наблюдать мгновенную диаграмму, соответствующую текущему положению

маркера
> Исследовать выделенные фрагменты волновой формы, имеющие произволь-

ную протяженность во времени
> Отображать результаты измерений в двух различных системах координат
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Кроме координатного поля, и окне Phase Analysis еще есть только три элемента.

Normalize — кнопка, нажав которую, вы нормализуете результаты измере-
ния параметров сигнала таким образом, что изображение займет максималь-
но допустимую область координатного поля.
M-S — кнопка, предназначенная для переключения системы координат, в
которой графически отображаются результаты измерений. Выбор произво-
дится из двух вариантов: М — S (Моно - Стерео, см. рис. 8.7) и L - R (Левый
- Правый, рис. 8.8)
Samples — раскрывающийся список, позволяющий задать количество от-
счетов в анализируемом сигнале, на основе которых программа выполнит
быстрое преобразование Фурье и вычислит фазовые сдвиги. Чем больше
число, выбранное в этом списке, тем выше точность вычислений, но и тем
больше времени они займут.

Рис. 8.8. Окно Phase Analysis. Выбрана
система координат L — R

Окно Phase Analysis, как и рассмотренное в предыдущем разделе окно анализа-
тора спектра, немодальное, поэтому, когда оно открыто, можно работать с эле-
ментами управления, расположенными в главном окне. В частности, можно вос-
производить записанные волновые формы и наблюдать за игрой красок и форм
оживших графиков фазового анализатора. Кроме того, окно Phase Analysis плава-
ющее, поэтому его можно пристыковать к обрамлению главного окна (рис. 8.9).

Итак, с технической точки зрения применение окна Phase Analysis не составля-
ет труда: открыли — и смотрите. Вопрос в том, что можно здесь увидеть. Для того
чтобы ответить на него, потребуется, вспомнив школьный курс физики, разоб-
раться, прежде всего, в том, что такое фигуры Лиссажу, как они получаются и ка-
кую информацию в себе несут.

Фигурами Лиссажу называются траектории точки, одновременно совершаю-
щей гармонические колебания в двух взаимно перпендикулярных направлениях.
Траектория точки — замкнутая кривая, форма которой зависит от соотношений
амплитуд, частот и начальных фаз складываемых колебаний.
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Рис. 8.9. Окно Phase Analysis встроено в главное окно программы

Текущие координаты x(t) и y(t) точки определяются системой выражений:

y(t) =

где т и m — начальные фазы колебаний.

Фигуры Лиссажу вписываются в прямоугольник, центр которого совпадает с
началом координат, а стороны параллельны осям координат (ОХ и OY) и располо-
жены по оба направления от них на расстояниях, соответственно равных А2иА}.

Отношение частот рш и до) складывающихся колебаний равно отношению чис-
ла касаний (узловых точек) соответствующей им фигуры Лиссажу со стороной пря-
моугольника, параллельной оси OY, и со стороной, параллельной оси ОХ.

Во времена, когда об электронно-счетных частотомерах никто даже не мечтал, ла и
позже, когда они еще оставались большой редкостью, с помощью фигур Лиссажу изме-
ряли неизвестную частоту колебания, сравнивая ее с частой колебания эталонного.

Измерительным прибором может служить осциллограф. На пластины, откло-
няющие светящуюся точку экрана в вертикальном направлении, как обычно по-
дают исследуемое колебание. Но, в отличие от традиционного режима работы
прибора, на горизонтально-отклоняющие пластины электронно-лучевой труб-
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Суммарно-
разностный
преобразователь

Электронно-
лучевая трубка

Рис, 8.10. Схема, поясняющая принцип действия стереогониометра

ки не подают сигнал, создающий временную развертку наблюдаемого процесса.
Вместо него подключают эталонное гармоническое колебание. Наблюдая фигу-
ры Лиссажу, сравнивая их с образцовыми изображениями и подсчитывая узло-
вые точки, определяют разность фаз, отношение амплитуд и частот колебаний.

Описанный принцип действия лежит в основе стереогониометра. Виртуаль-
ный аналог прибора встроен в Cool Edit Pro 2, а доступ к нему осуществляется
посредством окна Phase Analysis. Работа стереогониометра поясняется схемой,
представленной на рис. 8.10.

На два входа прибора подаются сигналы левого (А) и правого (В) каналов. Сум-
марно-разностным преобразователем, выполняющим функцию, обратную функ-
ции стереодекодера радиоприемника, эти сигналы преобразуются в:

> Суммарный сигнал М = А + В (монофоническая компонента)
> Разностный сигнал S — А — В (стереофоническая компонента)

Усиленные сигналы подаются на пластины электронно-лучевой трубки: М -
на вертикально-отклоняющие, a S — на горизонтально-отклоняющие. Таким спо-
собом происходит сложение колебательных движений светящейся точки экрана в
двух взаимно перпендикулярных направлениях — в системе координат М - S
(Моно — Стерео), т. е. образуются фигуры Лиссажу.

Точно также действует и виртуальный стереогониометр программы Cool Edit Pro 2.
Правда, для него предусмотрен и еще один режим работы: на виртуальные от-

клоняющие пластины вместо суммарного и разностного сигналов подаются сиг-
налы левого и правого каналов, а графики, соответственно, строятся в системе
координат L — R (Левый — Правый).

С точки зрения информативности такие способы отображения результатов из-
мерения равноценны. Ведь между парой сигналов А, В, с одной стороны, их сум-
мой и разностью, с другой стороны, существует однозначная линейная связь. Изоб-
ражения одного и того же процесса, полученные в двух системах координат,
оказываются очень похожими друг на друга и отличаются, в основном, направле-
ниями своих осей. Иными словами, пользователю предоставляется выбор более
привычного варианта отображения результатов измерений.

Для того чтобы помочь вам освоить виртуальный стереогониометр программы
Cool Edit Pro 2, приведем вид фигур Лиссажу для нескольких характерных случаев.

На рис. 8.1 f представлено изображение на рабочем поле окна Phase Analysis
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(система координат М — S, Моно — Стерео) для ситуации, когда сигнал присут-
ствует только в левом канале (А* О, В = 0). На рис. 8.12 та же самая фигура Л исса-
жу отображается в другой системе координат и (L— R, Левый — Правый)

Заметим, что перед использованием окна Phase Analysis важно установить пра-
вильное соотношение его сторон. Очень скоро вы узнаете, что оценка моносовме-
стимости реального сигнала производится на основе сравнения средней высоты и
средней ширины изображения наблюдаемой сложной фигуры. Поэтому рабочее
координатное поле должно иметь форму квадрата.

Геометрические размеры окна, как обычно, изменяют, поочередно ухватыва-
ясь мышью за нижнюю и левую его границы. Равенство сторон координатного
поля можно установить «на глазок». Этого, в принципе, достаточно. Но если вы
захотите откалибровать ваш виртуальный измерительный прибор с высокой точ-
ностью, то советуем действовать следующим образом.

1. С помощью опций окна Generate Tones, которое открывается командой
Generate > Tones..., сгенерируйте стереофонический синусоидальный сиг-
нал. О том, как выполняется подобная операция, рассказано в разд. 7.4.

2. На рабочем поле главного окна выделите волновую форму одного из кана-
лов (например, правого) и примените команду Effects > Silence (см. гл. 6).
После этого сигнал правого канала заменится абсолютной тишиной. Таким
путем будет смоделирована ситуация А * О, В = 0.

3. Откройте окно Phase Analysis. Вы увидите картину, которая должна почти в
точности соответствовать рис. 8.11.

4. Изменяйте вертикальный и горизонтальный размеры окна в небольших
пределах, наблюдая за изменениями фигуры Лиссажу (в данном случае —

Рис. 8.11. Фигура Лиссажу. А * О, В
= 0, система координат М - S

Рис, 8.12. Фигура Лиссажу. А / О, В = 0, система
координат L - R
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наклонной красной л и н и и ) . Исчезновение малейших изломов на ней и по-
служит признаком «квадратное™» координатного поля.

На рис. 8.13 ирис. 8.14 (в системах координат М— S и L— R соответственно)
представлена фигура Лиссажу для ситуации, когда сигнал присутствует только в
правом канале (А = О, В Ф 0).

На рис. 8.15 и рис. 8.16 (в системах координат М — S и L— Rсоответственно)

Рис. 8.13. Фигура Лиссажу. А = О, В f О, система
координат М - S

Рис. 8.14. Фигура Лиссажу А - О, В * о, система
координат L - R

Рис. 8.15. Фигура Лиссажу. А = В, система
координат М - S

Рис. 8.16. фигура Лиссажу. А = В, система
координат L - R
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представлена фигура Лиссажудля ситуации, когда сигналы присутствуют в обоих
каналах, причем они равны (А = В).

На рис. 8J7 и рис. 8.18 (в системах координат М — S и L — R соответственно)
представлена фигура Лиссажу для ситуации, когда сигналы присутствуют в обоих ка-
налах, но один из них инвертирован по отношению к другому (например, А = - В).

На рис. 8.19 и рис. 8.20 (в системах координат М — S и L — R соответственно)
представлена фигура Лиссажу для ситуации, когда сигналы присутствуют в обоих

Рис. 8.17. фигура Лиссажу. А = - В, система
координат М - S

Рис. 8.18. Фигура Лиссажу. А = - В, система
координат L - R

Рис. 8.19. фигура Лиссажу. А > В, система
координат М - S

Рис. 8.20. Фигура Лиссажу. А > В, система
координат L - R
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каналах, но наблюдается разбаланс уровней (панорама смещена влево. А. > В).
На рис. 8.21 и рис. 8.22 (в системах координат М — S и L— Rсоответственно)

представлена фигура Л иссажу для ситуации, когда сигналы присутствуют в обоих
каналах, но наблюдается разбаланс уровней (панорама смещена вправо, А < В).

На рис. 8.23 и рис. 8.24 представлена фигура Лиссажу для ситуации, когда на-
блюдается разбаланс уровней и один из сигналов инвертирован (В = - kA, k < 1).

Рис. 8,21. фигура Лиссажу. А < В, система
координат М - S

Рис. 8.22. Фигура Лиссажу. А < В, система
координат L - R

Рис. 8.23. Фигура Лиссажу 8 = - kA, k < 1,
система координат М - S

Рис. 8.24. Фигура Лиссажу. В = - kA, k < 1, система
<оординат L - R
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На рис. 8.25 и рис. 8.26 (в системах координат М — S и L— R соответственно)
представлена фигура Лиссажу для ситуации, когда амплитуды сигналов равны (|А
= |В|), но имеется разбаланс фаз, ср = 30°.

На рис. 8.27 и рис. 8.28 (в системах координат М — S и L — R соответственно)
представлена фигура Л иссажу для ситуации, когда амплитуды сигналов различны

, |А| > В), и имеется разбаланс фаз, ф = 30°.

Рис. 8.25. Фигура Лиссажу IAI = IBI, ф = 30°,
система координат М - S

Рис. 8.26. фигура Лиссажу. IAI = IBI, <р = 30°
система координат L - R

Рис. 8.27. фигура Лиссажу. IAI
30°, система координат М - S

Рис. 8.28. Фигура Лиссажу. IAI № IB!, IAI > IBI, j
30°, система координат L - R
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На рис. 8,29 и рис. 8.30 (в системах координат М — S и L — R соответствен но)
представлена фигура Лиссажу для ситуации, когда амплитуды сигналов равны ([А!
= |В|), но имеется разбаланс фаз, (р = 90°.

На рис. 8.31 и рис. 8.32 (в системах координат М — S и L — R соответственно)
представлена фигура Лиссажу для ситуации, когда амплитуды сигналов равны (А| =
|В|), разность начальных фаз равна нулю, а частоты различны, причем fB = 2fA-

Рис, 8.29. Фигура Лиссажу IA! = IBI, ip = 90°,
система координат М - S

Рис. 8.30. фигура Лиссажу. IAI = IBI, ср = 90е

система координат L - R

Рис. 8.31. Фигура Лиссажу IAI = IBI, fB = 2fAl

система координат М - S
Рис. 8.32. фигура Лиссажу. IAI - IBI, f3

система координат L - R
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Надеемся, что рассмотренные тестовые примеры помогли вам разобраться в
сущности отображения сигналов в виде фигур Лиссажу. Конечно, при анализе
реальных фонограмм картина на координатном поле окна Phase Analysis выгля-
дит значительно сложнее. Ведь в ее формировании участвует не одна пара коле-
баний, а теоретически бесконечное их множество. Во всяком случае, спектр ре-
ального аудиосигнала чрезвычайно широк. И каждое колебание, имеюшееся в
спектре, характеризуется своими собственными параметрами: амплитудой, час-
тотой и начальной фазой. Причем все три параметра непрерывно изменяются
случайным образом. И все же опытные звукорежиссеры широко используют сте-
реогониометри его виртуальные аналоги в целях определения правильности пе-
редачи звуковой картины, распределения направлений на источники звука, на-
личия или отсутствия баланса, фазовых соотношений и моносовместимости
фонограммы.

При широкой стереобазе фонограмма является моносовместимой, если все
координатное поле окна Phase Analysis заполнено сложным многоцветным ри-
сунком с приблизительно одинаковыми размерами вдоль различных направле-
ний (рис. 8.33).

У фонограммы, характеризующейся узкой стереобазой, признак моносовмес-
тимости заключается в том, что фигуры на координатном поле в основном вытя-
нуты вдоль вертикальной оси (рис. 8.34).

Фонограмма мононесовместима, когда фигуры на координатном поле растя-
нуты вдоль горизонтального направления (рис. 8.35)

Рис. 8.33. Моносовместимая фонограмма с
широкой стереобазой

Рис. 8.34. Моносовместимая фонограмма с узкой
стереобазой
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Рмс. 8.35. Мононесовместимая фонограмма Рис. 8.36, Панорама сдвинута вправо

Рис. 8.37. Панорама сдвинута влево

Если большая ось изображения на координатном поле отклонена от вертика-
ли, то это является признаком нарушения стереобаланса: панорама сдвинута впра-
во (рис. 8.36) или влево (рис. 8.37).

Проанализируйте свои работы с помощью окна Phase Analysis. Скорее всего,
вы обнаружите много поучительного и увидите ошибки, о которых раньше и не
подозревали.
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8.3. Statistics — получение статистической
информации о волновой форме

Окно диалога Wafeform Statistics открывается командой Analyze > Statistics... и
состоит из двух вкладок:

> General — статистическая информация о параметрах волновой формы
> Histogram — гистограмма значений отсчетов волновой формы

Рассмотрим назначение элементов перечисленных вкладок.

8.3.1. Вкладка General

Вкладка General, содержащая статистическую информацию о выделенном зву-
ковом фрагменте (или обо всей волновой форме), показана на рис. 8.38.

i Waveform Statistics

General

Left

Mtninwn Sarrpte Value: (-31651

MaamimSampteVakie:p160D

PeakAfr¥»Bude;|-.29dB

Possibly Clipped Samples: |Q

DC Offset: (-.003*

Minimum RMS Power J-83 2Э dB

Maximum RMS Power P -2 dB

AvetageRMS Power:}-15.01 dB

Tola! RMS Power |-14.08dB

. Right . -

L±j -J-32W6

b>j" (32386

L±| h08*

"B t»
|-.Ш2й:

|_̂ j j-87.18dB";

|j>J (-6.se dB "

|-14.Б4 dB

j-iaeedB- '

Шa
a,
3 ^ .

_d
3

АйыёбйОер*:)^

Copy Data to Clipboard j

RMS Settings-—

f OdB = FS Sine Wave

S" QdB^FS Square Wave

\У Account fat DC

Window Widlh: 150

Recalculate RMS

ms

Help

Рис. 8.38. Вкладка Genera!

окна диалога Wafeform
Statistics

В колонках для левого и правого каналов представлена следующая информации;

> Minimum Sample Value — минимальное значение звукового отсчета
> Maximum Sample Value — максимальное значение звукового отсчета



548 Глава 8

> Peak Amplitude — пиковая амплитуда сигнала
> Possibly Clipped Samples — количество отсчетов, имеющих уровень макси-

мального или минимального кванта (клиппированных отсчетов)
> DC Offset — среднее значение отсчетов (уровень постоянной составляющей

в выделенном фрагменте волновой формы)
> Minimum/Maximum RMS Power — минимальные и максимальные среднеквадра-

тические значения сигнала [8|
> Average RMS Power, Total RMS Power — варианты среднеквадратических зна-

чений сигнала
> Actual Bit Depth — фактическая разрядность представления звуковых данных

Группа RMS Settings содержит опции, определяющие порядок измерения и
вычисления среднеквадратического значения сигнала:

> OdB = FS Sine Wave — если выбрана эта опция, среднеквадратическое значе-
ние сигнала измеряется таким образом, что синусоида максимально допус-
тимой амплитуды будет соответствовать 0 дБ RMS.

> OdB = FS Square Wave — если выбрана эта опция, среднеквадратическое зна-
чение сигнала измеряется таким образом, что последовательность прямоу-
гольных импульсов максимально допустимой амплитуды будет соответство-
вать 0 дБ RMS. Так как при равных амплитудах субъективная громкость пос-
ледовательности прямоугольных импульсов на 3 дБ выше, чем громкость
синусоидального колебания, то при переключении опций OdB = FS Sine Wave
и OdB = FS Square Wave происходит коррекция среднеквадратического зна-
чения сигнала на 3 дБ.

> Account for DC — если этот флажок установлен, то при вычислениях будет
учтено наличие в аудиосигнале постоянной составляющей

В поле RMS Window Width_ ms вы можете изменить размер временного окна, в
котором программа измеряет RMS при поиске минимальных и максимальных
значений.

Если вы решите изменить объемы выборок, то перерасчет среднеквадратичес-
кого отклонения произведется после того, как будет нажата кнопка Recalculate RMS.

Напротив большинства полей расположены кнопки, помеченные символом ->.
При нажатии такой кнопки маркер в волновой форме устанавливается на отсчет,
соответствующий тому или иному параметру.

Если вы хотите сохранить значения параметров в файле для того, чтобы в даль-
нейшем получить распечатку или вставить данные, например, в документ Microsoft
Word, воспользуйтесь кнопкой Copy Data to Clipboard. Содержимое вкладки будет
скопировано в буфер обмена. Ниже приведен текст, который получен таким спо-
собом в окне, представленном на рис. 8.38.

Left Right
Min Sample Value: -31651 -32446
Max Sample Value: 31600 32386
Peak Amplitude: -.3 dB -.09 dB
Possibly Clipped: О С
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DC Offset:

Minimum RMS Power:

Maximum RMS Power:

Average RMS Power:

Tonal RMS Power:

Actual Bit. Depth:

'Jsina RMS Window of 50 rr.s

8.3.2. Вкладка Histogram

Вкладка Histogram, содержащая гистограмму значений отсчетов выделенного
фрагмента волновой формы, показана на рис. 8.39.

Waveform Statistics

Genera! Histogram

-RMS Settings —

С OdB=FS Sine Wave Window Width: J50

Recalculate RMS

Рис. 8.39. Вкладка Histogram
окна диалога Wafeform
Statistics

Гистограмма — широко распространенная (особенно в вероятностном анали-
зе) форма представления информации о каком-либо процессе. В данном случае
гистограмма представляет собой график зависимости количества отсчетов, сред-
неквадратическое значение которых попадает в заданный интервал, от величины
отсчета, выраженной в децибелах. Не очень понятно? Поясним. На рис: 8.39 пред-
ставлена гистограмма монофонической волновой формы, в которой содержится
синусоидальный сигнал, сформированный с помощью команды Generate > Tones....
В рассматриваемом случае заранее известно, что при формировании сигнала его
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амплитуда была установлена равной -3,2 дБ. Гистограмма совершенно верно от-
ражает этот факт. Действительно, все 100% отсчетов попадают в интерьал от—3,25
до —3,20 дБ. Отсчетов с большими значениями в анализируемом сигнале нет. Если
вы захотите преобразовать амплитуду такого сигнала (.усилить его), то можете смело
установить любой коэффициент усиления, не превышающий 3,2 дБ (см. гл. 6).
Искажения не появятся.

Точно так же можно анализировать те сигналы, свойства которых не известны
заранее. Результаты анализа пригодятся для принятия решения при любых пре-
образованиях амплитуды, например, при усилении сигнала или сжатии его дина-
мического диапазона. Приведем еще один пример. На рис. 8.40 представлена вол-
новая форма реального речевого сигнала.

:!е Edft View EFfetts Generate Ana^ze Favorites

Рис. 8.40. Волновая форма реального речевого сигнала

Статистические сведения об этом сигнале выглядят следующим образом.

Min Sample Value:

Max Sample Value:

Peak Amplitude:
Possibly Clipped:
DC Offset:
Minimum RMS Power:
Maximum RMS Power:

Average RMS Power:

Mono

-15467
18242

-5.09 dE

0

0

-65.29 dB
-9.18 dB

-25.32 dB
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Значение параметра Total RMS Power мало (—22.45 дБ). Речь будет звучать очень
тихо по сравнению, например, со звучанием музыки, наложенной с компакт-дис-
ка поверх речи.

Проанализируем гистограмму этого сигнала (рис. 8.41) и примем решение о
том, как оптимально его обработать. Хорошо бы при минимальных искажениях
максимально увеличить среднюю энергию сигнала (а тем самым и субъективно
ощущаемую громкость) и уменьшить уровень шума.

•RMS Settings
<Г OdB-FS Sine Wave

'*""' OdB = FS Square Wave

F AecomtforDC

Рис. 8.41. Гистограмма
волновой формы реального
речевого сигнала

Во-первых, настораживает немонотонное поведение графика приуменьшении
уровня сигнала (большие значения элементов гистограммы в области от -55 до —
65 дБ). Похоже, эта волновая форма записана либо в неблагоприятных шумовых
условиях, либо была использована аппаратура с высоким уровнем собственных
шумов. Принимаем решение: отсчеты, значение которых меньше —55 дБ, — это
шум. Поэтому одним из этапов динамической обработки может быть пороговое
шумоподавление, причем порог нужно выбрать равным -55 дБ.
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Во-вторых, из анализа гистограммы следует, что доля отсчетов, уровень которых
превышает — 12дБ, чрезвычайно мала. Поэтому положительный результат может
дать ограничение сигнала на уровне —12 дБ с последующим усилением на 12 дБ.

После завершения каждой из процедур динамической обработки есть смысл
проконтролировать результат на слух и убедиться, что вы идете по верному пути.



Глава

МЕНЮ FAVORITES - СОЗДАНИЕ СПИСКА
НАИБОЛЕЕ УПОТРЕБИМЫХ ОПЕРАЦИЙ

До тех пор пока вы не воспользовапись командой Edit Favorites..., в меню Favorites
она остается единственной. В дальнейшем в этом меню может появиться еще очен ь
много команд. Вы сами их создадите: присвоите им имена и определите их содер-
жание. Потом с помощью этих команд станете применять те операции, которые
вы часто используете при обработке звуковых данных.

Командой Favorites > Edit Favorites...открывается окно диалога, также называе-
мое Favorites (рис. 9.1).

О каких фаворитах здесь идет речь? В данном случае это наиболее часто упот-
ребляемые вами операции редактирования звуковых данных иди наиболее часто
используемые приложения Windows. Окно диалога Favorites предназначено для того,
чтобы облегчить, ускорить, в определенной степени автоматизировать применение

:

123

Pless new shortcut kej".

Function jsaipt | Tool | Help j

•Cool Edit E fleet

Рис. 9.1. Окно диалога Favorites зкладка Function
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операций-фаворитов. С помощью среде™ окна можно создавать, удалять, редакти-
ровать и организовать пункты, появляющиеся в меню Favorites. Каждый такой пункт
будет соответствовать либо отдельной операции, либо последовательности опера-
ций, либо команде вызова внешней программы (приложения MS Windows).

Создание списка фаворитов начинается с ввода имени фаворита в поле Name.
Поле расположено в верхней части группы Properties. Иерархические меню следу-
ет создавать, используя символ левой наклонной черты. Например, если записать
имя Effects\HalI Reverb, то в подменю Effects появится пункт Hall Reverb.

С помощью поля ввода Press new shortcut key можно выбрать горячие клавиши,
при нажатии которых будут выполнены операции, соответствующие текущему
фавориту. Допускается комбинирование функциональных клавиш с клавишами
<Ctrl>, <Shift>, <Alt>. Кнопкой Clear в случае необходимости удаляют комбина-
цию клавиш, введенную в поле Press new shortcut key.

Ниже строки Press new shortcut key расположены вкладки, позволяющие опре-
делить ту последовательность операций, которая будет выполняться после вызова
определенного фаворита.

Вкладка Function предназначена для выбора в качестве фаворита одной из опе-
раций, встроенных в Cool Edit Pro. Возможные операции перечислены в раскры-
вающемся списке Cool Edit Effect. Если говорить точно, то в этом списке содер-
жатся все обработки и эффекты, доступ к которым осуществляется из меню Effects
командами Amplitude, Delay Effects, Filters, Noise Reduction, Special и Time/Pitch.
Первая строка списка соответствует команде Amplitude > Amplify, а последняя —
Time/Pitch > Stretch.

Под раскрывающимся списком находится поле, в котором через запятую пере-
числены значения параметров, установленные в окне соответствующей обработ-
ки или эффекта. Например, цифры, которые вы видите в этом поле на рис. 9.1,
применительно к выбранной обработке (Amplify) означают следующее.

> 1, 41254 — усиление сигнала составляет 3 дБ (параметр Amplification равен
3 дБ), усиление сигнала в начальной точке выделенного участка волновой
формы составляет 3 дБ (параметр Initial Amplification равен 3 дБ), усиление
сигнала в конечной точке выделенного участка волновой формы составляет
3 дБ (параметр Final Amplification равен 3 дБ).

> 1, О, О, О, 1 — состояние флажков и опций Linear Fades, Logarithmic Fades,
View all Settings in dB, DC Bias и Normalisation (1 соответствует выбранной
опции или установленному флажку, а 0 — невыбранной опции или сбро-
шенному флажку).

Для того чтобы оперативно изменить параметры обработки, воспользуйтесь
кнопкой Edit Settings.... В рассматриваемом примере откроется окно Amplify, в ко-
тором и следует изменить необходимые параметры. Затем для обновления значе-
ний параметров команды-фаворита обязательно нужно нажать в окне Favorites
кнопку Save. После того как был применен фаворит, становится доступной кноп-
ка Copy From Last. Если ее нажать, все параметры настройки будут скопированы с
последней успешно завершенной обработки.
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При установленном флажке Show Dialog после выбора одного из фаворитов из
меню Favorites откроется соответствующее окно обработки или эффекта, тогда вы
сможете подкорректировать параметры. В противном случае окно не открывает-
ся, и программа сразу же приступает к реализации обработки.

Если установлен флажок Use Current Settings, то при обработке будут исполь-
зованы текущие параметры настроек.

Вкладка Script (рис. 9.2) предназначена для организации сценариев (группы пос-
ледовательно выполняемых операций). Сценарии создаются с помощью команды
Scripts & Batch Processing... меню Options (см. разд. 10.]).

'Favorites

; Effect; *

•; Reveib
=' Chorus
'
• Edit

'• Compressor
"i Filter

!l -3
~; Scripts

« Тсю!

' Sow
• Word
: Visual Arranger
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• ; ' ' • ' ' . . ' . ' • .
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Рис. 9.2. Вкладка Script окна диалога Favorites

Чтобы загрузить сценарий (хранящийся в файле с расширением SCP). следует
нажать кнопку Choose Script File.... Откроется стандартное окно загрузки файлов.
Используя это окно, найдите и загрузите файл, содержащий необходимый сцена-
рий. В поле Script Collection File появится полный путь к загруженному файлу, а в
поле Script — имя сценария.

Сценарий может включать в себя длинную цепочку команд. Каждая команда
соответствует определенной операции редактирования звуковых данных. Если
вы хотите, чтобы сценарий выполнялся без вашего участия, то не устанавливай-
те флажок Pause at Dialogs. Если данный флажок установлен, перед выполнени-
ем каждой очередной операции будет открываться соответствующее окно диа-
лога. Конечно, это удобно, когда требуется корректировка значений параметре и
обработки, однако вы оказываетесь привязанным к компьютеру в течение всего
вре\1ени выполнения сценария. Ведь для совершения каждого очередного шага
обработки вам потребуется, как минимум, нажать кнопку ОК в появляющемся
окне диалога.

Вкладка Tool (рис. 9.3) позволяет включать в число фаворитов команды, кото
рыми открываются любые приложения Windows. Эти приложения не обязательно
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• i

С от рг ess ш
,

3
Scri^t:-

Fijnctton | Script Тиз! j Help ]

Command Sine -

Рис. 9.З. Вкладка Tool окна диалога Favorites

должны быть предназначены для обработки звуковых данных. Вы можете запрог-
раммировать пункты меню Favorites или горячие клавиши для того, например, что-
бы ими запускался MS Word.

Вкладка Tool превращает меню Favorites в приспособление для удобной работы
не только с командами-фаворитам и обработки звука редактора Cool Edit Pro, но и
с наиболее часто применяемыми нами программами, установленными на компь-
ютере. Чтобы воспользоваться вкладкой, нужно задать имя приложения-фавори-
та. Затем в поле Command Line нужно указать путь к исполняемому файлу, запус-
кающему данное приложение. Если вы не помните наизусть путь к файлу, нажмите
кнопку, помеченную тремя точками. В открывшемся окне диалога, очень похо-
жем на стандартное окно загрузки, отыщите необходимый файл и нажмите кноп-
ку ОК. Путь к файлу появится в поле Command Line.

Итак, вы выбрали:

> Операцию, имеющуюся в Cool Edit Pro
> Сценарий
> Внешний инструмент обработки (приложение Windows)

Выбранному объекту было присвоено имя. Теперь следует нажать кнопку Save.
Имя объекта отобразится в списке (Favorites List). После закрытия окна Favorites
одноименная команда появится и в меню Favorites. Теперь можно применять ее
для выполнения необходимой обработки или последовательности обработок.
Пользуясь окном Favorites, вы п о с т е п е н н о заполните меню Favorites всеми важ-
ными для вас командами. Для их выполнения вам не придется больше обращаться
к другим меню. Наиболее часто употребляемые команды будут связаны с горя-
чими клавишами, что создает необходимый комфорт и повышает производи-
тельность труда (особенно тогда, когда вам часто приходится выполнять одно-
т и п н ы е операции).



Меню FAVORITES — создание списка наиболее употребимых операций

To oeate a separator bar,
name, like this: —

create з ;«b menu, use a backslash af lei the sub menu
name, fike ihis: Efiecls\Cod1

Рис. 9.4. Вкладка Help окна диалога Favorites

Для перемещения команды вверх по списку воспользуйтесь кнопкой Up, вниз —
кнопкой Down. Кнопка Delete предназначена для удаления команды из Favorites
List и соответственно из меню Favorites.

Вкладка Help (рис. 9.4) не содержит ни одной опции. Здесь вы увидите только текст,
поясняющий использование символов-разделителей для структурирования меню.

В примере предлагается отделять одну функционально однородную группу команд
меню от другой группы линиями, содержащими различное число черточек. На самом

деле в поле Name вы можете ввести любое имя, которое може г
служить заголовком в списке команд меню Favorites. Строго
говоря, этот заголовок также будет командой, но только пус-
той, т. е. такой, вызов которой не приводит к выполнению
программой или системой каких-либо действий. Пример
сформированного меню Favorites представлен на рис. 9-5.

Горизонтальные линии формируются в том случае, ког-
да в качестве разделителя вы ввели не менее трех символом
<-> (минус). Длина линии не зависит от числа этих симво-
лов. Вместо того чтобы вводить длинную цепочку симво-
лов <->, можно ввести лишь три таких символа и следом за
ними номер разделительной линии, например:

-01
-02

-03

Beverb

Chorus

Edit

Compressor

flter

Scripts

Crossfade

Tool

Sonar

Word

Visual Arranger

Edit Favorites.

Каждая из таких записей сформирует в меню Favorites
разделительную горизонтальную линию, причем номер ли-
нии программой игнорируется.

Рис. 9.5. Вариант заполненного меню Favorites
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Обращаем ваше внимание на то, что два одинаковых имени фаворита или два
одинаковых обозначения разделителя ввести нельзя. Например, нельзя ввести
разделитель, содержащий одинаковое число символов <->. Если в поле Name вы
наберете такую последовательность символов, которая уже использована в спис-
ке фаворитов, то после нажатия кнопки Save появится запрос о подтверждении
записи фаворита в список. Это и будет «намеком» на необходимость выбрать дру-
гое имя фаворита или обозначение разделителя.
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МЕНЮ OPTIONS - ОПЦИИ

В меню имеются следующие команды и подменю:

> Loop Mode — включение циклического воспроизведения клавишей <Пробел >
> Timed Record Mode — включение записи по таймеру (см. разд. 2.2)
> Monitor Record Level — включение измерителя уровня сигнала. Вместо вы-

бора этой опции можно в главном окне сделать двойной щелчок на измери-
теле уровня

> Show Levels on Play and Record — отображение уровня сигнала не только в
режиме записи, но и в режиме воспроизведения

> MIDI Trigger Enable — включение режима управления программой по MIDI -
интерфейсу. Установка параметров режима производится с помощью коман-
ды Shortcuts (Keyboard&MIDI Triggers)...

> Syncronize Cursor Across Windows — включение режима сохранения место-
положения курсора или выделенного участка волновой формы при перехо-
де от одного открытого файла к другим (полезно при монтаже фонограмм).
Пусть данная опция выбрана, вы работаете с файлом 1. wav и выделили фраг-
мент, заключенный в интервале от 0:01:00 до 0:02:00. Если затем переклю-
чить главное окно на просмотр файла 2.wav, то в этой волновой форме так-
же будет выделен фрагмент 0:01:00—0:02:00

> Windows Recording Mixer... — вызов окна диалога стандартного микшера
Windows

> Start Default Windows CD Player — запуск CD-плеера, предусмотренного в
Windows по умолчанию

> Scripts & Batch Processing... — редактирование списка операций обработки
сигнала(сценария)

> Settings... — установка параметров и режимов функционирования программы
> Device Properties... — выбор устройств записи и воспроизведения
> Device Order... — редактирование списков устройств записи и воспроизведения
> Shortcuts (Keyboard&MIDI Triggers)... — выбор горячих клавиш (на компь-

ютерной и MIDI клавиатурах)
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Применение команд Settings..., Device Properties..., Device Order и Shortcuts
(Keyboard&MIDI Triggers)... в процессе подготовки программы к работе рассмот-
рено в главе 1.

В ранних версиях программы с помощью команды Loop Mode включается
или выключается циклический режим воспроизведения выделенного звуко-
вого фрагмента или всей волновой формы. Если данная опция выбрана, то
кнопка Play, расположенная в главном окне программы, изменяет свое на-
звание на Loop.

Начиная с версии Cool Edit Pro 1.2, для включения циклического режима пре-
дусмотрена отдельная кнопка на панели управления. В меню Options имеется ко-
манда Loop Mode, ею включается циклический режим при запуске программы на
воспроизведение или запись с помощью клавиши <Пробел>.

10.1. Scripts & Batch Processing.,. — редактирование
списка операций обработки сигнала

Команда Options > Scripts & Batch Processing,., вызывает окно диалога Scripts
and Batch Processing (рис. 10.1), которое предназначено для создания, редактиро-
вания записей последовательностей операций (сценариев) и их выполнения.

! Scripts and Botch Processing

- i r-Mew Script- —

" Open / New Colectionj '•"'• . •'

{ - ]My lovely processing

Record

W £ause at Dialogs

v* £Jefl when complete

Г EiKcuteHelafc .

Enter title and cfck Recofd to.
make a new sciipt.

Scripi Works on
Highlgbted Setertbn

Hdp

:Cloie ̂

Рис. 10.1, Окно диалога Scripts and Batch Processing
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Слово «запись» в данном случае является синонимом слова «макрос». Было бы
правильнее говорить не «макрос», а «последовательность макрокоманд» или «пос-
ледовательность команд высокого уровня». Макросы бывают очень полезны тог-
да, когда приходится многократно выполнять одну и ту же последовательность
действий. Такой последовательностью может быть динамическая обработка сиг--
нала, фильтрация, наложение эффектов и т. п. Достаточно один раз, воспользо-
вавшись механизмом записи макросов, зафиксировать последовательность дей-
ствий, чтобы в дальнейшем выполнять ее с помощью всего одной команды
Макросы можно записать в файл, чтобы хранить их на диске. Вместо слова «мак
рос» можно употреблять термин «сценарий».

Прежде чем записывать сценарий обработки (с помощью кнопки Record), вы
должны дать ему название в поле ввода Title. До тех пор пока у сценария нет име-
ни, кнопка Record неактивна.

В процессе записи сценария обработки звуковых данных вы выполняете ка-
кую-либо последовательность действий в главном окне. Можно пользоваться ко-
мандами главного меню, открывать различные окна, устанавливать значения па-
раметров. Все это программа запомнит. После завершения необходимых операций
нужно возвратиться в окно диалога Scripts and Batch Processing и нажать кнопку
Stop Current Script, тогда запись данного сценария будет закончена. Если вы по
каким-то причинам решили избавиться от уже записанного сценария, нажмите
кнопку Clear.

В поле текстового редактора, расположенном в нижней части окна, вы можете
написать комментарии к записанному сценарию.

С помощью кнопки «Add to Collection« сценарий добавляется в список сце-
нариев, который сохраняется на диске с помощью кнопки Open/New Collection,
Используя эту же кнопку, можно загрузить ранее сохраненный файл, содержащий
сценарий. Кстати, в комплект Cool Edit Pro входит пять файлов (коллекций) сце-
нариев, демонстрирующих возможности программы.

Вообще говоря, кроме облегчения рутинной работы, сценарии предоставляют воз-
можность обмениваться с коллегами не только файлами с аудиоданными, но и техно-
логиями их обработки по Internet или даже посредством обыкновенных дискет.

Три поля, расположенных в нижней части окна, указывают тип текущего сце-
нария:

> Script Starts from Scratch — сценарий начинается до создания волновой формы
> Script Works on Current Wave — сценарий применяется к текущей волновой

форме
> Script Works on Highlighted Selection — сценарий применяется к выделенно-

му фрагменту волновой формы

Название типа текущего сценария выделяется черным шрифтом. А оставшие-
ся два названия остаются «затуманенными».

Итак, существует специальный тип сценариев, позволяющий обрабатывать
последовательность из нескольких звуковых файлов (нажатием на кнопку Batch
Run). Чтобы создать такой сценарий, не следует изначально привязывать его к
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какому-либо определенному файлу: перед нажатием Record в Cool Edit Pro не дол-
жно быть загруженного файла (воспользуйтесь командой File > New...).

В дальнейшем на встроенном в Cool Edit Pro специальном языке программи-
рования вы можете отредактировать макрос, хранящийся в виде последователь-
ности команд. Для этого нажмите кнопку Edit Script File. Откроется окно тексто-
вого редактора Блокнот (рис. 10.2).

• Untitied - Блокнот

Оравкй Формат Вид
Collection: New collection
Title: My lovely processing
Description:
Mode: 4

selected: 0 to 19344 scaled 19844 SR 22050
and: channel Both

Selected: 0 to 19844 scaled 19844 SR 22050
cmd: Noise Reduction\Noise Reduction
1: 1
2: 0
3
:
5
6
7

4096
300
7
22050
2
.

LO:
LI:
12:
L3:
L4:

J.'. :

1.1059e-OQS
4.01125e-006
1.147816-009
4.G5497e-GQ6
300

Рис. 10.2. Окно редактора Блокнот с
текстом сценария

Разобраться в тексте сценария не так уж и сложно. Здесь последовательно указаны:

> Границы выделенного фрагмента волновой формы
> Название очередной процедуры обработки
> Необходимые пояснения
> Значения параметров обработки или эффекта

Чтобы выполнить сценарий, выберите его из списка в окне Scripts and Batch
Processing и нажмите кнопку Run Script.

Если установлен флажок Pause at Dialogs, то в ходе выполнения сценария про-
грамма будет останавливаться перед началом очередной обработки. В открывшемся
соответствующем окне диалога вы сможете изменить необходимые параметры.
Если флажок Pause at Dialogs сброшен, то процесс обработки будет непрерывным.

При установленном флажке Alert when complete, завершив выполнение сцена-
рия, программа подаст звуковой сигнал.
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Если установлен флажок Execute Relative to Cursor, то программа назначит с
учетом текущего положения маркера позицию, с которой начнется обработка по
сценарию. Пусть имеется сценарий, первоначально записанный так, что обработка
начиналась с позиции маркера 0:10:00. Тогда, если данный флажок установлен.
волновая форма будет обрабатываться по сценарию с точки, отстоящей от теку-
щего положения маркера вправо на 10с. Например, если маркер находится в по-
зиции 0:05:00, то обработка начнется с позиции 0:15:00. Если флажок Execute
Relative to Cursor сброшен, то в нашем примере сценарий будет выполняться с
позиции 0:10:00.

Чтобы не запутаться и гарантировать выполнение обработки по сценарию с
текущей позиции маркера, перед записью любого сценария маркер лучше помес-
тить в позицию 0:00:00, а до начала выполнения сценария установить флажок
Execute Relative to Cursor.

10,2, Shortcuts (Keyboard&MIDI Triggers)..* — выбор
горячих клавиш

Cool Edit Pro предоставляет широкие возможности управления программой с
помощью горячих клавиш. Многие пользователи считают, что по-настоящему
эффективна работа именно с горячими клавишами, а не с мышью. Опишем соот-
ветствие горячих клавиш основным операциям.

Клавиши управления файлами:

> <Ctrl>+<N> — создать новый файл (New...)
> <Ctrl>-f-<O> — открыть существующий файл (Open...)
> <Ctrl>+<W> — закрыть текущий файл (Close)
> <Ctrl>+<S> — сохранить текущий файл на диск (Save)
> <Ctrl>+<Q> — выйти из Cool Edit Pro (Exit)

Клавиши управления выделением фрагмента волновой формы:

> <Ctrl>+<A> — выделить текущую волновую форму
> <Ctrl>+<B> — разрешить редактирование обоих каналов
> <CtrI>+<L> — разрешить редактирование левого канала
> <CtrI>+<R> — разрешить редактирование правого канала
> <<-> — передвинуть маркер на один отсчет влево
> <—*> — передвинуть маркер на один отсчет вправо
> <Shift>+<^-> — передвинуть границу выделенного фрагмента на один от-

счет влево
> <Shift>+<->> — передвинуть границу выделенного фрагмента на один от-

счет вправо
> <Ctrl>+<Shift>+<A> — выделить все открытые волновые формы
> <Escape> —- отменить выделение и возвратить маркер в нулевую позицию
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Клавиши управления редактированием:

> <Ctrl>+<Z> — отменить ранее выполненную операцию (Undo)
> <F2> — повторить последнюю операцию (откроется окно диалога)
> <F3> — повторить последнюю операцию (окно диалога не откроется)
> <Ctrl>+<C> — скопировать выделенный фрагмент во внутренний буфер

обмена
> <Ctrl>+<X> — вырезать выделенный фрагмент и поместить его во внутрен-

ний буфер обмена
>• <Ctrl>+< V> — вставить данные из внутреннего буфера обмена (или из сис-

темного буфера обмена, если внутренний буфер пуст)
> <Ctrl>+<Shift>+<N> — открыть новый файл и вставить в него данных из

внутреннего буфера обмена
> <Ctr!>+<Shift>+<V> — выполнить команду Mix paste...
> <Ctrl>+<M> — вставить выделенный фрагмент волновой формы в мульти-

трековую среду
> <Delete> — удалить выделенный фрагмент
> <Shift>+<Delete> — вырезать выделенный фрагмент
> <Ctrl>+<T> — удалить всю волновую форму, за исключением выделенного

фрагмента
> <FU > — открыть окно диалога Convert Sample Type
> <Ctrl>+<!> ... <Ctrl>+<5> — выбрать один из пяти внутренних буферов

обмена

Клавиши управления записью и воспроизведением:

> <Space> — переключение режимов Play / Stop
> <Ctrl>+<Space> — переключение режимов Record / Pause
> <Shift>-b<Space> — воспроизведение волновой формы, начиная с позиции

маркера
> <Ctrl>+<Shift>-(-<Space> — воспроизведение волновой формы, начиная с

нулевой позиции
> <Alt>+<P> — включение режима Play
> <Alt>+<S> — включение режима Stop

Клавиши управления отображением и масштабом:

> <F12> — переключение главного окна в режимы \\fcveform View/Multitrack View
> <Home> — перемещение участка, отображаемого на экране, к началу вол-

новой формы
> <End> — перемещение участка, отображаемого на экране, к концу волно-

вой формы
> <Ctrl>+<End> — изменение масштаба отображения справа от выделенно-

го фрагмента или позиции маркера
> <Ctrl>+<Home> — изменение масштаба отображения слева от выделенно-

го фрагмента или позиции маркера
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> <Alt>+<T> —увеличение масштаба отображения по вертикали
> < Alt >+<i> — уменьшение масштаба отображения по вертикали
> < Alt >+<—>> — увеличение масштаба отображения по горизонтали
> < Alt >-f-<^> — уменьшение масштаба отображения по горизонтали
> <Page Down> — прокрутка волновой формы вперед (при условии, что на

экране отображается лишь фрагмент волновой формы)
> <Page Up> — прокрутка назад волновой формы (при условии, что на экране

отображается лишь фрагмент волновой формы)

Клавиши специального назначения:

> <FI> — вызов помощи
> <F4> — вызов окна диалога Settings
> <F6> — включение управления программой по MIDI
> <F7> — включение программы в режим ведомой по SMPTE
> <F8> —добавление позиции курсора или границ выделенного фрагмента в

список Cue List
> < F10> — активизация измерителя уровня сигнала
> <AJt>+<Z> — вызов окна анализатора спектра
> <Ctrl>+<Tab> — переход к следующей странице, содержащей открытую

волновую форму
> <Ctrl>+<Shin>+<Tab> — переход к предыдущей странице, содержащей от-

крытую волновую форму

Именно такое закрепление горячих клавиш предусмотрено по умолчанию. Но, во-
первых, его можно изменить, а, во-вторых, существует возможность расширить пере-
чень функций, управляемых горячими клавишами. Кроме того, в качестве горячих
клавиш можно задействовать не только компьютерную, но также и MIDI-клавиатуру.

Командой Shortcuts (Keyboard&MIDI Triggers)... открывается окно диалога
(рис. 10.3.), предназначенное для выбора горячих клавиш.

В левой части окна расположен список. В нем перечислены те функции, кото-
рыми можно управлять с помошью горячих клавиш. Для облегчения поиска инте-
ресующей вас функции вы можете воспользоваться раскрывающимся списком
Category. Кнопками Multitrack и Edit View выбирают для отображения и редакти-
рования либо список функций, присущих мультитрековому режиму, либо — ре-
жиму редактирования отдельных волновых форм.

Назначение горячих клавиш компьютерной клавиатуры функции, выделенной
в рабочем списке, производится с помощью опций группы Shortcut Key. Щелкнув
на поле Press new shortcut Key: левой кнопкой мыши, нужно нажать одну из клави-
ши компьютерной клавиатуры.

Путем установки флажков Ctrl. Shift, Alt можно назначить для функции не одну
горячую клавишу, а комбинацию из 2-х и 3-х клавиш.

Если в списке выделить ту функцию, для которой по умолчанию имеются горячие
клавиши, то они отобразятся в группе Shortcut Key. Если по умолчанию горячие клави-
ши для функции не предусмотрены, то папе Press new shortcut Key: останется пустым.
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IShortcuts (Keyboard & MIDI Trlogers) *j
MulttlracK

.Copland Name

Adjust Selection Left Side to the Right
Adjust Selection Right Side to the Lett
Adjust Selection Right Side to the Right
EdftAddlndexMarker
Edil Add to Cue List
EditAddTrackMarker
Edit Adjust Channel Left / Track Up
EdilAdjust Channel Righl/TrackDown
EditBlockAdjuslWavePan
Edil Bbck: Adjust Wave Volume
Edit Block: Allow Multiple Takes toggle
Ed* Block: Convert to Unique Copy
Edit Block: Edit Waveform
Edit В lock: Loop Duplicate
Edit Block: Loop Properties
Edit Block: Merge/Rejoin Spit
Edit Block: MIDI Set Controller 7
Edit Block: MIDI Set Tempo
Edit Block: MIDI Zoom In/Oul
ЕЛ Block. Wave Block Properties
Edit Blocks: Adjust Boundaries
Edit Blocks: Align Left
EdkBlocks:AlignRight
ЕсЙ Blocks. Block Color
Edit Blocks: Block Color [Decrement!

.Shortcut

.1
К

СЫ+Р8
F8
shitt+F6

Down Arrow

MlDITiigger ]-^
-Shortcut Key----r-—

Press new shortcut key:

. Piess.n̂ i MIDI note or
adiuslriew coniwier/vakie:

Clrl*K
Cbi+Shitt+Down .

[This cotwia*d'rur« wfite tfe shortcut fee îs [Sessed,-

Рис. 10.3. Окно диалога Shortcuts (Keyboard&MIDI Triggers)

Если у вас есть MIDI-клавиатура и вы не хотите отвлекаться от нее в процессе
работы с Cool Edit Pro, то можете вместо горячих клавиш компьютерной клавиа-
туры пользоваться горячими MIDI-клавишами и даже «горячими элементами уп-
равления MIDI-контроллерами» (колесами, кнопками, слайдерами, рукоятками,
расположенными на MIDI-клавиатуре, или подключенными к ней педалями). Их
назначение производится в группе MIDI THgger. Чтобы опции данной группы стали
доступны, в меню Options следует установить флажок MIDI IVigger Enable. В рас-
крывающемся списке Channel; нужно выбрать один из 16-и MIDI-каналов.

Для того чтобы задействовать подключенную MIDI-клавиатуру, достаточно
нажать на ней клавишу.

Если вы попытаетесь назначить некоторой функции горячие клавиши, уже за-
действованные для управления другой функцией, то в поле Conflicting Keys: появит-
ся сообщение с напоминанием о том, к какой функции вы пытаетесь применить
данную комбинацию клавиш, и информация о функции, для которой эти клавиши
уже задействованы. В данной ситуации вы в праве поступать так, как считаете нуж-
ным, но лучше оставлять неизменными закрепления клавиш, предусмотренные по
умолчанию, иначе вам будет очень трудно работать с другими экземплярами про-
граммы, да и на вашем компьютере не сможет работать никто, кроме вас.
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МЕНЮ WINDOW И HELP

11,1, Меню Window—управление страницами
главного окна

ЕСЛИ нет открытых аудиофайлов, то в меню Window содержится только одна
команда Switch To.... Когда вы откроете файлы со звуковыми данными, в меню
появятся строки, содержащие их имена. Каждая такая строка представляет собой
команду, открывающую новую страницу и переключающую главное окно на ото-
бражение соответствующей волновой формы. Таким образом, в целях получения
доступа к редактированию заранее открытых файлов менять страницы можно не-
посредственно из меню Window,

Командой Switch To... открывается окно Switch To, в котором содержится тот
же, на первый взгляд, список загруженных файлов, что и непосредственно в меню
Window. Щелкая левой кнопкой мыши в окне Switch To на именах файлов, можно
переключать страницы программы и вызывать для редактирования необходимую
волновую форму.

Поначалу окно Switch To кажется лишним. Однако со временем вы убедитесь,
что оно полезно и даже необходимо. Дело в том, что в нем отображаются все заг-
руженные файлы, а список в меню Window не может содержать более Ю строк.
Таким образом, пользуясь окном Switch To, можно получить доступ к любому из
открытых файлов, а непосредственно в меню Window «под рукой» находятся те Ю
из них, к которым вы обращались относительно недавно. Причем в верхней стро-
ке всегда находится текущий файл, соответствующий волновой форме, отобража-
емой на рабочем поле главного окна в данный момент времени.
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11.2, Help — справочное меню
В меню Help по традиции собраны команды, позволяющие воспользоваться

справочной информацией и получить доступ к сетевым ресурсам разработчика
программы. Перечислим их:

> Contents — доступ к системе контекстной помощи
> Overview — доступ к обзорным сведениям о программе
> Search for Help On... — переход на вкладку Поиск, подготовка к вводу клю-

чевого слова
> Quick Reference — переход в раздел Quick Reference, содержащий основные

сведения, необходимые для начала работы с программой
> Technical Support — отображение информации о технической поддержке
> Online Resources — переход на страницу, посвященную программе Cool Edit

Pro сайта http://www.syntrillium.com
> Check for Updates — переход на сайт технической поддержки http://

www.support. syntrillium.com. Воспользовавшись опциями открывшейся стра-
ницы, можно скачать как собственно программу Cool Edit Pro 2, так и раз-
личные «примочки» к ней

> Download Loops — переход на сайт http://www.loopology.com. Здесь вы найде-
те и при желании скачаете множество лупов и грувов (заготовок ритмичес-
ких и мелодических партий, исполненных на различных инструментах). Для
удобства пользователей материал систематизирован в виде стилевых биб-
лиотек.

> Tip of the Day — совет дня; программа предлагает вам совет, как лучше сде-
лать что-либо в Cool Edit Pro

> About Cool Edit Pro... — отображения сведений о программе и ее разработчике
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MULTITRACK VIEW - МУЛЬТИТРЕКОВЫЙ
РЕЖИМ РЕДАКТИРОВАНИЯ

Мы уже подробно рассмотрели работу с Cool Edit Pro в режиме редактирова-
ния отдельных волновых форм (Waveform View). В старых версиях звукового ре-
дактора компоновка аудиокомпозиции из отдельных файлов осуществлялась на
единственной паре стереотреков (или единственном монотреке). В этих целях
можно было использовать только такие стандартные операции, как вырезка, встав-
ка, копирование и микширование. Монтаж фонограммы, по сути дела, немногим
отличался от традиционной склейки фрагментов магнитной ленты. Конечно, элек-
тронный монтаж значительно удобнее, чем работа с резаком, кисточкой, клеем и
прессом. Однако последовательная процедура сборки фрагментов в единое целое
требует немалых затрат времени на подгонку их соединения и достижение балан-
са в миксах.

Рассматриваемая версия Cool Edit Pro предоставляет в распоряжение компью-
терного музыканта и звукорежиссера качественно новый инструмент монтажа —
мультитрековую среду, которую с полным правом можно считать редактором в
редакторе. Кроме того, мультитрековый режим работы в Cool Edit Pro 2 является
основным: именно в этом режиме находится программа после запуска.

12.1. Работа в главном окне программы в режиме
Multitrack View

Для того чтобы перейти в мультитрековую среду (режим Multitrack View) из
режима редактирования волновой формы, нужно либо в меню View выбрать

команду Multitrack View, либо в главном окне нажать кнопку р *̂̂ ЗШ.|. либо

I' Зак. I I 5 2
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Рис. 12.1. Главное окно программы в режиме Multitrack View

воспользоваться клавишей <F12>. Главное окно программы примет такой вид,
как на рис. 12.1.

На рис. 12.1 мы видим много знакомых элементов: транспортную панель, ин-
струменты управления масштабом, табло времени, поля вода границ отображае-
мого и выделенного фрагментов волновой формы, измеритель уровня сигнала,
строку статуса. В верхней части окна, как обычно, располагается главное меню.

Однако на этом сходство с окном редактора, к которому мы привыкли, работая
в режиме Waveform View, заканчивается. Отличия же заключаются в том, что в муль-
титрековой среде главное меню представлено лишь семью, а не десятью позиция-
ми и, самое важное, в главном окне имеется не пара стереотреков, а много таких
пар. Если установить минимальный масштаб отображения по вертикали и вос-
пользоваться слайдером полосы прокрутки, то имеющиеся треки можно подсчи-
тать. Получится число 128.

12.1.1. Общие принципы работы в мультитрековой среде Cool Edit Pro

Волновые формы в мультитрековой среде представлены в виде блоков — раз-
ноцветных прямоугольников. В каждом из них просматриваются: волновая фор-
ма, название файла, в котором эта волновая форма хранится, и др. Т. е. блоки пред-
ставляют собой некие кирпичики, из которых в мультитрековой среде можно
собрать композицию.
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Блоки можно перемешать во времени и по трекам, а также разрезать на части и
микшировать (сводить в один стерео- или монотрек). Однако в мультитрекозой
среде невозможно редактировать саму волновую форму. Чтобы сделать это, нужно
щелкнуть на интересующем вас блоке — произойдет переключение в режим ре-
дактирования выбранной волновой формы. После того как из волновой формы
будет вырезано все лишнее, проведено шумоподавление, динамическая обработ-
ка, фильтрация, обработка эффектами, нормализация и др., достаточно переклю-
читься обратно в мультитрековый режим.

Надо отметить, что границы блока могут не совпадать с границами волновой
формы: в блоке может отображаться и воспроизводиться заданный фрагмент вол-
новой формы. Кроме того, в разных блоках может использоваться одна и та же
волновая форма. Причем возможны различные варианты: в одном блоке представ-
лен один фрагмент волновой формы, в другом блоке — другой фрагмент этой же
волновой формы, в третьем блоке — этаже волновая форма представлена полно-
стью и т. д. Естественно, при модификации общей для нескольких блоков волно-
вой формы изменения коснутся всех этих блоков.

Скоро вы узнаете, что можно управлять громкостью звучания и панорамой вол-
новой формы на каждом отдельном треке и применять к трекам эффекты реаль-
ного времени. Однако изменение громкости, панорамы, применение эффектов
достигается здесь путем пересчета значений отсчетов оцифрованного звука не-
посредственно во время воспроизведения, а в сами волновые формы не вносится
никаких изменений.

На треках можно размещать уже существующие волновые формы, но можно и
записывать их, находясь непосредственно в мультитрековои среде. Кроме того,
только в мультитрековои среде можно реализовать многоканальную запись, когда
одновременно на разные треки записывается несколько источников звука.

В мультитрековый проект можно включить MIDI-файлы и видеофайлы в фор-
мате AVI. И те, и другие невозможно редактировать в Cool Edit Pro. Зато у вас име-
ется возможность согласования своего многоканального проекта с MIDI-музы-
кой или видеорядом.

Особенно актуальна возможность работы с видео. Многодорожечные видеоре-
дакторы (например, Adobe Premier), хотя и позволяют редактировать звук, но их
возможности в этом значительно отстают от возможностей Cool Edit Pro.

На практике работа с видео в Cool Edit Pro осуществляется следующим обра-
зом. Импортируется AVI-файл, который в общем случае содержит видео- и аудио-
потоки. В мультитрековый проект можно включить только один видеоролик. Ви-
деоряд размещается на одном треке, а звуковая дорожка к нему из AVI-файла
автоматически размещается на другом треке. Вы можете открыть этот блок в ре-
дакторе волновой формы, очистить от шума, выполнить динамическую обработ-
ку и т. д., затем вернуться в мультитрековый режим и наложить в необходимых
местах фильма музыку, разместив соответствующие волновые формы на свобод-
ных треках. Вы можете заново озвучить фильм: заглушить или совсем стереть ис-
ходную звуковую дорожку, а вместо нее выполнить запись в студийных условиях с
одного или нескольких микрофонов. При воспроизведении мультитрекового про-
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екта видеоряд будет воспроизводиться в отдельном окне. Благодаря этому как раз
и существует возможность озвучивания или комментирования действий, проис-
ходящих в фильме.

Когда работа завершена, с помощью специальной команды вы сводите весь
звук и видео в новый AVI-файл. В этом файле останется прежний видеоряд и но-
вый или отредактированный звук.

Итак, простейший алгоритм работы с Cool Edit Pro как с мультитрековым ре-
дактором можно представить следующим образом;

> Создаете новую сессию (командой File > New Session...) или открываете уже
существующую (File > Open Session...)

> На необходимые треки от требуемой временной отметки производите за-
пись или вставляете уже готовые волновые формы-блоки

> Вновь записанные волновые формы обрабатываете, переключаясь в режим
редактирования волновой формы (щелчком на соответствующем блоке)

> При необходимости разрезаете, как угодно перемещаете, удаляете, объеди-
няете разные блоки

> Производите сведение: регулируете громкость и панораму треков, приме-
няете к ним эффекты реального времени, рисуете огибающие автоматиза-
ции, с помощью которых управляете во времени интересующими вас пара-
метрами

> Командой File > Save Mixdown As... или Edit > Mix Down to File > All Waves
сохраняете полученную композицию в виде одного стереофонического
аудиофайла.

> Если в проекте имеется видео, то вместо предыдущего пункта следует вос-
пользоваться командой File > Save Mixdown to Video As... и сохранить резуль-
таты работы в AVI-файле.

Что такое сессия? По существу сессия — это файл с расширением 5Е5,мульти-
трековый проект вашей композиции, в котором хранятся следующие данные:

> Пути к файлам с волновыми формами, размещенными на треках (входящи-
ми в данную сессию)

> Принадлежность волновых форм к конкретным трекам
> Значения моментов времени начала воспроизведения каждой из волновых

форм
> Атрибуты треков и шин, параметры подключенных к трекам и шинам эф-

фектов
> Автоматизация

Файл сессии занимает совсем немного места, потому что в нем не хранятся
непосредственно отсчеты оцифрованного звука. Он содержит указания о том, где
найти эти отсчеты, когда и как их воспроизводить, а это не требует много памяти.
Можно сказать (если на минутку забыть о файлах и дисках), что с точки зрения
пользователя сессия — это совокупность образов волновых форм, размещенных
на треках мультитрекового редактора.
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В то же время волновые формы существуют как бы независимо от сессии: вы мо-
жете редактировать их, сохранять, закрывать, удалять. Кроме того, вы можете создать
несколько разных сессий, в которых используются одни и те же аудиофайлы.

Если аудиофайл используется в открытой в данный момент сессии, и вы попы-
таетесь его закрыть (командой Edit > Close из редактора волновой формы), то по-
явится предупреждение о том, что соответствующий блок исчезнет из мультитре-
кового проекта. Если же средствами операционной системы вы удалите или
переместите какой-либо аудиофайл, а потом попытаетесь открыть сессию, в ко-
торой он используется, то возникнет стандартное окно диалога, в котором про-
грамма вам предложит указать путь к данному файлу (или любому другому файлу
на замену отсутствующему). В случае нажатия кнопки Cancel соответствующий
блок так и не появится в мультитрековом проекте.

Следует заметить, что имеет место следующее ограничение: все волновые фор-
мы, используемые в сессии, должны иметь одинаковую частоту сэмплирования
(дискретизации). При создании новой сессии командой File > New Session... от-
крывается окно диалога, в котором следует выбрать частоту дискретизации для
всего проекта. Если возникнет такая ситуация, что добавляемый в проект аудио-
файл будет иметь частоту сэмплирования, отличную от общей для всего проекта,
то программа предложит создать копию этого файла, произведет конвертирова-
ние волновой формы с учетом новой частоты сэмплирования и добавит в мульти-
трековую сессию эту сконвертированную копию исходного файла. Перед конвер-
тированием у вас будет возможность изменить формат файла (стерео/моно) и
разрешающую способность представления звукового сигнала.

12.1.2. Атрибуты аудиотреков, шины, запись звука на треки,
подключение эффектов к трекам, блокирование треков

Повторимся, что в Cool Edit Pro можно импортировать MIDI- и AVI-файлы.
Информация, содержащаяся в них, будет размешаться на MIDI- и видеотреке со-
ответственно. То есть фактически существуют три типа треков: аудио, MIDI и ви-
део. Набор атрибутов видеотреков сведен к минимуму и включает в себя лишь на-
звание трека. У MIDI-трека имеются следующие атрибуты: громкость, S (Solo),
М (Mute) и карта соответствия треков MIDI-портам, вызываемая кнопкой Map.
Любопытная вещь: в терминологии Cool Edit Pro существует понятие MIDI-тре-
ка, на котором размещается информация из MIDI-файла. В то же время, в этом
файле могут присутствовать свои треки. Вот и получается тавтология: MIDI-тре-
ки MIDI-трека.

А теперь подробно рассмотрим атрибуты аудиотреков.
В начале каждого из треков имеется поле атрибутов, в котором находятся раз-

личные поля и кнопки. Их состав зависит не только от типа трека, но и от геомет-
рических размеров полей атрибутов, которые определяются масштабом отобра-
жения треков по вертикали и положением правой границы полей атрибутов треков.
Кроме того, в верхней части главного окна, над полями атрибутов треков имеются
три кнопки, с помощью которых можно переключать порядок, в котором будут
отображаться атрибуты:
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> VOL — в первую очередь будут отображаться атрибуты громкости и панорамы.
> EQ — в первую очередь будут отображаться параметры эквалайзера (у каж-

дого аудиотрека имеется параметрический трехполосный эквалайзер)
> BUS — в первую очередь будут отображаться параметры, связанные с выво-

дом сигнала трека на заданную шину (подробнее об этом мы расскажем ниже),

Рис. 12.2. Атрибуты аудиотрека

Поле атрибутов аудиотрека показано на рис. 12.2. В верхней его части находит-
ся строка с названием трека. По умолчанию треки называются Track I, Track 2
и т. д. Чтобы изменить название трека, достаточно один раз щелкнуть на соответ-
ствующем поле и ввести новое название с клавиатуры.

Кнопки R, S, и М включают и выключают режим записи, режим соло и режим
мьютирования соответственно:

> R — включен режим записи: когда на транспортной панели будет нажата
кнопка Record, то на данный трек будет осуществляться запись сигнала с
заданного входа

> S — режим соло: звучать будут только данный трек, а также другие треки, у
которых нажата кнопка S

> М —данный трек будет заглушен, вобщеммиксе его не будет слышно

Нажав кнопку Out 1, вы сможете выбрать в окне диалога Playback Devices вы-
ходные порты для трека (рис. 12.3).

В окне имеются две вкладки Wave и MIDI. На вкладке Wave в списке Devices вы
можете выбрать выходной порт, через который будет воспроизводиться аудиоин-
формация данного трека, В нашем случае выбор не велик — всего одно устрой-
ство. Если выбрать это устройство и нажать кнопку Properties..., то появится окно
диалога Device Ordering Preference, описанное в разд. 1.3. В данном окне вы, кроме

*]
Wairt [MIDI

&evi&« Рис. 12.3. Окно диалога Playback Devices,
вкладка Wave
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всего прочего, сможете составить перечни аудио-и MIDI-устройств, доступных в
списках Devices окна Playback Devices.

Обратите внимание на список Buses. По умолчанию он пуст. Это список дос-
тупных шин. Посредством шин осуществляется группировка треков. Вы можете
создать шину и задать ее в качестве выходного порта для нескольких треков. Под-
ключая эффекты реального времени к этой шине, вы будете обрабатывать ими
сигналы группы треков.

Чтобы создать новую шину, нажмите кнопку New Bus..,, откроется окно диало-
га свойств созданной шины (рис. 12.4).

"Л" Properties

fndoBed Rtal-I ю* Effecii Cu rent E Reel* Ra<*

Ampftud»

Delay E fleets

Special

itj Time/Pitch

Рис. 12.4. Свойства шины

В поле Friendly Name вы можете задать имя шины. По умолчанию шины назы-
ваются Bus A, Bus В и т. д. В списке Output Device выбирается выходной аудиопорт,
через который будет осуществляться воспроизведение аудиосигнала данной шины.

В древообразном списке Installed Real-Time Effects вы можете выбрать один из
тех эффектов Cool Edit Pro, которые работают в режиме реального времени. Заме-
тим, что все DirectX-плагины относятся к категории эффектов реального време-
ни. Выбранный эффект нажатием кнопки Add-> переносится в список Current

Bus "A" Properties

F(ier*% Warae ,1 Виг Prewfe,

л1- Delay Effects

;-!• Fitters
Dynamic E L
Graphic Equalizer

Graphic Phase Sfiftei
••Notch Fitter

Pearrietric Equalizer

[*?• Special
& Time^Pilch

<c Ri^raoveAl j

tereo Field Rotate
Dynamic Delay

Рис. 12.5. Подключение
эффектов к шине
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Effects Rack. Тем самым осуществляется подключение эффектов к шине (рис. 12.5).
Аналогичным способом можно подключить к шине еще несколько эффектов.

Порядок, в котором эффекты подключены к шине, может быть важен. Если
выбрать один из эффектов в списке Current Effects Rack, станут доступными кноп-
ки Move Up и/или Move Down. С их помощью данный эффект можно перемещать
по списку вверх-вниз.

Если нажать кнопку Properties, то откроется окно свойств эффектов, показан-
ное на рис. 12.6.

Рис. 12.6. Свойства эффектов, подключенных к шине

В этом окне имеются несколько вкладок, каждая из которых соответствует под-
ключенным эффектам. Последняя вкладка называется Mixer, т. е. микшер (рис. 12.7).

С помощью данного микшера вы можете маршрутизировать сигнал между от-
дельными эффектами, подключенными к шине.

Первая линейка микшера всегда называется Dry Out, на ней расположен фей-
дер, регулирующий уровень необработанного эффектами сигнала на выходе шины.

Рис, 12.7. Микшер эффектов, подключенных к шине
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Далее следуют линейки эффектов. На каждой из линеек тоже имеется фейдер. С его
помощью задается уровень сигнала с выхода эффекта, посылаемого на выходной
аудиопорт. Кнопки Bypass осуществляют временное отключение эффекта. В по-
лях Рге задается уровень сигнала в %, снимаемого с выхода данного эффекта и
посылаемого на вход следующего эффекта. При этом положение фейдера не вли-
яет на уровень посылаемого сигнала.

Чтобы изменять значения параметров, указанных в цифровых полях (Рге к та-
ким и относится), следует щелкнуть на таком поле и, удерживая нажатой левую
кнопку мыши, перемещать курсор мыши влево-вправо.

В поле Src задается уровень исходного необработанного сигнала, подаваемого
на вход эффекта.

Кнопками Serial и Parallel, по сути дела, вызываются «заводские» настройки
микшера:

> Serial — последовательная обработка сигнала эффектами. Настройки мик-
шера таковы, что вход последующего эффекта соединен с выходом пред-
шествующего ему эффекта, и на выходной аудиопорт подается сигнал с
последнего эффекта

> Parallel — параллельная обработка сигнала эффектами. На вход каждого из
эффектов подается исходный необработанный сигнал, а сигналы с выходов
эффектов подаются на выходной аудиопорт.

Кнопкой Rack Setup вызывается окно свойств данной шины, которое мы рас-
смотрели выше (см. рис. 12.4, 12.5).

А сейчас вернемся к окну диалога Playback Devices. На вкладке MIDI (рис. 128)
расположен список выходных MIDI-портов, один из которых будет использоваться
для воспроизведения MIDI-сообшений. Понадобится этот порт в том случае, если
вы воспользуетесь командой Insert > MIDI from File..., импортируете MIDI-файл и
разместите его на данном треке.

Если установить флажок Same for All Tracks, то после нажатия кнопки ОК выб-
ранные в рассматриваемом окне выходные аудио- и MlDI-порты будут установ-
лены для всех треков. Эта опция имеется и в других окнах, в дальнейшем мы не
будем обращать на нее ваше внимание.

Playback Devices [Track 3]

Ыгне MIDI

Devices

Рис. 12.8. Окно диалога Playback Devices на
вкладке MIDI
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Продолжим рассмотрение остальных атрибутов аудиотреков. На очереди вход-
ной аудиопорт — порт, с которого будет осуществляться запись. Соответствующая
кнопка, расположенная в поле атрибутов треков, по умолчанию называется Reel.
После ее нажатия откроется окно диалога Record Devices, показанное на рис. 12.9.
В этом окне вы сможете выбрать входной аудиопорт (Wave), режим записи (Left
Carmel — левый канал, Right Channel — правый канал, Stereo), разрешающую спо-
собность цифрового сигнала (16-bit/32-bit).

ftetord D^vites [li-dtk 1]

[2] SB Audigy Audio [DF80]
[3] Модем №0. лине£иый вход Stereo

*.!

Г Sanstaftl
~

Рис. 12.9. Окно диалога Record Devices

Обратите внимание на устройство Wave Mapper — это некое устройство, кото-
рое используется по умолчанию для записи звука. В данном случае Wave Mapper
соответствует порту SB Audigy Audio. Переназначить Wave Mapper можно в настрой-
ках Windows (путь для Windows ХР: Пуск > Панель управления > Звуки и аудиоуст-
ройства > Аудио > Запись звука).

Кнопка Properties... вызывает окно диалога Device Ordering Preference, описан-
ное в разд. 1.3. После закрытия окна диалога Record Devices кнопкой OK, на соот-
ветствующем треке название кнопки Rec 1 может измениться на Rec N, где N -
номер входного аудиопорта, установленного для трека.

Теперь у вас достаточно информации, чтобы попытаться что-нибудь записать
на трек. Подготовьте один или несколько треков к записи: нажимая кнопки Rec 1
определите входные аудиопорты, и нажмите кнопки R. Установите маркер в пози-
цию, с которой нужно начать запись. Запустите запись кнопкой Record на транс-
портной панели. Если все сделано правильно, начнется запись. Остановить ее
можно кнопкой Stop на транспортной панели или клавишей <Пробел>.

Напомним, что с маркером (вертикальной линией из желтых точек), указыва-
ющим позицию, начиная с которой будет осуществляться запись/воспроизведе-
ние/вставка волновой формы, вы уже имели дело при работе в режиме редактиро-
вания волновой формы.

Запись может не начаться в том случае, если устройство, выбранное в качестве
источника сигнала, не поддерживает частоту сэмплирования, используемую для
всей сессии. Пример: входной аудиопорт голосового модема поддерживает часто-
ту сэмплирования 8 кГц, а при создании сессии вы указали частоту сэмплирова-
ния 48 кГц.
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На очереди следующие атрибуты аудиотрека — громкость и панорама. Циф-
ровое поле громкости обозначается буквой V, после которой следует значение
уровня сигнала в дБ. Вам уже известен первый способ изменения значения циф-
рового поля: «хватай мышью и тяни». Для данного поля есть и второй способ —
щелкните на нем правой кнопкой мыши. Откроется окно диалога Vol, показан-
ное на рис. 12.10 «.

Рис. 12.10. Регулировка громкости (а) и
панорамы (б)

С его помошь регулировать громкость трека удобнее.
Цифровое поле панорамы обычно расположено под полем громкости и по умол-

чанию называется Pan 0. При изменении панорамы влево-вправо название будет
меняться на L и R с указанием отклонения от центра в %. Щелчком правой кнои -
кой мыши на этом поле вызывается окно Pan (рис. 12.106).

На момент написания книги Cool Edit Pro 2 не имеет поддержки многоканаль-
ных surround-систем. Однако в его арсенале имеется эффект реального времени
под названием Stereo Field Rotate. Благодаря этому эффекту вы сможете разме-
щать виртуальные источники звука не только на стереопанораме, расположенной
перед слушателем, но и позади него. Т. е. фактически вы можете получить surround-
звучание на обычной стереосистеме. Кажется невероятным? Так и ушей у вас тоже
двое, но, тем не менее, вы можете различать направление на источник звука, где
бы он не находился.

Данный эффект подлежит автоматизации. Это значит, что вы можете управ-
лять им с помощью огибающих автоматизации. Например, вы можете сделать так,
что источник звука будет крутиться вокруг вас. Но об эффектах мы поговорим
позже, а сейчас возвратимся к атрибутам трека.

Если в качестве выходного порта выбрана шина, то будут доступны поля Wet и
Dry. Большинство программ разработаны по образу настоящих микшеров: в них есть
посылы на шины Aux, объединение нескольких треков в группу. В Cool Edit Pro
имеется окно-микшер, на котором имеются линейки треков и шин. Однако после
внимательного изучения программы вы поймете, что Cool Edit Pro имеет мало об-
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щего с настоящим микшером. Его ш и н ы не похожи ни на шины Aux, ни на основ-
ные шины, с которыми вы могли встретиться в программе Sonar [9]. Это, скорее,
нечто среднее. Вы можете задать для нескольких треков в качестве выходного аудио-
порта одну и ту же шину, к которой подключить один или несколько эффектов. А вот
еще не совсем привычная возможность; для каждого из треков вы можете независи-
мо регулировать уровень необработанного сигнала трека на выходе шины (Dry) и
уровень сигнала обработанного эффектами, подключенными к шине (Wet).

Своеобразным эффектом реального времени можно считать параметрический
эквалайзер, в обязательном порядке подключенный к каждому из треков. В полях
Lo, Mid и Hi регулируются коэффициенты усиления или ослабления сигнала тре-
мя фильтрами. Сделайте двойной щелчок на любом из этих полей. Откроется окно
диалога TYacks Equalizers, показанное на рис. 12.11.

Три белых точки соответствуют центральным частотам фильтров. Их можно пе-
ремешать с помощью мыши (рис. 12.11 5, в). С помощью поля Mid Q можно изме-
нять добротность среднего фильтра. Добротности других фильтров (Lo Q и Hi Q) no
умолчанию не доступны для изменений. Кнопкой Flat осуществляется сброс на-

строек эквалайзера, его АЧХ становится линейной. С помощью кнопки 1ЧЙ осуще-Шт
ствляется переключение в другой режим управления фильтром (рис. 12.12).

Рис. 12.11. формирование АЧХ трекового
эквалайзера
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Рис. 12.12. Еще один вариант управления трековым
эквалайзером

В данном режиме управление центральными частотами фильтров и усилени-
ем/ослаблением сигнала на них осуществляется как с помощью белых точек, так
и с помощью регуляторов. Можно очень точно изменять данные параметры, щел-
кая на треугольниках, расположенных по краям регуляторов.

С помощью кнопок Band переключаются типы фильтров Lo и Hi. Из фильтров верх-
них частот и фильтров нижних частот они превращаются в полосовые фильтры (как и
Mid). При этом для них становятся доступны параметры Lo Q и Hi Q — добротности.

Кнопкой Р, расположенной в верхней части окна, открывается окно EQ Presets, с
помощью которого можно сохранить текущие настройки эквалайзера в виде пресета.

Хотите узнать, почему рассматриваемое окно называется Thicks Equalizers (мн.
число), а не Tracks Equalizer (ед. число)? Не закрывая этого окна, щелкните на
каком-либо треке. Вы увидите, что в верхней части окна появится название этого
трека, и АЧХ эквалайзера будет не такой, как у того трека, для которого было от-
крыто это окно. Дело в том, что в окне Tracks Equalizers показываются настрой ки
эквалайзера текущего трека. А теперь нажмите кнопку QJ и попробуйте выбирать
разные треки в качестве текущих. Окажется, что в окне Tracks Equalizers имеется
несколько вкладок с эквалайзерами, каждая из которых соответствует определен-
ному треку (рис. 12.13).

Track Equalizers

Рис. 12.13. Несколько эквалайзеров в одном окне
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Как вы уже, вероятно, заметили, в Cool Edit Pro используется понятие текуще-
го трека. Текущий трек выбирается щелчком на треке. Текущий трек отличается от
остальных цветом — он немного светлее.

Среди атрибутов трека вы обнаружите кнопки Eq /А или Eq /В, которые имеют
прямое отношение к трековому эквалайзеру. Те настройки эквалайзера, которые
вы сделали, хранятся в одном из двух регистров. Но регистры можно переключать
с помощью указанных кнопок. В одном регистре — одни настройки эквалайзера,
в другом — другие. Непосредственно во время воспроизведения настройки можно
переключать и выбирать лучший вариант. Полезный прием — двойной щелчок на
кнопке настройки. В результате этого настройки из текущего регистра копируют-
ся во второй регистр.

До сих пор мы рассматривали только ситуацию, когда эффекты подключаются
к шине. Естественно, эффекты можно подключить и непосредственно к треку. Если
к треку не подключен ни один эффект (а по умолчанию так и есть), то нажатие
кнопки FX приведет к появлению окна Effects Rack, показанного на рис, 12.14.

Iracki? Effects Rack

л!
Hen \ Bete j Рис. 12.14. Подключение

эффектов реального
времени к треку

Ничего это окно вам не напоминает? Аналогичным окном мы пользовались,
подключая эффекты к шине, только называлось оно по-другому.

Подключите нужные эффекты, выбрав их в древоподобном списке Installed Real-
Time Effects и воспользовавшись кнопкой Add-> для занесения в список Current
Effect Rack. В строке friendly Name можно ввести название для набора эффектов,
подключенных к данному треку, хотя и название, принятое по умолчанию, не так
уж и плохо: FX и номер трека. Теперь воспользуйтесь кнопкой Properties... для до-
ступа к параметрам эффектов. Существует еще один способ подключения эффек-
тов к треку — с помощью органайзера (см. разд. 12.1.7): выбираете нужный эф-
фект в древовидном списке Effects, и буксируете на нужный трек. Так или иначе,
открывается окно, показанное на рис. 12.15.

Все эффекты, встроенные в Cool Edit Pro, можно разделить на эффекты реаль-
ного времени и те, которые можно применять только в режиме редактирования
волновой формы. Есть еще и мультитрековые эффекты, но это уже совсем другая
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Рис. 12.15. Окно свойств эффектов

история. Эффекты реального времени тоже можно использовать в режиме редак-
тирования волновой формы. В главе 6 вы познакомились со всеми эффектами,
включая и те, что относятся к категории эффектов реального времени. Однако в
мультитрековом режиме окна свойств этих эффектов могут выглядеть не совсем
привычно. В качестве примера рассмотрим эффект Stereo Field Rotate (surround-
эффект, вращение стереофонического поля вокруг слушателя). Напомним вид окна
этого эффекта в режиме редактирования волновой формы (рис. 12.16 а). С учетом
того, что эффект применялся к выделенному фрагменту волновой формы, потреб-
ность в графике, описывающем вращение поля в зависимости от времени, была
оправдана. При использовании эффекта в реальном времени вместо графика име-
ется регулятор, задающий угол поворота стереогтоля (рис. 12.16 6). Если потребу-
ется управлять этим параметром в процессе воспроизведения трека, то следует
воспользоваться опцией Automated. Тогда вид панели параметров данного эффе к-
та будет выглядеть так, как показано на рис. 12.16 в. Потребность в регуляторе
автоматизируемого параметра отпадает. Теперь параметр будет управляться оги-
бающей автоматизации. Однако вновь возникнет потребность в опциях, связан-
ных с изменением параметра эффекта в соответствии с графиком, коим, по сути,
является огибающая автоматизации. Чтобы увидеть эту огибающую и получить
возможность ее редактирования, нажмите две кнопки, расположенные на панели
инструментов главного окна:

— включение редактирования графиков автоматизации

— включение отображения графиков автоматизации эффектов реального времени

На треке, к которому подключен рассмотренный выше эффект, появится го-
ризонтальная линия, содержащая узлы в виде маленьких белых прямоугольников.
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Рис. 12.16. Параметры одного и того
же эффекта при использовании его в
режиме редактирования волновой
формы (а), в качестве эффекта
реального времени (б), в качестве
автоматизируемого эффекта реального
времени (е)

Добавляя новые узлы и перемещая существующие, вы можете сформировать гра-
фик изменения автоматизируемого параметра во времени — огибающую автома-
тизации. Подробно работу с огибающими автоматизации мы рассмотрим ниже.

А сейчас сделаем два замечания:
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> Не все эффекты реального времени имеют автоматизируемые параметры
> В мультитреконом режиме могут использоваться только эффекты реального вре-

мени, поэтому для краткости мы вновь будем называть их просто эффектами

Ешеодин атрибут треков, тесно связанный с применением эффектов, — кноп-
ка Lock, может заметно облегчить вам жизнь. Мы уже упоминали его. Теперь рас-
смотрим подробнее.

Допустим, вы, работая в мультитрековом музыкальном илиаудиоредакторе, осуще-
ствляете сведение. В какой-то момент начинает не хватать мощности процессора для
расчета эффектов реального времени. В этом случае обычно делается внутреннее пере-
сведение — делается mixdown (в Sonar [9] эта операция называться bounce) — один или
несколько треков * пересчитываются» с учетом подключенных эффектов, в результате
чего появляется новый трек. Исходный трек заглушается (или вообще удаляется), и ре-
сурсы процессора высвобождаются. Если вы решите исправить что-либо в настройках
эффектов, то потребуется каким-то образом вернуть исходный трек с подключенными
к нему эффектами реального времени и внести исправления. Естественно, в Cool Edit
имеется целый набор mixdown-команд и описанный прием вы, в принципе, можете
использовать для высвобождения процессорного времени. Но в этом просто нет необ-
ходимости. Поясним. Допустим, вы подключили эффекты к треку, настроили их, отре-
дактировали содержимое трека, применили огибающие автоматизации. Прежде чем
переходить к работе с другим треком, вы можете заблокировать текущий трек (нажать
кнопку Lock, в результате чего будут освобождены все ресурсы процессора, затрачивае-
мые на просчет эффектов реального времени для данного трека. Достигается это за счет
того, что Cool Edit Pro пересчитает содержимое этого трека с учетом эффектов и авто-
матизации, сохранив затем результаты во временном файле. При воспроизведении все-
го проекта расчет эффектов заблокированного трека выполняться не будет. Вместо это-
го будет воспроизводиться соответствующий временный файл. Если вы захотите внести
изменения в настройки эффектов или отредактировать трек— просто отожмите кноп-
ку Lock. Единственным неудобством можно считать то, что расчет временного файла
после блокировки трека будет занимать какое-то время.

На этом рассказ об атрибутах аудиотреков можно было бы закончить, но суще-
ствует еще одно окно, о котором нельзя не упомянуть. Щелкните правой кнопкой
мыши на свободном от каких-либо кнопок и полей месте области атрибутов аудио-
трека. Возникнет окно диалога, показанное на рис. 12.17.

Рис. 12.17. Окно свойств трека
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В этом окне отображаются все описанные нами атрибуты, но в более удобной
для редактирования форме. Кроме того, в данном окне могут располагаться атри-
буты сразу нескольких треков. Не закрывая этого окна, пощелкайте на разных тре-
ках, и вы увидите, как в окне появятся новые вкладки с их названиями.

12.1.3. Добавление существующих волновых форм в проект, основные
приемы работы с блоками (выделение нескольких блоков,
выделение частей блоков, перемещение, копирование,
расщепление, удаление, группировка, блокирование)

Итак, мы рассмотрели такой способ добавления волновых форм в проект, как
их непосредственная запись. Однако ничто не мешает вам добавить в свою ком-
позицию волновые формы, записанные вами ранее или хранящиеся в библиотеке
сэмплов.

Для осуществления этого есть несколько возможных путей:

> Вставьте в мультитрековый редактор волновую форму, открытую на теку-
щей странице в режиме Waveform View (командой Edit > Insert in Muititrack
из редактора волновой формы), которая до этого не входила в сессию

> Вставьте в мультитрековый редактор любую волновую форму, загруженную
в данный момент в Cool Edit Pro (воспользовавшись командой Insert > На-
звание волновой формы — здесь и далее речь идет о командах мультитреко-
вого редактора)

> Вставьте волновую форму из любого аудиофайла, т. е. осуществите загрузку
этого файла в Cool Edit Pro 2 и размещение в нужном месте нужного трека
(команда Insert > Wave from file)

> Командой Insert > Video from file вставьте в мультитрековый редактор видео-
файл, при этом сам видеоряд размещается на одном треке (видеотреке), а
звуковая дорожка из этого файла размещается на втором треке (обыкновен-
ном аудиотреке).

> Командой File > Open Waveform... загрузите волновую форму в Cool Edit Pro,
после чего можете с помощью команды Insert > Название волновой формы
разместить ее на одном из треков.

> Загрузите волновую форму (волновые формы) в составе сессии (Session),
работая в режиме Muititrack View

> Загрузите волновую форму в Cool Edit Pro, используя органайзер (см. разд.
5.2) и перетащите ее из органайзера на необходимый трек (разд. 12.1.7).

Как задать позицию, начиная с которой должна размещаться волновая форма?
Мы уже говорили о существовании текущего трека, который назначается щелч-
ком мыши или на самом треке, или на поле его атрибутов. Текущий трек выделя-
ется цветом — он более яркий (светлый). На рис. 12.18. текущим является третий
сверху трек.

Также, как и в редакторе волновой формы, в мультитрековом редакторе имеет-
ся маркер, обозначающий позицию, начиная с которой будет осуществляться за-
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Рис. 12.18. Указана позиция вставки волновой
формы

пись или воспроизведение. Положение этого маркера и определяет то место, куда
на текущий трек будет размещена волновая форма.

После попадания в мультитрековую среду волновую форму правильнее назвать
блоком. И причин здесь есть несколько:

> Волновал форма вписана в графический объект, который можно переме-
щать

> Блоки содержат (могут содержать) не только последовательность звуковых
отсчетов (волновую форму), но и огибающие автоматизации, а также це-
лый ряд атрибутов, о которых мы поговорим позже

Переместить блок с места на место очень просто. С помощью правой кнопки
мыши его нужно ухватить и перетащить на заданную позицию заданного трека.

Иногда требуется производить операции одновременно над несколькими бло-
ками. Их нужно предварительно выделить. Группа блоков выделяется с помощью
левой кнопки мыши, при этом следует удерживать нажатой клавишу <Ctrl>. Су-
ществует и альтернативный способ выделения группы блоков — удерживая нажа-
тыми клавишу <Ctrl> и левую кнопку мыши, «нарисовать» курсором мыши пря-
моугольник, охватывающий нужные блоки.

Для одновременного перемещения нескольких блоков с помощью правой кноп-
ки мыши захватывается любой из группы предварительно выделенных блоков и
вместе с остальными выделенными блоками перемещается п новую позицию.

Для выделения нескольких произвольно расположенных блоков нужно, не от-
пуская клавишу <Ctrl>, щелкнуть на каждом из них.

В ряде случаев вам потребуется выделить не отдельные блоки, а целый фраг-
мент многодорожечного проекта, охватывающий несколько блоков или их фраг-
ментов. Для чего это нужно? Например, чтобы произвести пересчет (Mixdown)
этого многодорожечного фрагмента в одну волновую форму.

Установите курсор мыши на любую из горизонтальных линий, разделяющих
треки, в той точке, с которой должен начинаться выделенный фрагмент. Нажмите
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левую кнопку мыши и, не отпуская ее, переместите курсор в конечную точку вы-
деляемого фрагмента. Отпустив кнопку мыши, вы увидите серую вертикальную
полосу. Только что вы выделили фрагмент проекта, включающий в себя фрагмен-
ты всех существующих треков. Учтите, что в этом случае сами блоки не считаются
выделенными, а выделен именно фрагмент композиции.

В пределах выделенного фрагмента проекта вы можете выбрать один или не-
сколько блоков. В результате могут оказаться выделенными даже отдельные части
блоков, если границы выделенного фрагмента проекта пересекают эти блоки. Что-
бы сделать это, нажмите клавишу <Ctrl> и щелкните левой кнопкой мыши на том
блоке, фрагмент которого следует выделить, в зоне, где блок пересекается серой
вертикальной полосой. Весь блок окажется подсвеченным, а его необходимый
фрагмент — выделенным.

Если нужно выделить фрагменты нескольких блоков, перекрывающихся во
времени, то порядок действий должен быть аналогичным. Единственное отли-
чие — на заключительном этапе нужно, не отпуская клавишу <Ctrl>, «перещел-
кать» выделяемые фрагменты всех необходимых блоков.

Что вы будете делать, если вам понадобится создать копию блока? Попытае-
тесь скопировать его в буфер обмена? Ничего не получится. Такой команды нет,
А реализовать копирование можно следующими способами:

> Повторно добавить в проект ту же самую волновую форму
> Удерживая нажатыми клавишу <Ctrl> и правую кнопку мыши, перетащить

копируемый блок на то место, где должна располагаться копия. Сам блок
останется на месте, а на указанном месте появится его копия

Первый способ нельзя назвать копированием в чистом виде. Повторное добав-
ление волновой формы приведет к появлению нового блока, у которого все атри-
буты будут находиться в состоянии, принятом по умолчанию. Вторым способом
копируются именно блоки: и волновые формы и их атрибуты.

Для расщепления блоков выполните следующие действия:

> Щелкните на месте расщепления левой кнопкой мыши (блок окажется вы-
деленным), маркер будет установлен на место будущего расщепления)

> Нажмите кнопку йЫ на панели инструментов или воспользуйтесь коман-

дой главного меню Edit > Split, или командой контекстного меню Split (кон-
текстное меню вызывается правой кнопкой мыши)

Для удаления блоков выделите один или несколько блоков, часть одного блока
или части нескольких блоков и нажмите клавишу <Delete>.

Если вы хотите не просто удалить блок из сессии, но и выгрузить его из Cool
Edit Pro, выделите его и нажмите одновременно клавиши <Shift> + <Backspace>.

В ряде случаев полезно объединить несколько блоков в группу. После объеди-
нения блоки будут перемещаться, копироваться и удаляться все разом, причем не
нужно будет выделять каждый из блоков по отдельности. Т. е. блоки одной группы
ведут себя словно один блок. Для группирования блоков:
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> Выделите нужные блоки

> Нажмите кнопку на панели инструментов или вызовите команду глав-
ного меню Edit > Group Blocks, или вызовите команду контекстного меню
Group Blocks

Вы можете блокировать один или несколько блоков (извините за нечаянный
каламбур, но по-другому не сказать). Данная операция не имеет ничего общего с
блокированием треков, и результат ее выполнения заключается лишь в невозмож-
ности перемещения блоков с места на место. Технология блокирования блоков
несложна:

> Выделите нужные блоки

> Нажмите кнопку Ц| на панели инструментов или вызовите команду глав-
ного меню Edit > Lock In Time, или вызовите команду контекстного меню
Lock In Time

В левом нижнем углу заблокированного блока появится изображение замка.
Разблокировка блоков осуществляется точно так же, как и блокировка — повтор-

ным нажатием на кнопку |Ц или повторным применением команд, перечислен-

ных выше.

12.1.4. Работа с лупами и грувами, параметры проекта (темп,
тональность и др.)

В разделе 5.10 мы рассказали, о том, как подготовить луп для использования в
мультитрековом проекте. На CD-ROM, прилагаемом к книге, в каталоге SAMPLES/
LOOPS вы найдете два файла-лупа: ANALOGUE_JUMPER_CJ40BPM. WAV и
BREAK_LOOP_A_132BPM.WAV. Данные файлы имеют все необходимые настрой-
ки, поэтому после загрузки в мультитрековый проект они будут восприниматься
программой как лупы. Визуально от всех других блоков лупы отличаются наличием

в левой нижней области блока.символа

Рис. 12.19. Блоки лупов
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Заметим, что лупы, приведенные нами в качестве примеров, скачаны с сайта
www. looperman. com, на котором вы можете найти множество бесплатных лупов.

На рис. 12.19 а показаны два блока-лупа. Темп одного лупа составляет 140 уда-
ров в минуту, темп другого 132 удара в минуту. Но если вы запустите проект на
воспроизведение, то никакого рассогласования в звучании лупов не будет. Они
будут звучать в таком темпе, какой задан для всего проекта.

Кроме WAV-файлов, в указанном выше каталоге вы можете найти файл проек-
та LOOPS. SES. В данном проекте уже присутствуют два лупа с разными исходны-
ми значениями темпа. Можете с ними поэкспериментировать.

Второе отличие блоков-лупов от остальных блоков заключается в том, что их
можно растягивать в длину. На рис. 12.196 показано, как верхний блок лупа растя-
гивается за правую границу. При этом блок циклически заполняется периодами лупа.

Согласование темпа лупа осуществляется «налету», во время его воспроизве-
дения в рамках мультитрекового проекта. Ради интереса можете сделать двойной
щелчок на блоке лупа и переключиться тем самым в режим редактирования вол-
новой формы. Вы обнаружите, что при воспроизведении темп лупа не отличается
оттого, в котором он записан. Несмотря на изменение длинны блока лупа в муль-
титрековом проекте, его длительность в редакторе волновой формы не меняется.

Вернитесь в мультитрековый режим, если это необходимо, и щелкните на лю-
бом из блоков правой кнопкой мыши. В контекстном меню выберите команду
Loop Properties.... Эта команда доступна для любых блоков. Возникнет окно Wave
Block Looping, показанное на рис. 12.20.

Опция Enable Looping дает понять программе, что данный блок является лу-
пом. В принципе, вы можете зациклить любую волновую форму, лишь бы в этом
был смысл. Если данную опцию отключить, то блок лупа превратится в обыкно-
венный блок, который нельзя будет растягивать, а его темп не будет подстраи-
ваться под темп проекта.

Wave Block Looping - analogue Jumper c_t

Ё liable Looping

С Repeatevaj"

(? 'Repeat ev«y beats» 140- bpm

I? Ffjtow session tempo
Is? Ueek'posiion to tempo

•I "~
Transpose rggSi 10 haf-ste^s Adjust ALL ioop-enabled-

block: ihal uce (his wave

Рис. 12. 20. Свойства лупа
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В группе Looping задаются параметры зацикливания, которые, в свою очередь,
определяют наполнение блока лупа при изменении его длины:

> Simple Looping (no gaps) — простое зацикливание (без подстройки темпа, без
пауз между периодами)

> Repeat every ̂ seconds — циклическое воспроизведение волновой формы лупа
каждые х секунд

> Repleat every x beats at у bpm — воспроизведение каждых х тактов с темпом у

По умолчанию включен последний (из перечисленных) режим зацикливании
и установлен флажок Follow session tempo, что буквально означает «следовать тем-
пу сессии». Если данный флажок сбросить, то параметр, обозначенный нами
как у, станет доступным, и вы сможете задать для лупа темп, отличный от темпа
проекта.

Если установлен флажок Lock position to tempo, то при изменении темпа лупа
длина его блока изменяться не будет. Например, после увеличения темпа в блоке
лупа уместится большее количество периодов, чем до увеличения, но длительность
звучания блока не изменится. Если флажок Lock position to tempo сбросить, то при
изменении темпа количество циклов в блоке лупа изменяться не будет — соответ-
ственно будет изменяться длительность его звучания.

В группе Source Waveform Information доступны некоторые из параметров ис-
ходной волновой формы лупа, описанные в разд. 5.10.2, когда речь шла о вкладке
Loop Info окна Wive Properties. Там же были рассмотрена группа Tempo Matching:
алгоритмы коррекции темпа лупа и их параметры.

В нижней части окна Wave Block Looping (см. рис. 12.20) имеются две опции;

> Transpose Pitch x half-steps — транспонировать тон лупа/грува на х полутонов
> Adjust ALL loop-enabled blocks that use this wave — применять настройки, выпол-

ненные в данном окне, для всех блоков, использующих эту же волновую форму

Напомним, что «волновая форма» не является синонимом «блока*. В несколь-
ких разных блоках, в том числе и с разными параметрами зацикливания, может
использоваться одна и та же волновая форма.

Мы уже несколько раз упоминали о существовании некого параметра — темпа
проекта. Отыщите в главном окне панель, показанную на рис. 12.21. Вызвать ее
можно командой главного меню View > Show Session Properties или с помощью
одновременного нажатия клавиш <АН> + <3>.

На данной панели, называемой Session Info, можно задать темп (Tempo), количество
долей в такте (beats/bar), тональность и музыкальный размер (Key) мультитрекового
проекта.

Tempo 1J2 Jbpm, ^Jbeats&ar

Key ; (none) О 4/4 time В

Рис. 12.21. Панель Session Info



392 Глава 72

Само по себе присутствие этих параметров кажется неестественным для звуко-
вого редактора. Изменить темп и тональность для музыки, записанной в виде MIDI-
команд, не составит труда, чего не скажешь о музыке, собранной из WAV-файлов.

Тем не менее, вы уже знаете, что лупы «умеют» подстраиваться под темп проек-
та, который задается именно на данной панели. А грувы подстраиваются и под
тональность проекта, которая задается здесь же. Давайте уточним границу между
понятиями «луп» и «грув». С точки зрения программы грув — это тот же луп, но
только такой, который состоит из мелодических звуков. Сама программа не мо-
жет определить, какие звуки (ударные или мелодические) присутствуют в волно-
вой форме. При редактировании свойств зацикливания (рис. 12.20) вы сами опре-
деляете для программы, считать ли волновую форму ритмическим лупом, для
которого тональность не имеет значения (параметр Key задан как Non-voiced), или
грувом с заданной тональностью (параметр Key отличен от Non-voiced).

Изменение тональности всего проекта повлияет только на тональность грувов —
тех блоков, для которых параметр Key отличен от Non-voiced.

На панели Session Info (рис. 12.21) имеются две кнопки:

> Metronome — включение метронома
> Advanced — открывает окно Advanced Session Properties — окно диалога с рас-

ширенным набором параметров проекта, среди которых есть те, что влияют
на работу метронома

В окне диалога Advanced Session Properties имеется несколько вкладок. Было бы
логично начать рассматривать данное окно со вкладки Metronome (рис. 12.22), от-
носящейся к настройкам метронома.

Advanced Session Properties

. General | Mixing] Tempo MefrortOffle j Notes j

- Г" Enable Metronome .
Qylput To

'.SoundSet JAfrieanl ^j |[1]SB Audicy Audio [DF3Q]̂

Volume }-6 <ЙЗ

Sign̂ ue J4/'2time jH Custom...]

Pattern {l"323 " -
Cancel j

Нф:

Рис. 12.22. Окно
свойств проекта,
вкладка Metronome

Флажок Enable Metronome дублирует кнопку включения метронома на панели
Session Info.

В раскрывающемся списке Sound Set содержится набор звуков, используемый
для озвучивания метронома.

Output To — аудиопорт, посредством которого будет выводиться звук метронома.
Volume — уровень громкости, a Signature — музыкальный размер.
Pattern — поле, в котором отображается шаблон метронома — последователь-

ность цифр, соответствующих долям. Первая по счету цифра соответствует пер-
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вой доле такта, вторая — второй и т. д. Цифрами от 1 до 3 обозначаются разные
звуки, а цифрой 0 обозначается отсутствие звука. Вы можете определить имя сво-
его собственного шаблона метронома, которое будет доступно в списке Signature,
и сформировать соответствующий ему шаблон. Для этого нажмите кнопку
Custom.... Возникнет окно диалога, показанное на рис. 12.23.

(Customize Metronome Time Signature

;. Name jUntilled

' Pattern J1 3 3 3

Beats/Bar J4

l Fa pattern зЫгщ, use 0 fofNoBeat
1 for Down Seal
2 lof Secondly Beat
3 lor Regular Beat

щ

Add : |

Cancel I

Help

Рис. 12.23. Редактирование шаблона
метронома

В поле Name вы должны ввести название шаблона метронома, под которым он
будет доступен в списке Signature. В поле Pattern с помощью цифр от 0 до 3, разде-
ленных пробелами, записывается собственно шаблон метронома. В поле Beats/
Ваг указывается количество долей в такте.

Вернемся к рассмотрению окна Advanced Session Properties и на этот раз откро-
ем вкладку General (рис. 12.24).

Advanced Session Properties

С eneral .j Мкшд j Tempo ] Metronome j I4oies j

0:00.000 **-*„, >-*-! [
: t-

jr. '̂ 1 If a foop has an associated key, it «Й1 he
transposed (o match the session key .

Carwel 1

Help-

Рис. 12.24. Окно свойств проекта, вкладка General

SMPTE Start Time Offset означает величину задержки между поступлением
команды на воспроизведение проекта и началом его фактического воспроизве-
дения. Задержка в принципе может потребоваться при совместном использова-
нии Cool Edit Pro и устройств, синхронизируемых с программой по протоколу
SMPTE. Нажав на кнопку Format..., вы можете изменить формат, в котором ука-
зывается величина задержки. Например, Samples — задержка указывается в ко-
личестве звуковых отсчетов, Decimal (hh: mm: ss. ddd) — в часах: минутах: секун-
дах, долях секунд и т. д.
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[Advanced Session Properties

General Mwrtg. j Tempo j Metioncme[ Notes j

Ffe-MixiRg; Г 16-bit Set As Default I

Panning: ff y& Cut Logarithmic (default}

С Equal-pcwes Sinusoidal OK

Cancel |

"-Heip j

Рис. 12.25. Окно
свойств проекта,

вкладка Mixing

В списке Key for Voiced Loops указывается тональность проекта (эквивалент
списка Key на панели Session Info).

Вид окна Advanced Session Properties открытого на вкладке Mixing, показан на
рис. 12.25. В группе Panning вы можете выбрать способ панорамирования:

> L/R Cut Logarithmic — панорамирование достигается понижением уровня
сигнала в противоположном стереоканале по логарифмическому закону

> Equal-power Sinusoidal — при панорамировании уровень сигнала в одном
стереоканале понижается, а в другом повышается, в результате чего энер-
гия сигнала сохраняется

В группе Pre-Mixing можно выбрать разрешающую способность цифрового
сигнала, получаемого в ходе фонового микширования: 16 бит или 32 (по умолча-
нию). Кнопкой Set As Default настройки, выполненные на рассматриваемой вклад-
ке, получают статус принятых по умолчанию при создании нового проекта.

Наверное, нужно рассказать о том, что такое фоновое микширование
(background mixing). Расчеты, связанные с обработкой звука, требуют значитель-
ного процессорного времени. Несмотря на то что операционная система Windows
является мультизадачной, процессорного времени, как правило, предостаточно:
поскольку компьютер является персональным, большинство обрабатываемых им
событий генерируется пользователем. Это означает, что в промежутках между по-
даваемыми вами командами компьютер практически бездействует. Конечно, на
нем выполняются различные системные процессы, но обработка системных со-
бытий отнимает гораздо меньше времени, чем, например, расчет эффекта ревер-
берации. Какова тактовая частота вашего процессора? Допустим, 2 ГГц. Тогда в
промежутках между выполнением ваших команд процессор успевает пройти мил-
лиарды тактов вхолостую. В Cool Edit Pro это время не пропадает впустую благо-
даря существованию фонового микширования: программа отслеживает все изме-
нения параметров треков, блоков, эффектов и т. п. и постоянно занимается
микшированием вашего проекта. Внесено какое-то изменение в настройки бло-
ка — нужно пересчитать микс, в котором данный блок участвует. А когда вы запу-
стите свой проект на воспроизведение, программа будет готова это сделать, по-
скольку все расчеты (или хотя бы какая-то их часть) к тому моменту будут
выполнены и сохранены во временных файлах. Естественно, в ходе воспроизве-



MULTITRACK VIEW — мультмтрековый режим редактирования 395

дения процесс фонового микширование в случае необходимости будет продол-
жаться. Вы можете вносить какие-то изменения в проект прямо во время воспро-
изведения- Они будут отработаны программой и воплощены в звук. Ход выполне-
ния фонового микширования отображается на индикаторе прогресса
•ИЯВтПШНВВ, расположенном под областью полей параметров треков. При этом
программа интенсивно обращается к жесткому диску.

Естественно, фоновое микширование выполняется только в том случае, если в
нем есть необходимость. Если же программа успела рассчитать микс для всего проек-
та, а новых ваших команд не поступало, то фоновое микширование осуществляться
не будет. Индикатор фонового микширования будет заполнен ярко-зеленым цветом.

Вид окна Advanced Session Properties на вкладке Tempo показан на рис. 12.26.

•Advanced Session Properties

Gsnefalj.Mwng T«*eo|Mete

: flSO be'atsAninute

jH ]5 beats/bar

: f16 «cfcwbeat

. ';i— •=

'

mome] Notes j ~

[j4.02 Reset 1:1 teCwKHJ

Song Start

jo ms
S : i ;

wl

1 ГС,,, 1

Canedj

Hdp j

Рис. 12.26. Окно свойств
проекта, вкладка Tempo

В группе Tempo для редактирования доступны параметры, имеющие отноше-
ние к темпу проекта (частично дублируют поля панели Session Info):

> _ beats/minute — собственно темп
> _ beats/bar — количество долей в такте
> _ ticks/beat — количество тиков в такте

Доли разбиваются на тики, которые можно считать временными метками, ис-
пользуемыми программой для решения всевозможных задач синхронизации.

В поле Cursor At: группы Offset вы можете задать смещение шкалы времени,
Если нажать кнопку Reset I: I to Cursor, текущая позиция маркера будет соответ-
ствовать нулевой отметке на шкале времени.

Вид окна Advanced Session Properties на вкладке Notes показан на рис. 12.27.

ГдНУ1пг..Н Ч^иЫп PrnpntiK

General) Miwnsj. Тавро] Metronome "Notes

*\

ZJ

Рис. 12. 27. Окно свойств
проекта, вкладка Notes
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Здесь вы можете сохранить спои замечания и комментарии, касающиеся про-
екта и не более того.

12.1.5. Автоматизация

Словом «автоматизация» в звукозаписи традиционно называется возможность
записи изменений положений различных регуляторов на микшере посредством
MIDI-сообщений. Все действия звукорежиссера сохраняются в секвенсоре, могут
быть отредактированы и воспроизведены. Во время воспроизведения регуляторы
на микшере перемещаются как бы сами собой.

В программах для работы с музыкой и звуком автоматизация тоже присутству-
ет. В данном контексте автоматизацию можно разбить натри составляющие:

> Запись пользователем перемещений виртуальных регуляторов (MIDI-кон-
троллеров) в виде огибающих автоматизации

> Создание «с нуля» и графическое редактирование огибающих автоматиза-
ции

> Изменение автоматизируемых параметров программой во время воспроиз-
ведения мультитрекового проекта

В Cool Edit Pro реализованы две последние составляющие автоматизации.
Программа не позволяет записывать производимые вами изменения в настрой-
ках треков, эффектов и прочего в процессе воспроизведения проекта. Естествен-
но, программа реагирует на эти изменения, но они не сохраняются в виде ка-
ких-либо графиков изменения каких-либо параметров во времени. Зато вы
можете создавать и графически редактировать огибающие автоматизации, ко-
торые будут управлять различными параметрами во время воспроизведения про-
екта. Фактически огибающие автоматизации и являются графиками изменения
каких-либо параметров во времени: чем выше проходит огибающая громкости,
тем громче будет звук в этом месте блока. И, наоборот, с помощью огибающей
можно, например, приглушить фоновую музыку в том месте, где разговаривает
диктор (подразумевается, что речь диктора хранится в блоке, размещенном па-
раллельно блоку с фоновой музыкой на другом треке).

Огибающую панорамы следует трактовать следующим образом: чем выше про-
ходит линия, тем левее будет уходить кажущийся источник звука; чем линия про-
ходит ниже, тем правее позиционируется источник звука. Центр панорамы соот-
ветствует середине блока по вертикали.

Огибающие автоматизации параметров эффектов можно трактовать следую-
щим образом: чем выше проходит линия, тем больше значение автоматизируемо-
го параметра; чем линия ниже, тем значение параметра меньше.

Перечислим кнопки панели инструментов и соответствующие им команды
главного меню, имеющие отношение к огибающим автоматизации.

(View > Show Volume Envelopes) — отображать/скрыть огибающие автома-
тизации громкости.
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(View > Show Pan Envelopes) — отображать/скрыть огибающие автоматиза-
ции панорамы.

(View > Show Wet/Dry Mix Envelopes) — отображать/скрыть огибающие ав-
томатизации параметра Wet/Dry (отношение уровня сигнала, обработанного эф-
фектом, к уровню исходного сигнала).

/"~*1 (View > Show FX Parameter Envelopes) — отображать/скрыть огибающие ав-
томатизации параметров эффектов.

(View > Show Tempo Envelopes) — отображать/скрыть огибающие автома-
тизации темпа в MlDI-файлах, добавленных в проект (эти огибающие хранятся
непосредственно в MIDI-файлах и недоступны для редактирования).

(View > Enable Envelope Editing) — включение/выключение режима редак-
тирования огибающих автоматизации.

Для начала сделайте так, чтобы кнопки j|j и j^y находились в нажатом состоя-

нии, а остальные кнопки были отжаты. При этом поверх каждого из блоков будет
видна линия — огибающая автоматизации громкости. По своей сути она является
графиком изменения уровня сигнала в зависимости от времени. Для редактирова-
ния доступна только огибающая выделенного блока. Если вы щелкнете на каком-
либо из блоков (и, соответственно, выделите его), то станут видны узлы огибающей
(точки перегиба). Вы можете создать новый узел. Подведите курсор к огибающей

(он должен принять вид\_А~,) и щелкните кнопкой мыши — появится новый узел.

При наведении курсора на узел в виде контекстной подсказки будет отображаться
значение автоматизируемого параметра вданной точке (рис. 12.28).

Рис. 12.28. Огибающая громкости
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Можно создать сколько угодно узлов, чтобы, перемещая их с помощью мыши,
придать огибающей желаемую форму.

Зачастую бывает полезной такая опция, как аппроксимация огибающих сплай-
нами. Т. е, огибающая будет выглядеть не как угловатая линия, состоящая из от-
резков, а как плавная кривая, проходящая около точек узлов. Включается данная
опция следующим образом: щелкните правой кнопкой мыши на блоке (предва-
рительно можно выбрать сразу несколько блоков), откроется контекстное меню
блока. Выберите в нем Envelopes, затем один из трех видов огибающих:

> Volume — огибающая громкости
> Pan — огибающая панорамы
> FX Mix — огибающие параметров эффектов

Затем, для выбранного вида огибающей выберите команду Use Splines.

Рис. 12.29. Варианты огибающих: обычная (а), с использованием аппроксимации
сплайнами (б)

Вид огибающей без аппроксимации и с аппроксимацией сплайнами показан
на рис. 12.29 а, б. Заметим, что если опция аппроксимации отключена, то при
построении огибающей по узлам фактически используется метод интерполяции
1-го порядка, т. е. узлы соединяются отрезками прямых линий.

Команда Use Splines находится в одном подменю с командой Clear Selected Points
(рис. 12.30), которая может вам пригодиться в том случае, если нужно удалить
несколько узлов.

Pan
FXMbc

Рис. 12.30. фрагмент контекстного меню блоки
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Прежде чем воспользоваться данной командой, следует выделить фрагмент
мультитрекового проекта, включающий те узлы огибающей, которые нужно уда-
лить. Затем для вызова контекстного меню щелкните правой кнопкой мыши на
блоке, содержащем удаляемые узлы. Тем самым вы локализуете область блока, на
которой следует удалить узлы огибающей.

Существует и более простой способ удаления узла огибающей: хватаете узел
мышью и тянете за пределы блока.

В разд. 12.1.2. мы коснулись вопроса автоматизации параметров эффектов,
Давайте разовьем эту тему и попробуем на практике автоматизировать какой-либо
эффект. Пусть это будет динамический фильтр (тот самый, с помощью которого
делается эффект «вау-вау»). Допустим, на одном из треков имеется блок, который
следует обрабатывать этим эффектом. С этим треком мы и будем эксперименти-
ровать. Перечислим этапы процесса:

I. Подключение эффекта к необходимому треку.
II. Выбор параметров, подлежащих автоматизации.
III. Создание огибающих.

А теперь рассмотрим последовательность действий на каждом из этапов.

I . П о д к л ю ч е н и е э ф ф е к т а к н е о б х о д и м о м у т р е к у :

> Нажмите кнопку FX в области атрибутов трека. Если к треку не подключен
ни один эффект, откроется окно Effects Rack. Если к треку уже подключены
эффекты, то возникнет окно их параметров, в нем нажмите кнопку Rack
Setup — возникнет окно Effects Rack

> В древовидном списке Installed Real-Time Effects выберите Filters, затем
Dynamic EQ

> Нажмите кнопку Add->, затем OK — эффект подключен к треку.

II. В ы б о р п а р а м е т р о в , п о д л е ж а щ и х а в т о м а т и з а ц и и :

> Еще раз нажмите кнопку FX в области атрибутов трека. Поскольку к треку
уже подключен как минимум один эффект, возникнет окно параметров эф-
фектов.

> Если к треку подключено более одного эффекта, выберите вкладку Dynamic
Е0(рис. 12.31)

> В нижней части окна выберите тип фильтра: Low Pass — ФНЧ, Band Pass —
полосовой, High Pass — ФВЧ.

> У эффекта для автоматизации доступно три параметра; усиление сигнала на
выходе (Gain), частота среза (Frequency) и добротность (Q). Последний пара-
метр доступен только для полосового фильтра. Установите флажки Automated
для тех параметров, которые следует автоматизировать. Мы выбрали для ав-
томатизации параметр Frequency. Вид окна несколько изменится (рис. 12.32).

> Если это необходимо, установите флажки Spline Curves для включения апп-
роксимации огибающих автоматизируемых параметров сплайнами,
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Рис. 12.31. Парамет-
ры эффекта Dynamic
EQ

> Закройте окно параметров эффектов или отодвиньте его в сторону, чтобы
не мешало.

III. С о з д а н и е о г и б а ю щ и х :

> С помощью команды View > Enable Envelope Editing или кнопки цУ, распо-

ложенной на панели инструментов главного окна, включите режим редак-

тирования огибающих автоматизации. С помощью кнопки или коман-

ды View > Show FX Parameter Envelopes сделайте огибающие автоматизации
параметров эффектов доступными. Щелкните на том блоке, огибающие
которого собираетесь редактировать.

> По умолчанию огибающие имеют форму горизонтальных линий. Посколь-
ку может быть несколько огибающих, для начала нужно найти ту, которую
вы хотите отредактировать. Для этого поочередно подводите курсор мыши
к каждой из них и смотрите на строку статуса главного окна, там будет ото-
бражаться название и значение параметра, управляющего той огибающей,
к которой подведен курсор. Мы остановим свой выбор на огибающей
Frequency.

> Щелчками на огибающей создавайте узлы и перемещайте их так, чтобы оги-
баюшая приняла нужную вам форму. Узлы, которые появились ошибочно,
вытаскивайте за пределы блока. Вы можете выделить фрагмент редактируе-
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мого проекта, включить режим циклического воспроизведения и слушать
результаты своих действий непосредственно в ходе редактирования огиба-
ющей. Чтобы включить режим циклического воспроизведения, следует
включить опцию Options > Loop Mode, расположенную в главном меню и
нажать <Пробел> или запустить воспроизведение с помощью соответству-
ющей кнопки транспортной панели.

Результаты своих действий мы сохранили в файле FX-AUTOMATION. SES,
расположенном в папке SAMPLES/FX-AUTOMATION на CD-ROM, прилагае-
мом к книге.

В завершение раздела перечислим веши, о которых нужно помнить.
Информация о формах огибающих автоматизации относится к блоку, а не к

треку. Т. е. формы огибающих являются свойствами блока. В то же время перечень
доступных огибающих автоматизации является свойством трека. Можете провес-
ти эксперимент: переместить блок, для которого мы только что сформировали
огибающую, сначала вдоль трека, а затем — на другой трек. В последнем случае вы
обнаружите, что те огибающие, которые были характерны для одного трека (на-
пример, огибающие параметров определенных эффектов, подключенных к тре-
ку) на другом треке просто исчезнут. Если вернуть блок на исходный трек, то оги-
бающие вновь появятся, но будут иметь п р и н я т ы й по умолчанию вид
горизонтальных прямых. Чтобы вернуть огибающим прежнюю форму, следует, как
минимум, один раз выполнить команду отмены Edit> Undo.

ЫЗак. I152
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12.1.6. Контекстные меню треков и блоков
Контекстные меню треков и блоков включают в себя большинство из тех команд,

что имеются в главном меню программы и относятся к редактированию мультитреко-
вого проекта. Однако пользоваться этими командами удобнее именно из контекстных
меню, вызываемых щелчком правой кнопки мыши над редактируемым объектом.

Контекстное меню трека
Контекстное меню трека вызывается щелчком правой кнопки мыши на треке

в свободном от блоков месте. Соответственно команды, выбранные в этом меню,
будут выполняться применительно к тому треку, на уровне которого был выпол-
нен щелчок. Некоторые из команд мы уже рассмотрели, а некоторые команды
вызывают появление окон, которые мы уже тоже рассмотрели. Вообще в Cool Edit
Pro одно и то же окно можно вызвать несколькими способами.

Команда Insert открывает подменю, в котором можно выбрать источник дан-
ных, добавляемых в многодорожечный проект:

> Empty Wave — создать блок, не содержащий волновой формы. Размер блока
определяется шириной предварительно выделенного фрагмента проекта.
Если фрагмент не был выделен, то команда недоступна

> Empty Wave (Mono) — команда аналогична предыдущей, но создаваемый блок
имеет монофонический формат

> Wave from File... — вставить в проект WAV-файл
> MIDI from File... — вставить в проект MIDI-файл
> Video from File... — вставить в проект видеоряд из AVI-файла
> Audio from Video File... — вставить в проект звуковую дорожку из AVI-файла.
> File/Cue List открывает окно Insert Into Multitrack, содержащее список заг-

руженных в Cool Edit Pro волновых форм и отметок (см. разд. 5.3)

Кроме того, в подменю Insert можно просто выбрать волновую форму из тех,
что уже загружены в Cool Edit Pro.

Команда контекстного меню Mix Down to Track (Bounce) открывает подменю,
содержащее команды, связанные с внутренним пересведением — объединением
нескольких блоков в один:

> All Waves — пересвести все блоки
> Selected Waves — пересвести только выделенные блоки
> All Waves (Mono) и Selected Waves (Mono) — команды, аналогичные предыду-

щим, но результат пересведения сохраняется в монофоническом формате

Следующие команды контекстного меню трека переключают состояния его
атрибутов:

> Mute Track — заглушить трек
> Solo Track — сделать трек солирующим
> Solo Current TVack Only — сделать трек солирующим, а с остальных треков

снять атрибуты S (соло)
> Arm Track for Record — подготовить трек к записи
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Следующие команды контекстного меню трека вызывают окна диалога, в ко-
торых для редактирования доступны различные параметры трека:

> Track Volume... — открывает окно с регулятором громкости
> Track Pan... — открывает окно с регулятором панорамы
> Effects Settings... — открывает окно параметров эффектов, если к треку под-

ключен хотя бы один эффект. В противном случае откроется окно Effects
Rack.

> Rack Settings... — открывает окно Effects Rack, в котором осуществляется
подключение/отключение эффектов.

> Playback Device... — открывает окно Playback Devices, в котором можно выб-
рать аудиопорт, на который будет выводиться звук данного трека.

> Recording Device... — открывает окно Recording Devices, предназначенное для
выбора входного аудиопорта, с которого будет осуществляться запись, а та к-
же формата (стерео/моно, разрядность).

> Track Equalizer... — открывает окно трекового эквалайзера
> Track Properties... — открывает окно свойств трека

В контекстном меню трека осталось рассмотреть две команды: Select All Blocks
in Track и Insert/Delete Time....

Первой из них (Select All Blocks in Track) выделяют все блоки, принадлежащие
треку, для которого было вызвано контекстное меню.

Команда Insert/Delete Time... вызывает появление одноименного окна диа-
лога (рис. 12.33), с помощью которого можно вставить в многодорожечный про-
ект паузу (раздвинуть блоки на всех треках) или удалить выделенный фрагмент
проекта. Прежде чем воспользоваться этой командой, имеет смысл выделить
часть многодорожечного проекта, которую следует освободить от блоков за счет
их передвижения вправо или удаления. После применения команды блоки, ко-
торые попали в выделенную область частично, будут разрезаны по границе вы-
деленной области.

insert/Delete Time

& Insert

Т Delete Selected Time

decimal time

j Alt blocks to the tight of the cursor
I Will be moved to the right OK

Рис. 12.33. Добавление паузы/удаление фрагмента

В окне Insert/Delete Time имеются две опции:

> Insert —добавить в проект паузу с длительностью, заданной в формате, выб-
ранным в подменю View > Display Time Format

> Delete Selected Time — удалить выделенный фрагмент проекта
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Контекстное меню блока (если выделен только один блок)

Контекстное меню блока вызывается щелчком правой кнопки мыши на каком-
либо блоке. Команды, выбранные в этом меню, будут выполняться применительно
ктому блоку, на котором был произведен щелчок. Перечислим команды этого меню.

> Edit Waveform... — открыть волновую форму блока в режиме редактирования.
> Loop Properties — вызов окна Wave Block Looping (см, разд. 12,1.4). Если для

данного блока включено зацикливание, то перед командой меню Loop
Properties будет отображаться галочка.

> Allow Multiple Takes — включение/выключение режима Multiple Takes. Если
вы сделаете несколько попыток выполнить запись примерно на одну и ту
же область трека, то старый материал окажется затертым вновь записан-
ным. Однако в режиме Multiple Takes все дубли сохранятся. Выбрать нуж-
ный дубль можно будет в подменю Take History. По сути дела в режиме
Multiple Takes вы сможете подставлять на одно и то же место трека разные
блоки, записанные в нескольких попытках. С помощью команды Delete This
Take подменю Take History текущий дубль удаляется.

> Adjust Wave Block Volume... — вызов окна с регулятором громкости. Причем
регулировка громкости будет осуществляться применительно к блоку, а не
к треку в целом.

> Adjust Wave Block Pan...— регулировка панорамы применительно к блоку,
> Wave Block Properties...— вызов одноименного окна (рис. 12.34), в котором

собраны основные свойства блока.

В окне доступны следующие параметры:

> Volume — громкость
> Pan — панорама
> Filename/Path — поле, в котором блоку можно присвоить новое имя, отлич-

ное от имени файла, в котором хранится волновая форма
> Time Offset — смещение блока от начала трека
> Hue — цветовой оттенок блока
> Mute — мьютирование (заглушение) блока
> Lock in Time — запрет на перемещение блока в другую временную позицию.
> Lock for Play Only — невозможность затирания блока новой записью

Вернемся к командам контекстного меню блока:

> Mix Down to File — микшировать блок с сохранением микса в файле. Может
показаться, что команду бессмысленно применять для одного блока, ведь
его волновая форма уже существует в виде файла. Но применение данной
команды приводит к расчету новой волновой формы с учетом таких пара-
метров, как громкость, панорама и др., а также эффектов, примененных к
тому треку, на котором размешен блок.

> Mix Down to File (Mono) — команда аналогична предыдущей за исключени-
ем того, что микширование осуществляется в монофоническом формате.

> Команда Block Color вызывает появление одноименного окна диалога, по-
казанного на рис. 12.35.
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Рис. 12.34. Свойства блока
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Рис. 12.35. Выбор оттенка цвета блока

С помощью этого окна вы можете скорректировать двет блока. Примечатель-
но то, то вы, в принципе, не можете выбрать такой цвет блока, при котором рабо-
та с ним была бы затруднительной, например, из-за того, что какие-то его графи-
ческие элементы сливаются с фоном.

Продолжим рассматривать команды контекстного меню блока.
Выбор команды Punch In приводит к следующему:

> Исходный блок разрезается по границам выделенной области проекта, в
результате чего получаются два или три независимых блока

> Для блоков, находящихся за пределами выделенной области, включается
режим Lock for Play Only

> Для блока, находящегося внутри выделенной области проекта, включается
режим Allow Multiple Takes
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В результате всех этих действий, выполняемых программой автоматически, вы
можете делать сколько угодно попыток записи на ту область трека, которая была
предварительно выделена. При этом вы не рискуете затереть материал, находящий-
ся за ее пределами, и впоследствии имеете возможность выбора наилучшего дубля.

Далее в контекстном меню блока следует не команда, а подменю Crossfade. Ко-
манды данного подменю выполнят автоматическое построение огибающей гром-
кости в пределах выделенного фрагмента блока. Громкость будет плавно возрастать
или затухать в зависимости от того, какая часть блока выделена (ближе к началу или
ближе к концу). Возможные варианты характера изменения громкости:

> Linear — линейный
> Sinusoidal — синусоидальный
> Logarithmic In — логарифмический (вогнутый)
> Logarithmic Out — логарифмический (выпуклый)

Наиболее естественными законами изменения громкости во времени являют-
ся логарифмические.

Следующая команда контекстного меню блока — Loop Duplicate —- вызывает
появление одноименного окна диалога (рис. 12.36), с помощью которого можно
создать несколько расположенных подряд копий блока.

Note: Foe waveform blocks, 'a more efficient and
flexible method of looping is to adjust the block's
Loop Properties.

t'nves

f* No gaps.-cotiirsjaus looping

C" Evenly Spaced j

Рис. 12.36. Создание повторяющихся копий блока

В поле Duplicate block _ times вы должны указать количество копий блока. Если
выбрана опция No qaps - continuaus looping, то копии блоков будут расположены
друг за другом без промежутков между ними. Если выбрана опция Evenly Spaced.
то вы можете указать интервал, через который будут размещаться копии блока.

Команда контекстного меню блока Convert to Unique Copy создает копию вол-
новой формы блока, которая замещает исходную волновую форму. Новая волно-
вая форма размешается в новом файле. Интересная особенность проявляется у
этой команды, если ее применить к лупу или груву. Допустим, реально волновая
форма лупа содержит один такт ритмической партии. Если растянуть блок лупа
на несколько тактов, то содержание его вол новой формы от этого не изменится —
в ней по-прежнему будет храниться всего один такт. Если после этого воспользо-
ваться командой Convert to Unique Copy, то возникнет новая волновая форма, ко-
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торая будет содержать уже не один такт, а столько, сколько их умещалось в исход-
ном блоке. Сам же блок свойства лупа потеряет.

Следующие команды контекстного меню блока относятся к свойствам бло-
ка, с которыми мы уже успели познакомиться: Mute Block — заглушить блок,
Lock in Time — закрепить блок на одном месте, Lock for Play Only — защитить
блок от записи.

С командой контекстного меню блока Split мы тоже успели вас познакомить в рлзд.
12.1.2. Она разрезает блок в позиции маркера или по границам выделенной области.

Команда контекстного меню блока Merge/Rejoin Split объединяет блок с со-
седними, прилегающими к нему блоками. Если блоки имеют разное происхожде-
ние (содержат разные волновые формы), то выполняется операция Merge — сли-
яние волновых форм в чистом виде с их нахлестом и кроссфейдом длительностью
в 30 мс. Если же объединяемые блоки были получены путем деления одного ис-
ходного блока командой Split (в данном случае операция объединения будет на-
зываться Rejoin), то они должны располагаться в той же последовательности, в
которой они находились после применения команды Split.

Следующие две команды контекстного меню блока Adjust Boundaries и Trim,
хоть и называются по-разному, но выполняют одно и то же действие. Может быть,
между этими командами и существуют какие-то отличия, но нам их выявить не
удалось. А действуют они следующим образом: фрагменты блока, которые выхо-
дят за границы выделенной области, удаляются. Но и удалением эту операцию в
полной мере тоже нельзя считать. Удаляются только узлы огибающих автоматиза-
ции, находящиеся за пределами выделенной области, и происходит перемещен ие
границ блока. Сами же волновые формы остаются нетронутыми. В случае необхо-
димости вы можете перетащить границы блока мышью на исходное место. Вы
обнаружите, что с самой волновой формой ничего не произошло. Такая техноло-
гия редактирования, когда границы блоков не имеют жесткой привязки к грани-
цам волновых форм, называется скользящим редактированием. Заметим только,
что перемещение границ блоков возможно, если включен соответствующий ре-
жим. А делается это с помощью кнопки Цу, расположенной на панели инстру-
ментов в главном окне программы или с помощью команды главного меню View >
Enable Block Edge Dragging.

Следующая команда контекстного меню блока Cut не имеет ничего общего с
привычной командой вырезания в буфер обмена. Все, что она делает, — разрезает
блок по границам выделенной области и удаляет тот фрагмент, который заключен
в ее пределах.

Команда контекстного меню блока Full раздвигает границы блока так, чтобы
они совпадали с границами волновой формы.

Команда контекстного меню блока Remove Block удаляет блок, но не выгружа-
ет из Cool Edit Pro файла волновой формы, соответствующего данному блоку.

Команда контекстного меню блока Destroy Block (remove & close) удаляет блок
и выгружает соответствующий ему файл волновой формы.

С командами контекстного меню блока, находящимися в подменю Envelopes,
мы уже познакомили вас в разд. 12.1.5.
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Контекстное меню блоков (выделена группа блоков)

Контекстное меню блоков вызывается щелчком правой кнопки мыши на лю-
бом из выделенных боков, при условии, что таковых, как минимум, два или более.
Команды, выбранные в этом меню, будут выполняться применительно ко всем
выделенным блокам.

В контекстном меню блоков команд значительно меньше, чем в контекстном
меню блока. Многие из присутствующих команд имеют такие же названия, что и
в рассмотренном меню. Они выполняют такие же действия, но только примени-
тельно не к одному блоку, а к группе выделенных блоков. Остановимся лишь на
некоторых специфических командах подменю блоков:

> Group Blocks — группировать/разгруппировать выделенные блоки
> Group Color... — вызывает одноименное окно диалога, с помощью которого

можно изменить цвет группы блоков
> Align Left —- выровнять выделенные блоки по левой границе того блока,

щелчком на котором было вызвано контекстное меню
> Align Right — команда аналогична предыдущей, но выравнивание происхо-

дит по правой границе блока

Хочется обратить ваше внимание на подменю Crossfade, содержащее команды
автоматического построения огибающей громкости. Мы уже сталкивались с эти-
ми командами, но тогда они работали применительно к одному блоку. Если же их
применять сразу к нескольким блокам, то огибающие будут построены таким об-
разом, что громкости одних пересекающихся во времени блоков будут убывать, а
других возрастать. Собственно слово «crossfade» и означает эффект пересечения -
плавного перетекания одного звука в другой.

12.1.7. Эффективное использование органайзера
С панелью органайзера мы познакомили вас в разд. 5.2. Вызвать эту панель

можно командой View> Show Organizer Window или одновременным нажатием кла-
виш <Alt> + <9>.

В мультитрековом режиме данная панель выглядит точно так же, как и в режиме
редактирования волновой формы: никаких новых кнопок, никаких новых опций и
вкладок. Но именно в мультитрековом режиме возможности данной панели рас-
крываются в полной мере. Воспринимайте органайзер как своеобразную палитру
эффектов и файлов, из которых как из кирпичиков формируется композиция.

На вкладке Files (рис. 12.37 а) отображаются все файлы, загруженные в Cool
Edit Pro 2. Вы хватаете нужный файл мышью и перетаскиваете на требуемое место
в многодорожечном проекте.

На вкладке Effects (рис. 12.37 б) отображается древовидный список эффектов.
Но доступны в нем только те эффекты, которые относятся к категории Real-Time
Effects. Нужно подключить эффект к треку? Хватайте его мышью и «бросайте» на
нужный трек. После этого сразу же открывается окно параметров эффектов, под-
ключенных к данному треку, на вкладке, соответствующей вновь подключенному
эффекту.
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Рис. 12.37. Органайзер; вкладка Files (а), вкладка Effects (6)

Вот и все, что можно сказать об особенностях применения органайзера в муль-
титрековом режиме.

12.1.8. Микшер
Наличие окна-микшера в программах для работы с музыкой и звуком стало

уже традицией. Имеется микшер и в Cool Edit Pro 2. Вызвать его панель можно
командой View > Show Mixers Window или комбинацией клавиш <Alt> + <2>.

В левой части микшера расположена мастер-секция с фейдером общей гром-
кости.

Вид остальной части панели зависит от того, какая из вкладок выбрана: IVack
Mixers — микшер треков (рис. 12.38) или Bus Mixers — микшер шин (рис. 12.39).

На вкладке Track Mixer каждая из линеек микшера соответствует одному из
треков. Слева от микшера треков имеется вертикальный ряд кнопок, определяю-
щих отображаемый на микшере набор атрибутов треков. Мы нажали все эти кноп-
ки, поэтому на рис. 12.38 показан наиболее полны и вид микшера. Поля и кнопки
атрибутов треков на микшере такие же точно, как и элементы полей атрибутов
треков в главном окне. Пожалуй, единственное отличие заключается в наличии
фейдера громкости (в главном окне для управления громкостью треков использу-
ются числовые поля).

Каждая из линеек микшера шин (рис. 12.39), как и следует из его названия,
соответствует шине. Исключение составляет только последняя линейка, на кото-
рой всегда доступна всего одна кнопка New — создание новой шины.
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Рис. 12.38. Панель микшера, вкладка Track Mixer

Кнопкой Out вызывается окно свойств соответствующей шины. Напомним,
что основное назначение данного окна заключается в подключении эффектов к
шине и определении выходного аудиопорта, на который будет выводиться сигнал
шины. Кнопкой Config вызывается окно свойств эффектов, подключенных к шине.
В этом же окне последняя из вкладок соответствует микшеру эффектов. Обо всех
этих окнах мы подробно рассказали в разд. 12.1.2.

Кроме перечисленных кнопок, на каждой из линеек микшера шин имеется
фейдер громкости и регулятор панорамы, кнопки М (Mute) и S (Solo).

Последнее, на что хотим обратить наше внимание, — панель микшера являет-
ся плавающей. Ее можно перетащить и встроить на любое место в главном окне.
Размеры панели микшера тоже можно изменять по вкусу.
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Рис. 12.39. Панель микшера, вкладка Bus Mixer

12.2. Команды главного меню
Со многими из команд главного меню мы уже успели вас познакомить. Мно-

гие из команд продублированы в контекстных меню. Поэтому данный раздел сле-
дует считать справочным. Мы просто еще раз перечислим эти команды в том по-
рядке, в котором они расположены в главном меню программы.

12.2.1. Меню File — работа с файлами

В меню File по традиции сосредоточены команды, предназначенные для рабо-
ты с файлами:
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> New Session... — создать новую сессию
> Open Session... — загрузить существующую сессию
> Append to Session... — загрузить сессию, не закрывая существующую (треки

подгружаемой сессии будут располагаться, начиная с первого свободного трека)
> Close Session — закрыть сессию
> Close Session and Waveforms — закрыть сессию и файлы с волновыми формами
> Close Only Non-Session Waveforms — закрыть файлы с волновыми формами,

не принадлежащие сессии
> Open Waveform... — открыть файл с волновой формой
> Save Session — сохранить сессию с прежним именем
> Save Session As... — сохранить сессию с новым именем
> Save All — сохранить все открытые файлы с волновыми формами и сессию
> Save Mixdown As... — свести все аудиотреки сессии в один звуковой файл
> Save Mixdown to Video As...— свести все аудиотреки и видеотрек (в сессии

может быть только один видеотрек) в AVI-файл
> Save All — сохранить все модифицированные звуковые файлы, загружен-

ные в данный момент в Cool Edit Pro
> Default Session — подменю, включающее в себя две команды: Set Current

Session as Default — считать текущую сессию шаблоном для новых сессий;
Clear Default Session — очистить шаблон для новых сессий (отменяет ко-
манду Set Current Session as Default)

> Free Up Space in Temp Files... — открыть окно диалога, содержащее сведения
об объеме свободной памяти на жестком диске; из данного окна вы можете
дать команду закрытия файлов (Close File), очистить буфер последних вы-
полненных действий (Clear Undo(s)), зарезервировать место на дисках под
хранение временных файлов и др.

> Exit — выйти из приложения Cool Edit Pro

Перечисленные команды вряд ли нуждаются в подробных пояснениях.

12.2.2. Меню Edit — редактирование
Большинство команд меню Edit дублируются в контекстных меню, описанных

в разд. 12.1.6. Кроме того, содержание данного меню зависит от того, выбран ли
один блок, выбрана ли группа блоков или же не выбран ни один блок. Перечис-
лим только те команды, о которых мы еше не упоминали или упоминали мельком.

> Undo (<Ctrl> + <Z>) — отменить последнюю операцию редактирования
> Mix Down to File — создание микса. Возможные варианты: микширование

всех незаглушенных блоков в стереомикс (All Waves); микширование всех
выбранных и незаглушенных блоков в стереомикс (Selected Waves); микши-
рование всех незаглушенных блоков в мономикс (All Waves (Mono)); мик-
ширование всех выбранных и незаглушенных блоков в мономикс (Selected
Waves (Mono)). После сведения микс окажется во временном файле, кото-
рый следует сохранить под нужным вам именем. Какая бы из перечислен-
ных команд не была выбрана, если выделен фрагмент проекта, то микши-
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роваться будут только те блоки (ил и фрагменты этих блоков), которые ока-
зались в зоне выделения

> Mix Down to Empty Track — группа команд, аналогичная приведенным выше,
отличается от них тем, что микс размещается на первом же треке, на кото-
ром имеется свободное место для размещения его блока

> Select All Blocks (<Ctrl> + <A>) — выделить все блоки
> Select All Blocks in Track n ~ выделить все блоки на текущем треке (п — но-

мер текущего трека)
> Group Waveform Normalize — совместная нормализация нескольких волно-

вых форм (см. разд. 4.13).
> Snapping — привязка графических объектов к сетке. По сравнению с режи-

мом редактирования волновой формы в данном подменю появились две
новые опции: Snap to Blocks — привязка к границам блоков (неважно, на
каком из треков они располагаются), Snap to Loop Endpoints — привязка к
границам периода лупов.

> Refresh Now (<F5>) — принудительный запуск процесса фонового микши-
рования и регенерация изображения

> Check For Hidden Blocks (<Shift> + <F5>) — выявление скрытых блоков: бло-
ки, перекрытые другими, более крупными блоками, будут выведены на «пе-
редний план»

12.2.3. Меню View - управление отображением
Некоторые из команд меню View уже знакомы по материалу главы 5, а некото-

рые мы уже упоминали и в данной главе. Пройдемся по командам и подменю,
имеющим в мультитрековом режиме специфические особенности:

> Edit Waveform View (<F12>) — переключиться в режим редактирования вол-
новых форм

> Show Pan Envelopes — отображать огибающие панорамы
> Show Volume Envelopes — отображать огибающие громкости
> Show Wet/Dry Mix Envelopes — отображать огибающие автоматизации па-

раметра Wet/Dry (отношение уровней обработанного эффектами и исход-
ного сигналов)

> Show FX Parameter Envelopes — отображать огибающие автоматизации па-
раметров эффектов

> Show Tempo Envelopes — отображать огибающую темпа на MIDI-треке
(в сессии может присутствовать только один MIDI-трек)

> Enable Envelope Editing — включить режим редактирования огибающих
> Show Session Properties (<Alt> + <3>) — отображать панель Session Info
> Show Mixers Window (<Alt> +• <2>) — отображать окно микшера
> Show Track EQ Window (<Alt> + <5>) — отображать окно трековых эква-

лайзеров
> Show Track Properties (<Alt> + <4>) — отображать окно свойств трека
> Show Load Meter — отображать диаграмму загруженности процессора
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> Show Video Window — отображать окно, в котором при воспроизведении
проекта будет демонстрироваться нидеотрек

> Show Advanced Session Properties — показать окно Advanced Session Properties

12.2.4. Меню Insert - вставка волновых форм, видео- и MIDI-файлов в
мультитрековый проект

Первой командой меню Insert открывается подменю Empty Wave, которое вклю-
чает в себя команды создания пустых блоков — волновые форма таких блоков не
содержат ничего кроме тишины. Команды данного подменю доступны лишь в том
случае, если выделен фрагмент проекта. Именно в рамках этой области и будут
создаваться пустые блоки. Охарактеризуем особенности действия команд подме-
ню Empty Wave:

> In Current Track — пустой блок будет размещен на текущем треке
> In Current Track (Mono) — пустой блок, имеющий монофонический формат,

будет размещен на текущем треке
> In All Record-Armed Tracks — пустые блоки будут размешены на всех треках,

у которых включен атрибут R (готовность к записи)

Следующая группа команд меню Insert позволяет добавлять в проект мульти-
медийные данные.

> Wave from File... — добавить аудиофайл (не обязательно в формате WAV)
> MIDI from File... —добавить MlDl-файл
> Vide from File... — добавить видео из AVI-файла
> Audio from Video File... —добавить звуковую дорожку из AVI-файла

Далее в меню Insert следует список загруженных в Cool Edit Pro файлов. Заметим,
что при загрузке сессии в программу подгружаются все используемые в ней файлы.

Завершает меню команда File/Cue List..., которая вызывает окно, с древовид-
ным списком загруженных в Cool Edit Pro файлов, для каждого из которых приве-
ден перечень фрагментов, размеченных с помощью опций панели Cue List (см.
разд. 5.3). Выбор имени того или иного размеченного фрагмента приводит к его
вставке на трек мультитрекового редактора.

12.2.5. Меню Effects — мультитрековые эффекты
В Cool Edit Pro 2 все эффекты разбиты на три категории:

> Real-Time Effects — эффекты реального времени (их можно применять как в
режиме редактирования волновой формы, так и в мультитрековом режиме)

> Off-Line Effects — эффекты, которые можно применять только в режиме ре-
дактирования волновой формы

> Multitrack — мультитрековые эффекты

Именно по этим категориям могут быть разделены эффекты в древовидном
списке панели органайзера. В действительности все эффекты Cool Edit Pro явля-
ются плагинами, а в органайзере отображается список этих плагинов. В принци-
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пе, эффекты категории можно подключить к треку методом перетаскивания из
органайзера на трек. Но так делать нельзя, т. к. мультитрековые эффекты можно
применять только к выделенным блокам, находящимся внутри выделенной обла-
сти мультитрекового проекта. Из органайзера их можно вызывать двойным щелч-
ком на названии нужного эффекта. Применять мультитрековые эффекты жела-
тельно только из меню Effects.

Мультитрековые эффекты работают применительно к одному или двум (в за-
висимости от эффекта) выбранным блокам. Но перед этим еще должна быть выб-
рана область мультитрекового проекта, включающая в себя эти блоки. Блоки дол-
жны пересекаться во времени. Результатом применения мул ьтитре ков ых эффектов
является создание нового блока.

Envelope Follower- повторитель огибающей

Окно данного эффекта (рис. 12.40) вызывается командой Efects > Envelope
Follower.... Недоступна эта команда лишь в том случае, если выделена область про-
екта и в ее пределах полностью или частично находятся два выделенных блока.
Причем блоки должны перекрываться во времени. Выполнить эти требования не
так уж и трудно: мышью выделите область проекта, включающую в себя интересу-
ющие вас блоки, затем, удерживая нажатой клавишу <Ctrl>, выберите блоки, щел-
кая на них левой кнопкой мыши.

Эффект Envelope Follower изменяет огибающую амплитуды обрабатываемой вол-
новой формы в соответствии с огибающей амплитуды образцовой волновой форм ы.

Данный эффект можно применить, например, если требуется, чтобы бас-гита-
ра звучала только в моменты ударов барабана. Для этого нужно барабанный сэмпл
выбрать в качестве образца, а обрабатывать сэмпл бас-гитары.

В дополнение к применению функции Envelope Follower вы можете изменять
параметры динамической обработки результирующей волновой формы. Рассмот-
рим опции окна Envelope Follower.

В раскрывающемся списке Analysis Wave содержится имя волновой формы-об-
разца, а в раскрывающемся списке Process Wave — имя обрабатываемой волновой
формы.

В списке Output To всего один элемент — трек, куда будет записана волновая
форма, получившаяся в результате обработки.

В группе Gain Processor можно выбрать параметры тракта усиления:

> Output Gain — коэффициент усиления на выходе
> Attack Time (Out) — время атаки (для выходного сигнала)
> Release Time (Out) — время спада (для выходного сигнала)
> Joint Channels — флажок, при установке которого оба канала будут обраба-

тываться совместно

В группе Level Detector выбирают следующие параметры тракта детектирования:

> Input Gain — коэффициент усиления на входе детектора уровня
> Attack Time (In) — время атаки (для входного сигнала)
> Release Time (In) — время спада (для входного сигнала)
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Рис. 12.40. Окно эффекта Envelope Follower

Переключателями Peak и RMS вы можете выбрать вид амплитудного детекто-
ра: пиковый или среднеквадратический соответственно.

В поле Low Cutoff требуется ввести нижнюю, а в поле High Cutoff— верхнюю
частоту среза полосового фильтра.

В поле Lookahead Time вводится интервал времени, на которое включение уст-
ройства динамической обработки должно опережать появление резкого перепада
уровня сигнала.

Нажатие кнопки Flat возвращает график в состояние по умолчанию.
Кнопка Invert позволяет инвертировать график относительно диагонали, про-

ходящей через углы поля с координатами (100. 100); (О, О)
Если установлен флажок Splines, то будет включен режим аппроксимации гра-

фика сплайнами.

Frequency Band Splitter — кроссовер

Данный эффект применяется к одному выбранному блоку, находящемуся в
области выделения фрагмента проекта. В результате применения эффекта созда-
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ется несколько новых блоков, каждый из которых содержит сигналы, спектры
которых располагаются в одном из заданных частотных диапазонов. Окно эффек-
та показано на рис. 12.41.

(Frequency Band Splitter zl
Bands Crossovers Output Waves

j CE FA/oices|3200H г-70£ЮНг)

JCEFVoees l?OGQHz-8QQQHz)

ICEPVoces (6QCÎ z-2205i3Hzl

Presets

Max FIR filter See

320 dose

Рис. 12.41. Окно эффекта Frequency Band Splitter

Многопозиционным переключателем Bands задается количество частотных
полос, на которые будет «расщепляться» исходный блок. В полях Crossovers зада-
ется верхние границы частотных полос. В полях Output Waves отображаются на-
звания блоков, которые будут созданы в результате применения эффекта Band
Splitter. Названия складываются из имени исходного блока и границ частотного
диапазона.

В поле Max FIR Filter Size вы можете изменить размерность цифрового фильт-
ра с конечной импульсной характеристикой [8], используемого при реализации
кроссовера и позволяющего получить минимальные искажения фазового спектра
аудиосигнала. В случае возникновения ощутимых на слух искажений значение
этого параметра следует увеличить.

Vocoder — вокодер
Вокодер — специальный эффект, в данном случае заключающийся в том, что

производится модуляция одной (обрабатываемой) волновой формы другой вол-
новой формой — сигналом управления (обычно голосом вокалиста).

Рассмотрим опции окна диалога (рис. 12.42), которое открывается командой
Vocoder.

В раскрывающемся списке Control Wave (voice) содержится имя волновой фор-
мы, используемой в качестве управляющей, а в раскрывающемся списке Process
Wave (synth) — имя обрабатываемой волновой формы.
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эффекта Vocoder

В раскрывающемся списке Output To указан трек, на который будет записана
волновая форма, получившаяся в результате обработки.

В раскрывающемся списке FFT Size вы можете выбрать одно из стандартных
значений объема выборки для реализации алгоритма быстрого преобразования
Фурье, а в поле Overlays — ввести показатель передискретизации (рекомендуются
значения 4—12).

В окне есть еще несколько опций, способствующих повышению качества об-
работки эффектом:

> Interval Size — выбор временного интервала обработки волновой формы по ал-
горитму быстрого преобразования Фурье (рекомендованы значения 10—30 мс)

> Window Width — выбор ширины окна — одного из параметров быстрого пре-
образования Фурье (рекомендовано значение 90%)

> Vocal Crossover — частота разделения частотных полос кроссовера
> Resynthesis Window — выбор ширины окна, используемого для ресинтеза

сигнала вокодером. При малых значениях этого параметра согласные звуки
будут воспроизводиться более ясно. Значение параметра Resynthesis Window
никогда не должно быть больше, чем значение параметра Overlays

> Affect Level — уровень воздействия (пропорция микширования исходного и
обработанного эффектом сигналов)

> Amplification — усиление

12.2.6. Меню Options — опции мультитрекового редактора
В меню Options входят следующие команды и подменю:

> Loop Mode — циклическое воспроизведение выделенного фрагмента проекта
> Monitor Record Level(s) — включение измерителя уровня входного сигнала
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> Show Levels on Play and Record — включение индикации уровня сигнала в
режимах записи и воспроизведения

> MIDI Trigger Enable (<F6>) — включение режима управления процессом
редактирования по MIDI-интерфейсу

> MIDI Panic Button (<P>) — команда сброса MIDI-системы
> SMPTE Slave Enable (<F7>) — включение режима синхронизации от внеш-

него источника по SMPTE-интерфейсу
> SMPTE Master Enable — Cool Edit Pro сам будет выступать источником син-

хронизации по SMPTE-интерфейсу для других устройств
> SMPTE Start Offset — редактирование смещения времени старта в SMPTE-

формате (открывается окно Advanced Session Properties на вкладке General)
> Sample Accurate Sync — включение поддержки еше одного вида синхро-

сигналов
> Pause Background Mixing — приостановка процесса фонового микширования
> Metronome... — открывается окно Advanced Session Properties на вкладке

Metronome
> Windows Recording Mixer... — открывается стандартный микшер Windows, в

режиме работы с источниками записи
> Start Default Windows CD Player — открывается программа CD-плеер, пре-

дусмотренная в Windows no умолчанию

Остальные команды меню Options полностью дублируют аналогичные коман-
ды в режиме редактирования волновой формы.

12*3. Если вы хотите разработать свой плагин для
Cool Edit Pro

Плагины эффектов, на которых базируется Cool Edit Pro, имеют открытую ар-
хитектуру. На сайте фирмы производителя http: //www. syntrillium. com в разделе
Download имеется SDK (Software Developer's Kit — набор разработчика программ-
ных средств — библиотеки на языке C++) для разработки фильтров файлов (FIT)
и плагинов (XFM). Версия SDK, актуальная на момент написания книги, имеется
на CD-ROM, прилагаемом к книге — файл CEPROSDK. ZIP в папке СЕР2.

На этом мы завершаем подробный рассказ о Cool Edit Pro 2 — программе, спо-
собной в ваших руках творить со звуком чудеса.
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ЗАКЛЮЧЕНИЕ

Уважаемый читатель! Мы благодарны Вам за вопросы, конструктивные заме-
чания и предложения, которые поступают на сайт http://www.musicalpc.com/ и по
электронной почте petelin@musicalpc.com (Роману Петелину) или musicalpc@mail.ru
(Юрию Петелину), а также высказываются при личных встречах. Ценим Ваше доб-
рожелательное отношение.

Приятно, что на каждой встрече с читателями к нам подходят коллеги и гово-
рят о том, что книги им пригодились.

Электронная почта приносит огромное количество писем, в которых люди,
живушие в самых разных уголках страны и за ее рубежом, пишут, что книги по-
могли в методическом отношении конкретной информацией о практике работы с
музыкальными программами и необходимыми сведениями теоретического харак-
тера. Оказалось также, что книги, зачастую, способствуют преодолению психоло-
гического барьера, связанного со свойственными многим творческим людям со-
мнениями и недооценкой своих возможностей.

Надеемся, что эта книга — не последняя наша встреча. Будьте здоровы и счаст-
ливы! И да поможет Вам музыка.
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ПРИЛОЖЕНИЕ. ОПИСАНИЕ ДИСКА,
СОПРОВОЖДАЮЩЕГО КНИГУ

П.1 * Минимальные системные требования

1. Операционная система: Windows 98/ME/2000/XR
2. Процессор: Intel Pentium 233 MHz (рекомендуется Pentium III 700 MHz).
3. Объем оперативной памяти 64 Mb (рекомендуется 128 Mb).
4. Видеокарта: на шине PCI/AGP, видеорежим 600x800 (рекомендуется

1024x768) High Color или True Color.
5. Звуковая карта: любая 16-битная.
6. CD-ROM, поддерживающий диски CD Extra.
7. Свободное место на диске: 55 Mb (для установки Cool Edit Pro).

Данный диск соответствует формату CD Extra. CD-плеером он воспринимает-
ся как диск в формате CD Digital Audio. Компьютером он воспринимается как
диск CD-ROM.

П2. Содержание CD-ROM раздела диска
Папка PROJECTS — авторские проекты-сессии Cool Edit Pro 2
(перед загрузкой в Cool Edit Pro папки проектов рекомендуется
скопировать на жесткий диск)

Папка SAMPLES — примеры, ссылки на которые имеются в книге
Папка SOFTWARE - программы:

cep2cdr.exe — плагин Cool Edit Pro для «прожига* CD-R(W)
ceprosdk.zip - SDK для разработки плагинов к Cool Edit Pro
Cepsetup.exe — демонстрационная версия Cool Edit Pro 2.0
winzip81.exe - архиватор WinZip

Папка SRC - служебная

Папка WWW — Off-line-версия сайта авторов книги http://
www.musicalpc.com
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П.З. Содержание Digital Audio раздела диска

1. «Возвращайся» — музыка, аранжировка, запись, сведение Роман Петелин,
слова Юрий Петелин, вокал Ирина Димакова (Санкт-Петербург).

2. «Город» — музыка, слова, вокал, аранжировка, запись, сведение Семен Об-
ломкин; аранжировка, сведение Андрей Мовсесян, Игорь Орлов; вокал Аня
Макаренко (группа «Небритые», Санкт-Петербург).

3. «Больше, чем любовь» — музыка, слова, вокал Ирина Полякова; аранжи-
ровка, запись, сведение Владимир Арутюнянц (шоу-группа «X-Press», г. Ка-
менск-Шахтински и, Ростовская область).

4. «Хиросима» — музыка, запись, сведение Максим Корольков (проект
«Pentagon», Санкт-Петербург).

5. «Ветер» — музыка, слова, вокал Ирина Полякова; аранжировка, запись, све-
дение Владимир Арутюнянц (шоу-группа «X-Press», г. Каменск-Шахтинс-
кий, Ростовская область).

6. «Птицы» — музыка, слова, аранжировка, запись, сведение, вокал Семен
Обломкин; аранжировка, сведение Игорь Орлов (группа «Небритые»,
Санкт-Петербург).

7. «Янтарное море» — музыка, аранжировка, запись, сведение Роман Петелин
(Санкт-Петербург).

8. «Идущий в темноту» — музыка, аранжировка, запись, сведение Роман Пе-
телин (Санкт-Петербург).

9. «Нет до этого дела» — музыка, аранжировка, запись, сведение Роман Пете-
лин (Санкт-Петербург).

10. «Птица-тройка 2000» — музыка, аранжировка, запись, сведение Роман Пе-
телин (Санкт-Петербург).

11. «Аэлита» — музыка, аранжировка, запись, сведение Юрий Петелин; аран-
жировка, запись, сведение Роман Петелин (Санкт-Петербург).
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ПРЕДМЕТНЫЙ УКАЗАТЕЛЬ

Adjust Sample Rate 1O2. 123
Amplify 182
Analyze Loudness 119
AttacK Time 191
Auto Play 71
Auto-Cue 1O1. 114
AVi-файл 371

13

Band Limiting 201
Batch File Convert 69, 88
Brainwave Synchronizer 292

CD Burning 69
CD Digital Audio SO
Channel Mixer 186
Chorus 224
ClicK/Pop Eliminator 278
Clip Restoration 261
Close 69
Colors 31
Colors - Controls 31
Colors - Spectral 3O
Colors-Waveform 28
Constant Bitrate 93
Convert Sample Type TO2
Convolution 294
Copy 1O1
Crossfade 35, 1O5

О

Delay 228
Delete Selection 1O1
Delete Silence 1O1. 1O7
Distortion 299
Dither 91

Doppter Shifter 3O3
DTMF Signals 316
Dynamic Delay 23O
Dynamic EQ 255
Dynamics Range Processing 188, 192

Echo Chamber 234
Edit Ю1
Edit Favorites 353
Edit Waveform View 49
Envelope 2O4
Envelope Follower 415
Exit 7O
Ext. Controller 46
Extract Audio from CD 69
Extract Audio from Video 69

Feedback 23O
FFT Filter 257
Filters 25O
Find Beats 1O1. 111
Flanger 235, 237
Flush Virtual File 28. 9fl
Frequency Analysis 327
Full Reverb 241

Generate Tones 321
Graphic Equalizer 263
Graphic Phase Shifter 268
Group Waveform Normalize 1O1, 118

H

Hard Limiter 2O8
Hiss Reduction 283
Histogram 349
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Insert 4O2
insert In Muttitrack 1O1, 1O6
Insert Play List MultitracK 1O7
Invert 175

LooKahead Time 121

M

MIDI Trigger Enable 359
MIDI-файл 377
MIDI-файлы 371
Mix Paste Ю1. 1O4
MP3 92
Multitap Delay 244
Music 3OO

N

Mew 69
New Waveform 56
Noise Reduction 283, 268
Normalize 12O. 2O9. 212
Notch Filter 269

К

Redo 101
Release Time 121. 2O1
Reverb 238, 247
Reverse 177
Rewind 53
RMS 12O
RMS Histogram 122

Save 69
Save All 69
Scientific Filters 274
Scripts &. Batch Processing 359
Select Entire Wave 1O1, 1O7
Set Current Clipboard 1O1, 1O2
Settings 23
SMPTE 39
Snapping 1O1, 116
Software Developer's Kit 419
Stereo Field Rotate 216
Stop 52
Stretch 3O8
Sweeping Phaser 246
System 25

Open 69
Option 23

Pan/Expand 212
Parametric Equalizer
Paste 1O1
Pause 52
Peak Files 33
Phase Analysis 215
Pitch Bender 3O6
Play 52
Play to End 52

QuicK Fitter 273
QuicKVerb 246

271

Temp Fokler 27
Total Buffer Size 26
Trim 1O1

и
Undo 27, 101, 102
Use System's Cache 27

Variable Bitrate 96

w
Wave Cache 27
Wave Mapper 378
Waveform Display 33
Waveform Statistics 347
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Zero Crossings 1O1, 1О9
Zoom tn Horizontally 67

Абсолютная тишина 115. 178
Автоматизация 396
Анализ гистограммы 351
Аппроксимация сплайнами 398
Атрибуты треков 372
Аудиопорт 378

Белый шум 317
Битрейт 93

Блоки 37О
Блокирование 389
Быстрое преобразование
Турье (БП«Р) 251, 257

В

385

190

399

Внутреннее пересведение

Волновая форма 61
Воспроизведение 53
Ввращение стереополя 2"
Время атаки 19О
Время восстановления

Вставка Юб
Входные аудиопорты 378

Выбор буфера обмена 1О2
Выбор горячих клавиш 365
Выбор параметров автоматизации

Выбор устройств ввода 41
Выбор устройств вывода 41
Выделение фрагмента волновой формы
Выделение фрагмента проекта 388
Выделение фрагментов
нескольких блоков 388

Гейт 189
Генерация сигналов тонального набора 315
Генерация тишины 315
Генерация тона 321
Генерация шума 316

65

Гистограмма 122. 327. 347
Главное меню 49
Главное окно 5О
Горячие клавиши 363
Границы блока 371
Графический эквалайзер 253, 263
Гребенчатая ЛНХ 235
Грувы 392

Деэсер 192
Дилэй 229

Динамическая обработка 188
Дитеринг 35. 91

Зацикливание 391

И

Извлечение аудиоданных с компакт-доска 77
Извлечение аудиоданных из видеофайла 77
Изменение амплитуды 182
Изменение высоты тона ЗО8
Измерение Multitrack Latency 44
Измеритель уровня 55
Импульсная характеристика 296
Инвертирование звукового сигнала 175
Индикаторы перегрузки 55
Интенсивность шума 317

К

Канальный микшер 188
Команды главного меню 411
Компрессор 188
Конвертирование форматов файлов 8в
Контекстное меню блока 4О4
Контекстное меню блоков 4Ов
Контекстное меню трека 4О2
Контроль моносовместимости 327
Коррекция постоянной составляющей 45
Коэффициент компрессии 19О
Кроссовер 253
Кэширование 27



426 Cool Edit: Pro 2. Секреты мастерства

Л

Лимитер 169
Линейна прокрутки 63
Лупы 389

М

Макросы 361
маркер 51. 64, звб
Масштаб отображения 62, 37О
Меню Edit 412
Меню Effects T73
Меню File 69. 411
Меню Insert 414
Меню View 413
Метроном 392
Микс 394
Микшер 4О9
Микшер эффектов 377
Моносовместимость 345
Мультитрековая среда 369
Мультитрековые эффекты 382
Мультитрековый проект 373
Мультитрековый редактор 1О6
Мультитрековый режим 37.1О6. 369

Н

Нойс-шейпинг 43
Нормализация 117. 2О9
Нулевые точки ПО

Область тишины 1О8
Объединение блоков 368
Огибающие автоматизации 363, 396
Огибающая амплитуды 195
Ограничитель 166
Окно New Waveform 7O
Органайзер 4О8
Отображение спектральной функции ЗЗО
Отрицательная область трека 84

п
Панели инструментов 51
Панель Level Meters 56
Панель Time 58

Панель управления 51
Панорама 379
Панорамирование 394
Параметрический эквалайзер 253. 254,
38О
Перемещение блока 387
Перемещение границ блоков 4О7
Подключение эффекта 399
Подключение эффектов к треку 382
Подключение эффектов к шине 376
Подменю Amplitude 162
Подменю DirectX 18O
Подменю Unsupported 16О
Поиск фразы 114
Порог срабатывания 19О
Прогресс-индикатор 31

Расширение стереобазы Т77. 214
Расщепление блоков 388
Реверберация 236
Ресэмплирование 38

Свертка 294
Сессия 372
Создание новой волновой формы 7О
Создание огибающих 399
Соадание узлов 4ОО
Сохранение файла 81
Спектр 328
Спектральный анализ 327
Сплайн-аппроксимация 195
Среднеквадратическое значение сигнала 34S
Средний канал 212
Статистическая информация о файле 347
Стереобаза 214, 334
Стереогониометр 334
Стереосигнал 334
Сценарии 355. 361

Текущий трек Звб
Темп 391
Тип звукового файла 71
Тишина Ю8
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Тон грува 391
Тональность 391

Удаление блоков Зй8
Удаления узла огибающей 399
Указатель текущей позиции 51
Уровень аудиосигнала 54
Установка маркера 66
Установка уровня записи 54
Устранение клилпирования 28О

Фигуры Лиссажу 336, 342
Фильтр Баттеворта 274
Фильтр Бесселя 274
Фильтр присутствия 253
Фильтр Чебышева 274
Фильтрация 25О
флэнжер 235
Фоновое микширование 394
Фэйзер 235

Центр панорамы 214
Центрирование сигнала 163
Циклы 22О

Частота сэмплирования 123, 373

ш
Шаблон метронома 393
Шины 375
Ширина стереобазы 214
Шкала времени 64

Эквалайзер 253
Экспандер 189
Эффект Band Splitter 417
Эффект Доплера 236, ЗО4
Эффекты реального времени Зв5
Эхо-камера 233

Хорус 224
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К настоящему времени в серии «Компьютер и творчество»
вышли следующие книги Романа Петелина и Юрия Петелина,
посвященные проблемам применения персонального
компьютера для сочинения, записи, аранжировки музыки
и обработки звука.

Р. Петелин, Ю. Петелин. Персональный оркестр
в PC. Издательство «BHV-Санкт—Петербург»,
1998.- 240 с. Начинающим компьютерным
музыкантам о записи MIDI-композиции.

Р. Петелин, Ю. Петелин. Звуковая студия в PC.
Издательство «BHV-Санкт-Петербург», 1998. -
254 с. Начинающим компьютерным
звукорежиссерам о дополнении MIDI-композиции
вокальной партией и партиями в исполнении
акустических инструментов.

Р. Петелин, Ю. Петелин. Музыка на PC. Cakewalk.
Издательство «БХВ-Санкт—Петербург», 1999.— 512
с. Подробное описание универсального
музыкального редактора, системы подготовки
нотных партитур к изданию, интеллектуального
МЮЬаккомпаниатора, редактора гитарных
партий, трех пакетов аудио эффектов.

Р. Петелин, Ю. Петелин. Аранжировка музыки на
PC. Издательство «BHV—Санкт-Петербург»,
1999.- 272 с. Основы теории гармонии, программы
автоматической аранжировки музыки для
начинающих и продвинутых пользователей,
детальное описание технологии управления
ресурсами звуковых карт и синтезаторов,
поддерживающих стандарт Yamaha XG.

Р. Петелин, Ю.-Петелин. Cakewalk. "Примочки" и
плагины. Издательство «БХВ-Санкт-Петербург»,
«Издательская группа Арлит», 2000. — 272 с. Работа
с программой для создания реалистично звучащих
партий гитарного аккомпанемента, многими
MFDI- и аудиоплагинами.



МУЗЫКАЛЬНЫЙ

P. Петелин, Ю. Петелин, Cakewalk Pro Audio 9.
Секреты мастерства. Издательство «БХВ-Санкт—
Петербург», Издательская группа «Арлит», 2000. -
432 с. Подробное руководство по применению
профессионального музыкального редактора.

Р. Петелин, Ю. Петелин. Музыкальный компьютер.
Секреты мастерства. СПб.: БХВ-Петербург, Арлит,
2001. — 608 с. Книга переведена на английский
язык и издана в США: Petelin, Roman, and Yury
Petelin. PC Music Home Studio: Secrets, Tips, &
Tricks. Wayne: A-LIST, 2002.- 640 p. Теория
обработки звука. Звуковой редактор Cool Edit Pro
1.2. Виртуальный инструментарий музыканта
(Gigastudio, Reason). Теория и практика мастеринга
дисков.

Р. Петелин, Ю. Петелин. Sonar. Секреты мастерства.
СПб: БХВ-Санкт-Петербург, Арлит, 2002. - 656 с.
Детальное описание секретов работы с мощным
музыкальным редактором Sonar 1.3.1. Диске
формате CD Extra. В CD-ROM разделе видеошкола
о создании домашней компьютерной студии,
примеры проектов, демоверсии программ, много
статей и рассказ о «Музыкальном компьютере» с
сайта авторов. В разделе CD Digital Audio
музыкальные композиции авторов и читателей.

PC MUSIC
HOWSTUDIQ
Secrets, Tips & Tricks
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